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Introduction 
Genbox Family History is a complete genealogy software package that will help you organize your research, 
store your data, enter proper source citations, and produce professional-quality charts and reports that you 
can preview and modify, then print or publish on the web. 

Features 

Charts can be saved in Genbox format for later viewing or modification, or in JPEG or PNG format ready for 
inclusion on web pages. They can be printed on large-format printers or plotters for impressive color wall 
charts that will be the talk of your next family reunion. Text reports can also be saved in Rich Text Format 
(RTF) or HTML so you can edit them with your own editor or upload them to the web.  

Genbox has an attractive, powerful, and flexible user interface. 

Data entry boxes are thoughtfully organized onto multi-page tabbed dialog windows. Auto-completion on date 
and place boxes speeds data entry. A double-click on a selected box is all it takes to jump to associated data 
on another window or page, and back/forward arrows on the common toolbar will help you navigate among 
your jump positions. You can also step through your records one at a time, type in a name or ID in the key 
boxes at the top of most view windows, or set up a filter to quickly find and move between particular records of 
interest. Window fonts, sizes, and background colors are your preference. 

Genbox Family History has an unmatched level of flexibility and control in its production of genealogy 
charts.  

There are eleven pages of options available for controlling the five basic chart types (Ancestor, Descendant, 
Related, Convergent, Everyone). Multiple "key" individuals can be selected to focus chart production. The 
number of generations produced, the types of parent-child links to follow, and the kinds of "collateral relatives" 
off of the direct lines to include can be finely controlled, allowing charts to be produced for specific sections of 
a genealogy. Layout options include "direction of drop", link alignment, generational alignment, fan chart 
curved text type, book layout, "unboxed", "names on lines", and more. Styles and content can be assigned 
according to individual groups, to visually distinguish particular genealogical lines, surnames, key individuals, 
or any arbitrarily defined group. Styles include fonts for each type of text, box shapes (independently selected 
for box head and tail), shadows, fills, line styles, and colors. Content for individuals can be any combination of 
identifiers, attributes, events, pictures, and notes. Content can be independently selected for primary and 
spouse. Extra flags and icons can be added to further identify groups of individuals. Source citations can be 
included in the legend.  Numerous sizing options provide fine control over chart density, overall shape and 
size, and margins. Frames can be added to the chart, pictures, title box and legend box, controlling corner 
shape, fill, shadow, and colors. 

The text reports produced by Genbox Family History live up to the standards set by its excellent chart 
production.  

Eleven pages of options are available to help you control the eighteen basic text report types (Ancestor 
Narrative, Pedigree, Descendant Narrative, Outline Descendant, Family Group, Individual Narrative, 
Calendar, Individuals, Places, Events, Citations, Sources, Media, Researchers, Correspondence Log, 
Research Targets, Projects, Lists). Each report type has a number of layout options that make the reports 
ideal for numerous purposes. Produce everything from a simple data list or table to a multiple-section book 
with table of contents, unified name and place index, pictures, bibliography, and footnotes or endnotes. 
Multiple key individuals can be used to control the focus of the report. Fonts, headings, style, and format can 
be finely controlled. Individual content can be varied according to type of individual. 

For the narrative reports, an advanced context handler has the job of identifying and reducing redundancy in 
the output, to create a more natural text flow. When you have settled on a set of chart or report options that 
you like, you can name the options set and save it for later use, and even make it a choice on the Charts or 
Reports menu for the fastest access. 

Genbox has a powerful database engine, with full UNICODE support. 

Genbox Family History uses the Jet Database Library for its data storage and SQL query functions, the same 
database library as used by Microsoft Access 2000. Genbox is a fully UNICODE-enabled application. Text 
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data is stored in UNICODE format. GEDCOM import/export supports UNICODE and UTF-8 character sets. 
For Windows NT/2000/XP users, UNICODE text data can be entered directly into any text field in the system. 

Genbox supports multiple languages. 

The date routines, event templates, identifier types, and flag definitions include support for multiple languages. 
This allows the reports produced by Genbox to be output in different languages, by just changing the 
preferred output language in preferences. The program itself can now be installed in multiple languages. 
Future support will include more languages, and translation of the online help as well. 

Going beyond the basics, the unique data structure employed by Genbox offers support for 
previously problematic data relationships between individuals, events, dates, places, and source 
citations.  

Multiple personal names and identifiers, optionally linked to defining events, can be stored for individuals. 
Accurate relationships between each child and any number of parents can be stored. Any number of event 
types, attributes, and flags can be defined. Witnesses to events can be stored along with their roles. Places 
are considered independent data items in their own 6-level hierarchy. Each place can have multiple names, 
with optional date ranges of validity, yet still be recognized as the same place. Local sites are stored as the 
sixth level in the place hierarchy. Qualifiers can be applied to dates and places for a larger degree of 
expression. Source citations are divided into three levels, recognizing that source material is often found 
within a larger source, which now only needs to be entered once. Event types and source types are supported 
with a sophisticated template system.  

A powerful search system rapidly finds individuals matching your search criteria. 

You can define your SQL-powered searches by simply entering the matching values into the boxes on the 
search dialog. Complex relationships among up to four "logical" individuals can be part of the criteria. 
Searches can also be saved for future use. 

Individuals and other data items can be grouped into named lists which are then available for 
selection on charts and reports. 

This feature provides for some powerful and time-saving capabilities. List members can be defined by direct 
selection, as the output from a chart production, or as the output from an individual search. 

Genbox was designed with the needs of the researcher in mind. 

Unlike many other genealogy applications, Genbox is not just for storing your conclusions. It has been 
designed to support all phases of your genealogy research as well. Not sure which facts are correct? Store 
both sets! In fact, you can store every scrap of information you find, whether or not it conflicts or agrees with 
other information already stored. A second-generation approach to organizing data around sources, with a 
two-level approach of first identifying "personas" from sources and only later grouping them into "composite 
individuals" has been implemented. Data can be entered in "source lock" mode to rapidly and conveniently 
enter proper source citations at the time data is entered into the system.  

A project objectives hierarchy, research targets table, and a correspondence log are part of the system. Most 
records support two rich-text notes boxes: one for general notes and one for research notes. Charts and 
reports allow you to select which types of notes to include. 

Share your data with others. 

The GEDCOM 5.5 file format is supported for the transfer of data to/from other genealogical software 
programs. Additional tags have been defined to export the supplemental data types used by Genbox.  

Multiple character set standards are supported: ANSI, ANSEL, IBMPC, UNICODE, and UTF-8.  
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System Capabilities 
Genbox Family History uses the Jet Database Library for its data storage and SQL query functions, the same 
database library as used by Microsoft Access 2000. Text data is stored in UNICODE format. 
 
Maximum Records 
Individuals:    2 billion 
 
Individual Names and Identifiers 
Number per Individual: unlimited 
 
Maximum character length: 255 
 
Supported Multimedia File Types 
 
Image File Types  
BMP   Windows Bitmap 
JPG JPEG (Joint Photographic Experts Group) 
PNG Portable Network Graphics (8 and 24 bit) 
GIF Graphics Interchange Format 
PICT Macintosh PICT File 
PCX PC Paintbrush File 
TGA Targa Image File 
EMF Enhanced Metafile 
WMF Windows Metafile 
TIFF Tagged Image File Format (8 and 24 bit) 
 
Video File Types 
AVI   Audio/Video Interleaved File 
MOV, QT QuickTime Movie File 
MPG MPEG (Moving Picture Experts Group) 
WMV, WVX Windows Media File 
 
Audio File Types 
AIFF   Audio Interchange File Format 
AU, SND Audio Data File 
MID, MIDI Musical Instrument Digital Interface 
MP3, MPGA MPEG Audio Layer 3 
WAV Wave File Format 
   

System Requirements 
Genbox Family History runs under Microsoft Windows 95 or later versions (Windows 98, 2000, Me, NT, XP). A 
minimum processor speed of 600 Mhz is recommended, with 128 Mbytes of memory or more. Allow 40 
Mbytes of hard disk space for the program, with an additional 10 Mbytes for every 1000 people in your 
database.  
 
You will need to have Microsoft Internet Explorer 4.01 or later installed on your system to use the HTML 
output option and to view the online help.  
 
Microsoft Word is recommended for editing the reports produced by Genbox. 

Installation 
Genbox is installed automatically from the CD. 
 



       

Getting Started 
This chapter covers the essentials you need to know in order to get started with Genbox quickly. Genbox 
supports standard Windows Interface Usage guidelines for menus, mouse operation, window controls, and 
text entry. It also has additional features that will make data entry and other tasks easier to perform. 

Starting Genbox 
• To start Genbox, find the Genbox icon on the Windows desktop and double-click it. 

The Genbox Application Window will open, filling the screen. Beneath the title bar, you will see the menu 
bar and the shared toolbar. Across the bottom you will see the status bar. The workspace is the large, gray 
area beneath the toolbar. All data view windows in Genbox will appear in the workspace.  

 

When Genbox starts, it will automatically open the last active Genbox database, showing the Individuals View 
in the workspace. If this is the first time Genbox has been run, or if startup preferences have been set not to 
open the last viewed database, the Database Pick Dialog will appear. With this dialog, you can choose to 
create a new, blank database, to import a GEDCOM file into a new database, to select a Genbox database 
from among those recently viewed, or to browse for more files. 

Exiting Genbox 
• To exit Genbox, on the File menu, click Exit. 

Always exit the program this way, or by clicking on the "X" close box in the top right corner of the main 
window, to ensure that open databases are closed properly. 

Getting Help 
Genbox has a complete, online, context-sensitive help system. The Help Window will appear when help is 
selected. 

• To get help anywhere, press the F1 key. This works even when selecting menu options. 
• To get help on a particular window, click the question mark button on the window title bar. 
• To see a table of contents for help topics, on the Help menu, click Contents. 
• To search for help by keyword, on the Help menu, click Index. 
• You can also search for any text in the Help System by clicking the Search pane on the Help 

Window.  
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Creating a Genbox Database 
Before you can use Genbox, you will need to create a Genbox Database. You can create a blank database, 
ready for you to enter your data, or you can create a database by importing from a GEDCOM data file. 

• To create a new, blank Genbox database, go to the File menu and click New Database. Type a 
name for your database in the Open File Dialog. The Individuals View will open. Begin entering data 
on your first individual by typing their full birth name into the Name box. Press the TAB key to 
advance to the Sex box, and enter "Male" or "Female". 

• To create a Genbox database from a GEDCOM data file, click Import Data on the File menu, then 
choose "from GEDCOM file". The File Open Dialog will appear. If you have a GEDCOM file you want 
to use, you can select it now. When you have selected a GEDCOM file, click the Open button on the 
dialog. The Import File View will appear. Click the Import to New Database button. Type a name for 
your database in the Open File Dialog. After the data has been imported, the Individuals View will 
open, showing you the data of the first individual. 

Once you have a name entered for the individual, you can choose whatever data you would like to enter next. 
You can enter the names of parents and children of the current individual on this page. You can click the 
Events tab to display the Events page, where you can enter birth, death, and other event information for the 
current individual. 

Playing with a Sample Database 
The quickest way to become familiar with Genbox is to play with a sample database. A sample database 
allows you to see what the data views look like when filled with data. You can also make charts and reports to 
see the output capabilities of the program.  

Genbox is distributed with a sample GEDCOM file "sample.ged". When you first start Genbox, The Database 
Selection Dialog will include a "Sample" button. Click this button to open the sample database. The sample 
database will be initialized with the data imported from the sample.ged GEDCOM file. 

Shared Toolbar 
The main toolbar is shared by all views: the button operations apply to the active view. Tool tips are available 
for each of the toolbar buttons: pause the mouse cursor above a toolbar button and its function will be 
displayed. 

Data Views 
The underlying database is accessed and updated through data views, selectable from the View menu. 
Multiple views can be open at the same time. Each view displays data from a different main table. The views 
generally show one main data record at a time--the current record.  

Header Section 

Each view has a header section, which identifies the current record for the view by numeric ID and name. 
The header section usually is shown in a larger font. A different main record can be selected for viewing by 
typing its ID or name in the header section, or by using the first/previous/next/last buttons on the shared 
toolbar. 

Note: don't try to enter new data into the header fields. Enter data into the labeled text fields below. 

Page Tabs 

Under the header section is a row of tabs. The tabs provide access to pages which show subrecords or other 
information related to the main data record. The label on the tab indicates the type of data represented on the 
page. To see a page, click its tab. The current page fills the space immediately below the row of tabs. The 
selected tab and its page are drawn to appear "in front of" the other pages. Clicking the tabs does not affect 
the display of the header section, which allows you to continue to see the name and ID of the current record 
while you look at different pages of related data. Sometimes the labels on the tabs will be underlined. This 
indicates that there has been additional data entered on the indicated page. The underlining tells you whether 
there is something worth seeing on the page without needing to click its tab. 

Entering Text 



       

To enter text into a text box, you first need to select it so that it becomes current. The current text box is the 
one that contains the insertion point, which is a flashing vertical bar. The insertion point identifies the point at 
which typed text will be inserted. You can select a text box by clicking it. Or, you can use the TAB key to step 
through the text boxes and other data entry controls on a page in sequence, until you reach the text box you 
want to edit. You can also use SHIFT+TAB to step in the reverse direction. When you use the TAB key to 
move to a text box, the current contents, if any, will initially be highlighted (a different background color). 
Highlighting indicates the text has been selected. The selected text in a text box will automatically be replaced 
as soon as you start typing. If you want to keep the existing text in a text box and add to it or edit it, press one 
of the movement keys first (HOME, END, LEFT ARROW, or RIGHT ARROW) to remove the highlighting. 

Adding New Records 

New main records can be added by clicking the New Record toolbar button .  

Multiple Subrecords 

Many of the pages support multiple subrecords related to the main record. The subrecords may be shown one 
at a time, with a horizontal scrollbar to select them, as on the Individual Contact Page. Or, they may appear in 
a list, with each line representing a record, as on the Individual Identifiers Page. 

New subrecords on pages that support multiple subrecords can be added in several ways. On some pages, 
new records can be added by clicking the "star" button found beneath the horizontal scrollbar, as on the 
Individual Contact Page. Or, new subrecords are added by typing into the blank line at the bottom of a list, as 
on the Individual Identifiers Page and on the Children and Event lists on the Individual Summary Page. Some 
pages allow new records to be added by clicking the "...add" choice from a combo box and then typing the 
new value, as on the Individual Parents Page and the Individual Family Page. Clicking the "...add" choice on 
the Individual Events Page will bring up a list of all defined event types to choose from for the new record. 

Double-Clicking to Jump 
In many text boxes, a double-click of the left mouse button will cause a jump to the selected data item's main 
record. If you click an individual's Father text box, for example, you will jump to the individual record for the 
father. In this case, the Father's record becomes the new current record, and the Father box will now be 
displaying the father of this new individual. Repeated double-clicking the Father box will take you to each 
father in successive jumps, eventually ending on the earliest paternal ancestor recorded.  

In like manner, double-clicking the Place box on the Events Page will cause a jump to that place's main 
record on the Place View. The Place View will automatically be opened, or if already open the current place 
record will be updated. 

Genbox is heavily linked in this manner, making it easy to move between the main data views. The Back 
button on the common toolbar will take you in successive steps to the previous jump locations, and the 
Forward button will then allow you to repeat your forward jumps if desired. 

Context-Sensitive Menus 
The main menu bar is shared by all data views. The Edit, Data, and Select menus are context-sensitive; menu 
options may change according to the current data view, page, and box. 

In many text boxes, a click of the right mouse button will bring up an additional popup menu. This menu will 
have operations that apply to the current text box. 

Copyright © 2005  Thoughtful Creations. All rights reserved. 12



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 13

Viewing the Data 

Data stored in a Genbox database is easily viewed and modified with the View windows. Viewing and editing 
are combined: the record currently being viewed may be edited simply by typing the new data into the proper 
locations. 

Opening Views 

The underlying database is accessed and updated through views, selectable from the View menu.  Each view 
accesses a different main table. The Views menu is organized into groups of related views. There are five 
main data views that display genealogy data: Individuals, Places, Citations, Sources, and Media. There are 
four data views that are concerned with research: Researchers, Correspondence Log, Research Targets, 
and Projects. The Lists View has a unique layout; it displays sortable lists of other records. Three views 
allow control over customization of the current database: Event Types, Source Types, and Data Setup. 
Finally, the Preferences View allows control over program operation.  

• To open a view, click its menu option on the View menu. The view will open in a new window on the 
screen, showing either the first record in the table or the record that had been viewed most recently. 

• Multiple views can be open at the same time. 

Moving Between Records 

The views generally show one main data record at a time--the current record. Each view has a header 
section, which identifies the current record for the view by numeric ID and name.  

• To move to a different main record, type its ID or name in the header section. 
• You can also use the first/previous/next/last buttons on the shared toolbar. 

Using the Page Tabs 

Under the header section is a number of tabbed pages, which show subrecords or other information related 
to the main data record. The label on the tab indicates the type of data represented on the page. The tab of 
the current page appears "on top". A different page can be selected by clicking its tab. A page may have a 
scrollbar of its own, indicating multiple subrecords of that type are supported. 

Working with Data 

Each page has a number of labeled text boxes, check boxes, and list boxes. These boxes display data 
stored in the database. In general, for each text box there is a corresponding field in the current database 
record, with the same name as the label shown. The text box displays the data that is stored in the record 
field. 

• To edit data, type the new text in the text box. Changes are saved automatically. 

Jumping to Linked Records 

In many text boxes, a double-click of the left mouse button will cause a jump to the selected data item's main 
record. If you click an individual's Father box, for example, you will jump to the individual record for the father. 
In this case, the Father's record becomes the new current record (and the Father box will now be displaying 
the father of this new individual). Repeated double-clicking the Father box will take you to each father in 
successive jumps, eventually ending on the earliest paternal ancestor recorded.  

In like manner, double-clicking the Place box on the Events Page will cause a jump to that place's main 
record on the Place View. The Place View will automatically be opened, or if already open the current place 
record will be updated. 

In rich text note fields, if you highlight an individual's name or a place name, you can right-click on it and 
choose "Jump" from the popup-menu to jump to the selected item. 
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Genbox is heavily linked in this manner, making it easy to move between the main data views. The Back 
button on the common toolbar will take you in successive steps to the previous jump locations, and the 
Forward button will then allow you to repeat your forward jumps if desired. 

Record Properties 

You can view record properties for the current record on the Record Properties Dialog, including creation date 
and researcher. It also shows information on the current data table: name, number of records.  

• To view the Record Properties Dialog, on the Edit menu, click Record Properties. 
• Click the pushpin image to "pin" this dialog to the screen, so that it remains open while you move 

between records. 

  



       

Entering your Information 
This chapter describes in detail how to enter data into Genbox. There are five main data views where you can 
enter genealogy data: Individuals, Places, Citations, Sources, and Media. Most of your data entry will be 
on the Individuals View. This view is divided into several tab pages. The Summary page can be used for 
entering basic information about individuals. More detailed information can be entered on each of the other 
pages. Think of data entry on the Summary page as a "short cut"; entering basic data on the Summary page 
is equivalent to entering it on the detail tabs, and when you select one of the detail tabs, you will see that the 
information you entered on the Summary page also appears there. In general, any information entered on the 
Summary page could also have been entered on one of the detail pages. 
 
Adding a New Individual  
Adding a Related Individual  
The best way to add a record for a new related individual is to type the person's name into one of the 
relationship boxes for an existing individual record: either as the Father, Mother, Spouse, or Child. This allows 
you to create a record for the new individual and link it to other people in your database at the same time. On 
the Summary page, you can type a new name into the Father, Mother, Spouse, and children boxes for the 
current individual. You can also add parents on the Parents page, spouses and children on the Family page, 
and a variety of types on the Events page. In each case, the program will check the name entered against the 
names already stored. If there is a match, the Individual Pick Dialog will appear with more information. You 
can choose to link to an existing individual, or add a new individual, even if the name is exactly the same as 
an existing one. 

If you wish to add additional information to the new individual record added this way, you will first need to 
make it the current record by double-clicking on the name.  

Adding an Unrelated Individual  

To add a new, unrelated individual, first check that the Individuals View is the active view. You may need to 
click it if another view is active. 

On the Data menu, click New Individual, or click the New Record  toolbar button. You will see a blank 
record appear. The text "New" will show in the ID key box.  

Entering the Birth Name  

Begin by typing the birth name of the new individual into the Name box on the Summary Page. Type the 
name as it would normally appear when written: this is usually given name, middle name, surname, as in 
"Reginald Edward Smythe". Use normal capitalization.  

Press the ENTER or TAB key when you are done. You will notice that the "New" text in the ID Key box will be 
replaced with an automatically-assigned ID value, and the Name Key box will automatically update to match 
the name you entered. 

You can edit the birth name on this tab at any time. You will notice that the larger Name box will be updated 
as you type. 

Male, Female, Other  

Next, enter the sex for the individual: Male, Female, or Other. You can type "M" for male, "F" for female, "O" 
for other, or select from the drop-down list. Leave it as "Unknown" if there is any doubt. When the correct 
value is shown, press TAB.  

Father 

Next, you can type the name of the individual's father in the Father text box. When you press ENTER, you 
may get a message similar to this:  
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This means the program could find no individual record in the database with the name you typed for the 
father. Click Yes to have the program automatically create a new individual record for the father. When a new 
individual record is added this way, it will automatically be linked to the current individual.  

Confirmation of new individuals can be enabled or disabled on the Preferences View.  

Mother  

Next, you can type a name for the individual's mother in the Mother box. Type her maiden (birth) name, if 
known.  

Events  

When a father and mother are both entered on the Summary Page, the program will automatically create a 
birth event record for the current individual, and link it to the family of the father and mother as the birth 
parents. You will see a line in the Event list box appear with the text "Birth" for Event Type, and blank values 
for Date and Place.  

To enter the date of birth, click the Birth line in the "Date" column. Type the date of birth, such as "3 Aug 
1780".   

Press TAB to move to the Place column. Type the place of birth, such as "Little Chesterford, Essex, England". 
When you press TAB again, you will be moved to the Event Type column on the next line, and a drop-down 
list of event types will be displayed. You can press ESC to close the list. If you want to add additional events 
for the current individual, use the scrollbar or type the first few letters of the event type to locate the event type 
desired, then press ENTER.  

Linking to an Existing Individual  

If the father, mother, spouse, or child of the current individual already has a record in the database, you can 
link to them by simply typing their name in the blank provided. The Individual Pick Dialog will appear to display 
the matching names.  

You can also double-click the blank text box to cause the Individual Pick Dialog to appear. You can then 
select the desired individual for the link.  

The Preferred Name  

Genbox uses the preferred individual name when it needs to refer to an individual by a single name in text 
boxes and reports. The preferred name is a composite name made up of one or more names selected on the 
Identifiers Page by placing a checkmark in the "P" column. Genbox will combine the names automatically. If 
no name has been marked, the first birth name entered will be the preferred name.  

The preferred name is your preference. Feel free to choose whichever names and identifiers you think would 
be most helpful in identifying the individual within the program.   

The names will be combined with a special arrangement and syntax to help you recognize the name types of 
the parts:  

• Nicknames are shown in double quotes. 
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• Other names are shown in parentheses. 
• Suffix Titles are shown at the end, separated from the rest of the composite name with a comma. 
• Prefix Titles are shown at the beginning. 
• Alias names appear with a comma and the word "alias" preceding the name. 
• User ID values appear in square brackets. 

You can follow this convention when entering names for new individuals as well. Genbox will recognize the 
embedded names and store each in a separate name record for the new individual. For example: 

    John "Johnny" Smith (Smythe), fisherman of Broad Cove 

This name would be stored in four name records, each of a different type: 

• Birth name: "John /Smith/" 
• Nickname: "Johnny" 
• Other name: "/Smythe/" 
• Suffix title: "fisherman of Broad Cove" 

The preferred flag would be set for all names, since they were entered together. The resulting preferred 
name, in this example, matches the text as originally entered, even though the name is now stored in four 
different records. 

If you decide that you don't want to see certain names as part of the preferred name, go to the Identifiers page 
for the individual and clear the "P" flag next to the undesired names. 

Deleting a Spouse 

To delete a spouse on the Summary page, select the spouse, then press the DELETE key. If you confirm the 
action, the link to the spouse will be removed in the family record. Any children will remain linked to the family 
record, which now has only a link to the current individual. The information on the spouse will remain in the 
database, but no link from the current individual to the spouse will remain. 

If, instead, you choose to delete a family record on the Family page, all family information will be deleted, 
including family events. The link from the spouse to the current individual will be removed. Any children will no 
longer be linked to either parent. 

Unmarried Couples 

If a spouse has been linked to a primary individual, but no marriage event has been entered, Genbox will 
generate a default sentence of the form "[P] married [S]" on narrative reports. If it is known that the couple did 
not marry, the MARR_NOT event tag should be used. This generates a sentence of the form "[P] was not 
married <to [S]>". Or, if you want to indicate that you are not sure if they ever married, use the MARR_UNKN 
event tag. This generates a sentence of the form "[P] was not known to have married [S]". If you prefer not to 
show the link between the primary and spouse at all, you can use either the MARR_NOT or MARR_UNKN 
tag, then set the sentence template to "<>". This will generate a blank sentence, and prevent the default 
"married" sentence from appearing.  
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Entering Events 
This chapter describes how to enter individual events into Genbox. Event records are the "meat" of your 
genealogical research. They store the dates, places, names, ages, witnesses, and notes for all the events that 
make up the lives of the people in the database.  

Event data is entered on the Individuals View, on four different pages:  

• The Summary page lists all events for the current individual in a table. You can add events, dates, 
and places on this page. 

• The Events page is the main place to enter events data. Detailed information on one event at a time 
is presented and can be edited. 

• The Family page lists just the family events for one family at a time. You can add family events, 
dates, places and children on this page. 

• The Attributes page indirectly allows editing event records that contain attributes which persist over 
long periods of time. 

Basic event information can be entered on the Summary page: event type, date, and place. Detailed event 
information can be entered on the Events page, including spouse/child involved, linked name or attribute 
value, witnesses, and a custom template for formatting the information into sentences for use on narrative 
reports.  

Principals  

Genbox supports up to three individuals in each event having principal roles.   

• Primary - the current "focus" individual, or Parent1 for a family event. 
• Spouse - the other individual in a family event. The "spouse" role does not necessarily mean the 

couple is married. 
• Child/Other - either the child of a birth event, or any other individual, possibly unrelated to the other 

principals. 

For a birth event, the principal individuals are the father, mother, and child. For a marriage event, the principal 
individuals are the primary and spouse. For an association event, the principals are the primary and other 
individual.  

Witnesses 

Witnesses are individuals present at an event that do not (usually) fill one of the principal roles (primary, 
spouse, child/other). You can specify the role that each witness did fill, if any. Any number of witnesses can 
be associated with each event. At a wedding, the witnesses would include the minister, priest, or judge; 
groomsmen, bridesmaids, and guests. Witnesses are useful to track because they can provide hints to family 
relationships or to further research leads. Because they can be people of genealogical interest, witnesses are 
treated like other individuals. This means witnesses have their own individual record which can be viewed in 
the Individuals View just like all other individuals. 

Witness data can appear in two different ways on a report: 

• When the current individual is one of the principals for the event, the witnesses for that event can 
appear as extra detail information. 

• When the current individual is a witness for an event, that witnessed event can be included along with 
other events. 

Witnesses to events are entered on the Events page, on the Witnesses List. 

Principals of an event can also be added as witnesses to an event. This can be useful when they serve 
additional roles, or when you wish to record that a father was physically present at a child's birth. 

Entering Witnesses 



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 19

The name and optionally the role of each witness to an event is added on the Witnesses List on the Events 
page.  

The Witnesses List has four columns: Name, Role, T (template), and S (source citation). 

Witness Name 

Type the name of the witness into this box. If this is a new individual name, you will be asked if you would like 
to create a new individual record. 

Witness Role 

Each witness can have a role in the event. You can type any descriptive name you want here. Some event 
types have predefined roles, which have their own witness sentence templates. If you type the name of a 
predefined role, the corresponding template will be the default template for use on reports. 

Witness Template 

Click on the Witness Template check box to open the Witness Template Preview Dialog, where you can 
customize the default witness template for use with the current event and witness. A check mark in this 
column indicates that a custom witness template has been defined. 

Witness Source Citation 

The Witness Source Citation button indicates the surety level for the current witness information. Click it to 
open the Citations View to enter source citation information. For help, see the chapter Citing your Sources. 
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Entering Dates 
Date boxes have special handling in Genbox. You can enter dates in a number of formats, and Genbox will 
convert to the standard display format, as selected in Preferences. Genealogical dates are often imprecise--
you may not know the day, or the month, or you may be unsure about the year. The approach you should take 
is to carefully record exactly what you do know, as contained in your source. 

• To enter a simple day-month-year date, the best approach is to type the day number, the name of 
the month, and the year, as in 1 March 1986. You can also type the date with the month before the 
day, as in March 1, 1986. 

• Month names can be abbreviated: 3 Feb 1962 will be recognized as 3 February 1962. 
• If the day number is unknown, it can be omitted: October 1836. 
• If both the day and month are unknown, just a year can be entered: 1836. 
• If the year is unknown, you can still enter what you know, as in "23 May". But when the year is 

missing, Genbox will add parentheses around the input: (23 May). 

Long Dates and Short Dates 
In the database, dates are always stored as a number and a text portion. The number stores the year, month, 
day, and date type. The text portion contains any additional qualifiers, the second date of a range or period 
date, date flags, and any other text that could not be parsed by Genbox. The actual presentation of the date is 
controlled by preferences settings, allowing the date to be formatted in different ways. Genbox formats dates 
using two date formats, depending on where the dates appear throughout the system: 

• Long dates are used when space is not limited, as on the Events page. 
• Short dates are used when space is limited, as when dates appear as a column on a list view. 

Charts and reports can optionally be set to user either long date or short date formatting. Charts use short 
dates by default, while most reports use long date formatting by default. 

Long and short date format options are set on the Preferences View. You can set the formatting for long and 
short dates to be exactly the same, or very different, even with different date part orderings. 

Note when a month is entered as a number, and the day number is less than 13, as in 2/3/1962, the 
ambiguity will be resolved according to the preferences settings for date part order on short dates. If ordering 
is set for Day Month Year, this date will be formatted as 2 March 1962. If ordering on short dates is set for 
Month Day Year, this date will be formatted as 3 February 1962. To avoid this ambiguity, month names 
should always be used on data entry, rather than month numbers. 

Using Date Qualifiers 
You can prefix your date with a qualifier. There are several types of date qualifiers that Genbox understands 
and can use when comparing and sorting dates. 

Approximate Dates 
To indicate that a date is approximate: 

• Use the qualifier about, as in about 1946. 
• You can also use abt, circa, cir, ca, and ~ (tilde). 

"Before" Dates 
When you know the date occurred before a known date: 

• Use the qualifier before, as in before 1928. 
• You can also use bef and < (left angle bracket). 

"After" Dates 
When you know the date occurred after a known date: 

• Use the qualifier after, as in after 15 May 1929. 
• You can also use aft and > (right angle bracket). 

Estimated Dates 
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If you know some dates for a individual or immediate relative, you can estimate other dates. 

To indicate that a date has been estimated: 

• Use the qualifier estimated, as in estimated 1626. 
• You can also use est and say. 

Some common guidelines used when estimating dates: 

• A man marries at age 25. 
• A woman marries at age 21. 
• A married couple has their first child one year after marriage. 
• Subsequent children are born two years apart. 

For example: suppose you know a couple married in 1925, and had two children, but don't know any other 
dates. You could estimate the following: 

• The husband was born in 1900. 
• The wife was born in 1904. 
• The first child was born in 1926. 
• The second child was born in 1928. 

Another example: suppose you know a man was born in 1812, married, and had one child, but don't have 
other information. You could estimate: 

• His wife was born in 1816. 
• They married in 1837. 
• Their child was born in 1838. 

You can enter these estimated dates into the event records for the individuals, using the est qualifier to 
indicate these dates did not come directly from a source, but were estimated based on other information. 
Estimated dates are better than no dates, because you can sort events using them, and you have a starting 
point to begin your search for records. 

Calculated Dates 
To indicate that a date has been calculated from other known dates and ages: 

• Use the qualifier calculated, as in calculated 1742. 
• You can also abbreviate this to calc or cal. 

Suppose you have a death certificate that gives the date of death and age at death, but not the birth date. You 
can calculate the approximate year of birth by subtracting the age from the death date. Another example: 
suppose you know that in the culture of the individual, a certain religious event always takes place at a 
particular age. If the date of this event for the individual is known, you can calculate the date of birth. 

A calculated date is likely to be more accurate than an estimated date. You will still want to search for primary 
records that reveal the actual date, and the calculated date should be a good indicator for where to start your 
search. 

Surety Qualifiers 
When a source citation is added to a date, you can select a surety level for the information. Certain surety 
levels can have default qualifiers that indicate the surety level on reports. These default qualifiers can be 
specified on the Data Setup View, Defaults page. If a custom qualifier has not been specified, the default 
surety qualifier will be shown. For example: 

• For a "Marginal Evidence" surety level: perhaps 1750. 
• For a "Probable Conclusion" surety level: probably June 10, 1752. 
• For an "Assemblage of Evidence" surety level: almost certainly October 12, 1763. 

For both "undecided" and "Convincing Evidence" surety levels, no default surety qualifier is defined. 

Custom Qualifiers 
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You can enter other qualifiers of your choosing. These will be stored and shown as a prefix before the date. 

You may wish to enter your own surety qualifier for specific dates, overriding the defaults. For example: 

• perhaps 1750; maybe 1750; possibly 1750 
• probably 10 June 1752; apparently 10 June 1752; presumably 10 June 1752 
• almost certainly 12 October 1763; most likely 12 October 1763 
• without a doubt 23 March 1789 

You can also add custom qualifiers that help to define the date when the day or month is not known: 

• during the spring of 1920 
• late winter 1847 
• early September 1746 
• Christmas 1752 
• Sadie Hawkin's Day 1964 
• the Ides of March 45 B.C. 

Notes: 

• The automatic addition of date prepositions "on" and "in" are suppressed whenever a custom qualifier 
is present. 

• Genbox will not interpret custom qualifiers when sorting dates. Only the recognized portion of the date 
will be used. 

• While custom qualifiers can be multiple words, certain punctuation characters cannot be included in 
the custom qualifier: slash, comma, period, dash, and question mark (/,.-?). 

Entering Date Ranges 
You should enter a date range when you know an event occurred between two dates, but you do not know 
the precise date. 

• To enter a date range, use the keywords between and and, as in between 10 Aug 1845 and 12 
March 1847. 

• You can abbreviate the keywords to "bet" and "&", as in bet 10 Aug 1845 & 12 March 1847. 
• Or, you can simply use a dash between two dates, as in 10 Aug 1845 - 12 March 1847. 
• If the begin date of the range is unknown, enter only the second date, using the keyword "by", as in 

by 12 March 1847. 

A date range is inclusive (the begin and end dates are considered part of the range). 

Note    If you want to indicate that an event occurred over a span of time, enter a Date Span instead. 

Entering Date Spans 
You should enter a date span to indicate that an event occurred over a continuous span of time. Residency 
and Employment events often use a date span. 

• To enter a date span, use the keywords "from" and "to", as in from 3 March 1927 to 1 June 1929. 
• If the end date of the span is not known, enter only the "from" date: from 3 March 1927. You can also 

use "since": since 3 March 1927. 
• If the begin date of the span is not known, enter only the "to" date: to 1 June 1929. You can also use 

"until": until 1 June 1929. 

You can choose to have date spans formatted on reports as simply a dash between the two dates. However, 
a dash between two dates on data entry will be interpreted as a date range. 

Entering Month Names 

Genbox recognizes month names used in other calendar systems, in addition to those in the Gregorian 
calendar. When a month name is recognized from the Republican, Hebrew, or Islamic calendar, the date will 
be converted to the equivalent Gregorian date for storage and display, and the date will also be preserved in 
its original calendar format enclosed in parentheses. 
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Entering Sort Dates 

When only a partial date is known, or when the ordering of children's births is known but not the actual dates, 
a special sort date may be entered. You can use sort dates to order events when you know their relative 
order, but not the actual dates. The sort date is used only for sorting the events into the correct chronological 
order. Sort dates are displayed inside the program but are omitted on generated charts and reports. 

When entering event dates, a sort date may be entered by enclosing it in square brackets, as in [12 April 
1858].  

Sort dates can have alternate text appearing before the first bracket; this text will print on charts and reports. 
For example, you could enter an event date of "during the great flood [12 April 1858]". The full text would 
appear as entered on the screen, but only the part "during the great flood" would appear on reports. 

Additional text can appear inside the brackets after a valid date. This can be used to enter time of day for 
sorting events occurring on the same day, or for any comments that should be excluded from the output. For 
example: 

shortly after dawn [12 April 1858 10:00] 

a little past noon [12 April 1858 12:15] 

at dusk [12 April 1858 19:30] 

By including times in the sort date brackets, these three dates would sort into the correct order. 

Entering Date Part Alternatives 

Genbox can accept dates with date part alternatives, like 15/18 Oct 1845, March/May 1892, and 15 Aug 
1840/1842. The single slash means "or" between the two part alternatives given. When a date with a date part 
alternative is entered, Genbox will automatically add a sort date that contains only the first in the pair of date 
part alternatives. Thus, if you type 15/18 Oct 1845, Genbox will format this as "15/18 Oct 1845 [15 Oct 1845]". 

A date with a single "or" between a pair of day, month, or year alternatives will also cause a sort date to be 
automatically generated. This allows dates such as "15 or 18 Oct 1845" to be entered and interpreted 
correctly. 

Entering Special Dates 
Genbox recognizes today, tomorrow, and yesterday and will convert them to standard display format. 

Unrecognized Date Entry 
If Genbox does not understand the last portion of your date entry, it will display the portion it does understand 
followed by the remainder enclosed in parentheses. This remainder will be stored in the database and also 
displayed when the date is formatted on charts and reports. This means no portion of your date entry will be 
lost; you can enter whatever you like for a date value, and Genbox will be able to store it and display it. If you 
do not understand the date in a source record, you can record it exactly as it appears. However, the 
unrecognized portion cannot be used when sorting dates. 

If Genbox cannot understand any part of your date entry, the entire text will be enclosed in parentheses. 

If Genbox does not understand what appears to be the month name, it will generate an error message. This is 
most likely a typing error. If the entered text is what you intended, enclose the entire date within parentheses 
to save it. 

Some examples with parenthetical parts: 

• 14 September 2002 (8 Tishri 5763)   
• 10 May 2001 (at least I think so!) 
• 30 Aug 1548 (or 1549) 
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• 2 Jan 1836 (the original says "the second day of the first month...") 
• 1746 (Source has Ma..., so month is probably May or March) 
• probably in late June, 1928 (or maybe early August) 
• (the summer of the great flood) 

Calendar Systems 
A number of different calendar systems have been used since antiquity. Several are in use today. This 
section provides a summary of the various calendar systems, and describes the calendar system support in 
Genbox. 

The Gregorian Calendar 
Today, the Gregorian calendar serves as the international standard for civil use.  It was introduced in 1582 
by Pope Gregory XIII. On the Gregorian calendar, a common year is 365 days in length; a leap year is 366 
days, with the extra day in the month of February. Leap years are determined according to the following rule:  

• Every year that is exactly divisible by 4 is a leap year, except for years that are exactly divisible by 
100, unless these centurial years are also exactly divisible by 400. 

This means 1988, 1992, and 1996 were leap years (divisible by 4); 1700, 1800, and 1900 were not leap years 
(divisible by 4, but also divisible by 100 and not divisible by 400); 2000 was a leap year (divisible by 4, 100, 
and 400). 

The Gregorian calendar is more accurate than the Julian Calendar, which it replaced. With an average year of 
365.2425 days, the error rate (compared to a tropical year of 365.2422 days) is one day in about 2500 years. 
It was first adopted by most Roman Catholic countries in 1582. Other countries adopted it at various times: 
Germany in 1700, Great Britain and its colonies in 1752, Russia in 1917-1918. 

The Hebrew Calendar 
The Hebrew calendar is the official calendar of Israel and is used for religious purposes by Jews worldwide. It 
is a combined solar/lunar calendar, with the complicated goal of keeping its years in sync with the tropical 
year and its months in sync with the lunar cycle. An ordinary year has 12 months and 353, 354, or 355 days. 
A leap year has 13 months and 383, 384, or 385 days. Each month starts approximately on the day of a new 
moon. The first day of the calendar year is 1 Tishri, Rosh HaShanah. Years are counted from the new moon 
that occurred on 6 October 3761 BC. 

The Islamic Calendar 
The Islamic calendar is the official calendar in Saudi Arabia and other countries around the Persian Gulf. 
Other Muslim countries use the Gregorian calendar for civil purposes and the Islamic calendar for religious 
purposes. The Islamic calendar is a purely lunar calendar, so it shifts with respect to the seasons and solar 
calendars. Years are counted since Mohammed's emigration to Medina in 622 AD. 

The Republican Calendar 
The Republican, or French Revolutionary calendar, was introduced in France on 24 November 1793 and 
abolished on 1 January 1806. A year consisted of 365 or 366 days, divided into 12 months of 30 days each, 
followed by 5 or 6 additional days. Years are counted since the establishment of the first French Republic on 
22 September 1792. That day is known as 1 Vendemiaire of the year 1 of the Republic. During the short time 
the calendar was in use, the years 3, 7, and 11 were leap years. 

The Early Roman Calendar 
The early Roman calendar was nominally a lunar calendar. The year was 355 days long, with twelve months 
that varied between 29 and 31 days, with 28 days for February. An extra month was added in some years to 
bring the calendar back in sync with the seasons. Years were counted ab urbe condita, that is, "from the 
founding of the city" of Rome (1 AUC).  

The Julian Calendar 
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The Julian calendar was adopted in 709 AUC (46 BC on the Gregorian calendar) by order of Julius Caesar, 
to bring order to the calendar and to correct for the discrepancy with the seasons without requiring the extra 
months. Unlike the earlier Roman calendar, the Julian calendar is truly solar, with 365 or 366 days a year. It 
also established the lengths of the months we still use today. For the Julian calendar, the leap year rule is 
simply every year divisible by 4. The average Julian year is thus 365.25 days, or about 11 minutes and 15 
seconds too long, an error rate of one day every 128 years. 

Adoption of the Gregorian Calendar 
The adoption of the Gregorian calendar began in 1582 and continued over a period of 350 years. In 1582, the 
error in the Julian calendar had accumulated to 10 days. The adoption of the Gregorian calendar in that year 
initially by Italy, Spain, Portugal, and Poland included skipping 10 days to catch up with the tropical year: 
October 4, 1582 on the Julian calendar was followed by October 15, 1582 on the Gregorian calendar. By 1752 
when Great Britain switched, the error had accumulated to 11 days, so Wednesday, September 2, 1752 in 
Great Britain and its colonies was followed by Thursday, September 14, 1752. 

Old Style Dates 
The Gregorian calendar officially designated January 1 as the first day of the year. While the Romans had 
also used January 1 as the start of the new year, other days were later used, beginning in the seventh century 
A.D. Standard practice varied depending on the country and sometimes by different groups within a county. In 
the ninth century, the use of March 25 as the start of the year began in parts of Europe, becoming widespread 
by the twelfth century. So in the British colonies, March 25 was considered the first day of the new year in the 
Julian calendar. Thus, dates in January, February, and most of March would have a year one less than 
otherwise would be expected. George Washington, who was born on 11 Feb 1731 on the Julian calendar, 
was born on 22 Feb 1732, according to the Gregorian calendar. 

Throughout the world, civil practice of celebrating January 1 as the first day of the year sometimes preceded 
official practice. Even in England, January 1 was used as the start of the year for some purposes before the 
official adoption of the Gregorian calendar. Years starting on January 1 were called "historical years". The 
year starting March 25 was called the Civil or Legal Year, although the phrase Old Style was more commonly 
used.  

Scotland officially changed to January 1 as the starting day of the year in 1600, 152 years before England. 
The year 1599 lasted from March 25 until December 31. However, Scotland did not adopt the Gregorian 
calendar in 1600 - it was not until 1752, along with England, that Scotland adopted the Gregorian calendar 
with its new leap year rules, and made the correction of eleven days. 

Having these two different days for the start of the year causes ambiguity for dates in January, February, and 
most of March. On historical documents, you may see dates marked "Old Style" or "O.S.". This means the 
year shown is according to the old system of using March 25 as the first day of the year. Dates marked "New 
Style" or "N.S." would indicate a starting day of January 1 was used.   

Double Dates 
More commonly, dates falling January 1 - March 24 in the period from 1582 to 1752 are shown on historical 
documents as a double date to resolve the ambiguity:  two year numbers are shown, separated by a slash: 
the first year is the "Old Style" year; the second number is the "New Style" year, as in "17 January 1729/30". 
Only the year is doubled. Dates on or after March 25 of each year are not shown with double dates. The use 
of a double date format implies the date is a Julian calendar date. In the Washington family bible, for example, 
a double date appears on the entry for the birth of George Washington: "George Washington, Son of 
Augustine by Mary his Wife was born [on the] 11th Day of February 1731/2 about 10 in the Morning". 

Double dates also permit the proper chronological sorting of events. The Old Style date 12 Dec 1741 came 
before the Old Style date 15 Feb 1741. Without the double date format, these dates would not sort correctly 
in Genbox. When you add the double dates, the dates become 12 Dec 1741 and 15 Feb 1741/42, which do 
appear in the correct order, because it is the second year of a double date that is used for sorting. 

Interpreting Old Style Dates 
Because Old Style dates have March 25 as the first day of the year, genealogists have to be careful in their 
interpretation of dates before 1752: 

• The day after December 31, 1733 was January 1, 1733. 
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• The day after March 24, 1733 was March 25, 1734. 
• A John Smith born April 2, 1689 and a William Smith born March 19, 1689 could be brothers, with 

William nearly a year older than John. 
• A child baptized on March 10, 1729 could indeed be the legitimate child of a couple married February 

13, 1730, if the baptism date was recorded in Old Style and the marriage date in New Style. 

Recording Old Style Dates 
Most authorities agree dates should be recorded in the style of the times and places in which they were 
recorded. That means you should enter Old Style dates when that is what you have, indicating such by using 
a double date format (only for dates January 1 - March 24) or by adding "(Old Style)" or "(O.S.)" after the date. 

Unfortunately, historical documents do not always use double dates or "O.S./N.S." notation, which can make 
the date ambiguous. What should you do when you are not sure if the date you have is Old Style or New 
Style? Examine the entire context of the source record carefully. Most records are recorded chronologically. 
Study the pattern. If the December dates are followed by January dates of the same year, or if March records 
were followed by April records of the following year, they were most likely recorded in Old Style and you can 
indicate such in your records.  

If you still can't tell for sure, but you have an educated guess, add your guess in parentheses after the entry: 
17 Mar 1744 (O.S.?). 

Converting Dates 
Genbox uses the Gregorian calendar internally for its date operations. You may wish to convert your Old Style 
dates (and dates of other calendars) to the Gregorian calendar (New Style). When you convert a date, include 
the date as it originally appeared in the source in parentheses after the converted date, as in "22 Feb 1732 
(11 Feb 1731 O.S.)". 

Be careful when converting dates. A church christening record for "the 6th day of the third month" may or may 
not be the 6th of March, depending on the starting day of the year, for example. If you are not sure, enclose 
the portion of the date that you do not understand in parentheses. 

Genbox includes a Date Converter Tool that can be used to convert dates. 

 

 

Double Dates in Genbox 
Genbox can display dates prior to a specified cut-off year (typically, the year of adoption of the Gregorian 
calendar in the country of your ancestors) in double date format. Specify the cut-off year on the Preferences 
Dates page.  

• To enter a double date, enter the Old Style year first, followed by a slash, then two digits for the New 
Style year, as in "3 February 1722/23". This format is only valid for days January 1 - March 24, and for 
years beginning in 1583. 

• To indicate that a date is in Old Style (Julian) for days March 25 - December 31, add "(Old Style)" 
or "(O.S.)" after the date. 

You can have Genbox automatically format entered dates in double-date format by selecting "Automatic 
double dates" on the Preferences Dates page. Enter the second year (New Style) into the date field, and 
Genbox will automatically add the first (Old Style) year. 

Note:  If double date format is not used, Genbox will treat the date as a Gregorian date.  

Proleptic Calendars 
Historians sometimes apply calendar systems to epochs earlier than their adoption, even though people of 
that time would have used a different system. To indicate this extension, the adjective proleptic is sometimes 
inserted before a calendar name. This allows us to say, for example, that the Julian calendar was adopted in 
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46 BC, the date on the proleptic Gregorian calendar that is equivalent to the year 709 AUC. The Date 
Converter tool will show dates in calendar systems for periods both prior to their adoption and after their 
discontinuation, with the exception of the Republican calendar.  

The proleptic Gregorian calendar is used internally by Genbox for all date information.  

BC / AD 
The system of numbering years BC (Before Christ) and AD ("Anno Domini", in the year of Our Lord) was 
instituted in about 1280 AUC by the Roman abbot Dionysius Exiguus, who reckoned that the Incarnation had 
occurred on March 25 in the year 754 AUC, with the birth of Jesus occurring nine months later. Thus the year 
754 AUC was designated by him as the year 1 A.D., making the current year 527 A.D. This change affected 
the Julian calendar, which was in use at the time. The Gregorian calendar, which is used today, continues this 
year numbering system. It is also common practice now to show Julian dates earlier than 527 A.D. using this 
numbering system as well.  

The equivalent terms BCE (Before Common Era) and CE (Common Era) are sometimes used in place of BC 
and AD. 

Genbox formats dates with a year earlier than 1000 using the selected labels for BC/AD. 

Note    There is no "year 0" on the proleptic Gregorian and Julian calendars; the year before 1 AD is 1 BC. 
This means that on the proleptic Gregorian calendar, 1 BC, 5 BC, etc. are leap years. 

BC Dates in Genbox 
• To enter a B.C. date, type the letters "BC" after the year, as in "42 BC". 
• You can also indicate a B.C. date by prefixing the date with a minus sign (dash). 
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Places 
Places in Genbox are considered individual data items, which have their own data records, viewable with the 
Places View. A place can have multiple names defined, its own associated media, notes, and citations. 

Place Level Hierarchy 
Each place record in Genbox is defined with a place level. The six place levels are: 

• Nation/Area - United States, England, France, North America 
• State/Province - Ohio, Newfoundland 
• County/Parish - Hamilton County, Natchitoches Parish, Co. Ulster 
• Township - Springfield Township, Brighton Twp 
• City/Town - London, Maysville 
• Local Site - County Courthouse, Mercy Hospital, National Archives, The Washburn Family Estate 

The names on the place levels are meant to be suggestive; City/Town could also include village, hamlet, etc.; 
County/Parish could also include district. When entering data, look at the place names and decide on a 
consistent way to divide them into six levels. 

Each place record links to a higher place record. Local Site links to City/Town; City/Town links to Township; 
Township links to County/Parish; County/Parish links to State/Province; State/Province links to Nation/Area. 

A Local Site can also link to a higher Local Site. This means you can structure your place data with an 
unlimited number of place name divisions below the City level. The program will treat all these levels as Local 
Site levels. 

A Nation/Area can also link to higher Nation/Area. This allows nations to be grouped by continent. It also 
allows larger governmental structures to be represented: "England" links to "Great Britain", which links to 
"United Kingdom", which finally links to "Europe". This extra structure is useful when performing data searches 
and filtering. On reports, only the first Nation/Area is included in the place names. 

Place levels can also be skipped: City/Town could link directly to State/Province, for example, skipping both 
the Township and the County/Parish level. When the data is available, though, place levels should not be 
skipped. 

Because places link to higher places, each place record stores only one piece of a full place name. The name 
stored in a place record is only the name at its level. Consider the place name: 

    Front Porch, Bob's Antiques, Old Style Village, Antiquity, Goodman Twp., Meigs County, Ohio, 
United States 

This would be stored in Genbox as 8 place records, each linked to a higher record: 

• Front Porch -  local site 
• Bob's Antiques - local site 
• Old Style Village - local site 
• Antiquity - city/town 
• Goodman Twp. - township 
• Meigs County - county/parish 
• Ohio - state/province 
• United States - nation/area (links to North America) 

Blank Place Levels 
When entering place names, include as many of the place levels as known: rather than just city and state, 
enter city, county, and state. Separate each place name level with a COMMA. If a level is not known, a 
comma can be inserted to help Genbox assign the other place names to their proper levels. 

Auto-completion 



       

When typing into the Place box, Genbox will provide auto-completion text, based on the history of places 
recently entered, on other place values entered for the current individual, and on places stored in the Places 
Table. This means only a few keystrokes are needed to enter place names that have been entered before. 
Even for new places, only the lower place levels need to be typed, as Genbox will recognize the commas 
entered and begin the auto-completion anew on each place level. When the auto-completion text matches the 
full name you wish to enter, press ENTER to accept the value and move to the next field. Otherwise, continue 
typing the new place name.  

Leading Modifiers 
If the precise location of an event is not known, or if the precise location is known but it does not correspond 
with a known place name, a leading modifier can be used before the place name, to "modify" the information 
that follows. Genbox will treat any lowercase text appearing before the first capitalized word as the place 
modifier ("number words" appearing before the first capitalized word will be considered part of the place 
name, as in street addresses). For example: 

     near Hobogon, Missouri 

     30 miles north of Railwood, Montana 

    just off the coast of South Carolina 

    in a dry creek bed behind 2446 Maple Street, Treetown, Ohio 

     next to, or perhaps under, an old stump on the trail leading west from Cherry Grove Park, St. Somewhere, 
Texas 

     the master bedroom, second floor, of his summer home at 2258 Romano, Naples, Italy  

The modifier text will be stored in the Event record, not in a Place record. When charts and reports are 
produced, the leading modifier will be shown along with the place name. 

On the Events page, leading modifiers will appear in the Local Site box, before the local site name, if any. 

Initial Place Data 
Each new, "blank" Genbox database begins with several hundred place records already defined. These 
records are for nations of the world, U.S. states, Canadian provinces, counties of the United Kingdom, 
Australian states, and several well-known cities. Short forms of the names are also included in some cases. 
This data helps to anchor the places system, to improve consistency in entered data and provide the auto-
completion routines with a set of known values to match against. 

If you develop an extensive or specialized place database in one of your databases, you may wish to import it 
into your new Genbox database as an even better starting data set. 

Deleting Places 
• To delete a place record, choose Delete Place on the Data menu, or click the Delete Record  

button on the toolbar. All references to the place will be set to zero. Research targets for the place 
will be deleted as well. 

Opening the Magnify Place Dialog 
Sometimes it is helpful to view/enter the place name parts separately, rather than working with the complete 
name all on one line. The Magnify Place dialog was designed for this purpose. This dialog allows you to easily 
move name parts between place levels and verify the levels of the new place names being added. 

• To open the Magnify Place dialog, first click in the place name field, then press F5 or choose 
"Magnify Place..." from either the right-click context menu or the Select Menu. 
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Notes 
A genealogy is more than names, dates, and places. It is an exploration into the fascinating world of our 
ancestors. How they lived, what was important to them, what were there dreams, their achievements and 
tragedies. It is this related information that makes a genealogy compelling to the reader. In Genbox, this 
information is stored in the General Notes boxes. You can write as much about your ancestors and their 
world as you like. The general notes can be included in the body of your reports, immediately following the 
factual information that they amplify. 

While researching your genealogy, you may find it helpful to have a convenient place to store your research 
notes related to specific data items. A place to record your past research efforts, your thoughts and your "to-
do" items. If something looks wrong or doubtful, you'd like to make a note of it before you forget. What you 
would like is a place to record notes about your research, separate from the genealogical data itself. In 
Genbox, this information can be stored in the Research Notes boxes. The research notes boxes appear next 
to the general notes boxes on a number of data view pages. By keeping the general notes and research notes 
separate, it is possible to generate reports that contain just the general notes or just the research notes, or 
both. Include the research notes when you would like a "research report" for your own use. Include just the 
general notes when preparing your genealogy for publication.  

General notes and research notes can be entered for a number of data items:  

• Individuals 
• Individual identifiers 
• Parent links 
• Families 
• Events 
• Places 
• Place names 
• Sources 

In addition, there are other note boxes for special purposes throughout Genbox. 

Entering Notes 

Note boxes can contain an unlimited amount of text. When entering text, use complete sentences. The notes 
will be shown on reports just as you type them. 

Text Styles 

The General notes and Research notes boxes contain rich text. Unlike text in most data entry boxes, the 
text in notes can be styled: bold, italic, and underline. Use these styles to enhance the text, emphasizing 
words that you want to draw attention to. 

• For bold style, click the Bold button  on the toolbar, or type CTRL+B. 

• For italic style, click the Italic button  on the toolbar, or type CTRL+I. 

• For underline style, click the Underline button  on the toolbar, or type CTRL+U. 

These style buttons on the toolbar will be disabled when the insertion point is not in a notes box. 

Note   There is no "font style" toolbar button for note fields. On reports, notes will be shown in the font 
selected for the body of the report. On the screen, the font for notes is selected on the Preferences View. 

 

Source Citations in Notes 
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Note boxes do not have an associated source citation button, unlike other data entry boxes. Because notes 
can contain a large amount of text, source citations should properly be placed after each small section to 
which they apply, usually just a few sentences. 

1. To add a source citation to a note, click the position in the text at which the note number should 
appear. 

2. Click the Source button  on the toolbar or press the F4 function key. You will see a code similar 
to [S120] inserted into the note, and the Source Pick Dialog will appear. 

3. Choose a source record from the Source Pick Dialog, or click "Add New" to enter a new source 
record. 

4. After choosing a source, the Citations View will open. Here, you can enter the "where in source" 
information, such as the actual page number in the source where you found the information. 

Field Codes in Notes 

In addition to source citation codes, notes can have other special field codes that appear enclosed in square 
brackets, such as [L1234]. The field codes will be replaced with data values when the note appears on a chart 
or report. By using field codes for data values, such as individual names and place names, Genbox will be 
able to include index references and HTML hyperlinks on the reports. It can also save you a lot of typing. 

The full range of field codes available for event templates can be used in the notes. However, the field codes 
that are specific to event records will only work correctly in the general notes and research notes on the 
Events Page. In other notes, they will have a blank value. 

To add a field code to a note, first position the text cursor at the proper location, then do one of the following: 

• Type it in directly, or 

• Open the Add Field Code Dialog by clicking the Insert Field Code button  on the toolbar, or by 
typing CTRL+D. 

Previewing Notes 
If you have added field codes or embedded source citations to your note text, you may wish to preview how 
the note will be displayed on reports, once all the field codes have been filled with data values. 

• To preview how your note text will appear on a report, click the Toggle Codes button  on the 
toolbar, or press the F2 key. 

When showing field values, the note box will be in read-only mode. Source citations will be shown as 
footnotes. Press F2 again to return to normal mode. 

Private Notes 
Sometimes you may wish to store your own personal observations or reminders in the notes fields, but don't 
want these additions to appear on charts, reports, or GEDCOM exports. You can mark a range of text as 
"private" by enclosing the text in curly braces. For example:  

Martha was feisty until the day she died. {This is the aunt that didn't come to our wedding.} She was sorely 
missed by her husband. 

On reports, this will print "Martha was feisty until the day she died. She was sorely missed by her husband." 

Note you can set the "override privacy flags/marks" setting when you do want to see the private notes on the 
output. 
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Opening the Notes View 

When you want to view the contents of a notes field in a larger window, you can open the Magnify Notes 
View. This view allows you to see the notes on the current page in a larger view. A number of operations can 
also be performed on the note text, such as spell checking, wordwrap, importing text from a file, and exporting 
text to a file. 

• To open a Notes View for the current notes field, press F5 or choose "Magnify Notes" from either 
the right-click context menu or the Select Menu. 

The Notes View is modeless. This means you can freely move between the Notes View and other views, 
entering and modifying text. 



       

Adding Multimedia 
Adding pictures and other multimedia to your database can make your charts and reports much more 
interesting. Follow these broad guidelines: 

1. Use a scanner to create electronic images of your pictures. 
2. Save the images in separate files with descriptive filenames. 
3. In Genbox, create a media record for each image, audio, and video file. 
4. Define links from individuals, families, events, places, sources, or researchers to the media records. 
5. Select appropriate options on the Media options page when making charts and reports. 

Media Control 

The Media control is used to select and display the multimedia that is linked to a data record. The Media 
control appears in the following places:  

• Individuals View, Summary page: link multimedia to individuals 
• Individuals View, Family page: link multimedia to families 
• Individuals View, Events page: link multimedia to events 
• Places View, General page: link multimedia to places 
• Sources View, General page: link multimedia to sources 
• Media View, General, Content, and Clip pages: show multimedia associated with the media record 
• Media Preview Dialog: display the multimedia in a larger view window 
• Researchers View, General page: link multimedia to researchers 

The Media control is the open space on the right side of the page. It initially displays the principal media that 
is linked to the data record, if any. Any number of multimedia objects can be linked to each individual, family, 
event, place, and source. 

Media Control Buttons  

There are four media control buttons beneath the image area: Play, Previous, Next, and New.  

• The Play button will appear as a picture when a picture has been linked to the current data record 
and it is being shown. Click this button to view the picture in the larger Media Preview Dialog.  

• The Play button will have an ear on its face when an audio sound is the linked media. Click this 
button to hear the sound.  

• The Play button will look like a film strip when a video is the linked media. Click this button to start 
the movie. A second click will stop the movie.  

• The Play button will display an image of the world  when a URL is the linked media. Click this 
button to open your web browser and view the linked web page. 

• The Play button will display a document when the linked media is an object. Click this button to 
view the object in its native application. For example, if the linked media record is a Word document, 
then Microsoft Word will be launched to display the file. 

• The Play button will display a question mark when the linked media is of unknown type. 
• The Play button will not appear if there is no linked media, and the Media control will be blank. 
• Use the Previous button and the Next button to step through all of the pictures linked to the data 

record. If both buttons are grayed, that means there are no other pictures. If a button is bold, that 
means there are more pictures to view in that direction. Clicking a grayed button will cycle to the 
picture at the other end of the sequence. 

• Click the New Media Link button  to add a new media link to the current data record. The Select 
Media Dialog will appear and allow you to choose the media you wish to link. If you are adding the 
first media object to a data record, you can also click the open area to bring up the dialog.  

Caution    Be careful not to confuse the media buttons with the subrecord buttons on the Events page and 
the Family page. The media buttons always appear BELOW the Media control.  The subrecord buttons 
always appear immediately below the horizontal scrollbar, ABOVE the Media control. 

When you already have a picture, you can double-click it to jump to its record on the Media View where you 
can set picture properties, such as a caption and preferred size for reports. 
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Principal Media 
A data record can have several media records linked to it. Of these, only one can be marked as the principal 
media for the data record. The principal media is the one that will initially be displayed alongside the data in its 
view. It is also the media that will appear on charts, and on reports when the number of media items is set to 
one. 

Marking Media as Principal 
The first media record linked to a data record is marked as its principal media record. If there are several 
media records linked to a data record, you can choose which one of them to mark as the principal media: 

• On the data view, use the media next/previous buttons to bring the desired media into view. 
• Right-click on the media control to display the popup menu. 
• Select "Mark as Principal Media" from the popup menu. 

Media File Search Paths 
When you specify the file names for your media files, you can enter either a complete file path (one 
beginning with a driver letter or backslash) or a partial file path. A partial file path, also known as a relative 
file path, will cause the system to search for your file according to the following sequence: 

1. The Preferred Folder for Media Files, as set in Preferences. 
2. The Default Folder for Media Files, as set in Data Setup. 
3. The same folder as the database file (.GDB) 
4. The application directory (the directory where GENBOX.EXE is installed) 

This search order (preferences folder, data setup folder, database, application) is fixed. If you have entered 
relative file paths, this search order allows you to easily redirect where the system expects to find your media 
files.  

You can redirect the location for all media files globally (by changing the value in preferences) or all media in 
a particular database (by changing the value in Data Setup). Otherwise you can have your media simply 
stored with the database or a subfolder beneath the database. Finally, media that would be useful for several 
databases can be stored in the application folder or a subfolder. 

Overriding the Media File Search Path 
In addition to letting the system apply the default search order for media files with relative file paths, you can 
prefix your filename with one of the following prefixes to override the default search order and pre-select 
which of the four default file paths will be used: 

• "pref" 
• "data" 
• "db" 
• "app"  

Include the double quotes enclosing the prefix, as in: 

    "data"\media\gen7\AuntTilda.jpg 

 If the media file is not found in the specified location, no other locations will be searched. 



       

Citing Your Sources 
The source documentation is what separates the genealogy of an beginner from an expert. Source 
documentation that is properly formatted and complete lends credibility to your work. It provides 
accountability, because a fact that is properly documented can be verified. Information without the 
documentation to back it up is sure to frustrate the next researcher, who will either repeat your research or 
ignore your data altogether. 

What should be documented? The general rule is: 

• Any fact that is not general knowledge should have a source citation. 

Adding Source Citations 

• To add a source citation to a data item, click the "open book" Source Citations button to the right 
of the text box that contains the data item. 

• If the data item is in a list, there will be a column of open-book icons for the same purpose. 
• To add a source citation to a portion of a rich text note, highlight the range of text that applies, then 

click the source citation  button on the main toolbar. A marker will be inserted at the end of the 
marked range. 

When adding the first citation for a data item, you will be prompted first to choose a source record, or create a 
new one. Then the Citations View will appear. If a citation already exists for a data item, clicking on the 
Source Citations button will open the Citations View and the citations will be displayed. Additional citations 
from other sources can then be added.  

Source Citation Button Faces 

The faces of the "open book" source citation buttons indicate both the presence of a source citation and the 
selected surety level for the corresponding data item: 

•     - (star) Convincing evidence. 
•     - (plus) Assemblage of evidence. 
•     - (tilde) Probable conclusion. 
•     - (dash) - Marginal evidence. 
•     - (bullet/zero) - A source citation record exists, but no surety assignment has been made yet. 
•     - (blank) No source citation record exists. 

See the section Assertion Surety Levels for a fuller description of these levels. 

Source Citations Embedded in Notes 

For rich text notes, source citations will be marked with a special format: the letter "S" followed by the source 
citation record ID and surety code, delimited in square brackets, as in "[S48~]" for a source citation ID of 48 

and surety of "probable conclusion". You can click within the brackets and then click the source citation  
toolbar button to jump to the indicated source citation record. You can also delete the marker to remove the 
reference to the source citation, or cut and paste it at a new location within the note, or change the surety 
level to a different code. Rich text notes can have multiple source citations for different (non-overlapping) text 
ranges; in this case, the range of text to which a source citation applies will end when the previous source 
citation marker is reached, or when a hard line break is reached. 
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Source Documentation Views 

In Genbox, source documentation is divided between two views: the Sources View and the Citations View. 

• The Sources View displays records from the Sources table. The Sources table has one record for 
each source. 

• The Citations View displays records from the Citations table. The Citations table records define the 
links between data items and source records. Each data item, or assertion, can have citations to 
multiple sources. The Citations View presents all the source citations for a particular assertion as a 
group. 

There can be many citations to the same source record. By keeping information on each source in a separate 
table, most of the citation information only needs to be entered once. 

The Sources Table also has a similar feature. Source records can link to higher source records. When a 
source document is actually found within a larger source, such as a book, the information on the higher 
source is kept in a separate record from the lower source. Then, if another source document is used from the 
same higher source, the information on the higher source does not need to be entered a second time. 

This means, when a data item is linked to a citation record, the citation record will be linked to a source 
record, which in turn can be linked to a higher source record. A data item can have multiple citations, as well. 

Citation Support Levels 

The Citations table stores links from data items to source records. Each Citation record can specify how well 
the source supports the data item. The Support Level can be one of the following values: 

• +2: Primary and Direct Support 
• +1: Secondary or Indirect Support 
• -1:  Inconsistent 
• -2:  Direct Conflict 
• ?    Undetermined 

Primary and Direct Support 

Primary means that the source was recorded by someone with personal knowledge of the data and that it 
was recorded at or near the time of the event. Direct means that the source directly addresses the assertion 
that is being linked. If the assertion is that a birth occurred on a particular date, direct support would mean that 
the source specifically mentions that the birth occurred on that date. 

Secondary or Indirect Support 

Secondary means that the source was recorded by someone without personal knowledge of the event, or 
that it was recorded long after the event occurred. Both of these conditions tend to degrade the accuracy of 
data. Indirect means that the source doesn't specifically state the assertion, but it can be inferred from the 
context and other data that is included. 

Inconsistent 

A support level of inconsistent indicates that the source may be suggesting the assertion is wrong at one 
point, but that it also seems to support it at another point. 

Direct Conflict 

A support level of direct conflict indicates the current source's data negatively supports the assertion. In fact, 
the source is asserting something opposed, such as an entirely different date, different place, different 
relationship, etc. It is still important to include these source citations, so that the surety of the conclusion can 
weigh all of the evidence, both pro and con.  
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Undetermined 

New Citation records initially have the support level set to undetermined. When you have made a 
determination of the support level of the source for the assertion, you should change the support level to one 
of the other values. 

Citation Credibility Levels 

Each Citation record can also specify a level of credibility for the source. The Credibility Level can be one of 
the following values: 

• Very high 
• High 
• Medium 
• Low 
• Very low 
• Undecided 

Citation Rationale 

The Rationale text box can be use to store text that briefly explains why you believe the cited source is 
relevant to the current assertion. It is for your own personal research purposes, and does not normally appear 
on output reports. You can store here the reasons why you assigned a low/high support level or low/high 
credibility, or the facts extracted from the source that you think make your case, or personal reminders of work 
yet to be performed. 

The rationale text is entered on the Cited Sources page and appears as a column in the cited sources list on 
the Assertion page, so that it can be used when assessing the overall surety level for the assertion. 

Assertion Surety Levels 

A data item, or assertion, can have more than one source citation. Each source citation can have a support 
level, credibility level, and rationale. By careful consideration of all of the source data, the support levels and 
credibility levels, a determination is made for the Surety Level of the assertion. 

Source citations with a high support level will increase the surety level, and citations with a low support level 
will decrease the surety level. Also, source citations with a higher level of credibility should be weighed more 
heavily. 

The Surety Level of an assertion can be one of the following values: 

• 4: Convincing Evidence 
• 3: Assemblage of Evidence 
• 2: Probable Conclusion 
• 1: Marginal Evidence 
• 0: Undecided 

Convincing Evidence 

A surety level of convincing evidence means that the sources have convinced you of the validity of the 
assertion. They were of high credibility, mostly from primary sources, directly stating the assertion. You 
consider the assertion to be reasonably certain, and your reports will present the asserted data as a fact. 

Assemblage of Evidence 

A surety level of assemblage of evidence means that there was a "preponderance" of evidence in support of 
the assertion. While there may not have been any primary sources, or maybe the assertion wasn't stated 
directly, but there were many sources available that suggested the assertion with reasonable certainty. You 
will report the fact as "most likely" true. 
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Probable Conclusion 

A surety level of probable conclusion suggests that, while you believe the assertion is correct, your evidence 
isn't as strong as you hoped. You still have some doubts. That key document you wanted couldn't be found, 
and what you did end up with was either sparse or had other problems. Still, you don't have a strong reason to 
think the assertion is wrong. On reports, you will qualify the fact as "probably" true.  

Marginal Evidence 

A surety level of marginal evidence suggests that, far from finding anything conclusive, your evidence is very 
minimal. Maybe all you have is an oblique reference in a highly questionable source. Or, the data that you do 
have doesn't seem to agree well, leading you to believe something is suspect. On the other hand, you do 
have some support, and some source documentation is better than nothing. Also, it may spark the next 
researcher into investigating the issue further. On reports, you will qualify the fact as "perhaps" or "maybe" 
true. 

Undecided 

A surety level of undecided means you haven't had an opportunity to properly consider the sources, and 
have left the default surety level unchanged. 

Source Templates 

The formatting of source citations is complex. A citation should provide enough information so that the next 
researcher can easily relocate the source. Because there are many different types of source documents, there 
are also many different source citation formats. In Genbox, the formatting of a source citation is controlled by 
a source template. The source template controls how the data is presented to the user. Like the event 
templates, the source templates reference values stored in the data records, using variables. 

Each source record is categorized by its Source Type. The source types are defined in the Source Templates 
table, which can be viewed with the Source Types View. The Source Templates table contains default 
templates for each source type. This simplifies the formatting of source citations considerably. Once you 
identify the type of source record, Genbox can format the source citation automatically, using the default 
templates. Each source record can also have its own templates. This allows you to modify the default 
templates to better suit individual source records, if desired. 

Source Lock Mode 

A good practice to follow when entering your genealogical data is to begin with your source documents, 
working with one source document at a time. You enter all the information you can extract and store it to the 
proper records in your database. You may add data for several individuals. After you finish with the first 
source document, you then move on to the next one. 

When entering data this way, you can use Source Lock Mode to automatically create source citation links 
between the data you enter and the "locked" source document record. 

To use source lock mode: 

1. Open the Individuals View and the Sources View. 
2. On the Source View, move to the source record that you want to lock. 
3. You may wish to click the Evidence page so you can view the evidential data while you work. 
4. To lock the source record, click the image of a key that is on the Sources view. Or, go to the Select 

menu and click Lock to Source. The image of a key will change into the image of a padlock, and the 
Sources view title bar will include the word "LOCKED". These changes indicate source lock mode is 
on.  

5. On the Individuals View, enter the data that is contained in the source. Citation records will be created 
automatically. Also, any data fields that are edited will also receive a source citation record 
automatically. (Data that is only viewed will not receive a source citation.) 

6. When you are done, click the image of a padlock that is on the Sources view. Or, go to the Select 
menu and click Unlock Source. 



       

Note The key on the Individuals View, which is used to select Source Filter Mode, will NOT change when you 
click the key on the Sources View. 

Source Filter Mode 

In addition to Source Lock Mode, you can also choose Source Filter Mode. This is similar to Source Lock 
Mode, in that data you enter will automatically receive source citations to the locked source record. But 
Source Filter Mode also filters the display of data: only data items with source citations to the current 
source will be displayed in the Individuals View. This means most of your individual records will be hidden, 
and many of the events, identifiers, and other details of the remaining individuals will appear to be missing. 
But remember: this is a filtered display; the data not shown is still stored in the database. 

To use source filter mode: 

1. Open the Individuals View and the Sources View. 
2. On the Source View, move to the source record that you want to lock. 
3. You may wish to click the Evidence page so you can view the evidential data while you work. 
4. To lock the source record, click the image of a key that is on the Individuals view.  The images of 

keys on both the Individuals View and the Sources View will change into padlocks. The Individuals 
View title will include "LOCKED to Source X", where "X" is the Source ID number. The background 
color on the Individuals View will also darken. These changes indicate source filter mode is on.  

5. On the Individuals View, you will see only the individuals and records that have source citations to the 
locked source record. You can enter more data and it will automatically receive a source citation to 
the locked source. 

6. When you are done, click the image of a padlock that is on either the Individuals View or the Sources 
view, or go to the Select menu and click Unlock Source. 

The advantages of Source Filter Mode include: 

• You can lock a source to see what data is linked to it. 
• You can return to source filter mode to add or modify data linked to a source record 

Source Names 

When you are entering your research, it is important to record data as accurately as possible. This includes 
recording names exactly as they appear in your source. 

Deleting Sources 

To delete the source record currently visible on the Sources View, click the Delete Record  button on 
the toolbar, or choose Delete Source from the Data Menu. 

When a source record is deleted, all linked source citation records are also deleted. Lower source records are 
kept, but the link to the higher source is set to zero. 
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Organizing Your Research 
The key to making the best use of your research time is organizing your tasks and identifying your objectives. 
Genbox provides several tools for managing your ongoing research. 

Overview 

The general goal of a genealogist is to reconstruct a family history that is as accurate as possible. This is 
accomplished by performing a thorough search for relevant information sources, careful analysis of the 
evidence, and finally the formation of well-supported conclusions, which take all of the evidence into account. 
It is this careful, thoughtful, step-by-step process from sources to conclusions that produces the best results, 
and "doing it right" can also make genealogy a more rewarding experience. 

During your collection of source documents, you will encounter conflicting data--dates, places, and other facts 
that do not seem to agree. Which is correct? Don't store one and ignore the other, as that would be jumping to 
a conclusion; instead, store all of the relevant data you find. Genbox supports the storage of multiple data 
values for names, events, and relationships. Two different birth dates or places? Create two birth event 
records. Two different sets of parents? Store two parent family records. Carefully document your sources for 
each set of information. Later, you can evaluate the credibility of each piece of evidence, both in the context of 
the source where it was found and in light of all the information collected. Your final conclusions can refer to 
both the supporting and conflicting accounts and explain your reasoning for why you think one fact is more 
likely than the other. 

The previous chapter stressed the importance of citing your sources.  

A second-generation approach to organizing data around sources, with a two-level approach of first identifying 
personas from sources and only later grouping them into composite individuals has been implemented. 
Data can be entered in source lock mode to rapidly and conveniently enter proper source citations at the 
time data is entered into the system.  

Research Notes 

Most records support two rich-text notes boxes: one for general notes and one for research notes. You can 
use the research notes boxes as a "work area" or "scratch pad" to jot down your ongoing research status, a 
list of "to do" items, things to check, your hunches, whatever you like. Charts and reports allow you to select 
whether research notes should be included. On reports, you can also select whether the research notes 
should appear in the main body of the text or in the footnotes/endnotes. 

Research Targets 

When you identify a part of your genealogy that you want to investigate further, you can easily mark it as a 
research target. Research targets are marked (and accessed) by clicking the Target button  on the data 
view for the desired data record: 

• Individual identifiers: Identifiers Page 
• Individual parent links: Parents Page 
• Individual spouse links: Family Page 
• Individual events: Events Page 
• Research on an individual in general: Notes Page 
• Place names: Places Names Page 
• Research on a place in general: Places Notes Page 
• Research on a source: Sources Notes Page 

When you click a Target button, the Research Targets View will open to display the Research Targets record 
associated with the current data record. If no record exists, a new one will be created.  

The coloring of the Target button indicates whether a Research Target record exists for the current data 
record, and its status: 
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 (gray): no Research Target record exists. 

 (red rings on gray): Target record exists, but no searches have been defined. 

 (red rings on yellow): one or more open searches have been defined. 

 (black rings on green): all searches have been completed. 

Research Target records are good for keeping track of your research related to a data item. You can describe 
what you are looking for, plan your research trips, and record your findings. 

On the Research Targets View, the Target page identifies the data record that is the target, and lists the 
searches that have been defined for it. It has a Description box where you can describe the nature of your 
research. The Searches Page displays information on each search scheduled for the current research target. 
Your results are stored back to the same search records, providing you with a history of your past research 
efforts. The Links Page shows how your research efforts are related to your project objectives. 

Projects and Objectives 

Researching a genealogy can be a very big undertaking. There can be dozens of genealogical lines of 
interest, each with hundreds of research tasks that could be performed. You need some way to organize 
those tasks, make decisions about priorities, and keep track of progress, at both the low level and the big 
picture. 

The Projects View supports these capabilities. You can define top-level projects that are composed of lower-
level objectives. Objectives can have their own sub-objectives, creating a hierarchical organizational 
structure. The General Page provides for entry of status information on projects and objectives: date 
scheduled, date completed, priority, status, percent complete. It also has a notes box for a description of the 
project or objective. The Objectives Page displays the project hierarchy as an indented list, or tree. Each 
objective is listed, along with an indicator of its current status. With this page, you can study the project as a 
whole, and identify areas where you want to work next. Clicking an objective will cause a jump to that record. 

Each project/objective record can be associated with a number of research targets. The Research Page lists 
the Research Target records that are linked to each project/objective record. Using this page, you can tie your 
research efforts directly to your larger research goals. 

Correspondence Log 

Another organizational goal is keeping track of your correspondence with archives, courthouses, 
governmental offices, distant relatives, and other researchers. When did you send a letter, to whom, and why? 
Where is the letter now? What information did you request the last time you wrote to Uncle Fred, and how 
long has it been? Who is your contact at the Peabody Library, and what is the address? 

You can keep track of your correspondence with the Correspondence View. The Log Page displays a list of all 
correspondence records. You can click its column headers to sort by correspondence type, direction, 
correspondent, date, or subject. You can add new correspondence records by typing into first blank row at the 
bottom of the list. For the currently selected correspondence record, you can view and enter Details and 
Storage information at the bottom of the page. 

The Contact Page provides a place to view/enter address and E-mail information for each correspondent. 

 

Merging Records 

A fundamental task in genealogy research is determining when two (or more) identified individuals are actually 
the same person. Genealogies are built by identifying the connections between people, so much can be 
gained by finding these individual-to-individual matches. Typically, the data collected will not be an exact 
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match, and the overlap will be only partial. Maybe the names are spelled slightly differently, or the birth dates 
are off by a few days.  

A good way to compare a pair of merge candidates is to open their data records side-by-side. To open a 
second Individuals View in Genbox, choose the "Windows: New Window" menu option. This will open 
another copy of the current view. You can choose "Window: Tile Horizontally" to get them side-by-side. Then, 
use the key boxes to position each view on one member of the merge candidates pair. By stepping through 
the tabs on each view, all of the data stored for each of the individuals can be compared. 

Extracting Marked Subrecords 

When you have determined that data stored for an individual actually belongs to a separate individual, you 
can mark subrecords that you want to move to a new individual main record. 

1. To mark subrecords: Go to each subrecord that you want to extract on the Individuals View. 
2. On the Select menu, click Mark/Unmark. Or, press CTRL+M. 

You can also mark/unmark all subrecords for an individual with options on the Select menu. 

Once you have the desired set of subrecords marked, on the Data menu, click Extract Marked Subrecords. 
The subrecords will be moved to a new individual main record. 
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Searching and Grouping 
Loading all your information into a database is great for storage, but not of much use if you can't easily find 
what you are looking for later. Genbox provides a number of ways to search for data. You can quickly locate 
single records or groups of records. 

View Headers 

View windows that display data records have a header section, which contains an ID box, a Name box, and 
a Filter button. The header section indicates the current record and filter conditions, and can be used to select 
the record to view.  

• If you know the ID of the record you want to view, the easiest way to locate it is to type the ID into the 
ID box and press ENTER. 

• When you know the name of the record, type it into the Name box and press ENTER. You can type 
just part of the name if you prefer. In most views, Genbox will automatically complete the name to one 
of the existing records; if this is the name you intended, simply press TAB to accept it; otherwise, 
simply keep typing more of the name. 

• When there are several records with names that match the name you typed, a Pick Dialog will 
appear, displaying data on each of the matching records. You can select the record you intended from 
the list. 

Pick Dialogs  

Each of the main data types has a corresponding Pick Dialog that can be used to select records. A pick 
dialog will appear whenever the name value you enter in a data reference text box is ambiguous. It will display 
all the matches that have been found, and allow you to select the record or group of records that you 
intended. You can also specify filtering conditions for the list, to make it easier to find the records of interest. 
More information is available on each of the pick dialogs:  

        Citations Pick Dialog

        Correspondence Pick Dialog

        Icon Pick Dialog

        Individuals Pick Dialog

        Media Pick Dialog

        Places Pick Dialog

        Projects Pick Dialog

        Research Targets Pick Dialog

        Researchers Pick Dialog

        Sources Pick Dialog

Refer to the Table of contents for where to find details on each of these dialogs. 

Filtering Views  

The data views normally display all records stored in the database. Using the record movement buttons on 
the toolbar, you can step through all records that have been stored.  

Sometimes you may be interested in a small subset of the records. You can define a filter for the view. When 
a filter is active, only the records that match the filter will be visible when the record movement buttons are 
used: the First Record button will take you to the first matching record, and the Next Record button will take 
you to the next matching record, skipping over all records that don't match the current filter conditions. This 
allows you to quickly move between records that are related, according to your selection criteria.  



       

1. To filter records, press the Filter button  at the right side of the header section of the view. A Pick 
Dialog will open. 

2. Enter the filter conditions you want. For the Individuals Pick Dialog, this can be name pattern, range 
for birth date or death date, sex, number of children, number of spouses, number of families, and 
individual flags. 

3. Click the Set Filter button. The Pick Dialog will close, and the first matching record will be the current 
record. 

The Filter button will have a pressed appearance  whenever a filter is active. This is to remind you that the 
record movement buttons are only stepping through a subset of the total records. 

• To turn off filtering, press the Filter button . A Pick Dialog will open. 
• Click the Clear Filter button. The Pick Dialog will close, and the Filter button will resume its normal 

appearance. 

Lists 

Some operations are easier or quicker to perform when records can be grouped into lists. Rather than 
selecting records one at a time, you select a predefined list instead.  

The List View is for manipulating all types of lists in Genbox. Lists can be viewed, created, edited, renamed, 
copied, pasted, and deleted. Lists can then be used for group record selection on charts, reports, filters, 
queries, and export. You can also use a list to delete a group of records at once, mark all records in a group, 
copy a list to a view filter, or use a list to update the flags for individuals, places, or media. 

Genbox has a number of predefined lists, such as the lists of Individuals, Families, Places, Sources, and other 
main data records. Some lists are created automatically by the program as the results of various commands: 

• The Query Results list is created when you run a query with the Search View. 
• The Possible Duplicates list is created when you use the Match Finder Tool. 
• The Potential Problems list is created when you use the Problems Spotter Tool. 
• The Jump History list maintains a record of all views and records visited, to support the Back and 

Forward buttons. 
• The Filter Lists are created when you define a filter for any of the main views. 
• The Flag Lists display the records that currently have each type of flag set. 
• The Mark Lists display the records that have been marked. 
• The Chart Keys, Chart Starters, and Chart Results lists are defined automatically when a chart is 

produced. 
• The Report Keys list is defined automatically when a report is produced. 

You can define your own lists, by copying and pasting from other lists. You can create groups of records that 
will then be available for use on charts or reports, either as the keys or as a styling or content group.  

Searches 

The most powerful and flexible search capabilities for individuals are supported by the Search View. Several 
pages of search criteria can be specified. When you are ready to perform the search, click the Search button. 
The results will be saved to the Query Results list, which is visible on the List View. The List View will be 
opened automatically to display the results. 

 

 

Match Individuals 

Because a Genbox database stores genealogy data, the search capabilities were designed around retrieving 
individuals that have specified relationships between each other. You can set search criteria for up to four 
match individuals, including their relationships. This powerful capability allows you define searches such as: 
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• Children who have the same given name as their father 
• A child born on his parents' wedding anniversary. 
• Someone whose initials were "J. T." who had a father named "Paul", a mother who emigrated from 

Scotland, and was married to someone who died in May, 1952. 
• A man who died in his fifties in London that had a son who was serving in the military in 1945. 
• A woman who had one parent from Germany, the other parent from England, a grandparent from 

France, and another ancestor from Spain. 
• A tailor with 3 or more children who had an ancestor that was Roman Catholic and a brother who was 

married 4 times, once to an Irish woman who died before 30 years of age. 

Special Characters 

When entering match conditions, you can enter special characters that control the search. 

• For text fields, you can use: 
• * (asterisk) matches any number of characters (including zero characters). 
• ? (question mark) matches any single alphabetic character. For example: Gord?n will match Gorden, 

Gordan, Gordon. 
• # (pound sign) matches any single digit (0-9). For example: 1#3 find 103, 113, 123. 
• ! ( exclamation mark) means "not". 
• [abc] matches any single character within the brackets (a, b, c in this case). For example: b[ae]ll finds 

ball and bell but not bill or bull. 
• [a-z] matches any single character within the specified range (a through z in this case). 
• [!xyz] means match any single character NOT within the brackets (x, y, z in this case). For example:  

b[!ae]ll finds bill and bull but not bell or ball. 
• !* matches empty fields (not anything) 
• [] also matches empty fields (zero-length strings). 
• If you want to search on one of the special characters listed here, enclose it in brackets. For example: 

Gord[?]n will match Gord?n but not Gordan or Gordon. Another example: [[]S84[!0-9] will find the 
note with source citation 84. You can search for an opening bracket with [[]. The [!0-9] part prevents 
matches to S842, S849, etc. There is not a way to search for a closing bracket. 

Note: if no wildcard asterisks are included, asterisks will be added both before and after your entered search 
text. So, if the entered text is "father", then the actual search will be on "*father*", allowing a match anywhere 
in the field. If instead you include an ending asterisk, as in "father*", then this match string will only match to 
the beginning of the field; records that have father later in the text will not be returned. If you include a 
beginning asterisk, as in "*died.", then only records with text that END with your match string will be returned.  

• For numeric fields, you can use: 
• <   less than 
• >  greater than 
• <= less than or equal 
• >= greater than or equal 
• ! not equal 
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Making Charts 
A chart is an excellent way to present your genealogical research. With a glance, people can appreciate the 
depth and breadth of your work. With a closer look, they can discover a wealth of details--dates, places, 
notes. They can be stylized with flourishes, color-coded to emphasize certain facts or lineages, and illustrated 
with images of people and places. Charts can be formatted onto multiple pages, or big enough to fill a wall. 
They can be tall and thin, short and fat, rectangular or round. You can present your entire genealogy or any 
portion. You can preview your chart onscreen, zoom and pan, and make changes or additions.  

Making a Chart 

Hint    Before you start, move to the individual on the Individuals View that you wish to be the default "key" 
individual for the chart. 

To make a chart, begin by going to the Charts Menu and pointing to one of the general chart types:  

• Ancestor 
• Descendant 
• Related 
• Convergent 
• Everyone 

A submenu of specialized chart types will appear. Click either Basic or one of the specialized chart types. 

The Chart Options View will open. It has eleven pages of options, which are similar for each of the chart 
types: 

            Key Page

            Titles Page

            Section Page

            Layout Page

            Content Page

            Styles Page

            Detail Page

            Links Page

            Format Page

            Sizes Page

            Frames Page

Each chart type has default settings. You can change any of the options you wish. 

Finally, click the Make Chart button. The Chart View will open, displaying your chart with scrollbars. 

You can scroll around, zoom, move and resize boxes, and add additional pictures, annotations, and lines. 

If you don't like the options you picked, you can close the Chart View, go back to the Chart Options View, 
change some options, and click Make Chart again. Experiment and have fun! 

When you are satisfied with the appearance of your chart, you can save it or print it. You can reload your 
saved charts later for viewing or further editing. You can also E-mail them to relatives for them to view, if they 
have Genbox. 

Reading Charts  



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 47

Genbox charts are constructed of boxes and links between the boxes. The boxes represent individuals or 
families. The links are lines that represent the genealogical relationships between the individuals. Each box 
can be a different size, depending on the amount of content contained within it. You can choose from a wide 
range of styles (colors, fonts, shapes, shadows, borders) to add visual interest and draw attention to specific 
portions of your chart.    

The boxes for individuals in the same generation are generally aligned in rows (or columns for sideways drop 
directions). For a descendant chart with a downward drop direction, the top row on the chart will be for the 
oldest generation.  

There are two types of links shown on charts: child/parent links which connect children with their parents, 
and family links which connect the two spouses of a family.  

Chart Layouts  
Each of the main chart types can be drawn in a number of different layouts, specified on the Layout page. 
There are three main types of layouts supported: rectangular, circular or fan, and timeline. Rectangular 
layout charts are the most versatile, with the largest number of options. A fan layout is useful for special 
purposes and for creating a distinctively different look. Timeline charts present the boxes sized and positioned 
according to the birth and death dates of the individual, which can be helpful in understanding how the lives of 
the individuals may have intersected.   

Box Contents  
Each box contains, as a minimum, information on a single primary individual. A primary individual is an 
individual that was reached by following the parent or child links from the ancestors or descendants of the key 
individuals.  

A box can also contain information on one or more spouses. Spouses are individuals that are reached by 
following the family (marriage) links from the primary individuals. When such an individual can also be 
reached by following the direct lines from the key individuals, the individual may be treated instead as a 
primary individual.  

Within a chart box, information on the primary individual is shown first, beginning with their name and other 
selected identifiers. The name of the spouse follows, with other selected spouse information. Family 
information, such the date of marriage, appears third. If there are additional spouses shown in the same box, 
their names, other information, and family information will follow. Multiple spouses can be shown in the same 
box when they have neither ancestors nor descendants displayed on the chart.  

If there are multiple spouses shown in the same box, they will be listed in chronological order, according to 
the date of the first family event. In this case, the link to the children boxes below will be labeled with the 
family number, to indicate which spouse is the parent of the children.  

Box Parts  
Each box has two ends: a head and a tail. Relative to the direction of drop, the head comes first, followed by 
the tail. On an ancestor chart, the direction of drop is normally up; the head would then be the top side of each 
box. On a descendant chart, the direction of drop is normally down; the head would then be the bottom side of 
each box. You can choose styles for the head and tail of the box independently, which provides for many 
unique combinations.  

Boxes usually have borders. The box border is a line that defines the extents of the box. It can include an 
interior margin area which separates the contents from the line. Borders provide a neat appearance. You can 
choose a variety of styles for box borders. An unboxed chart style is also supported; with this style, box 
borders and their margins are omitted, although the data content continues to be organized into rectangular 
areas. Charts with the unboxed style generally are more compact than charts with box borders, because the 
margin areas are omitted.  

The interior of each box contains the data content, which can be a combination of text, icons, and pictures. 
You can choose a color for the interior of the box, which on the Styles page is called Shading.  

Boxes can have simulated drop shadows, which can produce a three-dimensional appearance. The color, 
size, and placement for shadows can be specified.  
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Child/Parent Links  
Child/parent links connect children with their parents. Each child/parent link connects to the head end of 
one box and the tail end of another box. On descendant charts, the links connect between the head of the 
parent box and the tail of the child box. On ancestor charts, the links connect between the head of the child 
box and the tail of the parent box. Child/parent links are normally drawn with a solid line that always connects 
between the head and tail ends of the two boxes, never on the sides. Usually, the link line has three 
segments: a short segment sticking out from each box, called stubs, and a connector between them, called a 
child bar. When several child boxes connect to the same parent box, the child bar is shared by all the 
children, and it extends from the "leftmost" child stub to the "rightmost" child stub.  

Genbox charts can show parents in the same box or in separate boxes. A child/parent link to a box containing 
two individuals means that both individuals are the parents of the child. A parent box can also contain more 
than two individuals. This means the primary individual had multiple spouses, of which some had no children.  
A child/parent link to a box with a primary individual and more than one spouse will be labeled with the family 
number of the spouse that is the second parent of the child.  

When the parents appear in separate boxes, the child/parent link will be drawn to only one of the parent 
boxes. The other parent can be found by following the family link. Child/parent links can also connect directly 
to the family link between the two parent boxes. This option is selected by choose the Link center drop 
alignment choice on the Layout page.  

Family Links  
Family links connect the two spouses of a family. The family links can be drawn in two ways. When the two 
boxes to be connected are side by side, they are connected with two straight, solid, parallel lines drawn 
between the sides. This style of family link is called a side family link. This is the only time when links are 
connected to the sides of the boxes.  

Often, it is not possible to draw the chart with every pair of spouse boxes side by side; there are other boxes 
in the same generation that appear between them. In this case, a crossing family link is drawn. A crossing 
family link is a single dashed line that contains two short segments with a long segment between them. The 
short segments, called family stubs, attach to each spouse box on the child side. The connecting segment of 
this dashed line, called the family bar, runs in the space between generations. The family stubs never 
connect to the center of the child side of the spouse boxes, which is used only for the child stub line. The 
family stubs will be offset in the direction leading to the other spouse box. If there are several family links to a 
box (representing multiple marriages), the family stubs will be spaced out along the side of the box.   

A crossing family link means the same thing as a side family link. It is drawn differently so that it can avoid 
the intervening boxes, by going down, under, and back up. The line is drawn dashed because it often needs 
to cross the child/parent links of the intervening boxes. On charts, dashed and solid lines never connect.  

When a primary individual has more than one family shown on the chart, each family link will include a label. 
The label will consist of the marriage order number. The family link label will appear outside of the box, next to 
the family stub line. Spouse names inside the box will also be labeled with the marriage order number, 
appearing in parentheses before the spouse name.  

Link Channels  
Boxes are usually drawn in generational rows (or columns). The space between each pair of rows, called the 
drop space, is used for the link lines, both child/parent links and crossing family links. The "height" of the drop 
space is set with the Drop distance setting on the Sizes page.  When there is a single child bar within a given 
span in the drop space, it will be drawn in the middle of the drop distance.  

Depending on your layout and data, your chart may have multiple child bars and/or family bars within the 
same span in the drop space. To avoid confusion, each bar will be assigned a link channel. Link channels 
are small offsets in the drop direction. Only one bar will be drawn in each link channel in a given span. While 
the spacing of link channels is automatic, you may need to increase the Drop distance setting on the Sizes 
page to allow for more room between generational rows.  

Saving Charts  
Charts produced by Genbox can be saved in a number of formats:  
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• Genbox chart format (extension .GCT) 
• BMP image file (.BMP) 
• JPEG image file (.JPG) 
• PNG image file (.PNG) 

If you plan to put your chart on a web page, you will need to save it in JPEG or PNG format. 

When saved in Genbox chart format, charts can be reloaded back into Genbox, where you can view, zoom, 
and edit the chart, then save your changes again. If you plan to delete or add boxes, add annotations or lines, 
or reorganize the chart, saving in Genbox chart format is best. 

The other three formats save the chart as an image file. You can load a saved image file into a graphics 
program, such as Adobe Photoshop, for further modifications. When an image file is saved, the current Chart 
View zoom setting will affect the size of the image: before saving the chart, change the zoom setting to the 
size you want for the chart. Also, the color mode of the display (256 color or full color) will affect the format of 
the saved image file. 

The BMP image format is uncompressed. While it is not suitable for use on the Web, you may find it useful to 
save charts in this format if you plan to process them further in a graphics program. BMP image files tend to 
be huge. 

The JPEG format works best when your chart contains lots of pictures, or has a background picture, because 
its compression methods are designed for those types of images. For line-oriented drawings, such as normal 
Genbox charts, its compression does not work as well. Unlike BMP and PNG formats, JPEG format is "lossy"; 
some of the pixel colors will be off, producing "noise" that is particularly visible if you zoom in on the image. 

The PNG format has the best compression for Genbox charts, and is most suitable for producing charts for 
the Web. Unlike JPEG, the compression used in PNG format is lossless, so the image file can be zoomed to a 
larger size with no visible artifacts. For the smallest image file sizes, set your display to 256-color mode first, 
then save the chart in PNG format. 

Note: large charts require more computer memory in order to produce. You will get an error message 
"Insufficient memory to save image file" if you do not have enough memory. In this case, try choosing a 
smaller zoom setting, make a smaller chart, switch your display to 256-color mode first, or use PNG format 
instead of JPEG or BMP. Remember, larger files also take longer to download from the web.  

It is also possible to save most charts in Portable Document Format (PDF). A number of third-party 
companies provide specially-designed printer drivers that, instead of printing a document, produce a file in 
PDF format. With one of these products installed, you can produce Genbox charts in PDF format.  

Chart Examples  
• Ancestor 
• Descendant 
• Related 
• Convergent 
• Everyone 
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Making Reports 
A report is a rich text document that is generated from your data, according to a wide range of formatting, 
layout, content, and style options. They can contain the same data as a chart, but presented in a narrative 
format. They can be illustrated with images of people, places, source documents, and even charts. You can 
preview your report onscreen, and make changes or additions.  

Making a Report 

Hint    Before making a report based on an individual, move to the individual on the Individuals View that you 
wish to be the default "key" for the report. 

To make a report, begin by going to the Reports Menu and pointing to one of the general report types:  

• Ancestor Narrative 
• Pedigree 
• Descendant Narrative 
• Outline Descendant 
• Family Group 
• Individual Narrative 
• Calendar 
• Individuals 
• Places 
• Events  
• Citations 
• Sources 
• Media 
• Researchers 
• Correspondence Log 
• Research Targets 
• Projects 
• Lists 

A submenu of specialized report types will appear. Click either Basic or one of the specialized report types. 

The Report Options View will open. It displays several pages of options: 

            Key Page 
            Front Page 
            Sections Page 
            Back Page 
            Headings Page 
            Content Page 
            Content Page (Custom Reports) 
            Content Page (Calendar Reports) 
            Sort Page (Custom Reports) 
            Media Page 
            Media Page (Calendar Reports) 
            Style Page 
            Detail Page 
            Format Page 
            Frames Page

Each report type has default settings. You can change any of the options you wish. 

Finally, click the Make Report button. After a progress window is displayed, the Report View will open, 
displaying your report. 

You can scroll around, zoom, add pictures, annotations, and lines. 



       

If you don't like the options you picked, you can close the Report View, go back to the Report Options View, 
change some options, and click Make Report again. Experiment and have fun! 

Saving Reports 

When you are satisfied with the appearance of your report, you can save it or print it. You can reload your 
saved reports later for viewing or editing. Format choices for reports are: 

• Genbox format (.GRT). This format requires Genbox to view. Use this format if you plan to view or 
edit your report later with Genbox. 

• Rich Text format (.RTF). This format can be opened by Genbox and most text editors, including 
Microsoft Word and Corel WordPerfect. 

• Text format (.TXT). In this format, the report is saved in plain ASCII text. Note: multimedia and most 
formatting is lost. Use this format only if you plan to load it into another application that does not 
support Rich Text format. 

It is also possible to save reports (and most charts) in Portable Document Format (PDF). A number of third-
party companies provide specially-designed printer drivers that, instead of printing a document, produce a file 
in PDF format. With one of these products installed, you can easily produce Genbox reports and charts in 
PDF format. 

You can also configure Genbox to open the reports it generates directly in your default rich text editor, instead 
of the Report View. Then you have full editing capabilities at your control, as well as additional printing and 
report format options. 

Genbox reports can also be generated in HTML format (.HTM), ready for uploading to the internet. This 
option is selected by clicking the Make web pages check box before making the report. The generated report 
can be previewed in either Genbox or in your default web browser. 

Viewing and Editing Reports 

Once a report has been produced, the Report View window opens and displays the report. 

The Report Toolbar will appear next to the main toolbar. It provides several options for editing the report. You 
can add text annotations, lines, and picture boxes. You can also select boxes for deletion. When boxes are 
deleted, the chart will resize automatically. 

   

 Select Tool 

 Magnify Tool 

 Zoom Size Tool 

 Text Tool 

 Picture Tool 

 Line Tool 
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Sharing Your Information 
The very nature of genealogy--finding relationships between individuals--suggests that research efforts should 
be collaborative. Once you have labored to produce proper source citations for your data, it would be valuable 
to the next researcher who otherwise might repeat your work. Likewise, much can be gained from the 
research of others when their results intersect with your own objectives.   

When you have your data ready to share with others, you can copy a portion of it to an external file, a process 
known as exporting. The process of loading data into your database from an external file is known as 
importing.  

Exporting Data  

Data in a Genbox database can be exported to a new Genbox database, or to a file in GEDCOM format, a 
standard for information exchange between genealogy programs. Options for export are set on the Export 
Options View. Genbox can write virtually all of its data in GEDCOM format, using the extension capabilities of 
the standard. However, only another Genbox system is likely to understand the data in the extensions, while 
other genealogy programs will import only the standard portion.  

If your intended destination program is another Genbox system, you can export the data into a new Genbox 
database, which will be more compact than a GEDCOM file.  

Importing Data  

Data can be imported from a GEDCOM file or from another Genbox database. Importing is controlled by the 
Import File View.  

• To import data from a GEDCOM file, click Import Data on the File menu, then set the "Files of type" 
pick control on the File Open Dialog to "GEDCOM File". Select the desired GEDCOM file, then click 
the Open button. The Import File View will appear. 

• To import data from a Genbox Database, click Import Data on the File menu, then set the "Files of 
type" pick control on the File Open Dialog to "Genbox Database". Select the desired database, then 
click the Open button. The Import File View will appear. 

When you are considering importing data into your main database, it is a good idea to first load it into a new, 
empty database, so that it can be studied first. You may decide the data is not useful after all, or that only a 
portion of it will be useful. Then you will be better prepared to import the data into your main database. If you 
want to import only a portion of it, you can export the desired portion from your trial database, and use that file 
as your import source.  

Publishing on the Web  

Another way to share your data is to generate text reports based on it, then distribute the reports, rather than 
the data file itself. A low-cost method to disseminate information widely is to publish it on the web, by 
uploading it to a web site and then making the web site location widely known.  

Genbox reports can be produced directly in HTML format, ready for uploading to the web.  

Making a CD  

Another popular way to distribute genealogy data is on a Compact Disk (CD). Writable CDs are inexpensive 
and durable, and can hold 600 MB of information.  
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Customizing Genbox 
Recognizing that each user will have language preferences, stylistic preferences, and specific data collection 
purposes, Genbox provides a number of ways that the program can be customized. The fonts, window 
background colors, date formats, data flag definitions, event and source templates, and chart and report 
submenus, as well as other options, can all be controlled by the user.  

     Preferences View 
     Data Setup View 
     Sentence Templates 
     Source Templates 
     Charts and Reports Submenus  

Details on how to change Preferences and Data Setup can be found in the Views section of the manual. Refer 
to the Table of Contents on where these sections are located. 

Sentence Templates, Source Templates, and Charts and Reports Submenus are described on the following 
pages. 
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Sentence Templates 
A template is a text framework that defines how data values should be formatted into sentences for 
presentation on charts and reports. Templates are often predefined for various types of data, then selected 
automatically according to type, so that a report with flowing narrative text can be quickly and elegantly 
produced. You can also customize templates for use with each data record. 

The template itself normally does not contain any data values. Instead, it includes one or more "place-
holders", called field codes, that define which data values are to be used, where and when the data values 
should appear, and how the data values should be formatted. A single template can define different sentence 
structures according to which data values are available at the time the template is applied.  

Each event type has one or more predefined templates, for one or several languages, and each individual 
event can have its own custom template, plus there is a global event template. Also, general notes and 
research notes can include custom templates. Together, these options provide for a great degree of 
customization. 

Source citations have their own set of template codes which are explained in the section Source Templates. 

Introduction 
Here is an example of a simple event template: 

    [P] was born [D+L] 

The text portions enclosed in square brackets are called field codes. The field codes will be filled with values 
from the database when a chart or report is produced. "[P]" stands for PRIMARY, and will be filled with the 
name of the primary individual. "[D+L]" stands for DATE and LOCATION. So, if the Birth event record for 
"Reginald Smythe" contained a date value of "3 August 1780" and a place value of "Little Chesterford, Essex, 
England", then this data would be formatted on a narrative text report using this template as: 

    Reginald Smythe was born 3 August 1780 in Little Chesterford, Essex, England. 

The template controls the order and inclusion of data values. Suppose the template was changed to the 
following: 

    [D], [P] was born to [PP] father [O] and [PP] mother [S]. 

The field code [PP] is possessive pronoun, [O] and [S] for a birth individual are father and mother, so the data 
would now be formatted as: 

    On 3 August 1780, Reginald Smythe was born to his father Sir Charles Smythe and his mother Jane 
Edwards. 

We moved the date to the front of the sentence, left out the location completely, and added the parents, all by 
changing the template; the data was unaffected. 

Conditional Groups 
Templates can have optional parts which are included only if the corresponding data value isn't blank. 
Conditional groups are marked with angle brackets, as in this example: 

   [PP] marriage < to [S]> was annulled [D+L] 

In this example, the word "to" will be included only when the spouse is non-blank, because it appears within 
the same angle-bracketed group as the field code [S]. This leads to two possibilities on a report, depending on 
whether the SPOUSE box is filled: 

    His marriage was annulled on 10 August 1803 at Chancery Court, London. 

    His marriage to Elizabeth was annulled on 10 August 1803 at Chancery Court, London. 
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If you would like some text to appear only when a data value is NOT present, this can be accomplished in an 
angle-bracket group using the vertical bar to separate the two possibilities, as in the following example: 

    <[D], >[P] purchased <[T] | land> [L] 

In this example, the word "land" will appear only for event records where the "detail" data value is empty. 

Use conditional groups whenever there is wording that would appear out of place if the data value is blank. 

Balancing Conditional Groups 
Whenever you open a conditional group with a left angle bracket, a matching right angle bracket must appear 
later in the template. Conditional groups can "nest", which means a conditional group can appear completely 
within another conditional group. Sometimes, you may forget to include a left or right angle bracket for one of 
your conditional groups. When a report is generated, the program will detect a conditional group that is not 
balanced. It will place a warning message in the output at the point the error was detected. Possible 
messages include: 

• *STACK UNDERFLOW*  - an opening "<" angle bracket is missing (a closing ">" angle bracket was 
found without a matching "<" bracket).  

• *STACK OVERFLOW* - a closing ">" bracket is missing (a opening "<" angle bracket had no 
matching closing ">" bracket).  

Directional Templates 
Event data for an individual appears on the "Events" tab. But because event records can be shared by up to 
three individuals, an Events record entered for one individual may automatically appear as a record on the 
Events tab of up to two other individuals. For example: suppose a marriage event for Reginald Smythe is 
entered, with a date of 15 July 1803 at Burnt Pelham, Hertfordshire, England, and the spouse is entered as 
Elizabeth Conyer. Later, when you are looking at the data for Elizabeth Conyer, you will see that she has a 
marriage event record, with the same date and place, showing a spouse by the name of Reginald Smythe. 
This is another view of the same event record, except that the viewpoint has changed. Elizabeth is now 
considered PRIMARY, and Reginald is the SPOUSE. 

This change in viewpoint is key to understanding how the event templates are used. Most event types have a 
single template defined, as most event templates work equally well when PRIMARY and SPOUSE are 
switched, such as "[P] married [S]". Other event types have two templates defined: a "Forward" and a 
"Reverse" template. The Reverse template is used when the viewpoint is changed. Consider this template: 

    [P] proposed <to [S]> [D+L] 

    Reginald proposed to Elizabeth in July, 1803. 

If the template is not changed, this event record when viewed from Elizabeth's viewpoint would read: 

    Elizabeth proposed to Reginald in July, 1803. 

This problem can be corrected by defining and using a "Reversed" template: 

    [P] received a marriage proposal <from [S]> [D+L] 

    Elizabeth received a marriage proposal from Reginald in July, 1803. 

Or, another possibility: 

    <[S] | an unknown gentleman> proposed to [P] [D+L] 

    Reginald proposed to Elizabeth in July, 1803. 

It is important to craft the templates so that they read equally well when data is missing. Suppose we knew 
Elizabeth had received a proposal but don't know the name of her suitor. The two template examples above 
would produce the following alternatives: 
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    Elizabeth received a marriage proposal in July, 1803. 

    An unknown gentleman proposed to Elizabeth in July, 1803. 

Empty Templates 
Even though the event templates provide a lot of flexibility in formatting the event data into sentences for use 
on a narrative report, in some cases you may wish to override the template behavior altogether, and just 
format the event information yourself. 

There are two ways to override the default template behavior: 

• Method 1: Edit the template, replacing any template codes with the text you want. 
• Method 2: Set the template to just "[G]" or "[R]" (and optionally "[CR]"), then type the formatted text 

you want into the general notes (or research notes). 

For Method 2, the narrative report generator will assume the notes text is already formatted as desired, and 
no terminating punctuation will be added. This means you should format the notes text into complete 
sentences, including a period at the end.  

When using Method 2, the global event template will also be overridden. This means any data normally 
included by the global template, such as witness information, will only be included if you add the template 
codes to your notes text. 

Witness Templates 
Witnesses are individuals present at an event that are not (usually) one of the principal participants (primary, 
spouse, child/other). At a wedding, the witnesses would include the minister, priest, or judge; groomsmen, 
bridesmaids, and guests. 

The template codes used for witness data include: 

• [W]    witness name 
• [WR]    witness role 
• [AW]    age of witness at time of event 
• [WW]    list of all witnesses in comma-separated list 
• [WWR]    list of witnesses in comma-separated list, with role names. 

Witness data can appear in two different ways on a report: 

• When the current individual is one of the principal participants, the witnesses appear as extra detail 
information added to the event, according to the event template. 

• When the current individual is a witness, the witnessed event can be included along with other events, 
formatted according to the witness template. 

Let's consider a witness to the signing of a will by Archibald Cummins, named Henry Smith. A sample event 
template is shown below: 

   [P] signed a will [D+L]<. Witnesses: [WW]> 

   Archibald signed a will 12 March 1856. Witnesses: Henry Smith, Carla Johnson, Jonathan Doe. 

Here, we have part of the paragraph about Archibald Cummins, who signed a will in 1856 with three known 
witnesses. The three witnesses entered for the WILL event are included in the report with the information 
about the event, because the template uses the template code [WW].  

For an example of the second case, a sample witness template is shown below: 

    [W] <witnessed | was the [WR] at> the will signing of [P] [D+L] 

    Henry Smith witnessed the will signing of Archibald Cummins on 12 March 1856. 
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Here, we have part of the paragraph for Henry Smith, who was a witness when Archibald Cummins signed his 
will in 1856. A similar line would be added in the individual paragraphs for Carla Johnson and Jonathan Doe. 

Note that when constructing a witness template instead of the main event template, the [W] code is used to 
refer to the current individual (the witness). 

Witness Template Codes 
When constructing templates for displaying witness data, you can use either numeric values or role names 
appended to the template codes W and WR to refer to specific witnesses. For numeric values: [W1] would be 
the first listed witness to an event; [WR3] would be the role entered for the third listed witness to an event, and 
so on. Referring to witnesses by numeric value is most useful when witnesses for a particular event type are 
entered in a predefined order. 

Witnesses can also be referred to by their role names, following a colon, as in: [W: maid of honor] and [W: 
minister]. Be sure to use the singular role name. If there are multiple witnesses with the same role, such as for 
[W: groomsman], then only the first witness with that role will be returned. If you want all witnesses of a 
particular role to be returned in a comma-separated list, use the double-W version: [WW: groomsman] or 
[WWR: groomsman].  

Witness List Template Codes 
There are two witness list template codes: 

• [WW]    returns a list of all remaining witnesses in a comma-separated list, with "and" before the last 
witness name in the list. 

• [WWR]    returns a list of all remaining witnesses, with role names included, if any. Witnesses are 
grouped by role. 

The [WW] and [WWR] template codes only return witness names that haven't been already mentioned by 
another witness template code. This allows them to be used as a "catch-all" following role-specific template 
codes, as in: <Minister: [W: minister]> <Bridesmaids: [WW: bridesmaid]>< Groomsmen: [WW: groomsman]>< 
Other witnesses: [WWR]>. 

Singular or Plural Witness Lists 
When constructing a template for witnesses, you may want to specify different text when there is just one 
witness. You might want to use the singular form of a verb. This can be accomplished by using specialized 
versions of the [WW] or [WWR] template codes: a trailing single quote (') qualifier to indicate singular, and a 
trailing double quote (") qualifier to indicate plural: 

• [WW]     list of all remaining witnesses 
• [WW']   "list" of remaining witnesses, when exactly one witness left 
• [WW"]    list of remaining witnesses, when two or more witnesses left 
• [WWR]   list of all remaining witnesses, with role names 
• [WWR'] "list" of remaining witnesses with role names, when exactly one witness left 
• [WWR"]  list of remaining witnesses with role names, when two or more witnesses left 

 For example: 

    <. The only witness was [WW']|. The witnesses were [WW"]> 

Here, the [WW'] template code will activate the first text ("the only witness was ...") when there is one witness. 
If there are two or more witnesses, the second text will appear ("the witnesses were ..."). If there are no 
witnesses, neither will appear. 

The single-quote and double-quote qualifiers can also be used when specifying role names: 

    <. Surprisingly, there was only one groomsman: [WW':groomsman]|. The groomsmen were [WW": 
groomsman]> 
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To help remember the template code qualifier syntax, read the single quote as "single", so that [WW'] is read 
"witnesses - single". 

The Current Witness 
For a witness template, the [W] code naturally refers to the current individual. But when constructing regular 
event templates, a [W] code without a numeric or role variable will instead refer to the current witness, which 
is the last-named witness. Thus, you could have a construction like  

    <Serving as best man was [WW': best man]. Unfortunately, [W] lost the ring> 

Here, the [W] code refers to the witness that filled the [WW': best man] template code. It would result in an 
output like the following (bold emphasis added): 

    Serving as best man was John Runner. Unfortunately, he lost the ring. 

Event Subtype Templates 
In addition to the default forward/reverse templates, event types can have any number of additional templates. 
Additional templates can be defined for named subtypes of the current event type on the Event Templates 
Page. The choice of template can then be made from a pick list before the event sentence on the Events 
Page.  

Event Templates for Multiple Languages 
Each event type is defined for a particular language. By defining multiple event types with the same tag (key 
value) but with different language codes, it is possible to produce reports in different languages simply by 
changing the selected output language in preferences. The program will use the templates from the event 
type records with the specified language when formatting event data into sentences. 

The event subtypes work the same way: when multiple subtypes have been defined with the same subtype 
name but for different languages, the correct language variant will be used on the reports. 

For event roles, a similar selection process occurs. For each of these three template sources (Event Types, 
Event Subtypes, Event Witness Roles), there is a language-invariant key field that groups the records by 
content, allowing the report generator to pick the correct variant according to language. 

Note For a custom event template sentence stored in an event record, no automatic translation is possible. If 
translation is desired, convert the custom event template into an event subtype, then define the language 
variants on the Event Types View. 

Base Language Templates 
Instead of selecting a particular language, it is possible to define event templates for a base language. A 
base language can be considered the subset of language features in a language family that are the same. 
These features are shared in common by the language variants. Base languages are not real languages, but 
they are useful when defining templates that will not vary across many of the language variants in a language 
family. 

For example: consider the English language family. Some of the language variants in this family are: 

• English (United States) 
• English (United Kingdom) 
• English (Australia) 
• English (Canada) 
• English (Ireland) 
• English (New Zealand) 
• English (South Africa) 

Defining and maintaining a full set of event templates for each of these language variants would be tedious, 
time consuming, wasteful of storage space, and prone to error. The solution is to define the templates in the 
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English base language. Then only add additional templates in a sublanguage when they differ from the base 
language template. 

When a report is produced, the program will select the best template to format the event data. It will look first 
for an event type record defined in the currently selected output language. If not found, it will then look for an 
event type record defined in the base language. If still not found, it will look for an event type record defined 
for another language variant in the same language family. The full search list appears below: 

• Output language 
• Base language of output language  
• Any language in same family as output language  
• EN English  
• ENU English (US)  
• Any English language  
• Any base language  
• Any language 

With this search order, the data will always be output. 

All base languages are represented with a two-letter code, such EN for English. All specific languages are 
represented with a three-letter code, such as ENU for English - United States. 

Base languages can only be selected for use in data records (event types, subtypes, roles; identifier types; 
flag definitions). Choices for program language and output language still require a specific sublanguage 
selection, whenever there are more than one for a language family. So for a report in Norwegian, you would 
select one of the two language variants (NOR (Bokmal) or NON (Nynorsk)) as your output language. 

Special Templates 
There are two special event templates for each language: 

• Global Event Template 
• Initial Event Template 

These templates are used for special processing. 

Global Event Template 
The Global Event Template affects all other event templates. It provides a convenient place to put portions of 
the templates that are in common to all event sentences. The keyword [...] is used to indicate where the 
results of the local event template are to be placed. It allows the global template to position elements both 
before and after the local template's results. The default global template is: 

    [...]<. Witness: [?WWR']|. Witnesses: [?WWR]> 

This global template says: if there are witnesses that weren't already shown in the local template, add them in 
a sentence beginning either with "Witness: " or with "Witnesses: ", depending on whether there is one or 
several. By defining this portion of the sentence template in the global template, it does not need to be 
repeated for every event template. Also, it is easy to make a change to the global template to affect all the 
templates at once. You could change the "Witness:" text to "Also present:", for example. Or, you could add 
"[CR][CR]" to the end, which would separate all event sentences in narrative reports with a blank line. 

For the Global Event Type record, only the template itself can be edited; all other fields are disabled. 

Note: the inclusion of the general notes after an event sentence is not handled by the global template; it is 
determined by the report options settings, which controls whether the general notes are shown in the text, in a 
footnote, or omitted. To override this default behavior for a local event template, use [!G] (see the discussion 
below). 

Initial Event Template 
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The Initial Event Template is used to initialize new event types, both when adding on the Event Types View 
and when new event types are detected in a GEDCOM import file. To use, set the values to those that new 
event types should have. The defaults are: 

• Secondary type: Text 
• Class: Mature/default 
• Flags: Recent 
• Template: [P] participated in [E] [D+L] 
• Witnessed Event Macro: the [E] of [P] [D+L] 
• Witness Default Role Template: [W] <witnessed|was the [WR] at> [WE] 

Variable Control Parameters 
Because the same template codes may be used in both the global event template and the local event 
template, two special variable control parameters have been defined. 

Question Control Parameter 
Suppose you want witnesses, if any, to be shown after every event sentence. You add something like: <. 
Witnesses: [WWR]> to the global template. But then suppose you have an event where you want the text to 
be different: "<. Also appearing on the census were [WWR]>". You add this to the local template. But now you 
are getting the witnesses shown twice; once from the local template and once from the global template. How 
do you prevent that?  

The Question control parameter has been defined for this purpose. The control parameter is a question 
mark (?) that appears inside the field code's brackets, either before or after the keyword, as in: [?WWR] or 
[WWR?]. It means "if this field code has not already appeared". When used in the global event template, it will 
suppress template codes that have already appeared in the local template. It can be used on any field code. 

Note: the global template is processed after the results of the local template have been processed. This 
affects the interpretation of the variable control parameters. A global template of "<Primary ID: [?PID] >[...]" 
would show the ID of the primary individual only when it was not included in the local template itself, because 
the local results are processed first and become what has "already appeared". 

The question control parameter can also be used in the local template. 

Exclamation Control Parameter 
Suppose you have a sentence where you don't want the default witness sentence to appear, but you also 
don't want to use the [WWR] code because, perhaps, you are referring to each witness individually with the 
[W1], [W2], etc. codes. To accomplish this, include the [!WWR] code in the local event template. The 
Exclamation control parameter, which is an exclamation mark (!), means "NOT" or "do not show" or "mark 
as hidden". The parameter is placed inside the code's brackets, either before or after the keyword, as in 
[!WWR] or [WWR!]. Unlike the Question control parameter, the meaning is different, depending on the side it 
is placed: 

• If the exclamation mark appears BEFORE the keyword, then the corresponding data is considered 
"blank" and never shown. 

• If the exclamation mark appears AFTER the keyword, the corresponding data is shown, but then it is 
marked as blank, effectively suppressing it for any following references.  

For most purposes, you will want to put it BEFORE the keyword. 

This control parameter is effective for suppressing the default inclusion of the general notes, by using [!G] in 
the local event template. 

Case Qualifiers 
The base codes [P], [S], [O], [W], and [I] (primary, spouse, other individual, witness, individual) can be 
modified by appending case qualifiers. A case qualifier identifies the sentence case in which the individual 
appears. This controls the choice of pronoun when a pronoun is to be used. 

• Possessive: P 
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• Nominative: N 
• Direct object: D 
• Indirect object: I 
• Reflexive: X 

Possessive Case 
The possessive case qualifier "P", used with one of the individual base codes for [PP], [SP], [OP], [WP], [IP], 
produces "his" and "her" in English, as well as constructions like "John's". 

Nominative Case 
Nominative case is used for the subject of the sentence. This is the default case when no qualifier is specified. 
The nominative case qualifier is "N", and is used with the individual base codes for [PN], [SN], [ON], [WN], 
[IN]. It produces "he" and "she" in English. 

Direct Object 
The direct object qualifier is "D", and is used with the individual base codes for [PD], [SD], [OD], [WD], [ID]. It 
produces "him" and "her" in English. 

Indirect Object 
The indirect object qualifier is "I", and is used with the individual base codes for [PI], [SI], [OI], [WI], [II]. It 
produces "him" and "her" in English. 

Reflexive Case 
Reflexive case produces "himself" and "herself" in English. The reflexive qualifier is "X", and is used with the 
individual base codes for [PX], [SX], [OX], [WX], [IX]. 

Gender Qualifiers 
The base codes [P], [S], [O], [W], and [I] can be modified by appending gender qualifiers. A gender qualifier 
designates the gender of the individual that is required to fill the template code. By using conditional angle-
bracket portions for each gender, it is possible to have different text to appear for different genders. This 
approach permits the surrounding words to be inflected properly for the gender. 

The gender qualifiers are m, f, u, o (male, female, unknown, other). They are added inside the closing 
bracket, appearing after any case qualifier. For example: [Pm] would match a primary male; [Sf] would match 
a female spouse.  

A keyword without a gender qualifier will match an individual of any gender. Because Genbox supports four 
genders instead of two, a good approach might be to construct sentences of the form <[Pf] ... | [P] ...>, so that 
the first section would work for a female, and the second section would work for a male but also those labeled 
"other" or "unknown". That way, output for the two extra genders will be produced without the extra burden of 
needing to construct 4-way groupings every time. 

Case and gender qualifiers can be combined, for field codes like [PNm], [SDo], [WXf], etc. 

ID Parameters 
Several field codes can be appended with a numeric value. This value is often the ID value of a record in the 
database. By using a record ID with a field code, the data in a particular record can be referenced. For 
example: 

    John's hero when growing up in the backwoods of [L456] was his grandfather, [I289]. He called his 
grandfather "[N1392]". 

Here, [L456] would be replaced with the standard name for place record 456. [I289] is the preferred name for 
individual record 289, and [N1392] is one of his name variants. 

The use of ID parameters with field codes is particularly useful when adding field codes to notes. If no ID 
parameter is included, the value for the current context is returned, if any. For event templates and event 



       

notes, the current context is the event record. In that context, [L] would be the location of the event, and [N] 
would be the linked name variant, if any. 

Subpart Numbers 
Some data values can be further divided by a subpart number. The subpart number precedes the field code, 
so that it is not confused with an ID parameter. Subpart numbers are supported by the L, D, and E base 
codes: 

• 0L    place modifier 
• 1L    local site 
• 2L    city/town 
• 3L    township 
• 4L    county/parish 
• 5L    state/province 
• 6L    nation/area 
• 0D    date qualifier 
• 1D    date without the qualifier (use DD, DM, DY for further division into day, month, year parts) 
• 0E    leading indefinite article on the event name (in English: "a" or "an") 
• 1E    event name without the leading article 

In general, subpart numbers divide data values left to right, so the "0" part is the first part of the data value. If a 
subpart has no value, it will be empty. 

"Hide Value" Modifier 
When parentheses are placed inside the square brackets, as in "[(Pm)]", then the value, if any, is not included 
in the sentence. This modifier is useful when constructing conditional phrases: it allows a template code to be 
used in the sense of "if this field code is not blank, then..." without actually outputting the field code value. For 
example, you could have: 

    This event is about< a male.[(Pm)]| a female.[(Pf)]>" 

and only the correct phrase would appear, without showing the actual name of the primary. 

Special Characters 
The template system and privacy system define special meanings for the following characters: 

    { } [ ] < > | 

To treat any of the special punctuation characters as normal text, precede each with a backslash, as in: 

    \{these braces and text will print\}. The field code \[P\] is used often. \>\>\> Look at this! 

The backslash will print normally when it is not followed by a punctuation character or space. This lets you 
enter filenames into notes, such as: 

    c:\program files\Genbox Family History\Genbox.exe 

without needing to double the backslashes (although you can for the same result). 

If you want to have a backslash showing before a punctuation character or space, add an extra backslash: 
"\\]" will show as "\]". 

Also, runs of spaces are normally reduced to one space; if you want to force two or more spaces, precede the 
extra spaces with a backslash: "This is far \ \ apart" will print as "this is   far apart". 

Entering TAB 
To enter a tab character, simply press the TAB key. 

How to Add Field Codes 
To add a field code, first position the text cursor at the proper location, then do one of the following: 

• Type it in directly, or 

• Open the Insert Field Code Dialog by clicking  on the toolbar, or by typing CTRL+D. 
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If your text cursor is positioned inside an existing field code with the Insert Field Code Dialog is opened, it will 
become the default value, and any changes will replace the existing field code when the dialog closes. This 
allows you to edit existing field codes. The information provided by the dialog also provides a way to remind 
yourself of what a particular field code does. 

Field Codes in Notes 
Field codes can be used in the general notes and research notes for individuals, events, identifiers, and other 
data records. By using field codes instead of typing the data values directly, reports can properly index the 
names and places, data can be highlighted, and any corrections to spelling will be automatically reflected. 

When using event field codes in notes, special consideration must be taken to ensure the correct values are 
returned. The general guideline is: 

• Event field codes in an event note will always be interpreted in the context of their native event. 

If the general note of Event 123 has the field code [GE345], then the general note for event 345 will first be 
interpreted in the context of event 345, then the result will be inserted into the general note of event 123. 
Thus, if the general note for event 345 has a [D] code, the value will be the date stored in event 345, not the 
date shown in event 123. 

Principal References in Notes 
The field codes [P], [S], and [O] are not recommended for use in event notes, because the value of these 
codes can change depending on the focus individual. Instead, use [P1], [P2], and [P3] to refer to each of the 
three principals of an event: Primary, Spouse, and Other/Child. The values returned by these field codes will 
not vary according to the current focus individual. 

Template Code Reference 
For a full list of sentence template codes supported by Genbox, see the section Sentence Template Code 
Reference. 
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Source Templates 
Genbox has a sophisticated source template system used during narrative report production to produce 
flowing citation and bibliography text from source data records. Citation records define the links between data 
records and sources, and each source is identified as a particular source type. Each source type has its own 
set of three templates: for use in primary citation references, in secondary references, and in bibliographies. 
Each individual source record can also have its own set of customized templates. Also, there is a global set of 
templates. 

Source Template Levels 
Source records have a characteristic known as "level" than determines whether they represent a document, a 
document in a higher source, or a source. In general, document-level source records represent unpublished 
works with limited distribution, and source-level source records represent published works intended for wide 
distribution. A "document in higher source" source record represents a named portion of a larger source. This 
source record will usually have a link to higher source record representing the larger source. 

When sources are linked to a higher source, the templates used in a citation will be those of the FIRST 
(lowest) source, which is linked directly to the citation record. For example: if a citation is to a document, which 
itself is in a book, the templates used will be those defined for the source record of the document, and not 
those for the source record of the book. The template can draw on data in both the current source record and 
the higher source record. Template codes that refer to the lower level source generally begin with "DOC", 
while codes that refer to the higher source record generally begin with "SOURCE". Publication facts are 
assumed to come from the higher source record, and begin with "PUB". Codes can also begin with 
"REPOSITORY" to refer to the repository of the source. For document-level sources that do no link to a higher 
source, codes referring to a higher source should not be used, and for source-level sources, codes referring to 
a lower source should not be used. 

Here is the primary template for the source type "Book", which is a source-level source type: 

<[SOURCE AUTHOR], <[SOURCE AUTHOR TYPE], >>[ITAL][SOURCE TITLE][ITAL0]<, 
[SOURCE QUALIFIER]> (<[PUB ORIGINAL DATE]; reprint, >[PUB PLACE]: [PUBLISHER], 
[PUB DATE])<, [CD]>.< [SOURCE NOTES]> 

The text appearing in square brackets represent field codes that will be filled with values from the source 
record, except for "[CD]" which stands for Citation Detail; it will be filled with data from the citation record. 

Templates can have optional parts which are included only if the corresponding data value isn't blank. 
Optional parts are marked with angle brackets. In this book example, the "reprint" text will appear only if the 
[PUB ORIGINAL DATE] field is not blank. The [SOURCE AUTHOR TYPE] text is also optional, and it is 
nested within another optional part controlled by [SOURCE AUTHOR]. This means that if the author field is 
blank, then the author type will also be omitted even if it has a value. 

Here is the secondary reference template for the source type "Book": 

<[SOURCE AUTHOR], >[ITAL][SOURCE TITLE][ITAL0]<, [CD]>. 

Secondary references are usually shorter then primary references. By having a separate template, you can 
directly control which elements are omitted or shortened. 

Likewise, bibliographic entries are controlled by their own templates: 

<[SOURCE AUTHOR]<, [SOURCE AUTHOR TYPE]>. >[ITAL][SOURCE TITLE][ITAL0].< 
[SOURCE QUALIFIER].> <[PUB ORIGINAL DATE]. Reprint, >[PUB PLACE]: [PUBLISHER]<, 
[PUB DATE]>. 

Note that citation detail and notes are omitted, and some punctuation has changed. Often, the order of 
elements is changed in bibliographic entries as well. 

Consider the following primary template, used for a "Book Chapter or Part", which is a document-in-source 
source type: 
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<[DOC AUTHOR], <[DOC AUTHOR TYPE], >>"[DOC TITLE]"<, [DOC QUALIFIER]>, in 
[ITAL][SOURCE TITLE][ITAL0]<, [SOURCE QUALIFIER]><, [SOURCE AUTHOR]<, 
[SOURCE AUTHOR TYPE]>> (<[PUB ORIGINAL DATE]; reprint, >[PUB PLACE]: 
[PUBLISHER], [PUB DATE])<, [DOC LOCATER]><, [CD]><; [DOC NOTES]>. 

Here, data fields in two source records are being referenced. The lower source record represents the book 
chapter, and the higher source record is for the book itself. The template starts with the author of the chapter 
(if any), followed by the chapter title in double quotes. The book title follows, in italics. Then the book author, 
and the publication information. 

The actual fields that are filled in each source record will vary, according to the source type and the available 
data. The templates should be designed so that the resulting formatted text is correct even when many data 
values are missing. Punctuation separators between elements should be placed within angle bracket groups 
controlled by a data field code, so that when the data value is missing, the punctuation is also removed. 
Otherwise, extra commas, periods, and other punctuation may appear. Genbox can automatically remove 
some extraneous punctuation. 

Global Source Template 
The Global Source Template affects all other source templates. It provides a convenient place to put 
portions of the templates that are in common. The keyword [...] is used to indicate where the results of the 
local source template are to be placed. It allows the global template to position elements both before and after 
the local template's results. The default global primary source template is: 

<[?LEAD TEXT] ><[?EXCERPT] >[...]<. [?DOC NOTES]|. [?SOURCE NOTES]>< [?ANNOTATION]> 

This global template says: Include lead text if not in the local template; follow with the excerpt text if not in the 
local template; show the local template results; include the document notes or source notes, if not already 
included by the local template; end with the annotation text, if not already included in the local template. 

The default global secondary template is: 

<[?LEAD TEXT] ><[?EXCERPT] >[...]< [?ANNOTATION]> 

The default global bibliography template is blank. 

The global source template is also useful for diagnostic purposes. You can add <Citation ID: [?CITATION ID]> 
to the front, and then every one of your primary source citation footnotes will be labeled with the citation ID 
record number. This may help you identify where particular parts of a mysterious footnote are coming from. 

Variable Control Parameters 
Because the same variable code may be used in both the global source template and the local source 
template, two special variable control parameters have been defined. 

Question Control Parameter 
The Question control parameter is a question mark (?) that appears inside the field code's brackets, either 
before or after the keyword, as in: [?ANNOTATION] or [ANNOTATION?]. It means "if this field code has not 
already appeared". When used in the global source template, it will suppress template field codes that have 
already appeared in the local template. It can be used on any data variable. 

Note: the global template is processed after the results of the local template have been processed. This 
affects the interpretation of "what has already appeared" for the variable control parameters. 



       

Exclamation Control Parameter 

The Exclamation control parameter, which is an exclamation mark (!), means "NOT" or "do not show" or 
"mark as hidden". The parameter is placed inside the field code's brackets, either before or after the keyword, 
as in [!LEAD TEXT] or [LEAD TEXT!]. Unlike the Question control parameter, the meaning is different, 
depending on the side it is placed: 

• If the exclamation mark appears BEFORE the keyword, then the corresponding data is considered 
"blank" and not shown. 

• If the exclamation mark appears AFTER the keyword, the corresponding data is shown, but then it is 
marked as blank, effectively suppressing it for any following references.  

For most purposes, you will want to put it BEFORE the keyword. 

"Hide Value" Modifier 

When parentheses are placed inside the square brackets, as in "[(Pm)]", then the value, if any, is not included 
in the sentence. This modifier is useful when constructing conditional phrases: it allows a template code to be 
used in the sense of "if this field code is not blank, then..." without actually outputting the field code value.  

Special Characters 

The source template system defines special meanings for the following characters: 

    [ ] < > | 

To treat any of the special punctuation characters as normal text, precede each with a backslash. 

If you want to have a backslash showing before a punctuation character or space, add an extra backslash: 
"\\]" will show as "\]". 

Also, runs of spaces are normally reduced to one space; if you want to force two or more spaces, precede the 
extra spaces with a backslash: "This is far \ \ apart" will print as "this is   far apart". 

Entering TAB 
To enter a tab character, simply press the TAB key. 

How to Add Source Field Codes 
To add a source field code, first position the text cursor at the proper location, then do one of the following: 

• Type it in directly, or 

• Open the Insert Source Field Code Dialog by clicking  on the toolbar, or by typing CTRL+D. 

If your text cursor is positioned inside an existing field code with the Insert Source Field Code Dialog is 
opened, it will become the default value, and any changes will replace the existing field code when the dialog 
closes. This allows you to edit existing field codes. The information provided by the dialog also provides a way 
to remind yourself of what a particular field code does. 

Source Template Code Reference 
For a full list of source template codes supported by Genbox, see the section Source Template Code 
Reference. 
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Charts and Reports Submenus 
The Charts and Reports menus are used to select the options for chart and report production. Genbox has 
default options for each chart and report type. You can define your own options files and have them appear as 
submenu options on these menus.  

There are two subfolders beneath the Genbox Main Folder that are used to define the submenus. These 
folders are named: 

    Chart Options Menu 
    Report Options Menu 

Chart Options Submenus 

The "Chart Options Menu" subfolder contains the Genbox chart options files (extension .GCO) that will appear 
as the choices on the five submenus of the Chart Options Menu.  The filenames of some of the chart options 
files included with Genbox are listed here: 

Ancestor Fan.GCO 
Ancestor Right.GCO 
Ancestor Ring.GCO 
Descendant Fan.GCO 
Shared Arrow.GCO 
Shared Curvy.GCO 
Shared Dignified.GCO 
Shared Full Data.GCO 
Shared On Lines.GCO 
Shared Unboxed.GCO 

The name of each chart options file determines both where it will appear on the submenus and what the text 
of the menu option will be. The leading word will determine the submenu. The remainder of the name will be 
used as the menu option. For example, consider "Ancestor Fan.GCO". The leading word in this case is 
Ancestor. The remainder of the name is "Fan". So in this case, a menu option "Fan" will be added to the 
Charts Ancestor submenu. When selected, the "Ancestor Fan.GCO" options file will be loaded. The leading 
word can be Ancestor, Descendant, Related, Individual, Convergent, Everyone, or Shared. 

Shared Options Files 

If the leading word of an options filename is shared, then the remainder of the name will appear as an option 
on all five submenus. This feature makes it easy to reuse an options file with multiple chart types. On the 
submenus, shared filenames will appear first, followed by the filenames specific to each submenu. Fox 
example, if the list of options files given above were the contents of the "Chart Options Menu" subfolder, then 
the "Ancestor" submenu would have nine menu choices: "Arrow", "Curvy", "Dignified", "Full Data", "On Lines", 
"Unboxed", and "Fan", "Right", "Ring". 

Note: When you choose a menu option that is a shared options file, certain settings will be automatically set, 
according to the current chart type for which it is being used. This "tailoring" process makes shared options 
files more convenient, as settings that are required or nearly always used for a particular chart type are set for 
you automatically.  

Report Options Submenus 

The "Report Options Menu" subfolder contains the Genbox report options files (extension .GRO) that will 
appear as the choices on the submenus of the Report Options Menu.  

The name of each report options file determines both where it will appear on the submenus and what the text 
of the menu option will be. The leading word will determine the submenu. The remainder of the name will be 
used as the menu option. For Report Options Files, the leading words are: 

• Ancestor Narrative: Ancestor 
• Pedigree: Pedigree 
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• Descendant Narrative: Descendant 
• Outline Descendant: Outline 
• Family Group: Family 
• Individual Narrative: Individual 
• Calendar: Calendar 
• Individuals: Individuals 
• Places: Places 
• Sources: Sources 
• Media: Media 
• Researchers: Researchers 
• Correspondence Log: Correspondence 
• Research Targets: Research 
• Projects: Projects 
• Lists: Lists 

Note: If the Shared leading word is used, the report options file will appear on the submenus for the first six 
report types (Ancestor Narrative, Pedigree, Descendant Narrative, Outline Descendant, Family Group, 
Individual Narrative). 
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Managing your Data 
A number of utilities have been included to help you manage your database. The Backup and Restore 
operations are part of routine maintenance. A number of utilities are provided for detecting and correcting 
problems with the structural integrity of the database file. Finally, the Problems Spotter and Match Finder 
utilities help you manage the content of the database. 

Backing Up your Data  

The importance of regularly backing up your genealogy data files cannot be overstressed--your computer's 
hard drive could fail at any time, wiping out your Genbox database along with everything else in your system. 
You don't want to lose all your hard work. By making a backup and saving it to offline storage, you will have 
the confidence in knowing your valuable data is safe. A backup is also important in the event you inadvertently 
delete data you intended to keep. 

All files that contain data or settings should be backed up. This includes the main database files (extension 
.GDB), media files, options files (extensions .GCO, .GXO, .GRO), query files (.GQY) and any source 
GEDCOM files (.GED). You may also wish to back up your saved charts and reports (.GCT, .GRT, .RTF). 

Backup files are saved in standard ZIP format.  

1. To make a backup file, on the File menu, click Backup. The Backup Select Files Dialog will appear.  
2. Select the files you want to back up, then click Add. The Save File Dialog will appear.  
3. Enter a name for your backup file, then click Save. 
4. To really add safety, you should copy your backup file to a floppy disk or writable CD, then store it at a 

different site. 

To decide when you should make a backup, consider how much work would have to be repeated if you 
suddenly lost your hard drive and had to return to the last backup. If you've done little since the last backup 
except view data and make charts and reports, you can wait. Once you've invested some time entering data, 
it's time for another backup. 

Restoring from a Backup File  

A backup file is in standard ZIP format. You can use WinZip and other ZIP utilities to open and view it. You 
can also open it with Genbox. 

1. To restore from a backup file, on the File menu, click Restore. The Open File Dialog will appear.  
2. Select the backup file (extension .ZIP), then click Open. The Restore from ZIP File Dialog will appear. 
3. Enter the desired destination folder to restore the files to, and other options. 
4. Click Restore. 

Be careful about the destination directory. It is a good idea to create a new folder to restore the files to, rather 
than overwriting existing files of the same name. That gives you an opportunity to check the restored files and 
see if they are what you expected. It also allows you to select just a few of the restored files and copy them to 
their correct destinations, in cases where you aren't interesting in restoring all the files. 

Checking the Structure of your Database 

A Genbox database is in Microsoft Jet database format, the same format that is used by Microsoft Access 
2000. If Genbox is terminated abnormally, it is possible for the database file to become corrupted. You may 
get an error message when trying to open the database, or an error may occur later when you try to access a 
particular data table. 

When you suspect a database may be corrupted, you can check its structure. Genbox will compare the 
structure of the selected database file with an internal copy of the correct structure, and report any detected 
problems. You will then be asked if you want the damage repaired. Genbox will then repair the file for you, 
and then you will be able to use it normally. 
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1. To check the structure of a Genbox database, on the File menu, click Repair/Compact. The Open 
File Dialog will appear. Enter the name of the database file you want to repair. The default filename 
will be the current Genbox database. 

2. Click Open. The Repair/Compact Dialog will open.  
3. Click Check Structure to see if the database needs repairing. 
4. If the file is okay, the message "Data Structure Verified, No problems detected" will appear. 
5. If problems are detected, you will be given a summary of the problems, and asked if you want to 

correct the problems. Click OK to have the problems automatically corrected. 

Compacting your Database 

When a record is deleted in a Genbox database, the space it occupied in the file is not automatically 
reclaimed. These "holes" remain in the file, and will be reused as new records are added. If you have made a 
large number of deletions, however, you may wish to compact the file, which will make it physically smaller by 
removing all the holes. Compacting has other benefits, as well. Records are written out in primary key order, 
which can speed up data retrieval. Record counts in the tables are also updated, which can fix abnormal 
program behavior caused by incorrect values. 

1. To compact a Genbox database, on the File menu, click Repair/Compact. The Open File Dialog will 
appear. Enter the name of the database file you want to compact. The default filename will be the 
current Genbox database. 

2. Click Open. The Repair/Compact Dialog will open.  
3. Click Compact. A message will appear when the operation is completed. The reduction in size will be 

reported. 

Checking the Links 

Genbox databases are relational. A relational database contains multiple tables of data records. Data records 
can link to records in the same table or other tables. When Genbox is terminated abnormally, sometimes the 
links become corrupted. If you suspect the links between data records may need repair, you should check the 
links: 

1. To check the data record inks, on the File menu, click Check Links.   
2. If any problems are detected, you will be prompted whether they should be corrected. 
3. To see a list of the problems that will be corrected, click the "View Details" button. 

Refreshing your Data 

After changes have been made to a Genbox database by external programs, or when the program was 
abnormally terminated, you may need to refresh your data. 

1. To refresh data, on the File menu, click Refresh Data.  

This operation will look through the tables for internal consistency and make corrections where needed. 

Spotting Data Problems 

When entering data, even the best researchers occasionally make mistakes--enter the wrong year for a date, 
choose the wrong event type for an event, or even link children to the wrong parents. Sometimes it isn't a data 
entry problem, it's a transcription problem: information found in a source document was copied down 
incorrectly to begin with. Mistakes can also be present in GEDCOM files that are imported into your database. 
While some mistakes would be hard to identify, such as a misspelled name or an incorrect place, there are 
some problems that can be detected when considering the consistency of the database. 

Genbox can identify some types of data consistency problems, primarily related to dates.  

1. To check for data consistency problems, On the Tools menu, click Problems Spotter. The Problems 
Spotter Tool will open. 

2. Enter your settings for limits, or use the defaults. 



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 71

3. Click Generate List. When the operation completes, the List View will open to display the results as 
the Potential Problems list. 

The list will show a row for the ID and name of each individual with a data consistency problem, followed by a 
row that describes the nature of the problem. You can double-click on each name to jump to their data record, 
where you can investigate the problem. If you determine it is a data entry error, you can make the correction, 
then proceed to the next individual on the list. 

Finding and Merging Duplicate Individual Records 

When you import data from a GEDCOM file, new individual records are automatically created for each 
individual in the file. This can lead to duplicate individual records--two records in the Individuals Table that 
represent the same real person, each with their own set of subrecords for names and events. Because the 
links between children and parents and the links between spouses reference the individual records by ID, it is 
important to merge the duplicate individual records into one record, and fix all the references to use a single 
ID. Otherwise, charts and reports won't display correctly, and data entry will be frustrating when there are two 
places for the same data. 

Finding duplicate individuals can be complicated. In the typical case, one of the records will be entered by 
you, using your own source documents. The other record will originate from an imported GEDCOM file, and 
contain data that came from different source documents. This means the names could be spelled slightly 
differently, the birth and death dates could be off by a few days or years, particularly if they were estimates, 
and some data may be present in one record but not the other. Also, identifying candidates can be tedious 
when there are thousands of individual records.  

Genbox can help you find potential duplicate individuals, with the Match Finder Tool.  Pairs (or larger groups) 
of individual records that potentially represent the same person can be detected, according to your match 
criteria. 

1. To find potential duplicate individuals, On the Tools menu, click Match Finder. The Match Finder 
Tool will open. 

2. Enter your settings for match conditions, or use the defaults. 
3. Click Generate List. When the operation completes, the List View will open to display the results as 

the Possible Duplicates list. 

You can then compare the individual records in each group on this list, and make your own determination as 
to which are the same individual, and then merge their records together. 

Merging Individual Records 

Once you have determined that two (or more) records are duplicates, you can merge them together. This will 
result in only one record for the individual in the Individuals Table. All link references to the removed record 
will be redirected to the kept record. 

To merge two individual records: 

1. Move to the target individual on the Individuals View (the one you want to keep). 
2. On the Data menu, click Merge Individuals... 
3. The Individuals Pick Dialog will open to allow you to select the individual record you want to merge 

with the current one. 
4. You will be prompted to confirm the operation, then the source individual's data will be merged into 

the target individual's data. The Source individual will then be deleted. 



       

View Windows 
The View Windows provide much of the interface in Genbox. They are used to display and modify data, 
search for data, and select options for charts, reports, export, and import. You can have multiple view 
windows open at once. The view windows are selected from the View Menu.  

View windows that display data records have a header section, which contains an ID box, a Name box, and 
a Filter button. The header section indicates the current record and filter conditions, and is used to select the 
record to view. 

All view windows have multiple pages. Only one page can be viewed at a time. Select a page by clicking on 
its tab.  

Some view windows have a row of buttons. These provide access to special functions.  

ID 

Every record has a unique identification number, or ID, that is used to reference it. The ID values are 
assigned by the program when records are created. The ID box in the header section displays the 
identification number for the current data record. If you know the ID value of a record, you can select the 
record by typing the ID into the ID box and pressing ENTER. Sometimes it is easier to select a record by its ID 
than by its name, especially when the name is long or similar to several other names in the current data table. 

Name 

The Name box in the header section displays the name for the current data record. To select a different 
record, type the name into the Name box. You can type just part of the name if you prefer. When there are 
several records with names that match the partial name you typed, a Pick Dialog will appear, displaying data 
on each of the matching records. You can select the record you intended from the list.  

Filter Button 

The Filter button  at the right side of the header section can be used to filter the records displayed on the 
view. Normally, the record movement buttons on the main toolbar will move to the first, previous, next, and 
last records in the current data table. When filtering is active, they are limited to only those records that match 
the current filter conditions: the First Record button will take you to the first matching record, and the Next 
Record button will take you to the next matching record, skipping over all records that don't match the current 
filter conditions.  

1. To filter records, press the Filter button . A Pick Dialog will open. 
2. Enter the filter conditions you want. For the Individuals Pick Dialog, this can be name pattern, range 

for birth date or death date, sex, number of children, number of spouses, number of families, and 
individual flags. 

3. Click the Set Filter button. The Pick Dialog will close, and the first matching record will be the current 
record. 

The Filter button will have a pressed appearance  whenever a filter is active. This is to remind you that the 
record movement buttons are only stepping through a subset of the total records. 

• To turn off filtering, press the Filter button . A Pick Dialog will open. 
• Click the Clear Filter button. The Pick Dialog will close, and the Filter button will resume its normal 

appearance. 
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Individuals View 
The Individuals View is the main data view in Genbox. It presents all the information stored for an individual 
in one view, with the data organized onto multiple pages, each with its own tab. Each person in your database 
will have a record in the Individuals Table.  

            Summary Page 
            Pedigree Page 
            Identifiers Page 
            Attributes Page 
            Parents Page 
            Family Page 
            Events Page 
            Contact Page 
            Notes Page



       

Individuals View: Summary Page 
The Summary page presents an overview of the data stored for an individual: birth name, sex, parents, 
spouses, children, events, and media. Complete data for the individual can be found on the other pages of the 
Individuals View. 

 

Name Box 

The Name box shows the (first defined) birth name of the current individual. An individual can have an 
unlimited number of names and numeric identifiers, which you can view and enter on the Identifiers page. On 
the Summary page, only the first birth name is displayed, and entering a name in this box will automatically 
set its identifier type on the Identifiers page to "Birth name".   

Complete information on names and other identifiers can be set on the Identifiers page. 

Sex Box 

The Sex box shows the sex of the current individual:  

 

A value can be selected from the drop-down list, or by typing "M", "F", "U", or "O". Complete information on 
attributes can be set on the Attributes page.  

When entering new individuals, it is a good idea to also enter their sex at the same time, if known. When the 
sex is known, pronouns (he/she, him/her) can be used on narrative reports, and role labels (husband, wife) 
can be used on family group reports. 

Father and Mother Boxes 
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The Father and Mother boxes show the preferred parents for the individual. Complete information on parents 
can be set on the Parents page. If these boxes are blank, you can enter the name of the father or mother here 
as well. You can double-click the name of the father or mother to jump to their individual record.  

When both a father and mother are entered on the Summary page, a family record for the father and mother 
will be created automatically. A birth record for the current individual will also be created, linked to the parent 
family record. 

Reversing Mother and Father 

When father and mother are entered on this page, their genders (Male and Female) will be automatically 
initialized as well. But if a parent is added on the Events page, the initial gender may be set to unknown. 
Later, when observing the father/mother links here on the Summary Page, you may discover that the roles 
appear to be reversed: the mother is in the father's box, and the father is in the mother's box.  

To correct this problem, double-click on the name of the father to make his record current. Change his sex to 
"M" (male). Then go to the record for his spouse (the mother). Change her sex to "F" (female). When this is 
done, the system will detect that a family record exists for the couple that appears to have the father/mother 
roles reversed. It will ask if the roles should be reversed, choose "Yes". Then when the parents appear on the 
Summary page, their father/mother roles will be correct.  

Note: this role reversal check is only performed when the gender on a spouse is changed, and only if the 
change results in male/female genders opposite of father/mother roles. If you have an existing family with 
roles reversed but correct genders assigned, you will need to temporarily change the gender on one spouse 
to "unknown", then back to the correct gender, in order to initiate this correction. 

Spouse Box 

The Spouse box initially displays the name of the preferred spouse. Complete information on spouses can be 
set on the Family page. All spouse names can be seen on the drop-down list. If there are additional spouses 
defined, the label on the box will change to indicate the spouse number: it will display "Spouse1" for the first 
spouse and "Spouse2" when showing the second spouse.  

• To add the first spouse, type the name of the spouse in the box. 
• To add an additional spouse, click the add option on the drop-down list, then type the name of the 

spouse into the box.  

You can double-click the name of a spouse to jump to their individual record. 

When a spouse is added on the Summary page, a Marriage event record will automatically be created for the 
current individual and spouse. 

Children List 

The Children list displays the name, sex, and birth date for each child that is linked to the current individual. 
You can type the information for new children into the next blank line. Children can also be added on the 
Family page or the Events page.  

• To add a child linked to the current individual and displayed spouse, click where it says "Add 
child" in the auto-generated font style, then type the child's name. Press TAB then "M" or "F" to enter 
the child's gender. Press TAB again to enter the birth date for the child.  

Children can also be added on the Family page or the Events page.   

A plus-sign ("+") appears before the names of children that have children of their own entered into the 
database. You can double-click the name of a child to jump to their individual record. The list can be sorted by 
name or birth date by clicking on the column headers.  

Notes  
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• If the current individual has multiple spouses, children of the currently displayed spouse will be shown 
in the normal data font, and children of the other spouses will be shown in the second layer text font. 

• A specific child will be listed only once, even when it is linked to the current individual in multiple 
parent families. 

• When a child is added to the Children list, it is automatically linked to the family of the current 
individual and the currently displayed spouse as the birth parents. If no spouse has been entered, a 
family record containing the primary individual only will be created, and the spouse box will display 
"(unknown spouse)". 

• If you want to link a certain group of children to a different unknown spouse than another group of 
children, you will need to first create records for the unknown spouses. You can use names like "First 
Wife" and "Second Wife" to identify them. Otherwise, all children entered with an unknown spouse will 
be added to the same family of the primary individual. 

• If you have several children with blank birth dates or with the same birth date, you can drag the rows 
up/down to specify birth ordering. 

Events List 

The Events list displays the event type, date, place, subject individual, age at time of event, a number of 
flags, and an Excluded checkbox for each event record stored for the individual. Complete information on 
each event can be viewed and entered on the Events page. Basic information on events can be entered on 
this page as well.  

Event Type Column 

The event type column displays the type of event. It is also used to create new event records.  

• To enter a new event, click where it says "Add event" in the auto-generated font style. 
• Select the event type from the drop-down list that appears. 
• Press TAB or use the mouse to move to the Date box and then the Place box. 

You can double-click the event type to jump to the events record on the Events page.   

Date Column 

The date column is used to display/enter the event date. 

Place Column 

The place column is used to display/enter the event place.  

If the value in the subject column is blank, a long place name in the place column will be allowed to overflow 
into the subject column. This provides for the best use of limited screen space. Note: overflow is disabled 
when the grid option is active.  

You can double-click the Place text to jump to the place record on the Places View.  

Subject/Detail Column 

The subject individual / detail column is used to display the "subject" individual of the event, if different than 
the current focus individual, or the detail text of the event. The subject individual is one of the principal 
individuals of the event (primary, spouse, other). The displayed subject individual depends on the event type 
and the current focus individual:  

• For a parents link event type, the subject is the child. For example: a "childbirth" event in the list 
would show the name of the child born in this column.  

• For a spouse link event type, the subject individual is the other spouse. For example: a "marriage" 
event would show the name of the person married.  

• For an associated individual event type, the subject is the other individual.  
• For a witnessed event, the subject is the child or primary individual of the witnessed event, 

depending on the event type of the witnessed event.  
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• For all other event types, the subject is the same the current individual, and this column will display 
the detail text of the event instead.  

You can change the focus to the subject individual by double-clicking the name shown in this column. If this is 
a witnessed event, the shown event record will also change; otherwise, the same event record will be shown. 

If the event record has no subject individual, then the "detail" text from the event record will be shown, if any. 
This includes attribute values, such as cause of death, occupation, and religious affiliation. 

Age Column 

The Age column shows the age of the individual at the time of the event, in years. If shown in the auto-
generated text font style, the age has been generated automatically, based on the difference between the 
event date and the birth date. If shown in the normal text style, this is a value that has been manually entered, 
overriding the automatically-generated value. 

Flags Column 

The column labeled "MGRSW" has space for five checkmarks for each event. The checkmarks represent the 
presence of additional data for media (M), general notes (G), research notes (R), source citations (S), and 
witnesses (W). This additional data can be viewed on the Events Page. You can double-click on the flags to 
jump to the corresponding event record. The flags column is read-only. 

Excluded Column 

The Exclude column has a checkbox for each event. Checking this box marks the event as "Excluded". 
Excluded events do not appear on any output (charts, reports, GEDCOM files, web pages). 

Basic Events 

If enabled on the Preferences Operation Page, event types marked "basic" will appear automatically for all 
individuals on the Event List. This makes it easy to add basic information for new individuals; you can 
immediately type the date/place information into the appropriate boxes. The event label on automatically 
added basic event types will appear in the auto-generated text font style.  

Source Citation Button 

You can enter a source citation that applies to the entire individual by clicking the Source Citation button on 
this page. Normally, you would enter source citations for specific data items. The button on this page may be 
useful when the current individual's data all came from a single source. For help, see the chapter Citing your 
Sources.  

Research Target Button 

You can make the current individual a target for further research by clicking on the Research Target button. 
This will open the Research Targets View. When the current individual has been linked to a Research Targets 
record, the Research Target button will be shown in bold. 

Media Control 

The Media control is the open area to the right of the middle boxes. It initially displays the principal media 
linked to the individual, if any. Any number of multimedia objects can be linked to each individual. Multimedia 
can also be linked to families on the Family page and to events on the Events page. Multimedia linked on the 
Summary page should be more closely related to the current individual than to a family unit or to a particular 
event. A good example is an individual portrait. See the chapter Adding Multimedia for help on the Media 
control.   

Splitter Bars 
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There are two splitter bars that allow you to adjust the sizes of the areas on this page. There is vertical 
splitter to the left of the Media control. You can use this splitter to reduce the area for the Media control if you 
need more space to display father, mother, spouse, and children information. There is a horizontal splitter 
between the Children list and the Events list. You can use this to increase the display area for either children 
or events.   

1. To move a splitter bar, position the mouse so that the cursor changes into the double-arrow shape. 
2. Drag the bar to the desired position by pressing and holding the left mouse button while you move the 

mouse. 

You can also resize the view to allow more information to be seen, by dragging the view edges to the new 
size. When a view is resized, the splitter bars will return to their default relative positions. You can resize a 
view slightly if you wish to reset the splitter bars. 



       

Individuals View: Pedigree Page 
The Pedigree page provides information on three generations of ancestors, siblings and their spouses, and 
children and their spouses of the current individual. This page can be helpful in understanding how the current 
individual fits into the family tree. It can also be used for navigation: you can jump to the individual record of 
any name displayed with a double click. Unlike the other pages on the Individuals View, the Pedigree page is 
not used to enter data.   

The Pedigree page contains the names of many of the relatives of the current individual. The preferred father, 
mother, spouse, and children can also be viewed, as well as edited, on the Summary page.  

 

Siblings List 

The Siblings List contains one row for each child and spouse of the current parent family, including the 
current individual and his/her spouses. The highlighted row indicates the current individual and spouse. 
When a sibling has more than one spouse, additional rows with each spouse name are shown. The Children 
List always displays the children and their spouses for the currently selecting sibling on the Sibling List. 

There are two columns: Sibling and Spouse. 

• To display the children of a different sibling or different spouse of the current individual, single-click on 
the row. If this is a different sibling, this action will make the sibling the new current individual. 

• To jump to the individual record for a spouse, double-click on the spouse name. 

Sibling Column  

The name of each sibling, including the current individual, appears once in the Sibling column. If a sibling has 
multiple spouses, additional lines will appear below the first, with a blank in the Sibling column. Siblings are 
shown in birth order. You can sort them in reverse order by clicking on the column header.  

Spouse Column  

The name of each sibling's spouse appears in the Spouse column. If a sibling has multiple spouses, the 
spouses will be shown in marriage order, with the order number in parentheses ("(1)", "(2)", etc.) preceding 
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the name. If a sibling and spouse have children, a plus sign (+) will be shown. To jump to the individual record 
for a spouse, double-click on the spouse name.  

Children List  

The Children List displays the children for the current sibling on the Sibling List. One row appears for each 
child and spouse. When a child has multiple spouses, additional rows with each spouse name are shown.  

The children of the current sibling and spouse are shown in the normal List font. Children of the current sibling 
and other spouses are also shown, but in the Second Layer Text font, which is typically in italics.  

Child Column  

The name of each child of the current individual appears once in the Child column. If a child has multiple 
spouses, additional lines will appear below the first, with a blank in the Child column. Children are shown in 
birth order. You can sort them in reverse order by clicking on the column header.  

Spouse Column  
The name of each child's spouse appears in the Spouse column. If a child has multiple spouses, the spouses 
will be shown in marriage order, with the order number in parentheses ("(1)", "(2)", etc.) preceding the name. If 
a child and spouse have children, a plus sign (+) will be shown. To jump to the individual record for a child or 
spouse, double-click on the name.  

Pedigree Boxes  
Three generations of ancestors for the current individual are shown in the Pedigree boxes. The two parent 
boxes are linked directly to the Siblings box, indicating that they are the parents of all the siblings shown. 
There are four grandparent boxes linked to the parent boxes, and eight great-grandparent boxes linked to the 
four grandparent boxes.  

To jump to the individual record for any displayed ancestor, double-click on the name.  

Ancestor Continuation Buttons  
If more than three generations of ancestors of the current individual are stored in the database for a particular 
ancestral line, an Ancestor Continuation button for that line will appear. It shows a plus-sign (+) to indicate 
that more generations are available for viewing.  

• To move back one generation, click the Ancestor Continuation button for the desired ancestral line. 
The parents of the selected third-generation ancestor will now be visible.  

This action causes one of the parents of the previous current individual to become the new current individual. 
This means the contents of the Pedigree boxes will change. To help you find where you were before clicking 
the button, the previous third-generation ancestor in the line of the selected Ancestor Continuation button will 
now be highlighted.  

Alternate Parents Button  
If the current individual has multiple parent families, the Alternate Parents button will appear between the two 
parent boxes. It will display the current parent family number and the total number of parent families, as in "1 
of 2". To view the alternate parents and their ancestors, click the button. Each click will cycle though the next 
set of parents.  



       

Individuals View: Identifiers Page 
Genbox supports an unlimited number of identifiers for each individual. An identifier is most often a name, 
but it can also be a number or a combination of letters and numbers, such as a social security number or 
other national ID. An individual can be known by many different names over the course of a lifetime:  birth 
names, nicknames, married names, legal name changes, aliases, nobility titles, professional titles, and military 
ranks. A name can also appear with different spellings or in different forms on source documents. It is 
important to record names exactly as you find them, because what you might assume is a name variation may 
actually be a reference to a different individual, and the original spelling could be useful later to resolve this 
research problem.  

The Identifiers page contains complete information on all individual identifiers. One name can be marked 
primary. The primary name is also viewable and editable on the Summary page.  

 

Identifier List 

The Identifier List contains one row for each identifier. There are eight columns: Identifier Type, Name / 
Number, Primary, Preferred, Source Citation, Event Link, Exclude and Identifier ID. The highlighted row 
indicates the selected identifier. For the selected identifier, related data is shown in the group box below the 
list. 

• To Add a new identifier for the current individual, click where it says "Add identifier" in the auto-
generated text font style, then type the new name. The type will default to "Other name"; you can 
change it to any of the defined identifier types.  

• To see the related data for an identifier, click on its row in the list box to select it. 
• To delete the selected identifier, press the DELETE key or go to the Data menu and click Delete 

Selected Name. 

Identifier Type Column  

Each identifier for an individual has an Identifier Type. The type can be changed by selecting from the drop-
down list. The names of the identifier types and their properties are set on the Data Setup View: Identifier 
Types page. The default non-hidden identifier types are:  
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Birth Name  

A birth name is the full name given to an individual at or shortly after birth. It normally consists of two or more 
parts: the given name(s) and the surname (family name). Usually an individual will have only one birth 
name. Additional birth names can be entered when there is some doubt over the correct name, or when there 
are birth names for additional languages. The notes box can be used to describe the specific situation.  

Nickname  

A nickname, or "pet name", is a personal name an individual is called in place of the birth given names during 
some part of their life. A nickname is often a diminutive form of a given name, as in "Jim" or "Jimmy" for 
"James".  

Nicknames are important to know and track because often the source documents we find will use the 
nicknames instead of the proper names. They also add a personal touch to reports, as nicknames may be the 
most personal thing we know about individuals.  

You can enter nicknames as part of the name by placing them within double quotes. The system will 
recognize this, and remove the nickname portion to its own name record. For example:  

    James "Jimmy" Smythe 

If this name were entered for a new individual, the birth name would be recorded as "James Smythe", and a 
separate nickname would be entered as "Jimmy". Both names would be marked "preferred" by default, 
resulting in a display of both names in the same format as shown above. 

A nickname record can also be used to indicate that the individual commonly used a middle name, or a 
combination of the first name and middle name, in informal use. You could enter a nickname record for "Mary 
Beth", to indicate that Mary Beth Simpson used both names together as her common name. If "Tobias Russell 
Jones" was commonly known as "Russell Jones", you would indicate this be adding a second name record for 
the nickname "Russell". 

Note    A nickname is considered a replacement for the given names of an individual. No surname should be 
included in the nickname. When searching for individual names elsewhere in the system, Genbox will 
recognize entry of a nickname and any surname assigned to the individual.  

Prefix Title  

A prefix title is a name part that appears before the given names, such as "Dr." or "Rev.". It could be an 
honorific title, nobility title, clerical title, or military title. It is a name part that is not part of the legal name of the 
individual.  

It is best to store the prefix part separate from the given names, so that a search on a given name won't be 
affected.  

Married Name  
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The married name type identifies a name assigned to an individual on the event of their marriage.   

Name Change  

The name change type identifies a name that replaces the birth name (or previous name change name) in 
chronological use. This name type is mainly used for individuals who undergo a legal name change for 
reasons other name marriage.  

Source Name Variation  

A source name variation, or name variant, is a name that is entered exactly as it is spelled in one or more 
sources. This type can be selected when using "Source Lock Mode" during data entry, or when entering 
source citations. It is important to keep track of name variations, because you may discover later that two 
sources with slightly different spellings that you thought were the same person are in fact referring to different 
individuals. Without a record of the variation, it would be harder to resolve this type of problem. It is also 
misleading in source citations to attribute a "normalized" spelling to a name in a source when in fact a different 
spelling appears.  

Source name variations can include:  

• spelling variations 
• translations 
• transliterations 
• name part order variations 
• shortened forms 

By storing the source name variations, Genbox can also make use of them when formatting the source 
citation text.  

See the chapter Citing your Sources for more information.  

Alias  

An alias is an unofficial name used by an individual. This name is in addition to the birth name. Several 
aliases may be in use during the same period.  

You can enter aliases when entering new individual names by prefacing them with ", alias " or ", aka ". The 
system will recognize this, and remove the alias name to its own name record. When included in the preferred 
name, the name will be prefaced with ", alias ".  

Suffix Title  

A suffix title is a name part that appears after the surname, such as "Jr.", "Duke of Windsor", or "fisherman at 
Broad Cove". It serves to further qualifier the name, to distinguish it from potentially other individuals with the 
same given and surname. Some titles of royalty (nobility titles) are also stored with this name type.  

You may wish to create your own suffix titles to distinguish people in your database that otherwise would have 
the same name, as in "John Smith, from family Bible" and "John Smith, in George's Will".  

On data entry of names on the Summary page and elsewhere, portions of a name that appear after a comma 
will automatically be extracted and stored as separate suffix title names. They will also be marked as 
"preferred", so they will be included as part of the preferred name wherever the individual is referenced.  

Other Name  

The other name type is for any name that does not fit into one of the other name type descriptions. An other 
name can be just a given name, a surname, or both.  

Possible uses for the other name type include:  
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• alternate name when you are not sure which is correct 
• translation / other language 
• pronunciation guide 
• invented names for your own use in identifying individuals 
• names of unknown type 

Note    When you have a source record that documents the name, you should choose the source name 
variation name type instead of the other name type. 

You can enter other names when entering new individual names by placing them inside parentheses. The 
system will recognize this, and remove the other name to its own name record.  

When an other name is marked for inclusion in the "preferred" name, it will be formatted to appear inside 
parentheses. Likewise, on data entry, portions of names that are placed within parentheses will automatically 
be extracted and stored as separate other name entries. They will be marked as "preferred", so they will be 
included as part of the preferred name wherever the individual is referenced. 

AFN  

AFN stands for Ancestral File Number. These 10-digit identifiers are assigned by the Family History 
Department.  

RFN  

RFN stands for Permanent Record File Number.  

SSN  

SSN stands for Social Security Number.  

National ID  

The National ID identifier type is for any national identifier, other than a social security number.  

User ID  

The User ID identifier type is for your own use. It can be a number or text. Genbox formats User IDs with 
angle brackets, so a User ID of MYID347 would appear on the display and reports as [MYID347]. This helps 
to distinguish them from data that originated from a source record.  

User IDs are useful when there are individuals in the database for which you have no other names. For 
example: suppose you know that June Schaefer and Jane Schaefer are sisters, but you do not know anything 
about their parents. In order to store the sister relationship, you will need to create an individual record for at 
least one of their parents, then add the two daughters as children of the parent. For this parent, you can 
assign a User ID such as [Father of June and Jane Schaefer]. This User ID makes it clear who the 
individual is, and the square brackets make it clear that this is a User ID that has been assigned; it is not data 
that originated from a source record.  

_UID  

UID stands for Unique Identifier. This identifier is used by Personal Ancestral File. Genbox will recognize 
these values on input and store them, so that they can be exported later.  

Name / Number Column  

The Name / Number column contains the actual text of the identifier. Given names and surnames are stored 
in Genbox as one data value. Click on a name to edit it. Use normal capitalization and name part order.  

Slash Marks in Names  
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Genbox uses slash marks to mark divisions between name parts. Usually, two slash marks are used to mark 
the beginning and ending of the surname part, as in "John /Smythe/".  Slashes are useful in identifying the 
surname portion when the surname is not a single word, as in "John /Du Pont/". They are also helpful when 
the surname is not the last word in the name. When you type a name and press ENTER or TAB, Genbox will 
automatically add slash marks around the last word in the name if slash marks are not already present. On 
charts and reports, the slashes are usually not shown. Also, slashes are not used on the numeric identifiers.  

You can also use a third slash to divide the surname into two parts: the surname prefix, and the surname 
base. A surname prefix is a leading portion of a surname that should not be used when sorting. In the name 
"George /van /Stone/", the word "van" is identified as the surname prefix. A surname sort would put this name 
under "S", not "v".  

Surname prefixes do not need to be separate from the surname. In the name "Carl /d'/Hondt/", the surname 
prefix is marked as "d'", and there is no separating space from the surname base "Hondt".  

Tip If you want to include a forward slash as part of the name itself, precede it with a backslash: "Gloria 
/Myers\/Smith/". This will appear as "Gloria Myers/Smith" on reports.  

Primary Column  

The Primary column is labeled with a circled "1". One identifier can be marked "primary". This is usually the 
birth name of the individual. The identifier type marked "primary" can be individually selected on charts and 
groups. It can also be viewed and edited on the Summary page.  

Preferred Column 

The Preferred column is labeled with a star. This column contains check marks next to those identifiers that 
are preferred. Genbox builds a composite name for an individual based on the names that are marked. This 
composite name, or preferred name, is used when a reference is made to an individual from elsewhere in the 
program. Typically, the birth name is the foundation of the preferred name. You can include suffixes or 
nicknames to further distinguish the name. This is particularly important when multiple individuals in your 
database have the same or similar birth names, a common occurrence in family trees.  

When you click on the Preferred column for an identifier, you will immediately see a change in the preferred 
name shown in the Name Key box in the header section of the view.  

Source Citation Column 

The Source Citation column contains "open book" buttons which indicate which identifiers have source 
citations, and the surety level for the data. Click one of these buttons to enter source citation information on 
the Citations View. For help, see the chapter Citing your Sources.  

Event Link Column 

The Event Link column shows which identifiers have defining events. A defining event is the event at with the 
identifier was assigned to or first used by the individual. The "calendar" icon will be yellow when an event link 
exists. The icon will be gray when no defining event has been entered. When there is a defining event, a 
double-click will take you to the event record on the Events page.  

Exclude Column 

The Exclude column is labeled with a circled slash mark. It shows which identifiers should be excluded on 
charts, reports, and exported data. This feature allows convenience names to be entered to help distinguish 
individuals without affecting the appearance of names on reports. To do this, set the name type to "Suffix 
Title" and check the "Preferred" and "Exclude" flags; your extra identifier will be appended to the individual's 
name inside the program but not on reports. The exclude flag can also be used to protect sensitive data from 
appearing on the output, such as for Social Security numbers.  

Identifier ID column  
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The identifier ID column displays the record ID for each identifier. This column is read-only.  

Defining Event  

Each name and identifier can be linked to a defining event. Linking a name to an event serves to define when 
the name first came into use.  If there is a link to a defining event, Genbox will be able to use this name on 
narrative reports with the event template code [N].You can select an event from the drop-down list.  

General Notes  

Use the General Notes box to enter notes regarding the selected identifier. You could describe the 
circumstances under which the name was given, for example. General notes can be included in the body or 
footnotes on a report.  

Research Notes and Target  

Use the Research Notes box to record your research efforts regarding the selected identifier. You can also 
make the name a target for further research by clicking on the Research Target button. This will open the 
Research Targets View. When the current identifier has been linked to a Research Targets record, the 
Research Target button will be shown in bold.  

Splitter Bar  

There is a horizontal splitter bar below the Identifier list. Drag it down to increase the number of list rows 
visible, or drag it up to see more of the notes text. There is a vertical splitter bar between the General Notes 
and Research Notes boxes. Drag it to adjust their relative sizes.  



       

Individuals View: Attributes Page 
The Attributes page contains complete information on individual attributes. An attribute is a characteristic of 
a person that can persist over an extended period of time, such as sex, physical description, national origin, 
and occupation.  

 

User-definable attributes in Genbox are divided into two groups:  

• Text attributes have a type and a text value. Text attributes are linked to a defining event. 
• Flag attributes are named check boxes. A check indicates the individual "has" the attribute identified 

by the flag name. 

When the Attributes page is selected, you will see the Text attributes list on the left, with one row for each 
text attribute type. The Flag attributes list is on the right, with one check box for each defined individual flag. 

Years Since Birth Box 

The Years since birth box displays the number of years since the individual was born. This is a read-only 
value automatically generated by Genbox, based on the earliest birth date stored for the individual. 

The label on this field indicates the "living" status for the current individual: if the system algorithm for 
determination of living status indicates this individual is still living, the label on this box will change to Age. 

Living Determination 

An individual is determined to be living under any of the following circumstances: 

• The birth date determines an age less than the preferences setting for "Living Individuals Age" and 
there is no death event recorded, OR 

• There is no birth date and no death event recorded, OR 
• the "Living" flag has been checked 
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The "Living" attribute flag functions as an "override". When the user sets this flag, the individual is treated as if 
they are still living, regardless of data values for birth and death. This override function can be useful when 
you wish to maintain the privacy of individuals who died recently on your reports and GEDCOM exports. 

Sex Box 

The Sex box shows the sex of the current individual. For the purposes of genealogy, the physical (biological) 
sex of the individual at birth is normally most relevant and is stored in the Sex box. If the individual has a 
gender identity or sexual preference that differs from their biological sex, you may wish to enter this 
information in the general notes field or in a text attribute. 

 Possible choices for the Sex box are:  

 
• Male - the individual was biologically male at birth. 
• Female - the individual was biologically female at birth. 
• Unknown - the sex of the individual is unknown. 
• Other - the individual has biological characteristics of both male and female and a determination of 

sex could not be made at birth. These individuals are sometimes described as "intersexed" or 
"hermaphrodite". This choice can also be selected to prevent the use of male/female pronouns. 

A value can be selected from the drop-down list, or by typing "M", "F", "U", or "O". 

Tip When entering new individuals, it is a good idea to also enter their sex at the same time, if known. When 
the sex is known to be male or female, pronouns (he/she, him/her) can be used on narrative reports, and role 
labels (husband, wife) can be used on family group reports. If there is any doubt, click "Unknown". 

Sex can also be viewed and set on the Summary page.  

Text Attributes Box 

The Text Attributes box contains at least one row for each defined attribute type. All defined text attribute 
types will appear for all individuals on the Attributes page, regardless of whether a value for the attribute has 
been entered. The list box has three columns: Attribute Type, Text, and Event Link. An individual can have 
more than one value for a particular attribute type, with each value on a separate row and linked to a different 
event record. 

• To enter text for one of the shown attribute types, type the text value in the blank space to the 
right of the attribute type label.  

• To add another text attribute for the current individual, click where it says "Add attribute" and 
choose the type from the dropdown list, then type the new text.  

• You can define new attribute types on the Event Types View.   

Attribute Type Column 

The Attribute Type column displays the name of each attribute, as defined by the Event Type records which 
have a "Secondary" value of "Attribute". 

1. To define a new attribute type, open the Event Types View. 
2. Create a new event type record. 
3. In the Secondary box, click on "Attribute" from the drop-down list. 
4. In the Secondary Label box, type the name for the attribute type. 

Note   The Attribute Type column on the Attributes page is read-only. 

Text Column 
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The Text column contains the actual attribute text values for the current individual. If the text value on a row is 
blank, it means the individual has no value entered for the attribute type listed on that row. 

Event Link Column 

The Event Link column for text attributes link to the defining events. The "calendar" in this column will be 
gray when no text has been entered, and yellow after attribute text has been entered. Click the icon to jump to 
the corresponding event record on the Events page. 

Every attribute has an associated defining event record so that there is a way to format the information for 
narrative reports. Attributes by themselves don't have default sentence templates or a way to order their 
output (no date fields). Because they are linked to event records, you can customize how the information will 
appear on reports. The event record does not have to describe the "defining" event for the attribute. It can be 
used to describe the attribute in general terms. It doesn't have to show a date or suggest the attribute was 
acquired at a specific point in time. You can also set the "Exclude" flag on the event record if you don't want it 
to appear at all on reports.  

Flag Attributes Box 

The Flag Attributes box contains one check box for each defined individual flag. If checked, an individual 
"has" the attribute indicated by the name of the check box. The individual flags are defined on the Data Setup 
View. All defined individual flags will appear for all individuals on the Attributes page. This makes it easy to 
see what flag attributes an individual does and does not have, and changes can be made with a single click. 

Splitter Bar 

There is a vertical splitter bar between the Text Attributes list and the Flag Attributes list. Drag this splitter 
to the right to increase space for text attribute names, or to the left to increase space for viewing the flag 
check boxes. 



       

Individuals View: Parents Page 
The essence of a genealogy is the links between its individuals. There are two kinds of genealogical links: 
from child to parent, and from individual to spouse. Genbox supports the entry of multiple sets of parents for 
an individual. When your research suggests more than one possibility for biological parents, you should enter 
a parents record for each conflicting pair, and create source citations for each. 

Parent records are not just for biological parents. Adoptive parents, foster parents, and even godparents can 
be entered. Genbox also supports "direct ancestor" as a parent type, which is useful when your research has 
shown a connection but the intermediate generations are not known. 

The Parents page contains complete information on parent links. The Parents page shows detail for one 
parents record at a time. 

 

Parents Selector Box 

The Parents Selector box appears at the top of the page, and displays the names of both parents joined by 
"and". It identifies the current parents record.  

• To select a different parents record to view or edit, click this box and select from drop-down list. 
• To add an additional parents record, click this box and then click add from the drop-down list. 

You can also select parent records and add new records using the subrecord controls. 

Check Boxes 

A number of check boxes can be checked for each parent record:  

Preferred parent family 

The Preferred parent family is the parent record that will be used elsewhere in the program when a single 
set of parents is required, such as on the Summary page and on charts when the Child-Parent Links to Show 
value is set to "preferred". Only one parent record can be marked preferred for each individual. When this 
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check box is checked, it will automatically be cleared for other parent records for the current individual. If no 
parent record is marked as preferred, the first parent record will be used as the preferred parent record. 

Alternate parents link 

Checking the Alternate parents link check box indicates that the current parent record is considered an 
alternate, rather than an additional, parent record. An alternate parents record would be treated on narrative 
reports as a research possibility, but secondary to the preferred parents link.  

Note    Parent records of non-biological types, such as adoptive parents, should not be marked as alternates. 

Exclude link from reports 

Checking the Exclude link from reports check box will cause the current parents link to be ignored when 
producing charts and reports. This can be used in two ways: to hide data that is considered inferior or 
incomplete, or to purposely introduce breaks in a genealogy to effectively "prune" a genealogical tree. 

Disproved 

The Disproved check box provides a way to indicate that a certain individual is known NOT to be a child of 
the indicated parents. This parents record will not be used in the creation of charts or for determining ancestry 
or descendants on reports. The information about the disproved relationship can appear on narrative reports 
as part of the discussion. 

Multiple birth 

Individuals who were born as part of a multiple birth (twins, triplets, etc.) can be indicated by checking the 
Multiple birth check box. When checked, the Multiple Birth Group box will be enabled, allowing you to 
choose a group identifier: 

   

• To indicate the members of a multiple-birth group, use the Multiple Birth Group box to assign the 
same group identifier to each member of the group.  

For example: suppose a family has twins, triplets, and two other children. The twins would each be marked as 
a multiple birth, with a group identifier of "A". The triplets would each be marked as a multiple birth, with a 
different group identifier, such as "B". The remaining children would not be marked as multiple births. 

You will need to go to the individual record for each group member in turn to set their group identifier on their 
respective parent records. The actual choice of group letter used for a group (A, B, etc.) is not important; it just 
needs to be different from that used by other groups involving the same individuals. 

When multiple births have been properly grouped, Genbox can produce better birth descriptions on narrative 
reports. 

Relation: private 

Check the Relation: private check box when the actual relations, as stored in the Relation boxes, should be 
ignored on charts and reports, treating the relations as biological instead. 

Role Boxes 

The Father Role box has the choices "Father", "Parent1", and "Other": 
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 The Mother Role box has the choices "Mother", "Parent2" and "Other": 

 

 The role choices provide a way to indicate nontraditional parent families. The role choices selected will affect 
the labeling of the parents on reports, such as the Family Group Sheet. 

Name Boxes 

The Father Name box and the Mother Name box are where the actual names of the parents are entered. 
The pairing of two names will automatically generate a Family record for the two parents. If only one parent is 
known, leave the other box blank. 

Relation Boxes 

The Father Relation box and the Mother Relation box indicate the type of parent relation. A different 
relationship type can be set for each parent. Click on the box to see the choices on the drop-down list:  

 

• Biological parent: a birth parent. 
• Adoptive parent: this parent formally adopted the child. 
• Foster parent: this individual is serving as a foster parent. 
• Stepparent: this individual is a spouse of a biological parent. 
• Godparent: this individual served as a sponsor at the current individual's baptism. 
• Sealing parent: this individual was sealed as a parent in an LDS sealing ordinance. 
• Direct ancestor: research indicates this individual is a direct ancestor, but there may be intervening 

generations. 
• Relative: this individual is known to be a relative, but the exact relationship is unknown, or is other 

than biological parent or direct ancestor. 
• Other: any other type of parent. 
• Unknown: this individual appears to be parent, but no evidence is available to indicate the 

relationship. 
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General and Research Notes 

Use the General Notes box to record your notes about the parent link. If the link is not biological, you can 
explain the relationship type. 

Use the Research Notes box to record the status of your research on the link. 

Research Target Button 

Click on the Research Target button to create a research target for the current parent link record with the 
Research Target View. The button will appear bold when a research target has been defined. 

Source Citation Buttons 

There are four Source Citation buttons on the Parents page:  

• Parents Link (next to the Parents Selector box) 
• Multiple Birth Grouping (next to the Multiple Birth Group box) 
• Father Link (next to the Father Relation box) 
• Mother Link (next to the Mother Relation box) 

Each of these buttons allow you to enter source citations, and will indicate the current surety level. Use the 
Parents Link button to record source citations for the parents when your source is for both parents. Use the 
Father Link or Mother Link buttons when your source is for only one parent. See the chapter Citing your 
Sources for more information. 

Defining Event Button 

The Defining Event button allows you to associate an event record with this parents link record. The defining 
event for a adoptive parent link would be the event of adoption, for example. When a defining event has been 
entered, the button will be bold and clicking it will cause a jump to the linked event record on the Events page.

Subrecord Controls 

The subrecord controls appear in the top right corner of the page. The Subrecord ID box displays the 
unique ID of the current parents record.  

• To move to a different parents record for the current individual, use the horizontal scrollbar. If the 
"thumb" occupies the entire width of the scrollbar, then there are no other parent records defined.  

• To add a new parents record, click the New Subrecord button . Or, on the Data menu, click Add 
Parent Link. 

• To delete the current parents record, click the Delete Subrecord button . Or, on the Data menu, 
click Delete Parent Link Record. 

You can also add new parent records with the Parents Selector box, or with the keyboard shortcut CTRL+L. 

Splitter Bar 

There is a vertical splitter bar between the General Notes and Research Notes boxes. Drag it to adjust their 
relative sizes. 
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Individuals View: Family Page 
In Genbox, a family is defined as a relationship between two or more individuals, either:  

• Two individuals are linked to each other by a family event, such as marriage. 
• One or two individuals are linked as parents to one or more children. 

A family can have both types of relationships, in which case the two individuals linked to each other are the 
parents of the children. 

The pairing of an individual with each of his or her spouses constitutes a different family, which is represented 
with a different family record.  

The Family page displays information on families. In particular, it displays information about spouses. One 
family record is displayed at a time. The current family record is selected by choosing from the spouses of the 
current individual. 

 

Spouse Box 

The Spouse Selector box appears at the top of the page, and displays the names of spouses. It identifies the 
current family record.  

• To select a different family record to view or edit, click this box and select the spouse from drop-down 
list. 

• To add an additional spouse and family record, click this box and then click add from the drop-down 
list. Type the name of the new spouse. 

You can also select family records and add new records using the subrecord controls. 

Check Boxes 

A number of check boxes can be checked for each family record:  

Pref (preferred spouse) 
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The Preferred spouse is the spouse that will be used elsewhere in the program when a single spouse is 
required, such as on the Summary page for the default spouse to display, and on reports where a different 
content set can be specified for the preferred spouse. Only one spouse can be marked preferred for each 
individual. When this check box is checked, it will automatically be cleared for other family records for the 
current individual. If no spouse is marked as preferred, the spouse of the first family record will be used as the 
preferred spouse. 

Partners 

The Partners check box should be checked when the current individual and "spouse" are not known to have 
been married. When marked as partners, the "spouse" label will change on this page to "partner", and 
references on reports will also be changed so that they are not referred to as spouses of each other.  

Private 

The Private check box is enabled when the Partners check box is checked. It allows the "partners" 
designation to be private. The effect is that output reports will treat the two individuals as spouses; they will be 
treated as partners only within the program. 

Exclude 

Checking the Exclude check box will cause the link to the current spouse to be ignored when producing 
charts and reports. This can be used in two ways: to hide data that is considered inferior or incomplete, or to 
purposely introduce breaks in a genealogy to effectively "prune" a genealogical tree. 

Alt (alternate spouse) 

Checking the Alt link check box indicates that the current spouse is considered an alternate, rather than an 
additional souse. An alternate spouse would be treated on narrative reports as a research possibility. 

Children Box 

Sometimes your research will provide the total number of children for a family, but the names of the children 
will be missing or incomplete. The Children box provides a place to store this total number of children in such 
a case. 

Family Events List     

The Family Events list contains one row for each family event for the current family. Family events include 
Marriage-related events and Childbirth events. The Summary page also has an events list, but that list 
includes all events for the current individual. The Family Events list provides a view of just the events linked 
to the current family. There are three columns: Family Event Type, Date, and Place / Child. Events are 
shown in chronological order. 

• To add a new family event for the current family, click where it says "Add event" and choose the 
event type from the dropdown list. Enter the date, place, and child, if any.  

General Notes and Research Notes 

Use the General Notes box to record your notes about the family. If the family is not a nuclear family, you can 
use the notes to describe the relationships and background. 

Use the Research Notes box to record the status of your research on the links. 

Research Target Button 

Click on the Research Target button to create a research target for the current family record with the 
Research Target View. The button will appear bold when a research target has been defined. 



       

Media Control 

The Media control is the open area to the right of the middle boxes. It initially displays the first picture that is 
linked to the family, if any. Any number of multimedia objects can be linked to each family. Multimedia can 
also be linked to individuals on the Summary page and to events on the Events page. Multimedia linked on 
the Family page should be more closely related to the family as a group than to either spouse or to a 
particular event. A good example is a family portrait. See the chapter Adding Multimedia for help on the Media 
control.  

Source Citation Buttons 

There are two Source Citation buttons on the Parents page:  

• Spouse Link (next to the Spouse Selector box) 
• Children Count (next to the Children Count box) 

Each of these buttons allows you to enter source citations, and will indicate the current surety level. See the 
chapter Citing your Sources for more information. 

Subrecord Controls 

The subrecord controls appear in the top right corner of the page. The Subrecord ID box displays the 
unique ID of the current family record.  

• To move to a different family record for the current individual, use the horizontal scrollbar. If the 
"thumb" occupies the entire width of the scrollbar, then there are no other family records defined.  

• To add a new family record, click the New Subrecord button . Or, on the Data menu, click Add 
Family. 

• To delete the current family record, click the Delete Subrecord button . Or, on the Data menu, 
click Delete Family Record. 

You can also add new family records with the Spouse Selector box, or with the keyboard shortcut CTRL+L. 

Splitter Bars 

There are three splitter bars on the Family page. There is vertical splitter bar to the left of the Media control. 
Drag it to the right when you need more space for the Family Events list. There is a horizontal splitter bar 
above the Notes boxes. Drag it up when you need more space to read the notes. There is a vertical splitter 
bar between the General Notes and Research Notes boxes. Drag it to adjust their relative sizes. 
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Individuals View: Events Page 
The Events page is perhaps the central focus of the Genbox program. It is here that the details of all events 
are entered and viewed. If the individual links form the skeleton of a genealogy, it is the event details that 
provide the meat. Genbox supports an unlimited number of event types, defined on the Event Types View. An 
event type definition provides a wealth of structure about an event, which is used to produce flowing narrative 
text on reports. 

On the Events page, one event record is displayed and edited at a time. 

While events often involve several individuals, there is not a separate "Events View" in Genbox. Instead, the 
event records are shown as a page on the Individuals View, subordinate to the current individual; however, 
the same event record will be viewable there for each of the primary individuals involved. This design allows 
the display and entry of the event data to be tailored to the context of the current individual. In particular, the 
event templates can be different, depending on the context of the current individual.    

 

Event Type Box 

The Event Type box displays the event type for the current record. Event types are defined on the Event 
Types View.  

When editing an existing record, the drop-down list contains one row for each event record defined for the 
current individual, in chronological order. Basic event types will also appear in italics on this list. To view a 
different event record for the current individual, select it from this list. 

Adding New Events 

To add a new event for the current individual, display the drop-down list and choose "...add", which is near the 
bottom of the list. The drop-down list will be replaced with the full list of defined event types. Make your 
selection, then start entering the date, place, and other data. 

You can add new basic events an easier way. On the drop-down list, you will see some event types shown in 
italics. These list entries are basic event types for which there are no event records for the current individual. 
You can create a new record for the indicated basic event type by selecting it. 
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Changing the Type of Event 

Sometimes you may wish to change the event type for an existing event record. To do this, select "...change 
type" from the bottom of the Event Type drop-down list. You will be presented with the full list of event types to 
choose from.  

Event Template Link Button 

Click the Event Template Link button to jump to the active event template on the Event Types View. You can 
make changes to the default templates there. 

Age Box 

When a date is specified for the event and the birth date of the individual is known, the age of the individual at 
the time of the event will be automatically computed and shown in the auto-generated text font style. You 
can also manually enter the age at the time of the event, in which case the value will be shown in the normal 
font style.  

Date Box 

The Date box displays the date of the event. Dates can be entered in a variety of ways. For help, see the 
section Entering Dates.  

Place Box 

The Place box displays the location at which the event took place. The place values displayed in this box 
begin at the city/town level. Local site information is displayed in the Local Site box. If a place name with a 
local site or leading modifier is typed into this box, the local site portion will automatically be moved to the 
Local Site box. 

Genbox has special processing for the entry of place names. For help, see the section Entering Places. 

Double-click the Place box to jump to the linked place record on the Places View.  

Local Site Box 

The Locate Site box displays the local site at which the event took place. The local site is defined to be 
located within the place displayed in the Place box. On the Events page, local sites are displayed and entered 
separately from other place levels to provide for greater flexibility:   

• Local sites can have their own source citations, separate from the place source citations. This is 
helpful when the sources used to determine the local site are different from those used to identify the 
higher place level. 

• Event type-specific labels can be defined for local sites, which can help prompt the user to enter the 
correct information. 

• Multiple levels of local sites can be entered, each separated with a comma. This allows you to 
structure your local site information with as many levels as you wish. A separate place record will be 
created for each local site level. 

In other parts of the program, such as on the Summary page when editing the Events list, local site and place 
information is entered and displayed in one field. When entering a local site into a place field, you can type a 
SEMI-COLON to separate the local site name(s) from the city/town name, to help Genbox recognize the 
proper levels for the information. 

Genbox has special processing for the entry of place names. For help, see the section Entering Places. 

Double-click the Local Site box to jump to the linked place record on the Places View.  

Secondary Data Box 
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The Secondary Data box provides a place to enter the names of other data records that are linked to this 
event. The type of data you can link is dependent on the "Secondary" setting of the associated event template 
record: 

Event Template Secondary Type: Box Label and Appearance: Usage: 
Omit (not shown) (box is not shown) 

Parents link 
"Parents". The box is divided into 
two boxes, one for entry/display of 
each parent. 

Entry of parents associated with an 
event, as for Birth and Baptism. 

Spouse link "Spouse", or Secondary label 

Link to spouse. The name of the 
spouse can be viewed or entered. 
Used primarily with marriage-related 
events. 

Other ind link "Other Ind", or Secondary label 
("Associate") 

Link to other individual. Like a 
Spouse link, but no family 
relationship is implied between the 
two individuals. The name of the 
other individual can be viewed or 
entered. 

Name variation "Name" 
Link to any identifier on the 
Identifiers page. The identifier text 
can be viewed and edited. 

Identifier Identifier Type ("SSN", "AFN", etc.)

Link to an identifier of a specific type 
on the Identifiers page. The label left 
of the box will identify the type of 
identifier expected. The identifier 
text can be viewed and edited. 

Contact "Address" 

Link to contact record on the 
Contacts page. Drop-down list. This 
provides a way to specify an 
address related to an event, which is 
useful for the "Residency" event. For 
transient events, address 
information should be treated as 
normal text, rather than creating a 
Contacts record to store it. 

Event Subtype Selector 

When the Event Type of the event record has multiple templates defined, a drop-down list box will appear to 
the left of the Template box to allow you to choose one of the subtypes. The subtype selector will also 
indicate when the default template has been modified by adding parentheses to the subtype name, as in 
"(stillborn)". 

Note: only the event subtypes of the event type that are defined for the current program language will be 
shown. 

Template Box 

The Template box displays the sentence template that will be used on narrative reports to format the data into 
a sentence. Each Event Type has at least one default template defined.  

The templates are shown in the currently selected output language.  

You can use the default template as is, or you can edit the template to create a custom template just for use 
with the current event record. Editing the default templates will provide additional variety to the sentence 
structures on the reports. For help on constructing event templates, see the chapter Event Templates. 

Template Preview Button 



       

Click the Template Preview button  next to the Template box to open the Template Preview Dialog 
where you can test your template and see how your event data will look formatted on a report. 

Detail Box 

The Detail box provides a place to enter extra factual information related to an event. The label to the left of 
the box can provide a hint as to what type of additional data is expected by the sentence template, as it will 
appear where the [T] sentence code is placed. Each event subtype can have its own hint to suggest what 
type of additional data is expected in the detail box. The hint might be something link "Achievement", "Rank", 
"Award", "Item", or "Status". 

If the event template record for the current event type has the attribute flag set, the text entered into the 
Detail box will also be shown on the Attributes page. The name of the attribute will appear to the left of the 
detail box. Attributes are used for data items such as caste name, physical description, national origin, 
occupation, religion, hobbies, etc. 

Witnesses List 

The Witnesses List provides a place to enter the names of individuals who were witnesses at the current 
event. A witness, as used in Genbox, is an individual who was at an event that had a non-principal role. An 
event can have up to three principal roles: primary individual, spouse, and child or "other" individual. For a 
birth event, the principal individuals are the father, mother, and child. For a marriage event, the principal 
individuals are the primary and spouse. For an association event, the principals are the primary and other 
individual. Principals of an event can also be added as witnesses to an event. This can be useful when they 
serve additional roles, or when you wish to record that a father was physically present at a child's birth. 

Witnesses are useful to track because they can provide hints to family relationships or to further research 
leads. Because they can be people of genealogical interest, the Witnesses List is implemented as links into 
the Individuals Table. This means witnesses have their own individual record which can be viewed in the 
Individuals View just like all other individuals. 

The Witnesses List has five columns: Name, Role, Template, Source Citation, and Exclude. 

• To add a witness to the current event, click where it says "Add witness" and type the name of the 
witness. Press TAB to enter the role.  

Witness Name 

Type the name of the witness into this box. If this is a new individual name, you will be asked if you would like 
to create a new individual record. 

Witness Role 

Each witness can have a role in the event. You can type any descriptive name you want here. Some Event 
Templates have predefined roles, which have their own witness sentence templates. If you type the name of a 
predefined role, the corresponding template will be the default template for use on reports. 

Witness Template 

The Witness Template column displays a magnifying glass as the label. Click a check box in this column to 
open the Witness Template Preview Dialog, where you can customize the default witness template for use 
with the current event and witness. A check mark indicates that a custom witness template has been defined. 

Witness Source Citation 

The Witness Source Citation column contains "open book" icons that indicate the surety level for the current 
witness information. Click an icon to open the Citations View to enter source citation information. For help, see 
the chapter Citing your Sources. 
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Exclude Witness 

The Exclude Witness check box can be used to omit the witness information from reports generated for 
principals of the event.  

General Notes and Research Notes 

Use the General Notes box to enter notes for the current event. Genealogical events are rich in details that 
can best be described in sentences. 

Use the Research Notes box to record your research efforts regarding the current event. 

Research Target Button 

You can also make the event a target for further research by clicking on the Research Target button. This will 
open the Research Targets View. When the current event has been linked to a Research Targets record, the 
Research Target button will be shown in bold. 

Source Citation Buttons 

There are six Source Citations  buttons on this view. You can enter source citations that apply to the 
entire event by clicking on the source citation button next to the Event Type box. You can also enter separate 
source citations for each of the five main data boxes (Age, Date, Place, Local Site, Detail) by clicking on the 
source citation buttons next to each of these text boxes.  

Note Number Placement on Reports 

When an event-level citation has been entered, or when all data items have a separate citation, narrative 
reports that include the event will merge all of the citations for the event into a single footnote/endnote, with 
the note number appearing at the end of the sentence or clause. When there is no event-level citation and 
only some of the data items have a citation entered, a separate note number will appear on each of the data 
items with citations. For example: if you have documentation for the place of an event but not the date, reports 
will show the footnote number immediately after the place instead of the end of the sentence, so that readers 
will know which parts of the statement have not been documented. 

For help on entering source documentation, see the chapter Citing your Sources. 

Alt Check Box 

The Alt check box marks an event record as an alternate. When clicked, you will be prompted to indicate 
which other event the current event record is an alternate to. Alternate events are a way to enter conflicting 
data for the same event. When you have two sources that disagree about a date, a place, a spouse, or some 
other detail of an event, you can create an alternate event record to store the second set of data, and attach 
its own source citations. An event record can have several alternates. 

By marking an event record as an alternate and indicating which event it is an alternate to, Genbox will be 
able to merge the data when producing a report. The surety levels, source citations, commonalities and 
differences will all be employed to create report text that describes the conflict. If multiple events of the same 
type are entered without marking them as alternates, Genbox will treat them as several different events, all 
processed separately. 

When you begin editing a new alternate event record, the data values from the base event record will be 
visible in dimmed text. You can enter your conflicting data normally; it will be shown in normal text. This 
"composite view" allows you see where the alternate record differs from the base record, and where it doesn't. 

Exclude Check Box 
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Click the Exclude check box to prevent the data in the current event record from being included on charts and 
reports. This is useful when you feel the data is inaccurate or incomplete, or you are creating a special report 
and excluding individual events is the easiest way to customize the included data. 

 Directional Template Button 

When the current event type has been defined on the Event Types View as having a secondary type of 
Other Individual Link, and is marked Directional, then there will be a pair of sentence templates available: 
the Forward template and the Reverse template. The Directional Template Button will appear near the top 
of the page, between the Event Template Link Button and the Event Source Citation Button. It will display 
the label "F" when the forward template is selected, and "R" when the reverse template is selected. Clicking 
the button will reverse the direction. Whichever direction is selected for the current (focus) individual, the 
linked other individual will have the template for the opposite direction. There is no special significance as to 
which individual gets the "forward" direction. The designation is only used in the selection of the appropriate 
event template. 

To illustrate how this button is useful, consider the Association (ASSO) event type. This is a directional 
"Other Individual Link" event type. It can be used for any non-genealogical relationships between two 
individuals. In addition to the two default templates, there are two subtypes defined: "Client" and 
"Administrator". Each subtype can have its own pair of forward and reverse templates. In this case, the special 
template code [ET] is used to reference the subtype label, allowing the default templates to simply be reused. 

• Forward: [P] was <[ET]|an associate> of [O] [T] [D+L]  
• Reverse: [O] was [PP] <[1ET]|associate> [D+L]  

So if Reginald Edward Smythe has a forward association link to George van Stone with a subtype of "client", 
then George van Stone will have the reverse client template, resulting in the pair of sentences: 

    Reginald was a client of George van Stone. (appears in Reginald's narrative report) 

    Reginald Edward Smythe was George's client. (appears in George's narrative report) 

Now, if you look at the sentences and suddenly think "Hey--it's really supposed to be George is a client of 
Reginald's!", it's easy to reverse the relationship. Simply click the Directional Template Button. Then the 
templates would read: 

     George van Stone was Reginald's client. (appears in Reginald's narrative report) 

     George was a client of Reginald Edward Smythe. (appears in George's narrative report) 

Directional templates can be used for any type of event between two individuals. Remember, the [P] code is 
usually for the individual that has the focus (the subject of the report), and the [O] code is for the other 
individual. For the reverse template, which is used when the previous "other individual" has the focus, the 
individual references will be reversed. If you use active voice in the forward template and passive voice for the 
reverse template, [P] and [O] will appear in the same order for both. If you want active voice for both 
directions, the codes will need to be reversed: 

Forward: (Active) Reverse: (Passive) Reverse (Active) 
[P] hired [O] [D+L] [P] was hired by [O] [D+L] [O] hired [P] [D+L] 

[P] murdered [O] [D+L] [P] was murdered by [O]
[D+L] [O] murdered [P] [D+L] 

[P] visited [O] [D+L] [P] was visited by [O]
[D+L] [O] visited [P] [D+L] 

By defining a pair of templates for these types of events, you only need to enter the event information once: 
date, place, details, notes, source citations, and the individuals involved. Then the event sentence will read 
correctly regardless of which individual is selected as the focus of a narrative report.  

Media Control 
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The Media control is the open area to the right of the middle boxes. It initially displays the first picture that is 
linked to the event, if any. Any number of multimedia objects can be linked to each event. Multimedia can also 
be linked to families on the Family page and to individuals on the Summary page. Multimedia linked on the 
Events page should be more closely related to the current event than to a family unit or to an individual. See 
the chapter Adding Multimedia for help on the Media control.   

Subrecord Controls 

The subrecord controls appear in the top right corner of the page. The Subrecord ID box displays the 
unique ID of the current event record.  

• To move to a different event record for the current individual, use the horizontal scrollbar. If the 
"thumb" occupies the entire width of the scrollbar, then there are no other event records defined.  

• To add a new event record, click the New Subrecord button . Or, on the Data menu, click Add 
Event. 

• To delete the current event record, click the Delete Subrecord button . Or, on the Data menu, 
click Delete Event Record. 

You can also add new event records with the Event Type box, or with the keyboard shortcut CTRL+L. 

Splitter Bars 

There are three splitter bars that allow you to adjust the sizes of the areas on this page. There is vertical 
splitter to the left of the Media control. You can drag this splitter to reduce the area for the Media control if you 
need more space to display local site, detail, template, and witnesses information. There is a horizontal splitter 
between the Witnesses list and the Notes boxes. You can drag this splitter to increase the display area for 
either witnesses or notes. There is a vertical splitter bar between the General Notes and Research Notes 
boxes. Drag it to adjust their relative sizes. 
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Individuals View: Contact Page 
The Contact page contains information on addresses for the current individual. 

 

Shared Address Check Box 

Contact records in Genbox can be shared by multiple individuals. This feature is useful when several 
individuals maintained in the database reside at the same address. Rather than recording their address 
information separately, a shared address can be used instead. Any changes to a shared address are 
immediately reflected to all individuals in the group. This also saves on postage and paper when sending out 
mailings, as only one letter will be sent for the group. 

1. To create a shared address, first enter the address normally. 
2. Click the Shared Address check box. 
3. Type a shared name into the Shared Name box. 

Once a shared address has been defined, it can be selected for other individuals when viewing their Contact 
page. 

1. To link to a shared address, start with a new, blank contact record. 
2. Click the Shared Address check box.  
3. On the Shared Contact Pick Dialog, click on the desired group name. Click Select. 

When viewing a shared address, the address boxes will be shown in dimmed text. This is to indicate that this 
data is being shared. The Mailing Name box, however, will be shown normally. The mailing name is not 
shared. It continues to serve as the mailing name for the address when the shared address feature is 
disabled.  

Shared Name Box 

For mailings to a shared address, a special mailing name is needed. The Shared Name box provides a place 
for this name. It can be something like "Mr. and Mrs. Reginald Smythe", or "The John Mulrooney Family". The 
shared name is also used to identify and select shared addresses; for this reason, shared names must be 
unique among all shared contact groups. 

Copyright © 2005  Thoughtful Creations. All rights reserved. 104



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 105

Mailing Name Box 

The Mailing Name is the name for the current individual that will be used when formatting addresses for 
individuals. Names used in mailings are often in a specialized format, with formal titles are other additions. 
This box provides a place to specify the text to use for the name. If left blank, the preferred name will be used 
on reports. 

Local Site Box 

If this address includes a local site, such as a building, enter it in the Local Site box. 

Address Boxes 

Enter the street address information into the Address 1 and Address 2 boxes. Address 2 can be left blank. 

Place Box 

Enter the place name in the Place box. See the section on Entering Places for information. 

Postal Code Box 

Enter the postal code (ZIP for U.S. addresses) into the Postal Code box. 

Phone and Fax Boxes 

Enter the principle telephone number in the Phone box, and the facsimile machine number, if any, in the Fax 
box. 

E-Mail Box 

Enter the E-mail address into the E-Mail box. (E-mail addresses have the "@" character in them.) 

Web Link Box 

Enter the home page URL associated with this contact, if any, in the Web Link box. This is a text string that 
usually begins with "http://www". 

Note Box 

The Note box provides a place to enter any other type of contact information. 

Preferred Check Box 

One address for each individual can be marked Preferred. The preferred address will be used on reports 
when a single address is needed. 

Historical Check Box 

If an address is being maintained for historical purposes, click the Historical check box. This serves to 
distinguish addresses that are genealogical data from addresses of current contacts. 

Address Type Box 

The Address Type box provides a drop-down list where you can identify the type of address: 



       

 

Subrecord Controls 

The subrecord controls appear in the top right corner of the page. The Subrecord ID box displays the 
unique ID of the current contact record.  

• To move to a different contact record for the current individual, use the horizontal scrollbar. If the 
"thumb" occupies the entire width of the scrollbar, then there are no other contact records defined.  

• To add a new contact record, click the New Subrecord button . Or, on the Data menu, click Add 
Contact. 

• To delete the current contact record, click the Delete Subrecord button . Or, on the Data menu, 
click Delete Contact Record. 

You can also add new contact records with the keyboard shortcut CTRL+L. 
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Individuals View: Notes Page 
The Notes page provides a place to enter general notes and research notes about the individual. 

 

General Notes 

Use the General Notes box to enter any comments about the individual that are not specific to a particular 
identifier, link, spouse, or event. 

Research Notes 

Use the Research Notes box to record your research efforts regarding the current individual.  

Splitter Bar 

There is a vertical splitter bar between the General Notes and Research Notes boxes. Drag it to adjust their 
relative sizes.  
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Places View 
Places in Genbox are treated like other data. Each place is represented by its own record, viewable in the 
Places View. Each place is defined with a level from a six-level hierarchy. A place can have multiple names 
defined, its own associated media, notes, and citations.  

            General Page 
            Names Page 
            Contact Page 
            Notes Page 
            Links Page



       

Places View: General Page 
The Places General page provides data entry for the place level, standard name, multimedia, and a number 
of other data items. 

 

Place Level 

The Place level box displays the place level for the current place record. The drop-down list displays the 6 
level names:  

 

For an explanation of place levels, see the section Place Level Hierarchy. 

You can change the place level for a place by choosing a new selection from the drop-down list. Some of the 
choices may be disabled: when there are links to a place from lower place records, you cannot change the 
place level to be the same or lower than one of places that are linked to it. Likewise, you cannot change it to 
be equal or higher than the place level of its own parent. 

Note    The choice of place level affects which other boxes are available on this page.  

Local Site Type 

For local site place records, the Local Site Type box will be available to set the type of local site. The drop-
down list displays the following choices:  
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Setting a value for local site type will be helpful when performing data searches. When new local sites are 
typed into place data boxes, Genbox will assign an initial value for local site type.  

Change Date 

The Change date box displays the date and time this place record was last edited. It is read-only.  

Standard Name 

The Standard name box displays the name for the current place record. Additional names for the current 
place can be entered on the Places Names Page.  

The standard name represents a single place level. For example: for a city, you would enter just a city name 
in this edit box, not the county, state, or nation. These "higher levels" should be entered in the Higher Place 
box. Local sites are special: they can encompass several "conceptual" levels, separated by commas, such as 
"East balcony, Fourth floor, City Government Building". Place levels higher than local site should not contain 
commas.  

Higher Place 

The Higher place box displays the names for the linked higher place records. A double-click will jump to the 
next higher place record.  

Postal Name 

The Postal name box is available to enter a street address or other postal designation for the current place. 
The postal name is stored as a place name variant, and can also be viewed/entered on the Places Names 
Page. 

Note If the standard name for the place is marked as "postal", then the Postal Name box will show the same 
name and it will be disabled. If you want to enter a separate postal name, you will need to go to the Places 
Names Page and clear the "Postal" flag on the standard name first.  

Date Range 

The Date range box can be used to enter the start and end dates for the associated place.  

Historical check box 

For nation/area place records, the Historical check box is used to mark nations/countries that no longer exist.  

Default Nation check box 
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For nation/area place records, check the Default nation check box to omit the nation/country name from 
being shown when place information is displayed.   

Well-Known check box 

For city/town place records, check the Well-known check box to indicate cities that don't need to be shown 
with higher place name levels, such as "Chicago" and "London". This affects output on charts and reports 
only.  

Latitude and Longitude 

The Latitude and Longitude boxes allow you to enter the exact location of a place. Future versions of 
Genbox may provide mapping, search, and distance calculation capabilities using this information. The boxes 
are divided into four data entry fields, which you move between by typing the SPACE BAR or RIGHT/LEFT 
arrow keys. The punctuation is not typed.  

• To enter a latitude value, click on the left side of the box and type the degrees 0-90. Press the 
SPACE BAR. 

• Type the minutes, 0-59. Press the SPACE BAR. 
• Type the seconds, 0-59. Press the SPACE BAR. 
• Indicate north latitude by typing 'N' or south latitude by typing 'S'. 

Values can be entered by typing the number, or by using the UP/DOWN arrow keys to increment/decrement 
the value. 

• To enter a longitude value, click on the left side of the box and type the degrees 0-180. Press the 
SPACE BAR. 

• Type the minutes, 0-59. Press the SPACE BAR. 
• Type the seconds, 0-59. Press the SPACE BAR. 
• Indicate west longitude by typing 'W' or east latitude by typing 'E'. 

Media Control 

The Media control is the open area to the right of the middle boxes. It initially displays the first picture that is 
linked to the place, if any. Any number of multimedia objects can be linked to each place. Multimedia linked to 
places should be more closely related to the current place than to an individual, family unit or to a particular 
event. See the chapter Adding Multimedia for help on the Media control.   

Research Target Button 

You can make the current place a target for further research by clicking on the Research Target button. This 
will open the Research Targets View. When the current place has been linked to a Research Targets record, 
the Research Target button will be shown in bold. 



       

Places View: Names Page 
Genbox supports multiple names for each place. The Places Names page shows a list of the names defined 
for a place. The standard name is listed first. 

When a data record links to a place, it is actually linking to a particular place name, which in turn is linked to 
the place record. This provides several advantages: 

• A data record can reference a place name that matches the exact wording and spelling as found in its 
source documentation, while also indirectly referencing the standard name for the same place. 

• A mapping of the uncommon name to the standard name can be produced. 
• A cross-reference entry in the index can be added. 
• Multimedia linked to the place record can be used to illustrate any of the place name variants. 

 

Place Names List 

The Places Names list contains one row for each name defined for a place. The standard name is listed first. 
When a row is selected, related data is shown in the boxes below. There are four columns: Name, Date 
Range, Source Citation, and Record ID. 

Name 

Enter the place names into the Name column. Enter only the name piece for the current level.  

• To add a new name to the current place, click where it says "Add Name". Type the new name.  
• Commas are not allowed in place names at the city level and higher. 
• Local site names can contain commas. This allows you to have several divisions in your local site 

name, such as "Room 212, Fourth floor, St. Luke Hospital". 

Date Range  

Enter the date range over which the name is valid. The beginning of the date range would be when the name 
was first used. Names that are still valid should have no ending date. 
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Source Citation 

Click the Source Citation button to enter a source citation for the current place name. 

Record ID 

The Record ID value for the current place name is shown in this column. This data is read-only. 

Higher Levels 

Each name variation can have its own Higher Level place. This feature allows a place to be part of different 
and possibly overlapping higher places. 

Replace with Standard On Input check box 

When Replace with standard on input is checked, this name variant will automatically be replaced by the 
standard name when it is typed into a place box on the Events page and other pages where places are 
entered. For example, suppose we have a place record for the state "Missouri", and it has a name variant 
"MO" that has Replace with standard on input checked. On the Events page, you click on the Place box, 
type "St. Louis, MO", and press ENTER. The text is automatically changed to "St. Louis, Missouri". 

There are some advantages to having certain name variants automatically replaced with the standard names. 

• It adds consistency. It prevents having a database intermixing "MA", "Mass.", and "Massachusetts". 
• You can define abbreviations for long names to save on keystrokes when typing data. 
• You can define misspellings as name variants to have the data automatically corrected on entry. 

Short Name check box 

The Short name check box is used to mark names that are acceptable as shortened forms of the standard 
name. The Use short names report option makes use of this information.  

Postal check box  

The Postal check box is used to mark names that are postal designations for the place, such as a street 
address for a local site, or a postal abbreviation for a state or nation.  

"The" check box 

Some place names, such as the United States and the Netherlands, are commonly shown with the definite 
article "The" when the name is used in isolation. When used with lower places, the article is omitted. The 
"The" check box indicates this usage. 

Record ID 

The Record ID box displays the Place Name ID of the current record. It is read-only. 



       

Variant Output and Wording 

When a data record links to a name variant, there are some choices as to how to format the data for output. 
The Variant Output box has a drop-down list with the following choices: 

 

When the third or fourth choice is selected, the Bridge Wording box is enabled. It has a drop-down list of 
bridge wording choices. You can also type in your own bridge wording. 

 

Using bridge wording, you can produce output from event records with place name variants such as: 

He was born in Leningrad (St. Petersburg). 
She was born in Peking, China (today known as Beijing). 
She died in Broad Ripple, Clinton County (now Boone County1), Kentucky. 

------------- 

1Clinton County was merged with Boone County in 1858. 

General Notes and Research Notes 

Use the General Notes box to enter notes regarding the selected place name variant. You could describe the 
circumstances under which the name was given, for example.  

Use the Research Notes box to record your research efforts regarding the selected name variant.  

Research Target Button 

You can make a place name variant a target for further research by clicking on the Research Target button. 
This will open the Research Targets View. When the current place name variant has been linked to a 
Research Targets record, the Research Target button will be shown in bold. 

Splitter Bar 

There is a vertical splitter bar between the General Notes and Research Notes boxes. Drag it to adjust their 
relative sizes.  
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Places View: Contact Page 
The Contact page contains information on a contact person for the current place. It can be used when the 
place is a local site, such as an archive, library, court house, or government office. It can also be used for 
higher levels to store an address of where to write for more information regarding the current place. 

 

Contact Name 

The Contact Name box displays the name that will be used as the first line when formatting addresses. 

Local Site 

If the address includes a local site, such as a building, enter it in the Local Site box. If the current place 
record is a local site, this field will be initialized with the name of the local site. 

Address Boxes 

Enter the street address information into the Address 1 and Address 2 boxes. Address 2 can be left blank. 

Place Box 

Enter the place name in the Place box. The default value will be the standard name of the current place. 

Postal Code Box 

Enter the postal code (ZIP for U.S. addresses) into the Postal Code box. 

Phone and Fax Boxes 
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Enter the principle telephone number in the Phone box, and the facsimile machine number, if any, in the Fax 
box. 

E-Mail Box 

Enter the E-mail address into the E-Mail box. (E-mail addresses have the "@" character in them.) 

Web Link Box 

Enter the home page URL associated with this contact, if any, in the Web Link box. This is a text string that 
usually begins with "http://www". 

Note Box 

The Note box provides a place to enter any other type of contact information. 

Flags List 

The Flags list box contains one check box for each defined place flag. If checked, a place "has" the attribute 
indicated by the name of the check box. The place flags are defined on the Data Setup View. All defined place 
flags will appear for all places. This makes it easy to see what flag attributes a place does and does not have, 
and changes can be made with a single click. 



       

Places View: Notes Page 
The Places Notes page provides a place to enter general notes and research notes about the place. 

 

General Notes 

Use the General Notes box to enter any comments about the place that are not specific to a particular name 
variant. 

Research Notes 

Use the Research Notes box to record your research efforts about the current place.   

Splitter Bar 

There is a vertical splitter bar between the General Notes and Research Notes boxes. Drag it to adjust their 
relative sizes.  
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Places View: Links Page 
The Places Links page contains a list box that displays all links to the current place. This list is useful to see 
where a place name is being used. A double-click on any row will cause a jump to the view and page where 
the place name is being used. 

 

Place Name Selector 

The Place Name Selector box allows you to filter the list to display only links to a particular name variant. 
Choose a name from the drop-down list, or choose "All Names" for an unfiltered view. You can also choose 
"Variant Names" to see all links to names other than the standard name.  

Link Type Selector 

The Link Type Selector box allows you to filter the list to display only links to the current place from a 
particular type of data record. Choices on the drop-down list are: 

 

When "Places" is selected, only the standard names of lower places are shown, regardless of the number of 
links. When "Place Names" is selected, all linked names are shown. This means a given lower place can 
appear more than once in the list, such as both "Ohio" and "OH" shown as sub-places to United States. 

Place Link List 
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The Place Link list box contains one row for each data record link to the current place. This list is read-only. It 
has five columns: ID, Type, Subtype, Date, and Name. Double-clicking on a row will cause a jump to the data 
record that is represented by that row. 

ID Column 

The ID column displays the ID value of the linked data record. 

Type Column 

The Type column displays the type of data record that is linked: Event, Place, or Source. 

Subtype Column 

The Subtype column displays data related to the linked record: 

• For Event records, it displays the Event Type. 
• For Place records, it displays the Place Level. 
• For Source records, it displays either "Repository" or "Publisher". 

Date Column 

The Date column displays data related to the linked record: 

• For Event records, it displays the date of the event. 
• For Place records, it displays the date range for the place name. 
• For Source records, it displays the publication date. 

Name Column 

The Name column displays data related to the linked record: 

• For Event records, it displays the name of the primary individual. 
• For Place records, it displays the place name. 
• For Source records, it displays the source name. 
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Citations View 
A source citation is the link from a data item to a source record. The Citations table stores these links, along 
with associated data, including support levels, credibility, and rationale. The Citations View presents the 
source citations for each data item. Each data item, or assertion, can have multiple source citations. The 
Citations View presents all the citations to single assertion as a group.   

Because citations are links between data items and source records, the initial citation for a data item is 
created by clicking the source citation button next to the data item on its own view. Citations to additional 
sources for a data item can be added on the Cited Sources page. 

• To create the initial citation record for a data item, go to the view that displays the data item.  
• Click on the source citation button next to the data item.  
• From the Source Pick Dialog, select the source you want to link to. 
• The Citations View will then open and display your new citation record. 

            Assertion Page 
            Cited Sources Page 
            Excerpts Page 
            Names Page 
            Formatting Page



       

Citations View: Assertion Page 
The Assertion page presents the data item and a statement of its surety, which together can be thought of as 
an assertion. It shows a list box containing one row for each source that is cited. By considering the support 
levels, credibility levels, and rationales shown in the list of cited sources, you can make a determination for the 
overall surety level for the assertion, and then click one of the surety level buttons on this page. The selected 
surety level will also be shown on the face of the citation button on the data view page that contains the data 
item. 

 

Type 

The Type box displays the type of data item. This text is read-only. Possible values include:  

• Individual 
• Individual Name 
• Parents Link 
• Father Link 
• Mother Link 
• Multiple Birth Grouping 
• Family Link 
• Family - Number of Children 
• Event 
• Event - Age 
• Event - Date 
• Event - Place 
• Event - Local Site 
• Event - Detail 
• Event - Individual 
• Event - Contact 
• Event - Name Variation 
• Event - Witness Name 
• Event - Witness Role 
• Media - Caption 

Individual Name Box 

For data items involving individuals, the Individual name box displays the name of the individual. This text is 
read-only. 
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Context Box 

The Context box provided the background context for the assertion. For event-related assertions, for 
example, the background context is the event. This text is read-only. 

Item Box 

The Item box displays the data item itself. This text is read-only. 

Sources List 

The Sources list box displays one row for each source citation for the assertion. It contains seven columns: 
ID, Source ID, Cited Source, Support Level, Credibility, Rationale, and Exclude Citation. The row 
corresponding to the current citation record will be highlighted. 

• To add another citation for the current assertion, click where it says "Add Source" and then type 
the name of the additional source. Click on the Cited Sources tab to enter the citation details.  

The sources are shown in the order in which they will appear in a merged footnote. To order the sources, drag 
the lines into the desired order. Usually, the stronger evidence should be shown first.  

For a citation embedded in a note, all citations for the same note will be listed; those that are for a different 
text range than the current citation will be shown in the second-layer text style. Citations that cover the same 
text range as the current citation will be shown in the normal text style. 

ID 

The ID column contains the ID of the Source Citation record.  

Source ID 

The Source ID column contains the ID of the linked Source record. 

Cited Source 

The Cited Source column contains the source name of the cited source. Double-clicking the name will cause 
a jump to the appearance of that source on the Cited Sources page. You can add additional sources for the 
current assertion by typing the name of the new source into the blank line at the bottom of the list, or by 
double-clicking on the blank to open the Source Pick Dialog. 

Support Level 

The Support level column displays the support level icon for each source citation. Values can be changed by 
pressing the space bar, or by clicking on the current value and selecting a new value from the drop-down list.  

See the description on the Cited Sources page for help. 

Credibility 

The Credibility column displays the credibility level for each source citation. Values can be changed by 
pressing the space bar, or by clicking on the current value and selecting a new value from the drop-down list.   

See the description on the Cited Sources page for help. 

Rationale 

The Rationale column displays the rationale text for each source citation. You can edit this text here or on the 
Cited Sources page. See the description on the Cited Sources page for help. 



       

Exclude Citation 

The Exclude Citation column shows a check box for each source citation. An "X" appears in the check box if 
the citation has been marked for exclusion from reports. Click the check box to mark or unmark a source 
citation for exclusion on reports. This setting can also be viewed and changed on the Cited Sources Page. 

Recent check box 

The Recent check box will be checked automatically for newly created source citations. You can clear and 
check this check box as you wish. 

Researcher Box 

The Researcher box displays the name of the researcher who last changed the surety level for the assertion. 

Surety Level Selector 

The Surety Level Selector allows you to select the surety level you wish to assign to the current assertion. 
For help on surety levels, see the section Assertion Surety Levels in the chapter Citing your Sources.  

The surety levels are represented by icons, as shown below: 

        Level 4: Convincing evidence 
        Level 3: Assemblage of evidence 
        Level 2: Probable conclusion 
        Level 1: Marginal evidence 
        Level 0: Undecided 

Click one of the buttons to set the surety level. 
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Citations View: Cited Sources Page 
The Cited Sources page contains the supporting data for the link, such as the support level and credibility 
level. 

 

Source Name 

The Source Name box displays the name of the linked source record. You can type the name of the source 
here. To display the record for the source, double-click this box to jump to the Sources View. 

Where in Source 

Enter the page number reference, or other locating information, into the Where in source box. This 
information will be used as the [CD] data ("Citation Detail") in the formatting template. 

Lead Text 

The Lead text can be any comments that you want to appear in the citation before the formatted part. 

Exclude Lead Text check box 

When checked, the Lead Text will not be included in output reports. This is useful when the lead text is 
lengthy and the report you are generating doesn't require it, or when you want to use the Lead Text box to 
record your personal thoughts that are not intended for output. 

Researcher 

The Researcher box displays the name of the researcher who last modified this source citation record. This 
text is read-only. 

Modified 

The Modified box displays the date and time this source citation record was last modified. This text is read-
only. 

Annotation 
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The Annotation can be any comments that you want to appear in the citation after the formatted part. 

Exclude Annotation check box 

When checked, the Annotation will not be included in output reports. This is useful when the annotation is 
lengthy and the report you are generating doesn't require it, or when you want to use the Annotation box to 
record your personal thoughts that are not intended for output. 

Exclude Citation check box 

When checked, the entire citation will not be included in output reports. This is useful when the citation is 
incomplete, for internal use only, or considered questionable. This setting can also be viewed and edited in 
the "X" column on the Assertion Page. 

Support Level Selector 

The Support level is your determination of how well the source citation supports the assertion that the data 
item is correct. 

Support levels for the data item are represented by icons, as shown below: 

 

For an explanation of the levels, see the section Citation Support Levels in the chapter Citing your Sources. 

Credibility Level Selector 

The Credibility level is your decision of how credible this source is regarding the data item being asserted. 

The choices from the drop-down list are: 

 

Rationale 

The Rationale text box appears beneath the Credibility combo box. It can be use to store text that briefly 
explains why you believe the cited source is relevant to the current assertion. It is for your own personal 
research purposes, and does not normally appear on output reports. You can store here the reasons why you 
assigned a low/high support level or low/high credibility, or the facts extracted from the source that you think 
make your case, or personal reminders of work yet to be performed. 

The rationale text appears as a column in the cited sources list on the Assertion page, so that it can be used 
when assessing the overall surety level for the assertion. 

Citation Group Controls 

The Citation group controls appear in the top right corner of the page. On the Citations View, citations are 
grouped by data item. On this page, you can use the Citation group controls to move between the citations 
in the current group. The Citation ID box displays the unique ID of the current citation record.  
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• To move to a different citation record for the current data item, use the horizontal scrollbar. If the 
"thumb" occupies the entire width of the scrollbar, then there are no citation records defined. 

• To add an additional source citation for the current data item, click the New Record in Group button 

. Or, on the Data menu, click Add Another Source. Or, use the keyboard shortcut CTRL+L. 

• To delete the current citation record, go to the Data menu and click Delete Citation. 
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Citations View: Excerpts Page 
The Excerpts page allows you to mark the exact text from the linked sources on which you are basing your 
assertion. This marked excerpt can be included as part of the citation on reports. 

The source text itself is not typed here. It is entered on the Evidence page of the Sources View. Excerpts are 
stored as a reference into the source text. This has a number of advantages: 

• The source text is edited and maintained in one place. 
• Duplication of text entry and storage is avoided. 
• Corrections to the source text are automatically reflected in all the excerpt references. 

 

Source Selector 

Use the Source selector box to select the source. The drop-down list will show the names of the source 
records that are linked to the current data item. This box is read-only. You can also user the left and right 
arrow buttons to the right of the Source selector to step between the source records. If there is only one 
source record linked to the current data item, these buttons will be disabled. 

Double-click on the selected source name to jump to its record on the Sources View. 

Source Text 

The Source text box will display the source text that was entered on the Evidence page of the Sources View 
for the selected source. If the text you want to mark as an excerpt is not shown, double-click on the Source 
selector box to go to the Sources View, where you can enter the text on the Evidence page. 

The text currently marked as the excerpt will be shown with the Marked record font style, which can be set on 
the Preferences View. 

Mark Button 

• To mark a range a text, position the insertion point at the start of the range. 
• Press and hold the SHIFT key. 
• Position the insertion point at the end of the range, using the arrow keys or the mouse. 
• Press the Mark button. 
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Marked text will appear with the Marked records font style, which can be set on the Preferences View. You 
can mark just a few words, several disjoint ranges, or the entire block of text. 

Clear Button 

To unmark a range of text, select it as described for the Mark button but this time press the Clear button. The 
highlighting of the text will be removed. 

Exclude check box 

Click the Exclude check box if you do not want the excerpt text to appear as part of the source citation on 
reports. 



       

Citations View: Names Page 
When entering source citations, part of the evidence is recording the names of the individuals exactly as they 
appear in the source. This information can be entered on the Names page. 

It is important to record the names exactly as they appear, because this information could be critical to 
resolving a research problem later. Linking directly to an individual record without recording the name 
variation will hide the assumptions you have made. This page makes the mapping between source name text 
and individuals explicit. 

 

Source Selector 

Use the Source selector box to select the source. The drop-down list will show the names of the source 
records that are linked to the current data item. This box is read-only. You can also user the left and right 
arrow buttons to the right of the Source selector to step between the source records. If there is only one 
source record linked to the current data item, these buttons will be disabled. 

Double-click on the selected source name to jump to its record on the Sources View. 

Individual Boxes 

Use the Individual boxes (1, 2, 3) to link to the individual records that you believe correspond to the names 
mentioned in the source. If your data item involves only one or two individuals, leave the other individual 
boxes on this page blank. 

Name in Source Boxes 

Use the Name in Source boxes to enter or select the name variations of the individuals that match the names 
in the source. If the individual you are mapping to does not have a name variation that matches the source, 
you can type a new name variation for the individual. It will be given an identifier type of Source name. 
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Citation View: Formatting Page 
The Formatting page displays how the current citation will be formatted on reports. The data can appear in 
up to three contexts: in the initial (primary) citation, in secondary citations, and in the bibliography. 

Note: The formatting information is actually stored with the linked Source record, and is normally viewed and 
modified on the Sources View Formatting Page. The formatting is also presented here on the Citations View 
as an added convenience. Any changes made to the templates will affect all citations to the same 
source. 

The default formatting is controlled by the linked Source Template record, which is defined on the Source 
Types View. The selection of Source Template Record is done by the Source Type box on the Sources View 
General Page. You can also override the default formatting by simply editing the text on this page. 

 

Primary Citation 

The Primary citation box displays how the current citation would be formatted as the initial reference to the 
source. This is usually the most complete citation format.   

Unlike on the Sources View Formatting Page, all template codes are translated, including the citation-specific 
codes.  

Secondary Citation 

The Secondary citation box displays how the current citation would be formatted as a secondary reference 
to the source. A source that is referenced only once on a report will never use this formatting. In general, the 
secondary citation formats are briefer than the initial citation formats. Some elements are left out, and some 
elements are shortened. 

Bibliography 

The Bibliography box displays how the current source will be formatted for inclusion on the bibliography 
section of a report. In this context, the source is presented in a general way, with fewer of the specific details. 
Often, there are no citation-specific data values shown in this format. 

User Edit 
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There are three User edit controls, one next to each template box. These are automatically set when you edit 
the corresponding template manually. When a template is marked "user edit", Genbox will not update the 
formatting, even when the data of the source record is updated. 

Default Buttons 

If you have manually edited the formatted text and want to return to the default formatting, press the 
corresponding Default button. 
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Sources View 
The Sources View presents information on source records. Each source document in your database will have 
a record in the Sources Table. Source records are part of the source citation system, which is explained in 
the chapter Citing your Sources. 

Source data is organized onto multiple pages. The General page displays most of the information for locating 
a source record. The Settings page contains additional data items. The Evidence page can store a copy of 
actual text from the source. The Content page can be used to catalog the contents of a source which holds 
multiple data items. The Formatting page can show you how the source information will be formatted on 
reports.   

To select a source record, type either the ID or name of the source in the key boxes in the header section of 
the view. Or, use the arrow buttons on the main toolbar to step through the records.  

            General Page 
            Settings Page 
            Evidence Page 
            Content Page 
            Notes Page 
            Formatting Page 
            Links Page

Source records should contain all of the information another researcher would need to both evaluate the 
validity of the data and also locate the original records himself should he care to do so. Information that 
describes your particular copy of a source can be entered into a Multimedia record on the Media View. 



       

Sources View: General Page 
The Sources General page displays most of the information for locating source records. It also provides for 
display of multimedia linked to a source record. 

Note    The labels for the text boxes on this page can change. The labels are controlled by the Source 
Template record, which is selected with the Source Type drop-down list box.  

 

Source Type Box 

The Source Type box presents a drop-down list of the available source types. Each new Genbox database is 
initialized  with over 100 source types for common source record types, such as birth, marriage, and death 
certificates, register entries, books, journals, censuses, National Archive items,  letters, and wills. The source 
templates can be modified and new source templates can be created on the Source Types View. 

Genbox will assign an initial source type to each new source record. If its selection is incorrect, choose the 
correct source type from the drop-down list as early as possible. The choice of source type affects the data 
entry on this page. Source types can be defined with default values for some of the data fields. 

The Source Type box displays an icon to the left of the name. This icon indicates the source level, which is 
also set by the choice of source type: 

        Document Level 
        Document-in-Source Level 
        Source Level 

The icons are intended to suggest, respectively: a loose paper sheet; a single page within a book; a book. 
This reflects the underlying data structure: A Document Level source record does not link to a higher source. 
Instead, a repository link can be specified. The Document-in-Source Level source record does link to a higher 
source record. The Source Level source record also does not link to a higher source record, but does have a 
link to a repository. 

Source Template Link Button 
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Click the Source Template Link button to view the active source template in the Source Types View. You can 
make changes to the default templates there, which will affect all linked source records. 

Title Box 

The Title box displays the descriptive name of the source. This is the most important data entry item. 

Name Box 

The Name box displays the name for the source record, used only inside Genbox. This is the name that will 
appear when the source record is referenced, so the name should be distinct from among all your source 
records. 

Genbox can automatically generate the source names, based off of the source type, source title, and other 
fields. The source type record has a special template for this purpose, on the Notes page of the Source Types 
View. For this reason, it is a good practice to enter data into the other boxes on this page first, to allow this 
feature to work. You may notice the Source Name box (and also the Name Key box in the header section) 
automatically update as you type into text boxes that are referenced on its name template. 

You can also edit the Name box yourself, to give the source a name that may be more meaningful to you. The 
automatic name generation will be disabled whenever the contents of the name box do not match what the 
automatic generation would have produced. 

Author Type Box 

Often, the "author" of a source document is somebody other than a true author. This information is important 
to include when formatting a source citation. The Author Type box contains a drop-down list for author type. 
The choices are: 

 

When Author or Agency is selected as author type, Genbox will omit the type from the formatting. The other 
types will be included. 

Use Agency when the author name is not a person. This affects how the author name is formatted. 

Author Box 

The Author box displays the name of the author of the source. Enter the name in normal word order, which is 
usually given name, middle name, surname. If the surname is not the last word, you may mark it with /slash 
marks/. Multiple authors may also be entered. Separate each name with a comma. 

Note    Because source document authors will rarely be of genealogical interest, this field is not linked to the 
Individuals Table. 

Qualifier Box 

In the Qualifier field, enter any information about the source that qualifies it or restricts it in some way. Often, 
the source template will have a specific use defined for this data item, suggested by its label. 

Place Box 
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The Place box is used to enter place information for the source. For a Source Level source, the label is 
typically "Pub. Place" and the field stores the place of publication. For a Document Level source, the place 
can be the place where the document was created. This field is a link to the Places table. 

Subject / Publisher Box 

For Source Level sources, this box is used to enter the name of the publisher. For Document Level sources, 
this box is used to enter the name of the subject. 

Date Boxes 

There are two date boxes, commonly labeled "Date" and "Original Date". The first date box is used when only 
one date is associated with the document. If the current source document is a published work that has been 
reprinted, the second date box is used to enter the original publication date. If there are two dates associated 
with a document, such as a will that was signed on one date and probated on a later date, the earlier date 
should be placed in the second date box. 

Dates can be entered as just years, if suitable for the type of source record. 

Repository Type Box 

For Document Level and Source Level sources, the Repository Type box presents a drop-down list of the 
following choices for type of repository: 

 

The default type is Place. In Genbox, "repository" is considered an attribute, rather than a separate data type. 
Most often, it is a place that serves as a repository for the source document. Sometimes it is an individual or 
researcher that personally holds the document. Rather than creating a "place" record of the form "holdings of 
John Smith" to store this relationship, Genbox allows you to link directly to the Individual's record. Their 
contact information is then available as the repository address. 

Repository Box 

For Document Level and Source Level sources, the Repository box is used to enter the name of the 
repository where the document is stored. This can be an individual, researcher, or place name, as determined 
by the Repository Type box. 

Higher Source Box 

For Document-in-Source Level sources, the Higher Source box is used to enter the name of the higher 
source record. 

Note    The higher source should be a Source Level source. 

Locater Box 

The Locater box is used to enter the "where to find it" information, in either the higher source or the 
repository. It may contain a call number, a page reference, or some other referential value. 

Media Control 

The Media control is the open area to the right of the lower boxes. It initially displays the first picture that is 
linked to the source, if any. Any number of multimedia objects can be linked to each source. You may find it 
helpful to scan your source documents, create a media record for each image file, then add a link to each 
corresponding source record. 
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Multimedia can also be linked to individuals, families, events, and places. See the chapter Adding Multimedia 
for help on the Media control.  

Research Notes and Target Button 

Use the Research Notes box to record your research efforts regarding the current source.  

You can make the current source a target for further research by clicking on the Research Target button. 
This will open the Research Targets View. When the current source has been linked to a Research Targets 
record, the Research Target button will be shown in bold. 

Key / Padlock Buttons 

The Key and Padlock buttons that appear to the right of the tabs are used for Source Lock Mode. Source 
lock mode makes it easy to add source citations when you enter data. See the Source Lock Mode section in 
the chapter Citing your Sources for help. 



       

Sources View: Settings Page 
The Settings page contains additional text boxes for entry of source data items. 

 

Media Type 

The Media type box provides a place to indicate the physical form of the source. It displays several choices 
on its drop-down list: 

 

It is intended that the current form of the source be recorded. For example, a manuscript that has been 
recorded on microfilm or microfiche should have a Media type of "Microform", not "Manuscript". 

Short Title 

The Short title box is for entry of a shortened form of the Source title. The shortened title will be used on 
reports when a source is referenced a second time. If no value is entered, Genbox will construct a short title. 

External Storage 

The External Storage text box is for entry of your own filing system code for the documents that you actually 
possess. It can be a file number or room location. 

Recent check box 
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The Recent check box is checked automatically for new source records created during an import operation. 
You can clear it and check it as you prefer. 

Exclude check box 

When the Exclude check box is checked, all citations to this source will be excluded on charts and reports. 
This is an easy way to suppress citations to sources that you have decided are questionable or want to 
research further before using. 

Change Date 

The Change date box displays the last date this source record was modified. This text is read-only. 



       

Sources View: Evidence Page 
The Evidence page is where actual text from the source can be entered. Making a transcript of the source, or 
at least an excerpt of the relevant parts, has several advantages: 

• It will preserve the information in your database, making it less likely to be misplaced or lost. 
• If you export your data for use by others, the evidence can go with the data. 
• You can easily print it out to make paper copies. 
• You can use "Find..." to search the text. 
• You can automatically include it in your printed reports. 
• You can keep it visible in a window while you enter data based on it. 

 

Source Text Type 
The Source Text Type radio button allows you to specify the type of source text entered: 

• Transcript 
• Extract 
• Abstract 

A transcript is a faithful recording of the entire contents of the source. An excerpt is like a transcript, except 
that only a part of the source has been entered. An abstract is a summary of the source. It is not a word-for-
word recording. 

Source Text 
The Source Text box is where you enter the source text. You can use the style toolbar buttons (bold, italic, 
underline) to make your entry more closely match the original. Line breaks are optional; if entered, they will 
affect the way the source text appears on output reports, which may not be desirable. 
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Sources View: Content Page 
The Content page provides a place to enter content information for a source. You can record the event types, 
date ranges, and jurisdictions (places) of the data which a source, such as a register, contains. This 
information would be helpful to have if you later do research that leads you to the same source. By recording 
at least this outline of its contents, you will know whether the information you are seeking is likely to be 
included before you start. 

 

Content List 
The Content List contains one row for each content record. It has three columns: Event Type, Date Range, 
and Jurisdiction. 

Event Type 
Enter the Event Type, such as Birth, Death, Marriage. 

Date Range 
Enter the Date Range, which can be a range of years, of months, or between two specific dates. 

Jurisdiction 
Enter the Jurisdiction, which may be a state, a county, or some other division. 

Responsible Agency 
The Responsible agency box is for entry of the agency that is responsible for this source. 

Notes 
The Notes box provides a place to enter any general notes about the contents of the source. Sometimes it is 
easier to describe a source this way than by entering records in the Content List. 
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Sources View: Notes Page 
The Notes page contains text boxes for entry of notes regarding the source. 

 

General Notes 

Use the General Notes box to enter any comments about the source. 

Note       The actual text from the source should be entered on the Evidence page. 

Research Notes 

Use the Research Notes box to record your research efforts regarding the current source. 
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Sources View: Formatting Page 
The Formatting page displays how the current source will be formatted on reports. The data can appear in up 
to three contexts: in the initial (primary) citation, in secondary citations, and in the bibliography. 

The default formatting is controlled by the linked Source Template record, which is defined on the Source 
Types View. The selection of Source Template Record is done by the Source Type box on the General Page. 
You can also override the default formatting by simply editing the text on this page. 

Note: the formatting for a source can also be viewed and modified on the Citations View Formatting Page, 
from any citation that is linked to the source. Any changes to the formatting made there will actually be stored 
with the Source record, and will also be reflected on this page when viewed. 

 

Primary Citation 

The Primary citation box displays how the current source will be formatted for its initial citation. This is 
usually the most complete citation format.   

You will likely see a code that looks like "<, [CD]>" in your formatted text. This is a place marker for the citation 
detail data. This code won't be translated into formatted text until the time of report generation. This allows the 
detail from each citation to be included in the formatting. If you manually edit the formatting, be sure to leave 
this code in to continue to support this feature. 

If you wish to see the formatting with the [CD] code and other citation-specific template codes translated, open 
the Citations View and go to a citation record that links to the source. On the Citations View Formatting Page, 
the complete formatting, including the citation-specific detail, can be viewed. 

Secondary Citation 

The Secondary citation box displays how the current source will be formatted for secondary citations. A 
source that is referenced only once on a report will never use this formatting. In general, the secondary 
citations are briefer than the initial citations. Some elements are left out, and some elements are shortened. 

Bibliography 
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The Bibliography box displays how the current source will be formatted for inclusion on the bibliography 
section of a report. In this context, the source is presented in a general way, with fewer of the specific details, 
such as page numbers. For some Document-in-Source Level sources, virtually nothing from the lower source 
is included; only elements from the higher source are considered appropriate. 

User Edit 

There are three User edit controls, one next to each template box. These are automatically set when you edit 
the corresponding template manually. When a template is marked "user edit", Genbox will not update the 
formatting, even when the data of the source record is updated. 

Default Buttons 

If you have manually edited the formatted text and want to return to the default formatting, press the 
corresponding Default button. 



       

Sources View: Links Page 
The Links page contains a list box that displays one row for each data item linked to the current source. A 
double-click on any row will cause a jump to the view and page where the source record is being referenced. 

 

Link Type Selector 

The Link Type Selector box allows you to filter the list to display only links from a particular type of data 
record. Choices on the drop-down list are: 

 

Place Link List 

The Place Link list box contains one row for each data record link to the current source. This list is read-only. 
It has four columns: ID, Type, Subtype, and Name. Double-clicking on a row will a cause a jump to the data 
record that is represented by that row. 

ID Column 

The ID column displays the ID value of the linked data record. 

Type Column 

The Type column displays the type of data record that is linked: Citation or Source. 

Subtype Column 

The Subtype column displays data related to the linked record: 

• For Citation records, it displays the type of data being cited (Parents Link, Individual Name, etc.) 
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• For Source records, it displays the Source Type. 

Name Column 

The Name column displays data related to the linked record: 

• For Citation records, it displays the name of the primary individual. 
• For Source records, it displays the source name. 
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Media View 
Adding multimedia to your genealogy can make it more appealing. A picture of an ancestor can reveal much 
more than just the name and vital events can. A video clip of an interview with a relative or of a special family 
event can be enjoyed over and over. 

First, you will need to use a scanner, a digitizer, or other tools to create electronic images and video clips. 

Multimedia files are not stored in your Genbox database. They remain as separate files, and can reside 
anywhere on your hard disk. In your Genbox database, Multimedia records store the filename, including the 
full or relative path, of each of your multimedia files. This approach has several advantages: 

• The creation, editing, and maintenance of multimedia files can take place outside of and independent 
of Genbox. 

• Several multimedia records can point to the same filename. This is useful when a picture of several 
people is to be linked to several individual records, each with a different caption, title, or other data. 

• The same multimedia file can be referenced by multiple Genbox databases.  
• The size of the Genbox database file is reduced. 

 The Media View presents information on multimedia records. 

            General Page 
            Content Page 
            Clip Page 
            Links Page  

Adding Multimedia Records 

With the Media View active, click the New Record button on the main toolbar to add a new media record. The 
File Open Dialog will appear, where you can browse for or type the path and filename of your multimedia file. 
When you return to the Media View, a new record will already be added.  

Reading of Embedded IPTC Data 

IPTC data embedded in JPEG or TIFF files added to the database will be used to initialize fields for the new 
media records:   

• "Headline" (or "Object Name" if Headline is empty) initializes the Title field.  
• "Caption" initializes the Caption field. 
• "Date Created" initializes the Creation Date field. 
• "Special Instructions" initializes the Description field. 

The default reference name will be the Title if it is not blank; otherwise it will be the filename without the 
extension.  

Refreshing Fields from IPTC Data 

If the IPTC data has been changed on a media file outside of Genbox, the Title, Caption, Creation Date, and 
Description fields can be updated to match the new text values embedded in the media file. To do this, click 
the "Open..." button to the right of the filename on the Media View. Select the filename again. When the Open 
File dialog closes, the fields will be updated with the new values, if any. 



       

Media View: General Page 
The General page data describes the physical makeup of the multimedia object, and also contains the title 
and caption. The description of the actual content of the multimedia is entered on the Content page. 

 

Filename 

Enter the full filename and path to the multimedia file in the Filename box. Or, to browse for the file, click on 

the Open File button.  

Reference Name 

The Reference name is the name by which this multimedia record is known within Genbox. Give the record a 
descriptive name that will suggest what the corresponding multimedia file shows. 

Media Type 

Each multimedia record is categorized as a particular type. The Media types are represented by icons, as 
shown on the drop-down list:  

 

An Object can be for example, a document or a spreadsheet. 

Format 
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The Format box displays the format type of the linked multimedia file. For image files, it might display "BMP", 
"GIF" or "JPG". This text is read-only.  

Pref. Size 

The Pref. size (Preferred size) box is for entry of the preferred (maximum) horizontal and vertical size, in 
inches, on charts and reports. This lets the picture have control over its presentation. This value can be left 
blank to allow the charts and reports to control the sizing. The value entered will set the larger dimension size, 
and the aspect ratio of the picture will be maintained to set the other dimension. 

Quality 

The Quality box presents a place to enter a short description of the physical quality of the multimedia. You 
can type in a value or choose from the drop-down list: 

 

Bitmap Size 

The Bitmap size box displays the dimensions of image files, as the number of horizontal pixels and vertical 
pixels. 

Modified 

The Modified box displays the date and time the media record was last changed. This text is read-only. 

External Storage 

The External storage box provides a place to enter the storage location of the physical multimedia object 
itself, not its electronic copy. For your pictures, this could be the label on a shoebox, or a file cabinet drawer, 
or a page reference in a book. 

Title 

The Title box is for entry of a title for the multimedia object. The title can be displayed on charts and reports. 

Caption 

The Caption box is for entry of a caption for the multimedia object. Unlike the title, the caption is usually a 
sentence or two that explains the picture or its relevance. The caption can be displayed on charts and reports. 

Media Control 

The Media control is the open area to the right of the middle boxes. It provides a preview of the linked 
multimedia object. The Play button, which appears to the left of the Media control, can be used to open 
image files in a larger view, or to hear audio files, or to start video clips. 
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Media View: Content Page 
The Content page is for entry of information that describes the content of the multimedia. This information 
can be helpful when you are maintaining a large library of multimedia, and you want to search for a particular 
record by its content. 

 

Subject 

The Subject box provides the following choices on its drop-down list: 

 

Choose the most appropriate selection for the content. 
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Setting 

The Setting box provides the following choices on its drop-down list: 

 

Choose the most appropriate selection for the content. 

Created 

Enter the date this multimedia object was created in the Created box. 

Media Flags 

The Media Flags box contains one check box for each defined media flag. If checked, a multimedia 
object "has" the attribute indicated by the name of the check box. The media flags are defined on the Data 
Setup View. All defined media flags will appear for all multimedia records. This makes it easy to see what flag 
attributes a multimedia object does and does not have, and changes can be made with a single click. 

Description 

Use the Description box to enter a general description of the contents of the multimedia object. 

Media Control 

The Media control is the open area to the right of the top half of the page. It provides a preview of the linked 
multimedia object. The Play button, which appears to the left of the Media control, can be used to open 
image files in a larger view, or to hear audio files, or to start video clips. You can review the multimedia while 
you are entering its content description. 
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Media View: Clip Page 
Genbox supports AVI, MPEG, Quicktime (QT or MOV), and Windows Media (WMV) format video files, and 
AU, AIFF, MIDI, MP3, and WAV format audio files. The Clip page allows you to specify a portion, or clip, of a 
video or audio file that you want to treat as a named piece that can be linked to data records. Only the 
selected clip will be visible or audible when it is linked to a data record. In addition, you can define a single 
frame within a video clip to be the still image representation that shows in the media control when the video is 
not playing, and also when the media is selected for inclusion on printed reports. 

 

Units 

The Units can be set to frames or seconds. This selection affects the display of values in the text boxes on 
this page. 

Start Box 

The Start box displays the starting position for the clip. You can type in a new value, or press the Set button 
to use the current position of the multimedia. 

Preview Box 

The Preview box displays the preview position for the video clip. You can type in a new value, or press the 
Set button to use the current position of the video. The preview position indicates the video frame to be shown 
when the video is not playing. For audio files, the preview controls are disabled. 

Stop Box 

The Stop box displays the stopping position for the clip. You can type in a new value, or press the Set button 
to use the current position of the multimedia. 

End Box 
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The End box displays the actual length of the multimedia. This value is read-only. 

Current Box 

The Current box displays the current position of the multimedia. Typing a value and pressing ENTER will 
update the current position. 

Frames Per Second Box 

The Frames per second box displays the frame rate defined in the multimedia file. This value is read-only. 

Set Buttons 

There is a Set button next to the Start, Preview, and Stop text boxes. Pressing a Set button will update the 
value in the corresponding text box to the current position. 

Media Controls 

                             

Start Clip Position 

Click the Start Clip Position  button to move to the starting position for the clip. 

Start  Position 

Click the Start Position button  to move to the very start of the clip. 

Preview Position 

Click the Preview Position button  to move to the preview position. The preview position determines the 
frame that will be shown with the video is not playing. The preview position can be at any position in the 
multimedia, even if it is outside the clip start and stop range. 

Play 

Click the Play button  to test out the clip. The clip will start playing at the Start Clip Position and stop at 
the Stop Clip Position. 

Stop Clip Position 

Click the Stop Clip Position button  to move to the stopping position for the clip. 

Stop Position 

Click the Stop Position button  to move to the very end of the multimedia. 

Slow Forward 
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Click the Slow Forward button  to play the multimedia at a rate half as fast as normal, beginning at the 
current position. 

Pause 

Click the Pause button  to stop the multimedia at its current position. Click the Forward button to 
resume. 

Fast Forward 

Click the Fast Forward button  to play the multimedia at a rate twice as fast as normal, beginning at the 
current position. 

Forward 

Click the Forward button  to play the multimedia normally, beginning at the current position. 

Step Back 

Click the Step Back button  to move to the previous frame. This is enabled for videos only. 

Step Forward 

Click the Step Forward button  to advance to the next frame. This is enabled for videos only. 

Slider Control 

The Slider Control beneath the Media Control is used to display the progress of the multimedia and also to 
move the current position to anywhere in the range by dragging the thumb of the slider. 
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Media View: Links Page 
The Links page contains a list box that displays one row for each data item linked to the current multimedia 
record. A double-click on any row will cause a jump to the view and page where the multimedia record is 
being referenced. 

 

Link Type Selector 
The Link Type Selector box allows you to filter the list to display only links from a particular type of data 
record. Choices on the drop-down list are: 

 

Media Link List 
The Media Link list box contains one row for each data record link to the current multimedia record. This list is 
read-only. It has three columns: ID, Type, and Name. Double-clicking on a row will a cause a jump to the data 
record that is represented by that row. 

ID Column 
The ID column displays the ID value of the linked data record. 

Type Column 
The Type column displays the type of data record that is linked: Individual, Family, Event, Place, or Source, or 
Researcher. 

Name Column 
The Name column displays the name of the linked data record. 
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Researchers View 
As part of the research subsystem, the Researchers View displays information on the researchers of the 
current genealogy database. Whenever a data record is modified, it is marked with both the current date and 
time and with the ID of the researcher who modified it. This makes it possible to determine who most recently 
edited a data record, for a level of research accountability. Information on researchers can be included on 
charts, reports, and exported/imported with the data. 

Records stored in the Researchers table are independent of records stored in the Individuals table. This 
design allows information on researchers for which there is no genealogical interest to be kept out of the 
Individuals table. When a researcher is also of genealogical interest, a record in both the Researchers table 
and the Individuals table should be created.  

            General Page 
            Contact Page



       

Researchers View: General Page 
The General page displays the name and other characteristics about the researcher.  

 

Name 

Enter the name of the researcher into the Name box.   

Same as Individual 

If the researcher also happens to be same person as an individual in the Individuals table, enter their name in 
the Same as Individual box.   

Languages 

Enter the languages in the Language box that the researcher can communicate in effectively.  

Reg. ID 

The Reg. ID (Registration ID) box is for entry of any researcher registration or identification number that you 
wish to use.  

Current Researcher 

The Current Researcher button marks the researcher that represents the current Genbox user. When new 
data is entered or existing data is modified, the current researcher ID is stored into the data record. This 
indicates the person who is responsible for entry of the data. 

Only one Researcher record can be marked as the current researcher at one time. Marking another record will 
clear the setting from the previous record that was marked. The name of the current researcher will appear in 
the status bar. 

You can set the Researcher ID that will be set current when a database is opened in Data Setup, on the 
Defaults page.  
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Notes 

Enter your notes about the researcher in the Notes box.  

Media Control 

The Media control is the open area to the right of the middle boxes. It initially displays the first picture that is 
linked to the researcher, if any. Any number of multimedia objects can be linked to each researcher. See the 
chapter Adding Multimedia for help on the Media control.  



       

Researchers View: Contact Page 
The Contact page contains information on addresses for the current researcher. The contents of this page 
are the same as for individuals. For help, see the section on the Contact page for the Individuals View. 

The address of the researcher can appear on reports, and exported with the data. 
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Correspondence View 
The Correspondence View presents information on correspondence that was received and sent. You can use 
it to keep track of your research correspondence. 

            Log Page 
            Details Page 
            Contact Page 
            Links Page



       

Correspondence View: Log Page 
The Log page displays information on correspondence received and sent, in a log format. The 
Correspondence list box contains one row for each correspondence record. It has six columns: ID, 
Correspondence Type, Correspondence Direction, Correspondent, Date, and Subject. 

To add a new correspondence log entry, click where it says "Add Correspondence" and type the name of 
the correspondent. 

 

ID 

The ID column displays the ID of the Correspondence record. 

Correspondence Type 

The Correspondence Type is represented with the following icons: 

 

To change the type, click on the icon or press the space bar until the desired type is shown. You can also 
press shortcut keys to choose the desired correspondence type: 

• C    Telephone call 
• E    E-mail (electronic mail) 
• F    Fax (electronic facsimile) 
• L    Letter (letter or postcard) 
• T    Tape (audio or video tape) 
• V    Visit (face-to-face meeting) 

Correspondence Direction 

The Correspondence Direction is represented with the following icons: 

    Correspondence that was sent (out box) 
    Correspondence that was received (in box) 
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To change the direction, click on the icon or press the space bar. You can also press shortcut keys to 
choose the desired direction: 

• T, S    Out box ("to" or "sent") 
• F, R    In box ("from" or "received") 

Correspondent 

Enter the name of the correspondent into the Correspondent column. This is a link to the Individuals table, 
the Places table, or the Researcher table. 

For correspondence with a local site, such as an archive or courthouse, enter the name of the local site, not 
the name of the contact person. If you wish, the name of the contact person, and their title, can be included in 
the notes. 

Date 

Enter the date the correspondence was sent or received in the Date column. 

Subject 

Enter the subject of the correspondence in the Subject column. 



       

Correspondence View: Details Page 
The Details page displays full information on the current correspondence record. 

 

Correspondence Type 

The Correspondence Type is represented with the following icons: 

 

To change the type, click on the icon or press the space bar until the desired type is shown. You can also 
press shortcut keys to choose the desired correspondence type: 

• C    Telephone call 
• E    E-mail (electronic mail) 
• F    Fax (electronic facsimile) 
• L    Letter (letter or postcard) 
• T    Tape (audio or video tape) 
• V    Visit (face-to-face meeting) 

Correspondence Direction 

The Correspondence Direction is represented with the following icons: 

 

    Correspondence that was sent (out box) 
    Correspondence that was received (in box) 

To change the direction, click on the icon from the list. You can also press shortcut keys to choose the 
desired direction: 

• T, S    Out box ("to" or "sent") 
• F, R    In box ("from" or "received") 

Researcher 
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The Researcher box displays the name of the researcher the correspondence was with. 

Correspondent Type 

The Correspondent Type drop-down list presents the following choices for type of correspondent: 

 

Correspondent 

Enter the name of the correspondent into the Correspondent column. This is a link to the Individuals table, 
the Places table, or the Researcher table. 

For correspondence with a local site, such as an archive or courthouse, enter the name of the local site, not 
the name of the contact person. If you wish, the name of the contact person, and their title, can be included in 
the notes. 

Date 

Enter the date the correspondence was sent or received in the Date column. 

Subject 

Enter the subject of the correspondence in the Subject column. 

Storage 

For the selected correspondence record, enter the offline physical storage location for the item of 
correspondence (letter, postcard, cassette tape, fax), if any. 

Details 

Use the Details box to record any other information about the correspondence. 
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Correspondence View: Contact Page 
The Contact page contains information on addresses for the current correspondent. This is the same as the 
contact page for individuals. For help, see the section on the Contact page for the Individuals View. 
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Correspondence View: Links Page 
The Correspondence Links page contains a list box that displays all links to the current correspondence 
record. Links to correspondence records can be added on the Projects View. A double-click on any row will 
cause a jump to the corresponding Project/Objective record on the Projects View. This list box has three 
columns: ID, Project/Objective, and Priority. This list box is read-only. 

 

ID 

The ID column displays the unique ID for each project/objective record. 

Project/Objective 

The Project/Objective column displays the name of the linked project/objective record. 

Priority 

The Priority column displays the priority set for the project/objective record. 
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Research Targets View 
Keeping track of your research efforts by recording what you have searched, your findings, and what you plan 
to search can save you valuable time: 

• You can organize your trips to the library or courthouse by reviewing your objectives first and printing 
out a list of what you hope to find to take with you. 

• You can avoid repeating a search by carefully recording what you found the first time. 
• You can look through the list of research targets to decide which loose ends you want to work on next. 

The Research Targets View helps you organize your research objectives and record your results. While you 
can create new records in this view, you can also create new records with the target data already filled in by 
clicking on the research target buttons that appear on the data view pages. 

            Target Page 
            Searches Page 
            Links Page



       

Research Targets View: Target Page 
The Target page contains information on the data item that is the focus of the current research objective. It 
also displays a list of the defined searches for the target. 

 

Main Item Type, ID, and Name 

The Main item type box identifies the main data type of the target data item: 

 

The Main item ID box displays the ID of the main data table, and the Main Item Name box identifies the 
target main data item by name. 

Sub-Item Type, Id, and Name 

The Sub-item type box identifies the type of the subrecord of the target data item, if any: 

 

The Sub-item ID box displays the ID of the subrecord, and the Sub-item Name box displays the specifics of 
the sub-item: the name variation, or parents, or event information. 

Target Description 

The Target description box can be used to enter your own description of the target of your research. While 
the Main item and Sub-item boxes are useful when the target is a specific piece of data already represented 
in the database, often your target of research will be more general. You can use this field instead of the item 
boxes. Or, you can set the Main item type to "Other" and use the Main item Name box for your own 
purposes.  

Searches List 
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The Searches list box contains one row for each Search record for the current target. This information is 
read-only. Double-clicking on a row will cause a jump to the corresponding Search record on the Searches 
page. There are five columns: Search ID, Scheduled, Completed, Priority, and Source/Rep. 

Search ID 

The Search ID column displays the unique Search record IDs. 

Scheduled 

The Scheduled column displays the date each search was scheduled. 

Completed 

The Completed column displays the date each search was completed, or blank if incomplete. 

Priority 

The Priority column displays the assigned priority for each search. 

Source/Rep 

The Source/Rep column displays the Source or Repository specified in each search. 



       

Research Targets View: Search Page 
The Search page displays information on each search scheduled for the current research target. Completed 
searches can remain as records in the database, so you can review your past searches and avoid repeating 
your work. You can also produce a report on your scheduled searches.  

This page displays one search record at a time. 

 

Description 

The Description box can be used to enter the specifics about the search: what you hope to find, how you 
plan to conduct the search, etc.  

Scheduled 

The Scheduled box is for entry of the date that you plan to perform this search. You can use the contents of 
this field to select search records for output to a report that you could take with you on your next research trip. 

Completed 

The Completed box is for entry of the date that the search was completed. If the search hasn't been 
conducted yet, this box should be blank. 

Priority 

The Priority box provides the following choices on its drop-down list:  
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Source 

If there is a particular source you plan to search, enter it into the Source box.  

Repository 

Enter the repository at which you plan to do the search in the Repository box. 

Location 

Use the Location box to enter the call number or other locating information you will need to find your source 
in the repository. 

Findings 

Use the Findings box to record the results of your search. Record both what you found and what you didn't 
find. 

Subrecord Controls 

The subrecord controls appear in the top right corner of the page. The Subrecord ID box displays the 
unique ID of the current search record.  

• To move to a different search record for the current research target, use the horizontal scrollbar. If 
the "thumb" occupies the entire width of the scrollbar, then there are no other search records defined.  

• To add a search record for the same research target, click the New Subrecord button . Or, on 
the Data menu, click Add Search. Or, use the keyboard shortcut CTRL+L. 

• To delete the current search record, click the Delete Subrecord button . Or, on the Data menu, 
click Delete Search. 
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Research Targets View: Links Page 
The Research Targets Links page contains a list box that displays all links to the current research target 
record. A double-click on any row will cause a jump to the corresponding Project/Objective record on the 
Projects View.  

 

Add Link Button 

Click the Add Link... button to add a link to an existing project/objective record. The Project Pick Dialog will 
open. 

Research Targets Lists Box 

The Research Targets List Box has three columns: ID, Project/Objective, and Priority. This list box is read-
only. 

ID 

The ID column displays the unique ID for each project/objective record. 

Project/Objective 

The Project/Objective column displays the name of the linked project/objective record. 

Priority 

The Priority column displays the priority set for the project/objective record. 

Deleting a Link 

To delete a link to a project/objective record, first click on the desired row, then press the DEL key. 
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Projects View 
A project in Genbox is a named organization of tasks, or objectives. Because the structure of a project is 
basically the same as an objective or task, both projects and their subordinate objectives can be displayed on 
the same view. The objectives are organized into a hierarchy beneath a project record. You can define 
several projects, each with its own hierarchy of objectives. 

The Projects View displays information on defined projects and their objectives. 

            General Page 
            Research Page 
            Correspondence Page 
            Hierarchy Page

A task can involve research or correspondence. You can link a project objective record to one or more 
Research Targets and Correspondence records. This can provide an effective system for organizing your 
project information.  



       

Projects View: General Page 
The General page contains a description of the project or objective, and related status and scheduling 
information. 

 

Project/Objective 

The Project/Objective box contains the name of the project or objective. The label on the box will change to 
indicate whether this is project or objective record. 

Level 

The Level box displays the level in the project/objective hierarchy. For a project record, the level is 0. For the 
first set of objectives, the level is 1. Note: this text box is for record selection only; the text cannot be edited. 
To change the level of the current objective, first click the tab for the Hierarchy page, then drag the name to 
the desired parent. 

• To move up a level, click the up-arrow in the text box. The parent objective record will become the 
current record. 

• To move down a level, click the down-arrow in the text box. The first child objective record will 
become the current record. 

Note: use of the up-down arrow buttons is not limited by the current filter, if one is active. 

Sequence 

The Sequence box displays the sequence number for the current objective and the total number of objectives 
for the parent of the current objective. For Projects, it displays the sequence number for the project and the 
total number of project records. Note: This text box is for record selection only; the text cannot be edited. To 
change the sequence position of the current objective, first click the tab for the Hierarchy page, then order 
the child objectives by dragging them one at a time in the desired order and dropping them on the parent. 

• To move to the next objective with the same parent, click the right arrow button in the control. 
• To move to the previous objective with the same parent, click the left arrow button in the control. 

Note: use of the left-right buttons is not limited by the current filter, if one is active. 
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Higher Objective 

For objective records, the Higher Objective pick control displays the name of the next higher objective (or the 
name of the project, if the next level up is the project level). Clicking on the control will display a drop-down list 
of the complete hierarchy to the current item. This can help provide a sense of context for the current 
objective. Note: this control is read-only. 

For project records, this text box is hidden. 

Scheduled 

The Scheduled box is for entry of the date that this objective or project is scheduled to be started. 

Completed 

The Completed box is for entry of the date that this objective or project was actually completed. 

Priority 

The Priority box is for entry of a priority indicator for the current project or objective: 

 

Status 

The Status box is for maintaining a status indicator on the current project or objective. The status is 
represented by icons made to look like clipboards, as shown below: 

 

Percent Complete 

The Percent Complete box is for entry of the percentage of the total task that has been performed. This 
value can be considered in conjunction with the status indicator to get a good idea of where things are.  

Some of the values of this indicator and the status indicator have been locked together for consistency: 

• Setting the Percent Complete to zero will set the Status to Defined. 
• Setting the Percent Complete to any value greater than zero and less than 100% will change a 

Defined status to In-Progress. 
• Setting the Percent Complete to 100% will change the status to Completed. 
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Hours 

The Hours box can store the amount of time spent so far on the current objective. Each click on the up-arrow 
control will add 1/4 hour to the total. You can also type in any amount that you wish, to the nearest 1/100th 
hour. 

Modified 

The Modified box shows the date the current record was last changed. This text box is read-only. 

Description 

Enter a description of the project or objective in the Description box. This can include what is involved, what 
needs to be done, and the results that are expected. 
 



       

Projects View: Research Page 
A project objective or task can be linked to one or more Research Targets. The Research page contains a list 
box that contains one row for each linked Research Target record. 

 

Research Targets List Filter 
The Research Targets List Filter provides the following options for filtering the display of linked research 
targets: 

• All - all research targets linked to any project records are shown. 
• Current record - only research targets linked directly to the current project/objective are shown. 
• Current record and lower - research targets linked to the current project/objective record and all 

lower project/objective records are shown. 

Add Target Button 
To add a new research target link, click the Add Target... button. The Research Targets Pick Dialog will 
open. You can select an existing research target or add a new one. 

You can also add a new target by clicking where it says "Add Target" in the list box and typing the text of the 
targeted item. 

Research Targets List Box 
The List Box contains one row for each linked Research Target record. 

• To add a new Research Target link, click on the next empty line in the box. 
• Type either the ID or the name of the Research Target you wish to link the current project/objective 

record to. 

The list box has two columns: ID and Target. 

ID Column 
The ID column displays the unique ID of each Research Target record. 

Target Column 
The Target column displays the name of the Research Target record. Double-click a row to jump to the 
corresponding Research Target record on the Research Targets View.
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Projects View: Correspondence Page 
The Correspondence page contains a list box that contains one row for each linked Correspondence record. 

• To add a new Correspondence link, click where it says "Add correspondence". 
• Type either the ID or the name of the Correspondence you wish to link the current project/objective 

record to. When typing the name, begin with the correspondence type, such as "Call" or "Letter". 
Genbox will auto-complete your entry to the first matching correspondence record. 

 

The list box has two columns: ID and Correspondence. 

ID Column 

The ID column displays the unique ID of each Correspondence record. 

Correspondence Column 

The Target column displays the name of the Correspondence record. Double-click a row to jump to the 
corresponding Correspondence record on the Correspondence View.
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Projects View: Hierarchy Page 
The Hierarchy page displays an indented hierarchy of project objectives. Subordinate objectives are shown 
indented beneath their parent objective. This view gives you an overview of the entire project/objective 
hierarchy. 

• A click on any row will cause a jump to the corresponding project/objective record. 
• The status of each objective is shown with an icon to the left of the objective name. 
• Rows shown in bold indicate items that are marked top-priority. 
• Click the Expand All button to expand all sub-items, making the entire hierarchy visible. 
• Click the Collapse All button to collapse the hierarchy, showing only the top-level project items. 
• Click on a "+" button to expand the hierarchy below a particular item. 
• Click on a "-" button to collapse the hierarchy below a particular item. 

 

Adding Objectives 

• To add a lower objective, click on the higher objective, then press CTRL+L. A new item will appear 
with the name "New". Type the name for the item, then press TAB. 

• To add a new objective at the same level as the current objective, press CTRL+N. 

Deleting Objectives 

• To delete the selected project objective, press DEL, click on the "X" on the main toolbar, or choose 
Delete Objective from the Data menu. All lower objectives will also be deleted. 

Moving Objectives 

• To move a project objective, drag its name and drop it on the desired parent. When dropped, it will 
be added as the last child of the parent. All lower objectives will be moved as well. 

You can use this feature to reorder the child objectives of a parent: drag and drop them on the parent in the 
desired order. 
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List View 
The List View is a general-purpose view for manipulating all types of lists in Genbox. Lists can be viewed, 
created, edited, renamed, copied, pasted, merged, and deleted. Lists can be used on this view for individual 
record selection, jumping directly to the main data record on the appropriate view. Lists can be used for group 
record selection on charts, reports, filters, queries, and export. Lists can also be used for deleting groups of 
records, marking records, filtering views, and setting attribute flags. 

 

Genbox has a number of predefined lists, such as the lists of Individuals, Families, Places, Sources, and other 
main data records. Other lists may be automatically created by the program as the results of various 
commands. By having the outputs of these commands as lists, you have many powerful options for 
manipulating your data. 

The view is divided into three panes: the Tree pane on the left, the List pane on the right, and the List 
Selection Pane on the bottom. The List Selection Pane is normally hidden. There is a vertical splitter bar 
between the left and right panes, and a horizontal splitter bar between the top two panes and the List 
Selection pane. You can drag the splitter bars to adjust the sizes of the panes. You can also drag the outside 
edges of the window to increase the sizes of the panes. 

Tree Pane 

The Tree pane displays an indented hierarchy, or tree, of the names of all the defined lists. List names are 
grouped by type. After each list name, the current number of members appears in parentheses.  

• To select a list, click on its name. The list members will appear in the List pane. 

The hierarchy is divided into five main headings: 

• Recent Activity: Jump History, Possible Duplicates, Potential Problems, Query Results, Chart and 
Report Result Lists, Filters 

• Saved Lists: user-defined lists that have been created by copying other lists and/or by 
adding/removing members. 

• Marks: lists of records that have been marked by pressing CTRL+M. Marked records are shown in 
the marked record font style. 

• Flags: lists of attribute flags for individuals, places, and media. 
• Records: read-only lists of records in each of the main data tables, events, and notes. 
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Jump History List 

The Jump History list maintains a record of windows and records that were reached by "jumping" to them. 
You can jump to related data records in many places in Genbox by double-clicking on the referenced name. 
You can also jump to a record by entering its record ID or name in the header area of a view, then pressing 
ENTER. (You can also move among records by using the previous/next arrow buttons on the toolbar; this type 
of movement, however, is considered "Browsing"; no entries are made on the jump history list for browsing.) 

You can quickly return to previous records by clicking on an entry in the jump history list. If the corresponding 
view is open, a single click will move to the correct record. Otherwise, use a double-click to cause the view to 
open and become the active view. 

Possible Duplicates List 

The Possible Duplicates list is produced by the Match Finder Tool, selected from the Tools Menu. This is a 
list of groups of two or more individual records that are considered possible duplicate records, as determined 
by the settings used for the Match Finder Tool. The groups are shown with one group member per row, and a 
horizontal line is drawn after the last member in each group to show the divisions between groups. Each time 
the Match Finder Tool is used, the contents of this list are replaced with the new result set. 

Potential Problems List 

The Possible Duplicates list is produced by the Problems Spotter Tool, selected from the Tools Menu. 
Each entry on the List pane will be shown on two rows: 

• The first row will give the ID and name of the individual record with the problem. 
• The second row will describe the nature of the problem. 

Dividing lines will be shown between problem entries. 

Query Results List 

The Query Results list appears when a query is performed for individuals on the Search View. 

Chart and Report Result Lists 

When a chart is produced, five lists appear under Recent Activity: 

• Chart Starters - a list of all individuals that appear at the "top" of the chart (not connected to a parent 
box). 

• Chart Keys - the list of individuals that were entered on the Key Page when selecting chart options. 
• Chart Results - the list of all individuals that appeared on the chart. 
• Report Keys - For narrative reports, this is the list of individuals that were entered on the Key Page 

when selecting report options. For custom reports, this is a list of the main entries before filtering.  
• Report Results - For narrative reports, this is a list of the main entry individuals. For custom reports, 

this is a list of the main entries after filtering.  

Each time a chart or report is produced, the activity lists are regenerated, replacing the previous list contents. 
You can copy and paste one of these lists if you wish to save it for future use. 

When a report is produced, a Report Keys list also appears under Recent Activity. 

Filter Lists 

All of the main data views can be filtered. Filtering restricts the set of records that can be reached by using 
the browse buttons on the toolbar (First, Previous, Next, Last). You can define a filter for a data view by 
opening its Pick Filter Dialog. When a filter has been defined, the matching records will also appear as a list 
on the Lists View, under the Filters heading. With access to this list, you can easily modify the filtered record 
set: you can add or remove list members, and you can also copy and paste other lists to a filter list, causing 
the corresponding view to update the filtered record set. 
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Saved Lists 

It is possible to name and save your own lists, which will appear under the Saved Lists heading. You can 
copy lists from Recent Activity, Records, Flags, Marks, and other saved lists. 

Mark Lists 

Records for each of the main data types can be marked. When a record has been marked, its name or other 
identifier appears in the mark font style. The default mark font style is italic red lettering. A Mark List appears 
for each data type. Editing a mark list will also update the records that have been marked. 

Flag Lists 

Each of the attribute flags for Individuals, Places, and Media has a flag list defined on the List View. Editing a 
flag list will update the records that have the corresponding flag set. If you wish to add a new flag type or 
delete an existing flag type, you will need to perform these actions on the Data Setup View. 

Each of the event type flags also has a flag list defined on the List View: Basic, Nonbasic, Group A, Group B, 
Group C, Group D, Unique, Hidden, Standard, Attribute, and Recent. Only one record per event tag is shown. 
This is the record with the best match to the current program language. The "Group A"-"Group D" and 
"Recent" flag lists can be edited on the List View. "Nonbasic" is a pseudo-flag that contains the event types 
that are not marked with the "Basic" flag. 

Record Lists 

The List View includes lists for all the main data records, notes, events, and event types under the Records 
heading: 

• Individuals 
• Families 
• Places 
• Citations 
• Sources 
• Media 
• Correspondence 
• Researchers 
• Research Targets 
• Projects 
• Notes 
• Events 
• Event Types 

When viewing a record list, you can double-click to jump to a particular record. 

Most lists show two columns: ID and Name. You can sort on a column by clicking on its header label. 

The Family list shows three columns: ID, Name1, and Name2. This allows you to sort on either spouse. 

When Projects is selected, the Tree pane will display an indented hierarchy of the sub-objectives, and the 
List pane will show the next hierarchy level for the selected objective in the Tree pane. 

The Events list shows five columns: ID, Date, Type, Principals, and Place. You can sort by any of these 
columns. When sorting the Principals column, the records will be sorted into two groups: the first group will be 
sorted by Primary Individual name for event records that have no Child/Other principal. The second group will 
be sorted by Child/Other name. 

The Event Types list shows four columns: ID, Tag, Name, Language. Only one record per event tag is 
shown. This is the record with the best match to the current program language. 
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The Record Lists are read-only. If you want a custom list of records, you can copy a record list to a Saved List, 
then add or delete list members as you wish. If you really do want to delete the records themselves, you can 
choose the "Delete All Records in List" option from the Data Menu. 

List Pane 

The List pane displays the list members for the list currently selected in the Tree pane. Each row displays the 
ID, name, and sometimes additional values of one list member. 

• To view the main data record for a list member, double-click the row. The appropriate view will 
activated. 

• To view the main data record when the appropriate view is already open, you can single-click the row. 

You can also use the list pane to step through records on the corresponding view. Press the up/down arrow 
keys, or the browse buttons on the toolbar to step through members shown on the list pane; the 
corresponding view will update in step. 

List Pane Sorting 

You can sort the names in the list pane by clicking on the column headers. A second click on the same 
column will reverse the sort. An arrow next to the column label will point in the direction of increasing values. 

For the "Name" column on Individuals lists, you can sort on either surname-first order or given-name-first 
order. The default sort order is by surname; clicking on the column header will cycle through surname 
ascending, surname descending, given name ascending, given name descending. The column header 
indicates the sort direction and sort type. 

List Selection Pane 

The List Selection pane is made visible when the "Select List..." button is clicked on another view window. 
This action begins list selection mode, which allows you to select a list or list members of a particular type, 
for use in the other view window. After you make your selection, you must click one of the buttons at the 
bottom of the List Selection pane before continuing. This pane will then be hidden again.  

The List Selection pane displays information about the currently selected list.  

List Name 

This box displays the name of the currently selected list. You can select a list in the Tree Pane by clicking on 
it. 

ID 

Each saved list has an ID, which is displayed in this box. 

Change Date 

This box displays the date the list was last modified. 

Description 

This box displays the description that was stored for the list, if any. 

Select List Name  

To choose the currently selected list, click the Select List Name button. The name of the list will be copied to 
the other view window, and the List Selection pane will be hidden.  
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When a list name is selected for use as a chart or report key / style set / content set, the members of the list 
will not be retrieved until the chart or report is generated. This ensures the output stays current with the 
current list membership. This is particularly useful when the list name is saved in the chart/report options file 
for later use.  

Select List Members  

As an alternative to choosing a list name, many list selection buttons allow you to choose particular list 
members of a list. A list member can be selected by clicking on it in the List pane (the pane on the right). To 
select more than one list member, hold down the CTRL key while clicking. Or, to select a range of list 
members, hold down the SHIFT key when making the second click.  

When you click the Select List Members button instead of the Select List Name button, the names of all the 
selected members will be copied to the other view window. If no list members were selected, then the names 
of all members in the currently selected list will be copied.  

Note: the List Name box will continue to show the name of the currently selected list, even when individual 
members have been selected. To see which list members are currently selected, you will need to look at the 
highlighted rows in the List pane.  

Cancel  

Click this button if you choose not to select a list or list members.  

Copying Lists

There are several ways you can make a copy of a list. The easiest way is to use the keyboard shortcuts: 

COPY AND PASTE 

• Click on the name of the list in the Tree Pane that you want to copy. 
• Press CTRL+C to make a copy. 
• Click on the destination if you want to send it to a particular list, otherwise skip this step. 
• Press CTRL+V to paste your copy. 

The Paste List Dialog will appear, allowing you to enter a new name for the list, or accept the default name. If 
you didn't choose a destination, your list will be pasted into the proper data type category under Saved Lists. 

Another way to copy lists is to use just the mouse: 

DRAG AND DROP 

• Point to the list you want to copy. 
• Press the left mouse button, then drag it to you where you want to paste the list. 
• Release the mouse button. 

While dragging, an image of the list you are copying will follow the arrow cursor. If the cursor changes to a 
circle with a bar through it, this means you cannot paste the list to the current destination. 

When you release the mouse button, the Paste List Dialog will appear, allowing you to enter a new name for 
the list, or accept the default name.  

BUILD YOUR OWN 

If instead of copying a whole list, you only want to copy a portion of the members, you can create a new list, 
then use the List Pane to copy just the members you want: 

• Right-Click on a list that has the desired data type for your new list, such as Individuals, Places, 
Sources, etc. 
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• From the Context Menu, choose "Create new list". A new list of the selected type will be created 
under "Saved Lists" with a default name. 

• Now, click on a list that has some records you want to copy. 
• On the List Pane, select the records you want to copy. You can select a single record or a range of 

records. 
• Press CTRL+C to copy the selected records. 
• Click on your newly created list. 
• Click on the (empty) List Pane side. 
• Press CTRL+V. The records you copied will be pasted into your new list. 

You can repeat steps 3-8 to copy records from other lists. This allows you build up a list with just the members 
you wish to include. 

Copying Lists to Particular Destinations 

The List View has several lists that include special functionality. When you manipulate these special lists, 
corresponding changes occur to the operation of the program. 

Copying to a Filter 

The Filter Icon under Recent Activity can be a destination for lists of any of the main data view types. If you 
have the Sources View open, and then copy and paste a Source list to the Filters heading, you will see a new 
list for "Sources" under filters, and your Sources View will immediately be filtered by the list you copied. You 
can add or remove members to this list on the List Pane side, and the corresponding view's filter will be 
updated. 

If you wish to clear the filter, you can either open the Pick Filter Dialog for the View and press the Clear 
Filter button, or delete the filter list itself. 

Copying to a Mark List 

Any list copied to either the "Marks" main heading or a subheading of the correct type will cause all records in 
the list to be marked. This will be immediately visible on the corresponding data view. 

Copying to a Flag List 

An Individual List can be copied to any of the Individual Flag lists, and this will update all of the records in the 
list to have the corresponding flag set. This is much faster than moving to each of the Individual records one 
at a time and setting the desired flag manually. The same is true for Media and Place flags. 

Copying to Another Saved List 

You can paste any list to another Saved List of the same data type. Using the merge operations available on 
the Paste List Dialog, you can build up a list with the members desired. 
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Event Types View 
At the heart of a genealogy are the events that are recorded for the individuals of interest. Each event data 
record that is stored for an individual is identified as being of a particular event type. Birth event records, for 
example, include the event tag BIRT to mark them as birth event type records. The Event Types View is 
used to view and enter information for all the event types used in the current database. 

Associated with each event type are a number of templates. The templates control how the data is formatted 
on reports. There is at least one template for every event type. You can define as many additional templates 
as you like. Each additional template is given a name to identify it. There are also templates for witnesses to 
the event. Templates can also be defined in multiple languages, allowing for reports to be output in different 
languages.  

Event types can be grouped into categories according to the number and types of links to other data elements 
that are involved. They can also be grouped according to the period of a person's life in which they normally 
occur, or by association with major events in a person's life such as birth, starting a family, and death. 
Sometimes it is useful to be able to group event types directly, for data selection on charts and reports. These 
capabilities and more are controlled by the Event Types View. 

The tag and name of the current Event Type record appear in the key fields at the top of the view. Unlike 
other data views which display numeric IDs, the Event Types View identifies each record by its tag. Event tags 
are unique one-word identifiers. Most are four letters, such as BIRT for birth, MARR for marriage, and DEAT 
for death. 

            General Page 
            Templates Page 
            Witness Roles Page 
            Notes Page 
            Links Page



       

Event Types View: General Page 
The General page shows both a summary of information for the current event type record and a list of event 
types in the current group. A different event type record can be selected by clicking on its name in the list 
box.   

 

Events Group Selector 

The Events Group list can display all event types or a selected group. You can filter the list by a particular 
flag, by secondary type, whether the type is directional, and by other ways. The choices provided by the 
Events Group Selector are:  

 

Basic event types are those that have the Basic Flag set.  The default basic events are Birth, Marriage, 
Death, and Burial. You may wish to include other events, such as Baptism, in the set of basic events. This 
group of event types marked basic is used for the default events to show on the Individuals View Summary 
Page, and the default list of events for the pick list on the Individuals View Events Page.  

The Group A - D choices reflect membership according to the corresponding group flags. Parent event 
types have a Secondary type of "Parents link". Family event types have a Secondary type of "Spouse link". 
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Custom event types are those that are not part of the GEDCOM standard.  Recent additions are those that 
have the Recent flag checked. This flag is set automatically for event types added during a data import. 

The Special Processing group contains the Global Event Template and the Initial Event Template. 

Events Language Selector 

The Events Language Selector selects the language of the event types that will be shown in the Events 
Group List.   

The pick list displays the names of languages that have templates defined at the top of the list. The count 
showing after the language name is the number of event type records defined in that language.  

To display event type records for all languages, choose the "(all)" choice at the top of the list. 

The Events Language Selector works together with the Events Group Selector to limit the Event Type records 
that are displayed in the Events Group List. If the Events Group Selector is set to Basic Events, for example, 
and the Events Language Selector is set to Italian, then only "Italian Basic Event Types" will be shown.  

Fill Check Box 

The Fill check box determines what should be done when the selected language does not have a full set of 
event types defined. If not checked, then only the event types that have been defined for the selected 
language will be shown in the list. If the Fill check box is checked, then there will be one Event Type record 
shown for each unique tag in the table, regardless of whether an event type record exists in the currently 
selected language. 

When a data record for a particular event type has not been defined for the current language, the "best" 
language record available will be listed. The three-letter language codes identify the language of each entry. 
The order for choosing the "best" language for event type records is the same as is used for generating 
reports:  

• Selected language 
• Base language of selected language  
• Any language in same language family as selected language  
• EN English  
• ENU English (US)  
• Any English template  
• Any base language template  
• Any language template 

When a substitution for a missing event type record is taken from a language that is not in the same language 
family as the selected language, the text of the data record will be shown in the Second Layer text style, and 
the text fields will be set to read-only. For example, suppose the Events Language Selector is set to "Italian", 
and there happens to be only four event type records defined for that language (the basic events Birth, Death, 
Marriage, Burial). If this check box is not checked, then only these four entries would be listed, even when the 
Events Group Selector is set to "All events". If the Fill check box is checked, then there will be over 100 event 
types shown, but most will be shown in the Second Layer text style (which typically is gray and italicized). This 
setting allows you see what you are "missing" in the current language.  These "filler" event type records in a 
different base language cannot be edited. You will need to either switch to their language first, or click the Add 
Translation button to add a translation in the currently selected language. 

Genbox is distributed with a large number of event type records defined for the base language of English 
(EN). When the language selector is set to either "English (United States)" or "English (United Kingdom)", you 
will see the list filled with the "EN" event type records instead. Because they are in the same language family, 
the text will be shown in the normal font style, and you will be able to edit them.  

Events Group List 
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The Events Group list displays the name of each event type record in the current group. You can select a 
record by clicking on its name in the list. There are four columns in the list: Class, Tag, Language, and Name. 
You can sort the list by clicking on any of the column headers. 

Multiple event types can be selected by holding down the SHIFT key and clicking a second event type. You 
can also choose "Select All" from the Edit Menu, or press CTRL+A. When multiple event types have been 
selected, most data entry fields are disabled. You are able to edit the flag check boxes. Any changes will be 
reflected in all the selected event type records. The check boxes will indicate the status of all records in the 
selected group: if the checkbox shows a check, that means all records in the selected group have the flag 
checked. If clear, none have the flag checked. If the checkbox is "colored", that means some of the records 
have the flag checked. 

When multiple records have been selected, clicking the "X" toolbar button will prompt for deletion of all the 
selected event type records.  

Class Column 

The Class column indicates the class of the event type. The classes group around life periods: birth, 
child/youth, education, family start, family end, mature, death, and burial. 

Tag Column 

The Tag column displays the event tag of the each event type record. Event tags are language invariant. 
Once defined, they should not be changed when the event type record is translated into other languages. The 
tag value is also used to identify events when performing GEDCOM import/export. 

Language Column 

The Language column displays the 2-letter or 3-letter code that identifies the language of the event type 
record. The 2-letter codes identify base languages. Some examples are:  

    ENU    English (United States) 
    ENG    English (United Kingdom) 
    EN       English base language 
    NOR    Norwegian (Bokmal) 
    DEU    German (Germany) 
    ITA      Italian (Italy)  

Name Column 

The Name column displays the name of the event type. The name is shown in the language of the data 
record.  

Tag 

The Tag box displays the tag identifier for the current event type. The tag is used to identify event types when 
exporting data in the GEDCOM format. For standard GEDCOM event tags, this box will be read-only. When 
adding new event type records for the same language, you will need to enter a unique identifier. When 
entering language variations of a tag, the tag value should remain the same: the tag text is language-
invariant. By keeping the tag value the same for each language variation, it serves to identify which event 
type records are translations of each other.  

The GEDCOM standard requires tags to be alphabetic/numeric characters only (no spaces). It is the standard 
convention to enter tags in all uppercase. For best compatibility with other programs, a leading underscore 
should be added to the front of the tag to mark the event tag as a user-defined tag. 

Secondary Type 

The Secondary Type box determines the principle roles that events of the current event type will use. Event 
records can link to up to three individuals directly, which have the role names primary, spouse, and other. 



       

They can also be associated with an individual identifier or a contact record. Choices on the drop-down list 
are: 

  

The choice for Secondary Type will determine the secondary data entry that is shown on the Individuals 
View, Events page.  

Omit 

When Omit is selected, the only link will be to the primary individual. No secondary data entry field will show 
on the Events page. 

Parents Link 

When Parents link is selected, all three principle roles will be used. In the forward direction, the context is 
that of the child, and there will be two secondary data entry fields, one for each parent. The BIRT ("birth") 
event type is a good example. In the forward direction, the event will be named "birth" and you can view/enter 
the birth information for the current individual, entering the names of the birth parents in the secondary data 
entry fields. In the reverse direction, the event name appears as "Childbirth", and the context will be that of 
one of the parents. The secondary data entry will be two data entry fields, one for the child and one for the 
other parent. 

Spouse Link 

When Spouse link is selected, the secondary data entry will hold the name of the other spouse. This 
secondary type is used for family event types, such as Marriage. 

When an event is added for an event type that has Spouse link as the secondary type, and a spouse name is 
then entered, a new family record will be created automatically. 

Spouse link event types are usually not directional, as the desired template formatting is often identical for the 
context of either spouse.  

Other Individual Link 

The Other individual link choice is similar to Spouse link, except that the two roles are "Primary" and 
"Other", not "Primary and "Spouse". The two individuals in an "other" link often are unrelated. These events 
are not considered family events. On charts, "Other individual" links are not shown. The ASSO ("associated") 
tag is an example of an Other Individual link event type. 

Other individual link types can be directional. For example, the event template for "Proposed" would be 
something like "[P] proposed to [S]" and the reverse template could be either "[S] proposed to [P]" or "[P] 
received a marriage proposal from [S]".  

Name Variation 

A secondary type of Name variation allows an individual identifier of any type to be linked to its defining 
event. Entry of a name into the secondary data entry box will also cause a new identifier record to be created. 

Identifier 

A secondary type of Identifier allows an individual identifier of a specific type to be linked to its defining event. 
Entry of text into the secondary data entry box will also cause a new identifier record of that type to be 
created. 
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Contact 

A secondary type of Contact allows an event record to link to one of the individual's contact records. This is 
useful for the Residency event type, so that the address can be indicated. The secondary data entry box will 
present a drop-down list of defined contact addresses for the current individual. 

Language 

The Language box displays the language of the current event type record. This box is read-only. 

Add Translation Button 

Whenever the language of the displayed event type record is not the same as the selected language, an Add 
Translation button will appear next to the Language box. The label on this button will contain a blue "star" 
and the missing language code. When this button is clicked, a new event type record will be copied from the 
current record, and the language will be set to the currently selected language. 

This button provides an easy way to add new records for translations of existing event types. When entering 
the translated text, be sure not to change the tag value. This data value is used to link the various translation 
records of the same event type together. 

Directional Event Types 

When Secondary Type is set to Parents link, Spouse link, or Other individual link, you can mark the event 
type as Directional with this check box. This permits the templates for the event to be different, depending on 
the context of the current individual. The Forward/Reverse button will be enabled to allow you to specify the 
settings for both contexts. 

Forward/Reverse Button 

For Directional event types, the Forward/Reverse button is used to select which set of settings to 
view/modify. Each click of the button will switch the display back and forth. The current selection will show on 
the button face, which will have a "pressed" appearance for Reverse. 

The data entry boxes within the group frame below the button are all directional, including the flags. (The 
Attribute flag and Recent flag, which appear outside the group frame, are not directional.) 

Event Name 

The Event Name box holds the descriptive name for the event type. For directional event types, a different 
name should be entered for the reverse direction. For example, the BIRT event type has a forward name of 
"Birth" and a reverse name of "Childbirth". The forward direction is for the context of the child, while the 
reverse direction is for the context of the parents. If a suitable reverse name is not readily apparent, you can 
add an asterisk after the name to distinguish it. The ASSO event type, for example, has the forward name of 
"Association" and the reverse name of "Association*". 

Event Class 

Event types can be grouped around life periods, such as youth and mature, or major changes, such as the 
start of a family. The Class box provides the following choices: 
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The event class groupings are roughly chronological.  The class assignments are used to order events when 
event date information is missing. 

Secondary Label 

The Events page can have a Secondary data entry box, for entry of the associated data with an event. The 
Secondary label will be displayed on this data entry box. 

The default secondary labels for each secondary type are: 

• Parents link: Parents (forward); Child (reverse) 
• Spouse link: Spouse 
• Other individual link: Other 
• Name variation: Name 
• Identifier: name of selected identifier type (chosen from dropdown list) 
• Contact: Address 

Chart Label 

Event data that appears on a chart is prefaced by a label that identifies its event tag. The Chart label is used 
for this purpose. The chart labels and their corresponding full event names can appear in the legend box on a 
chart. 

Template 

The template that appears on this page is the default template for the current event type. Every event type 
record has at least one template, named "default". It can be viewed and edited here, and also on the 
Templates page, which can display additional templates. 

Detail Label 

Beneath the sentence template box on the Events Page, there is a text entry box called "Detail". It can contain 
any additional text value for the event. The Detail Label box can be used to provide a hint to the user as to 
what type of data to enter into the Detail text box. It will appear immediately to its left. If no value is entered, 
the label will default to "Detail". 

Place Prefix 
Place names on narrative reports usually appear in a prepositional phrase, as in "John was born in Chicago." 
The choice for leading preposition defaults to "in" for place levels higher than local sites. The Place prefix box 
can be used to enter a preposition that should be used instead of "in", such as "from" for Emigration, or "to" for 
Immigration. The place prefix should be entered in the correct language for the event type. Leave this field 
blank to have the program use the default preposition according to the current language. 

Local Prefix 
Local site names on narrative reports usually appear in a prepositional phrase, as in "John and Susan were 
married at Christ Church, Newbury, Idaho." The choice for leading preposition defaults to "at" for local sites. 
The Local prefix box can be used to enter a preposition that should be used instead of "at". Leave this field 
blank to have the program use the default preposition according to the current language. 

Flags 
The following flags are defined for event types: 

Basic Flag 
The Basic flag identifies event types that are considered basic. The default basic event types are Birth, 
Marriage, Death, and Burial. You may wish to include other event types, such as Baptism, in the set of basic 
event types. This flag is used for the default events to show on the Individuals View Summary Page, and the 
default list of event types for the pick list on the Individuals View Events Page.  
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Group A, B, C, D Flags 
The Group flags (A, B, C, D) are for your own use. You can assign event types to these groups however you 
wish. Event data to include on charts and reports can then be selected by event type membership in these 
groups. 

Unique Flag 
The Unique flag indicates that the event type represents a single-occurrence event in the life of an individual, 
such as Birth and Death. This flag is used when processing alternate events.  

Hidden Flag  
The Hidden flag can be used to mark event types that should not be shown on the event type pick lists. This 
flag is useful for infrequently selected or obsolete event types. By marking these types as hidden, the pick lists 
will have a more manageable number of choices. Existing event data records of event types marked hidden 
are not affected.  

Standard Flag 
The Standard flag marks event types that are part of the GEDCOM 5.5 standard. 

Family Events versus Dual Individual/Family Events 

The Standard flag setting also controls how events with a Secondary Type of "Spouse Link" will be exported 
to a GEDCOM file: 

When the Standard flag is set, "Spouse Link" events will always be written to a GEDCOM file as "Family 
Events". This is the correct setting for tags like MARR, MARB, ENGA, DIV, and other tags that directly 
involve family relationships. 

When the Standard flag is clear, "Spouse Link" events that have a spouse entered will be written to a 
GEDCOM file as "Family Events", and those without a spouse entered will be written as "Individual 
Events". This is the correct setting for CENS (Census), RESI (Residence), and other event types that 
do not directly involve family relationships. 

Attribute Flag 
Attributes are individual characteristics that persist over long periods of time, such as national origin and 
religious affiliation. When the attribute flag is set, the event type record also serves to define an attribute that 
will be available to all individuals. The Detail Label will define the name of the attribute. All defined attributes 
appear on the Individuals View, Attributes page, where the values can easily be viewed and entered. Unlike 
other event secondary types that link to external records, Attribute event records store the attribute data within 
the event record itself. 

Recent Flag 
The Recent flag will be set automatically for newly added event type records, as when they are created during 
a data import. To review/modify the recent additions, you can set the Events Group Selector to "Recent 
Additions". After you have completed your update to a new event type, you can clear the Recent flag for that 
record. 

Adding New Event Types 
There are several ways to add a new event type record. First, you need to decide whether you want to add a 
translation of an existing type, or add an entirely new event type. 

If you want to add a translation for an existing event type: 

Check the "Fill" check box. 

Select the desired language from the drop-down list. 

Select the event type record of the desired type in any existing language translation. The Add 
Translation button will appear. 
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Click the Add Translation button. Or, choose Add Copy of Event Type in Selected Language from the 
Data Menu (shortcut key: CTRL+L). 

Translate all the text for the event type record, except for the tag itself. 

If you want to add an entirely new event type: 

Choose Add New Event Type from the Data Menu (shortcut key: CTRL+N). A new event type record will 
be created, with data values initialized according to the values set in the "Initial Template" record. The 
language will default to the currently selected language.  

Enter a unique value for the tag first. 

If you want to add an entirely new event type, but base it on values in the current event type record: 

Choose Make Copy of Event Type from the Data Menu. A copy of the current event type record will be 
made, with a "1" appended to the tag and to the name. 

Updating Empty Language Fields 
A database created prior to version 3.1.4 will not have any values set in the event type records for "language". 
You can update each record one at a time to enter the correct language, or you can update all of the event 
type records that have a blank language value at once. To do this update procedure: 

First, verify that that the current program language (set in Preferences on the Operation page) is the 
desired language. 

Open the Event Types View. 

Choose Update Empty Language Fields from the Data menu. When asked to confirm, choose OK. 

This operation should be performed once for older Genbox databases. 



       

Event Types View: Templates Page 
The Templates page displays the templates defined for the current event type record. Each event type will 
have a minimum of one template, which is the default template, and this template can also be viewed and 
edited on the General page. Additional templates can be defined, which will allow the user to pick the template 
he wants to use for event records.  New templates can be defined for particular subtypes of the current event 
type. Directional event type will have a pair of templates for each subtype.  

The subtype templates shown on this page are linked to the current event type record shown on the General 
page. 

• To add a new event subtype, click where it says "Add subtype" and type the text for the identifying 
SUBTYPE label. 

 

Language Selector 

The Language Selector selects the language of the event subtype records that will show in the Templates 
List. The pick list displays the names of languages that have event types defined at the top of the list: 

 

To display event subtype records for all languages, choose the "(all)" choice at the top of the list.  

Add Translation Button 

Whenever the language of the displayed event subtype record is not the same as the selected language, an 
Add Translation button will appear next to the Language Selector. The label on this button will contain a blue 
"star" and the missing language code. When this button is clicked, a new event subtype record will be copied 
from the current record, and the language will be set to the currently selected language. 

Copyright © 2005  Thoughtful Creations. All rights reserved. 194



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 195

This button provides an easy way to add new subtype records for translations of existing event subtypes. 
When entering the translated text, be sure not to change the SUBTYPE value. This data value is used to link 
the various translation records of the same event subtype together. 

Templates List 

The Templates List contains the full set of subtype records defined for the current event type. When a defined 
subtype is missing for the selected language, the "best" subtype record will be included in the list instead. If 
the language of this "best" subtype template is in a different language family, the text will be shown in the 
Secondary Data font style. 

The first template displayed is the default template for the event type. The SUBTYPE label for this record is 
displayed as "(Default)" and cannot be modified. 

The list box contains seven columns: SUBTYPE, Language, Subtype Label, Detail Label, Full Template, Brief, 
and Abbreviated.   

The SUBTYPE tag is language-invariant. Values for the other label and template columns should be entered 
in the selected language. 

You can right-click on any template and choose Magnify Templates (or click a row and press shortcut key 
F5) to edit the templates in a larger view. 

SUBTYPE 

The SUBTYPE column contains the language-invariant subtype tag that identifies the event subtype. By using 
the same text identifier for subtypes of the same event type but for different languages, the reports can 
choose the correct template according to the output language. If you are adding new subtypes, you can define 
the subtype tag in your own language. Then if your templates are used for other languages, the subtype tag 
will stay the same and the other columns will be translated.  

Language 

The Language column identifies the language of the subtype record. It displays the 2-letter or 3-letter 
language code. This value is read-only.  

Subtype Label 

The Subtype Label column contains the name that will appear on the Template Selector drop-down list on 
the Events page. It should be entered in the same language as the current Event record.  

Detail Label 

The Detail Label column contains the text that will appear as the label to the Detail box on the Events page. 
The text should be entered in the same language as the current Event record.  

Each subtype can provide its own hint to the user as to what type of additional data is expected in the detail 
field. The template can then refer to this data with the [T] sentence code. Often the detail label will be the 
same text as the subtype label.  

Full Template 

The Full Template column shows the full form of the template. This text can be edited the same way as the 
template text on the General Page.  

Brief 
The Brief column shows the brief form of the template. The brief templates can be selected for use on charts 
and in child paragraphs on narrative reports.  
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Abbreviated 
The Abbreviated column shows the abbreviated form of the template. Abbreviations can be selected for use 
on charts and in child paragraphs on narrative reports.  

Examples of full, brief, and abbreviated templates: 

 FULL BRIEF ABBREVIATED
 [P] was born [D+L] born b. 
 [P] was baptized [D+L] baptized   bp. 
 [P] died [D+L] died d. 
 [P] married [S] [D+L] married   m. 
 
Forward/Reverse Button 

For Directional event types, the Forward/Reverse button is used to select which set of templates to 
view/modify. Each click of the button will switch the display back and forth. The current selection will show on 
the button face, which will have a "pressed" appearance for Reverse. 

The subtype label, full, brief, and abbreviated template values can be different for forward/reverse directions. 
The SUBTYPE tag and Detail Label are the same for both directions. 

Deleting a Subtype Template 

To delete a subtype template, click on its row, then press the DEL key. You will be prompted to confirm the 
operation. When performed, only the subtype template record for the displayed language code will be deleted. 



       

Event Types View: Witness Roles Page 
In addition to the individuals participating in the principle roles in an event, there can be any number of 
witnesses. The names of witnesses are added to an event in the Witnesses list box on the Individuals View, 
Events page. The role that each witness plays can also be specified in the list box. 

You can define a template for named roles in an event. You can also define a default witness template for 
witnesses that are identified without one of the named roles. When reports are then generated, the witnesses 
data will be formatted into sentences along with the other event data, using the templates. 

• To add a new witness role, click where it says "Add role" and type the text for the role label.  

 

Language Selector 
The Language Selector selects the language of the event witness role records that will show in 
the Templates List. The pick list displays the names of languages that have event types defined at the top of 
the list.  

To display event witness role records for all languages, choose the "(all)" choice at the top of the list.  

Add Translation Button 
Whenever the language of the displayed event witness role record is not the same as the selected language, 
an Add Translation button will appear next to the Language Selector. The label on this button will contain a 
blue "star" and the missing language code. When this button is clicked, a new event witness role record will be 
copied from the current record, and the language will be set to the currently selected language. 

This button provides an easy way to add new witness role records for translations of existing event witness 
roles. When entering the translated text, be sure not to change the ROLE value. This data value is used to 
link the various translation records of the same event role together. 

Witness Role Templates List 
The Witness Role Templates List contains the full set of defined roles for the current event type. When a 
defined role is missing for the selected language, the "best" role template will be included in the list instead. If 
the language of this "best" role template is in a different language family, the text will be shown in the 
Secondary Data font style. 

The list box contains one row for each defined witness role for the event type. It has six columns: ROLE, 
Language, Singular, Plural, Unique Role (U), and Witness Template. 

The ROLE tag is language-invariant. Values for the other label and template columns should be entered in the 
selected language. 

You can right-click on any template and choose Magnify Templates (or click a row and press shortcut key 
F5) to edit the template in a larger view. 

Role Name 
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The ROLE column defines the language invariant names of the predefined roles for an event. By using the 
same text identifier for roles of the same event tag but for different languages, the reports can choose the 
correct template according to the output language. If you are adding new witness roles, you can define the 
role tag in your own language. Then if your templates are used for other languages, the role tag will stay the 
same and the other columns will be translated. 

Language 
The Language column identifies the language of the witness role record. It displays the 2-letter or 3-letter 
language code. This value is read-only.  

Singular 
The Singular column contains the name of the role in the language of the current event type record. It will 
appear on the Role Selector List on the Individuals View, Events Page. 

Plural 
The Plural column contains the plural form of the role name, in the language of the current event type record. 
It is used in the [WWR] (list all witnesses with roles) template code whenever two or more witnesses have the 
same role name. If no plural form is entered, the system will generate a plural form when required on reports.  

For example: for the role "groomsman", the plural would be entered as "groomsmen". 

Unique Role Column (U) 
The Unique role column ("U") contains check marks that indicate whether the corresponding roles are unique 
to the event. A unique role is one that can be filled by at most one individual. This influences the choice of 
article when formatting the text; "the" will be used for unique roles, and "a/an" for roles that can be filled by 
multiple people. 

Witness Template 
The Witness template column contains the witness templates for the predefined roles. [WE] can be used to 
refer to the Witnessed event macro, and [WR] can be used to refer to the name of the current role. The 
default witness template for most event types is "[W] <witnessed|was the [WR] at> [WE]". This produces 
sentences like "John Smith witnessed the marriage of Paul Stevens and Mary Owens in June, 1846". 

Witnessed Event Macro 
The first template displayed is the Witnessed Event Macro for the event type. The ROLE label for this 
template is displayed as "[WE]" and cannot be modified. 

The Witnessed event macro is like a portion of a template. It can contain template codes. Other witness 
templates can refer to it with the template code [WE]. This design is useful because the witness templates 
often have a portion that is common to all or most of them. By extracting this portion out and referring to it with 
its own code, the templates become simpler to understand and easier to maintain. 

Default Witness Role Template 
The second template displayed is the default witness template for the event type. This template will be used 
for witnesses that do not have defined roles. The ROLE label for this template is displayed as "(Default)" and 
cannot be modified. 

Delete a Witness Role 
To delete a witness role template, click on its row, then press the DEL key. You will be prompted to confirm 
the operation. When performed, only the witness role template record for the displayed language code will be 
deleted. 



       

Event Types View: Notes Page 
The Notes page contains a place to describe the event type, both generally and in terms of a definition, and a 
few other miscellaneous items.  

 

Default Source Type 

The data that a genealogy researcher collects comes from a variety source types. For some event types, a 
particular source type is most frequently employed, like birth registers for birth events, or marriage registers 
for marriage events. The Default source type box allows you to associate a particular source type with each 
event type. When a new source citation is then added for an event record, the default for the corresponding 
event type will initially be selected.  

Default Local Site Type 

For some event types, the local site information is often of a particular type. For Burial events, for example, 
the local site type is often "Cemetery". The Default local site type box allows you to associate a particular 
local site type with each event type. When a new local site is then added for an event record, the default local 
site will be the one associated with the corresponding event type.  

Change Date 

The Change data box indicates when this event type record was last modified. It is read-only.  

Definition 

While some event types are familiar to most people, a lot of event types are less common. The Definition box 
provides a place to explain the event type. 

Notes 

You can use the Notes box to enter any other information about the event type, such as guidelines on how 
the templates should be used, or examples of situations when other event types should be used instead.  
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Event Types View: Links Page 
The Links page contains a list box that displays one row for each Events record linked to the current Event 
Types record. A double-click on any row will cause a jump to the Individuals View of the primary individual to 
display the event. 

 

The list is read-only. It has four columns: ID, Date, Place, and Individuals. 

ID Column 

The ID column displays the ID value of the linked Event record. 

Date Column 

The Date column displays the date of the event. 

Place Column 

The Place column displays the place of the event. 

Individuals Column 

The Individuals column displays the principal individuals of the event. 
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Source Types View 
Sources used in researching a genealogy can be of many different types: birth, death and marriage registers, 
letters, wills, census records, national archive records, journal articles, family bibles, books, cemetery 
markers, church minutes, diaries, interviews, maps, obituaries, photographs, and so on. The information 
collected, and the format in which it is presented, will vary for each type. The Source Types View is used to 
define the source types: the types of data that will be stored, and how the data will be formatted on reports. 
Each time you add a new record on the Sources View for one of your source documents, you will select a 
Source Type for the record. Your selection will determine the data entry boxes that will be presented, and the 
default formatting for the data. The formatting is controlled by templates. There are three templates defined 
on the Templates page for each source type, which are used to format source citation data into sentences 
when producing reports. You can also override the default formatting and define you own formatting for each 
source record. 

            General Page 
            Settings Page 
            Templates Page 
            Notes Page 
            Links Page



       

Source Types View: General Page 
The General page shows both a summary of information for the current source template record and a list of 
source types in the current group. A different source template record can be selected by clicking on its name 
in the list box. 

 

Template Group Selector 

The Templates Group list can display the names of all Source Template records or a selected group. The 
choices provided by the Template Group Selector are:  

 

Recent additions are those that have the Recent flag checked on the Notes page. This flag is set 
automatically for event types added during a data import. 

Templates Group List 

The Templates Group list displays the name of each Source Template record in the current group. You can 
select a record by clicking on its name in the list. 

Level 

The Level box is used to assign a source level to the current record. The three source levels are represented 
by icons as follows: 

 

The Document level is generally for unpublished, loose documents (not part of larger works). The Document 
in Source level is for documents that are part of larger works, where the larger work is represented as a 
separate source record (at the Source level). The Source level is generally for published works. It can also be 
used for a collection of documents.  
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Template Name 

The Template name is the name that will appear as the Source type on the Sources View. It should be a 
descriptive name that will distinguish the current record from other source template records.  

Higher Source 

When the level for the current record is set to level 2 (Document in Source), the Higher Source box will be 
available to select the default source type for the higher source record.  

Field Labels 

While the Source Table has a fixed number of fields for storing source data, the labels that are displayed next 
to the data entry boxes on the Sources View can be changed to indicate what types of data should be entered 
into them. The default labels are slightly different for document-level sources and source-level sources. A 
table of the data fields that can have custom labels is shown below: 

Generic name (Source Types 
View) 

Default for Document Level 
(Sources View) 

Default for Source Level (Sources 
View) 

Title Doc title Source title 
Qualifier Doc qualifier Source qualifier 
Place Doc place Pub. place 
Subject Doc subject Publisher 
Date Date; Orig. date Date; Orig. date 
Locater Doc Locater Source locater 

The Place field holds a link to a Places Table record. The label can suggest a place level or purpose for the 
place that is expected. There are two Date fields which share a single label, and hold date values, either full 
dates or partial dates, such as a month and year or just a year. The Title, Qualifier, Subject, and Locater 
data fields are plain text fields that can hold anything. However, the suggestive names of these fields should 
direct usage when corresponding values are found in the source document, to lend consistency. The Title 
field is used for the identifying names of documents. The Qualifier field can store a modifier applied to the 
title, or something that in some way limits or restricts the reference. The Subject field can store what the 
document is about. The Locater field can provide the page number, call number, or other locating value, to 
locate a record in a repository or in the higher source. 

For example: the labels on the fields defined by a U.S. Census source template record could be: 
Generic 
name Custom Label Comments 

Title Schedule Tells user that the expected value is "population schedule" or some other 
schedule. 

Qualifier Page Location within the schedule. 
Place County The "County" label suggests the place level expected. 
Subject Household The "Household" label directs the user to the subject information. 

Date Census Year The "Census Year" label indicates that just a year is expected, not a full 
date. 

Locater   The "Locater" label is blank, so the default will be used. 
   

Field Defaults 

In addition to custom labels for data entry boxes, some of the data fields can have default values. When a 
new record is added on the Sources View, and the Source type is set to a source type record that has default 
values, the defaults will be copied into the fields in the new record. The user can still change the values to 
whatever he wants. 



       

The fields that can be assigned default values are: 

• Title 
• Qualifier 
• Subject 

Author Type Default 

The Author box on the Sources View, General page has a label that can be changed for each source record, 
to indicate the specific role of the "author", when the person given is, in fact, serving in some other role. The 
Author type default box can be used to specify what the default for the author label should be. Choices are:  
 

 

You can also type in your own label, if it is not available on the drop-down list. If you type in your own label, it 
becomes a fixed label that the user will not be able to change. For example, the "Interview" Source Template 
record has the Author type default set to "Interviewer", which tells the user that the name of the person 
conducting the interview should be typed in that box. 
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Source Types View: Settings Page 
The Settings page provides additional data elements for the current Source Template record. 

 

Default Name 
Each Sources record added on the Sources View needs to a have a name that will be used within Genbox. 
The name should clearly identify the record. A consistent naming system for your source records should also 
be used, so that it will be easier to find records when you want to reference them. The Default name box on 
this page is for entry of a template that will be used to name Source records. With a template defined, you can 
enter the other data fields on the Sources View, and the name will automatically be assigned, based on the 
data. 

For example, suppose you want your names to begin with the source template type, then to be followed by 
the title of the document. The special keyword [TEMPLATE] can be used to refer to the shortened form of the 
template name. The template would be: 

    [TEMPLATE]: [DOC TITLE] 

For other source template records, it could be that the subject is more important than the title, as on census 
documents. The template on those records would be: 

    [TEMPLATE]: [DOC SUBJECT] 

Recent Check Box 
The Recent check box indicates this is a recently added record. You can check and clear this field as you 
wish. 

Hidden Check Box 
When the Hidden check box is checked, the listing of the source type on the Source Type Pick List of the 
Sources View is suppressed. You may wish to hide the source types that you don't intend to use. 

Change Date 
The Change date field store the date this record was last modified. It is read-only. 
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Source Types View: Templates Page 
Each Source Templates record has three templates defined. The templates are used as the default 
formatting for source citations. They are defined on the Templates page. For help on the use of these fields, 
see the section Source Templates.  

 

Primary Citation 

The Primary citation template is used for formatting the first source citation to a source. It is the most 
complete citation.  

Secondary Citation 

The Secondary citation template is used for formatting secondary citations to a source. Its content is usually 
reduced.  

Bibliography 

The Bibliography template is used for formatting data about the source for the bibliography section of the 
report. Specifics of individual citations are often omitted from the bibliography. 
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Source Types View: Notes Page 
The Notes page provides for entry of any notes you may wish to store regarding the current source type 
record. Enter any text you wish, such as intended usage for this type, or how it differs from similar types. 
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Source Types View: Links Page 
The Links page contains a list box that displays one row for each Sources Table record linked to the current 
Source Templates record. A double-click on any row will cause a jump to the Sources View to display the 
corresponding record. 

 

The list is read-only. It has two columns: ID and Name. 

ID Column 

The ID column displays the ID value of the linked Sources Table record. 

Name Column 

The Name column displays the name of the linked Sources Table record. 
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Data Setup View 
The Data Setup View is for display and entry of identifier types, flag definitions, and other custom data items 
that are used on the other data entry views. These values are stored with the database, so each database can 
have its own values.  

            Identifier Types Page 
            Individual Flags Page 
            Media Flags Page 
            Place Flags Page 
            Defaults Page 
            Database Page



       

Data Setup View: Identifier Types Page 
Individuals in your database can have multiple identifiers. These include names that they used during various 
periods of their life, and also other types of identifiers, such as a social security number (SSN). You can also 
make up your own system of identifiers to help you keep track of the individuals in your database. 

The Identifier Types page on the Data Setup View is used to view/modify the list of identifier types that have 
been defined for the current database. This page contains a list box with one row for each identifier type that 
can be assigned to an individual, and a number of additional data fields below the list box that are associated 
with the currently selected list item. A language selector and language translation button appear above the list 
box. 

 

Language Selector 
The Language Selector selects the desired language of the identifier type records to show in the list box. 

Regardless of the language selected, the list box will show an entry for every unique identifier tag that has 
been defined. When an identifier type has not been defined in the selected language, the record with the 
"best" language match to the selected language will be shown instead. If the base language of this substitute 
record is different than the desired base language, the data values will be shown in the secondary font style 
(normally, this is gray italicized text). The data values will be read-only in this case.  

To display identifier type records for all languages, choose the "(all languages)" choice at the top of the list.  

Add Translation Button 
Whenever the language of the displayed identifier type record is not the same as the selected language, an 
Add Translation button will appear next to the Language Selector. The label on this button will contain a blue 
"star" and the missing language code. When this button is clicked, a new identifier type record will be copied 
from the current record, and the language will be set to the currently selected language. 

This button provides an easy way for you to enter translations of existing identifier types. When entering the 
translated text, be sure not to change the TAG value. This data value is used to link the various translation 
records of the same identifier type together. 

List Box 
The list box has seven columns: Tag, Language, Class, Name, Default1, Default2, and Number of Links.  
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You can reorder the identifier types be clicking and dragging lines up or down. The order that identifiers 
appear on this list determines the order they appear on the drop-down pick list on the Identifiers Page. 

For the selected identifier, additional data fields are displayed below. 

Tag Column 
Each identifier type is identified by its Tag Name during GEDCOM import/export. This provides a language-
independent way to identify and transfer identifier information. When entering a new identifier type definition, 
choose a short tag name that has not been used by another identifier type. By GEDCOM convention, custom 
tags should begin with an underscore character.  

Language Column 
The Language column displays the language code of the language for the current identifier type record. This 
value is read-only.  

Class Column 
Each identifier type belongs to an identifier class. The supported identifier classes are:  

 

Select the appropriate identifier class from the drop-down list. 

Prefix Class 

A prefix identifier is a name part that appears before other names. It is used for honorific titles and other initial 
name parts that come before the given names. A prefix identifier is not considered a full name. There is no 
"surname" associated with this name type. 

Name Class 

The name class contains all the real individual names. Each name can have a given part, a surname part, or 
both. The surname can come before or after the given names. The name should be entered in the format that 
is most common for how it was used. 

Nickname Class 

The nickname class contains names that individuals are known by. In the preferred (composite) name, 
nicknames are shown in double quotes. Surnames are not included in nicknames. 

Suffix Class 

A suffix identifier is a name part that appears after the given name and surname, and is usually separated 
from them with a comma. It is used for qualifiers added to names to make them more distinct, such as "Jr.", 
"fisherman at Broad Cove", or "Duke of Wellington". A suffix identifier is not considered a full name. There is 
no "surname" associated with this name type. 

Identifier Class 

The identifier class contains identifiers types that are not names and not user-assigned identifiers. This can 
include social security numbers and other national ID numbers.  

User ID Class 

The user ID class contains identifier types that are assigned by users of Genbox and other genealogy 
database programs. In the preferred (composite) name, user ID names are formatted with square brackets. 

Name Column 
Enter the distinct name of the identifier type in the Name column.  
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Default1 Column 
When a new individual is added to a database, the type of the initial name stored is determined by the setting 
in the Default1 column: one identifier type can be marked "default1". Normally, the "birth name" identifier type 
is marked as the initial default identifier type. 

Default2 Column 
When additional names are added for an individual, the default identifier type is determined by the setting of 
the Default2 column. Normally, the default identifier type for secondary names is "Other name" or "Name 
variant". 

Number of Links Column 
The Number of links column displays the current number of identifiers for each identifier type. This column is 
read-only.  

Short Name 
Enter a short form of the selected identifier type name in this box. This name is used on charts.  

Definition 
Enter an explanation for how the selected identifier type is used in this box. 

Include Label 
When Include Label is checked, it means identifiers of the selected type should be preceded with a label 
identifying the type. The label used is the name of the type. The label appears when the name is part of the 
preferred (composite) name, and also when "all identifiers" is selected for report content. Typically, the 
"alias", "aka", and "dit" name types are shown with a label. 

Hide 
Check the hide checkbox if the selected identifier type should not appear on the identifier type pick list on the 
Identifiers Page. By using this option, you can tailor the identifier type pick list to just those types you plan to 
use. Hidden identifier types have a shaded background in the list box.  

Note: marking an identifier type as hidden has no effect on the data. If there are existing identifier records of a 
type marked hidden, they will continue to display normally. 

Deleting an Identifier Type 
To delete the selected identifier, including all data values, press the DEL key. You will be prompted to confirm 
the operation. 

If you only wish to delete a particular translation of an identifier type, first set the language selector to "(all 
languages)". 

Note: Some identifier types cannot be deleted. 



       

Data Setup View: Individual Flags Page 
Individuals in your database can be marked with flags. A flag is a simple marker for a particular yes/no 
attribute, such as "Living" or "Attended 1992 Reunion". All of the defined individual flags appear as check 
boxes on the Individuals View, Attributes page.  

The Individual Flags page on the Data Setup View is used to view/modify the list of individual flag types that 
have been defined for the current database. This page contains a list box with one row for each flag that can 
be assigned to an individual, with an additional data field below the list box to enter the definition of the 
currently selected list item. A language selector and language translation button appear above the list box. 

 

Language Selector 

The Language Selector selects the desired language of the records to show in the list box. 

Regardless of the language selected, the list box will show an entry for every unique individual flag tag that 
has been defined. When an individual flag has not been defined in the selected language, the record with the 
"best" language match to the selected language will be shown instead. If the base language of this substitute 
record is different than the desired base language, the data values will be shown in the secondary font style 
(normally, this is gray italicized text). The data values will be read-only in this case.  

To display individual flag records for all languages, choose the "(all languages)" choice at the top of the list.  

Add Translation Button 

Whenever the language of the displayed individual flag record is not the same as the selected language, an 
Add Translation button will appear next to the Language Selector. The label on this button will contain a blue 
"star" and the missing language code. When this button is clicked, a new individual flag record will be copied 
from the current record, and the language will be set to the currently selected language. 

This button provides an easy way for you to enter translations of existing individual flags. When entering the 
translated text, be sure not to change the TAG value. This data value is used to link the various translation 
records of the same individual flag type together. 

List Box 
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The list box contains one row for each defined individual flag. The list box has five columns: Tag, Language, 
Name, Private, and Number of Links.  

Tag Column 

Each flag is identified by its Tag Name during GEDCOM import/export. This provides a language-independent 
way to identify and transfer flag information. When entering a new flag definition, choose a short tag name 
that has not been used before.  

Language Column 

The Language column displays the language code of the language for the current individual flag record. This 
value is read-only. 

Name Column 

Enter the distinct name of the flag in the Name column. Shorter names will display better. 

Private Column 

The Private column contains check boxes. Check the box if the flag is considered private. Private flags will 
not be output on reports. They can be for your internal use. 

Number of Links Column 

The Number of links column displays the current number of individuals that have this flag checked. This 
column is read-only.  

Definition 

Enter an explanation for what the select flag signifies in the Definition box.  

Deleting an Individual Flag 

To delete the selected individual flag, including all data values, press the DEL key. You will be prompted to 
confirm the operation. 

If you only wish to delete a particular translation of an individual flag, first set the language selector to "(all 
languages)". 



       

Data Setup View: Media Flags Page 
Media records in your database can be marked with flags. A flag is a simple marker for a particular yes/no 
attribute, such as "Portrait" or "Favorite". All of the defined media flag types appear as check boxes on the 
Media View, Content page.  

The Media Flags page on the Data Setup View is used to view/modify the list of media flag types that have 
been defined for the current database. This page contains a list box with one row for each flag that can be 
assigned to a media record, with an additional data field below the list box to enter the definition of the 
currently selected list item. A language selector and language translation button appear above the list box. 

 

Language Selector 

The Language Selector selects the desired language of the records to show in the list box. 

Regardless of the language selected, the list box will show an entry for every unique media flag tag that has 
been defined. When a media flag has not been defined in the selected language, the record with the "best" 
language match to the selected language will be shown instead. If the base language of this substitute record 
is different than the desired base language, the data values will be shown in the secondary font style 
(normally, this is gray italicized text). The data values will be read-only in this case.  

To display media flag records for all languages, choose the "(all languages)" choice at the top of the list.  

Add Translation Button 

Whenever the language of the displayed media flag record is not the same as the selected language, an Add 
Translation button will appear next to the Language Selector. The label on this button will contain a blue 
"star" and the missing language code. When this button is clicked, a new media flag record will be copied from 
the current record, and the language will be set to the currently selected language. 

This button provides an easy way for you to enter translations of existing media flag types. When entering the 
translated text, be sure not to change the TAG value. This data value is used to link the various translation 
records of the same media flag type together. 

List Box 
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The list box contains one row for each defined media flag type. The list box has four columns: Tag, 
Language, Name, and Number of Links.  

Tag Column 

Each flag is identified by its Tag Name during GEDCOM import/export. This provides a language-independent 
way to identify and transfer flag information. When entering a new flag definition, choose a short tag name 
that has not been used before.  

Language Column 

The Language column displays the language code of the language for the current media flag type record. 
This value is read-only. 

Name Column 

Enter the distinct name of the flag in the Name column. Shorter names will display better. 

Number of Links Column 

The Number of links column displays the current number of media records that have this flag checked. This 
column is read-only. 

Definition 

Enter an explanation for what the select flag signifies in the Definition column.  

Deleting a Media Flag 

To delete the selected media flag, including all data values, press the DEL key. You will be prompted to 
confirm the operation. 

If you only wish to delete a particular translation of a media flag, first set the language selector to "(all 
languages)". 



       

Data Setup View: Place Flags Page 
Places in your database can be marked with flags. A flag is a simple marker for a particular yes/no attribute, 
such as "Repository" or "Visited". All of the defined flags appear as check boxes on the Places View, Contact 
page. 

The Place Flags page on the Data Setup View is used to view/modify the list of place flag types that have 
been defined for the current database. This page contains a list box with one row for each flag that can be 
assigned to a place, with an additional data field below the list box to enter the definition of the currently 
selected list item. A language selector and language translation button appear above the list box. 

 

Language Selector 

The Language Selector selects the desired language of the records to show in the list box. 

Regardless of the language selected, the list box will show an entry for every unique place flag tag that has 
been defined. When a place flag has not been defined in the selected language, the record with the "best" 
language match to the selected language will be shown instead. If the base language of this substitute record 
is different than the desired base language, the data values will be shown in the secondary font style 
(normally, this is gray italicized text). The data values will be read-only in this case.  

To display place flag records for all languages, choose the "(all languages)" choice at the top of the list.  

Add Translation Button 

Whenever the language of the displayed place flag record is not the same as the selected language, an Add 
Translation button will appear next to the Language Selector. The label on this button will contain a blue 
"star" and the missing language code. When this button is clicked, a new place flag record will be copied from 
the current record, and the language will be set to the currently selected language. 

This button provides an easy way for you to enter translations of existing place flags. When entering the 
translated text, be sure not to change the TAG value. This data value is used to link the various translation 
records of the same place flag type together. 

List Box 
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The list box contains one row for each defined place flag.  The list box has four columns: Tag, Language, 
Name, and Number of Links.  

Tag Column 

Each flag is identified by its Tag Name during GEDCOM import/export. This provides a language-independent 
way to identify and transfer flag information. When entering a new flag definition, choose a short tag name 
that has not been used before.  

Language Column 

The Language column displays the language code of the language for the current media flag type record. 
This value is read-only.  

Name Column 

Enter the distinct name of the flag in the Name column. Shorter names will display better.  

Number of Links Column 

The Number of links column displays the current number of place records that have this flag checked. This 
column is read-only. 

Definition 

Enter an explanation for what the selected flag signifies in the Definition column.  

Deleting a Place Flag 

To delete the selected place flag, including all data values, press the DEL key. You will be prompted to 
confirm the operation. 

If you only wish to delete a particular translation of a place flag, first set the language selector to "(all 
languages)". 



       

Data Setup View: Defaults Page 
The Defaults page contains miscellaneous database setup items.  

 

Current Researcher 

Whenever data is updated, the ID of the current researcher is stored to the Researcher ID field in the record. 
This identifies the person who last updated the record. When you first start Genbox, the current researcher 
will be set by default to the value stored in the Current researcher box on this page.  

Default Indicators for Surety Levels 

When narrative reports are produced, the surety levels on data can be used to choose the wording that 
introduces the data. If a place or date value does not have a modifier stored with the data, and the surety is 
level 1, 2, or 3, the wording shown on this page will be used. You can use these fields to choose the default 
wording you want to use, then you only need to type in the modifiers on the data fields that you want to be 
different than the defaults.  

Default Folder for Media Files 

For media files that do not have complete paths, this preferred folder will be checked if the media file is not 
found in the "Preferred" folder, which is set in Preferences. By using relative file paths, it is easy to redirect the 
location where media files are found to another directory. This data entry box can be used to specify a new 
path that will be searched for all relative media files in the current database. 

If your entered text matches the file prefix of one or more media data records, you will be prompted "Change 
matching media file names to relative paths?". If you choose Okay, the file prefix on the matching media 
records will be replaced with the text "data". This will be interpreted by the system as the default folder 
specified here in data setup. 
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Data Setup View: Database Page 
The Database page provides a place to store your comments about the database. It also displays and 
provides control of the languages stored in the database.  

 

Copyright Statement 

Enter your copyright statement into this field. It will be included in exported GEDCOM files.  

Content Description 

Enter any comments you want to store about the database: a description of the contents, where this data 
originated, why it is interesting, or any other thoughts.  

Languages List 

A Genbox database can store multiple translations for a number of record types. These record types are: 

• Event Types 
• Individual Identifier Types 
• Individual Flags 
• Place Flags 
• Media Flags 

The Languages List on this page displays one row for each language that is stored in the current database. 
For each language, it shows the following counts: 

• total number of records 
• number of event type records (this includes subtypes and roles) 
• number of data setup records (this includes identifier types, individual flags, place flags, and media 

flags) 

Deleting All Records for a Language 

You can delete all language translations for a language or group of languages: 
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1. Click a row, or select a range of rows, to indicate which language records you want to delete. 
2. Press the DEL key. 
3. You will be prompted to confirm the operation. Click OK. 

Caution: This operation will remove all data records in the current database that are marked for the selected 
language(s). 

Note: Records for the current program language, output language, or base language of either cannot be 
deleted with this function. 
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Preferences View 
The fonts, colors, and sizes of the windows in Genbox can be customized. The format for dates and names 
can be selected. Additional operational parameters can also be controlled. These preferences are set on the 
Preferences View.  

            Fonts Page 
            Windows Page 
            Colors Page 
            Dates Page 
            Names Page 
            Operation Page 
            Style Page 
            Programs Page 
            Web Pages Page  

There is a row of buttons at the bottom of the view:  

• Click the Close button to save changes and close the view. 
• Click the Apply button to apply the changes to all open windows, and leave the view open. 
• Click the Reload button to restore preference settings to the way they were when Genbox was 

started. 
• Click the Defaults button to reset all preference settings to the way they were when Genbox was 

delivered. 
• Click the Cancel button to ignore your changes and close the view. 



       

Preferences View: Fonts Page 
The fonts used by Genbox to display the text on the views and other windows can be selected on the Fonts 
page. There are five font buttons for the main fonts, which display the current font settings on the button face. 
There are three font buttons for styles for special purposes. Clicking a font button will open the Select Font 
Dialog, where you can change the settings for the font. 

 

Main Fonts: 

Headers Font 
Labels Font 
Text Boxes Font 
Notes Font 
Lists Font

Styles: 

Marked Records 
Second Layer Text 
Auto-generated Text 
 
Text Expansion Percentage 
Font Buttons Demonstrate Font 
Genbox and System Defaults

Headers Font 

The Headers font is used in the headers section of view windows. Normally it has a larger font size than the 
Text boxes font. 

Labels Font 

The Labels font is use for text labels on the view windows. Normally it is the same size as the Text boxes 
font, but with bold styling. 
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Text Boxes Font 

The Text boxes font it the main font for view windows. It is the font used to display data. 

Notes Font 

The rich text Notes boxes on the data views will use this font. Rich text typically looks better with a serif font, 
such as Times Roman. 

Lists Font 

The Lists font is used for list boxes on the data views. It will be used for the column headings, and also for the 
rows if the list is read-only. 

Marked Records 

Certain data records in Genbox can be marked. To indicate when a link is to a marked record, the text will be 
shown with a special style. This style can be set by clicking the Marked records font button. The "marked" 
style is applied to the font that would normally have been displayed. 

Note    Only the font styles can be set with the marked records, second layer text, and auto-generated text 
buttons; the font family and font size will remain the same. Styles include the text color, bolding, and italics. 
The default marked record style is "red, italic". 

Second Layer Text 

For certain text boxes throughout the system, there are two types of values. In each case, it would be helpful 
to have an easy way to distinguish between the two types. The second layer text style is used for this 
purpose. It is applied to the font that would normally have been displayed. Values considered to be of the first 
type will be shown in the normal font; values considered to be of the second type will be shown with the 
second layer text style applied to the normal font.  The default second layer text style is "gray, italic". 

Hint    Choose a style that is different than the marked records and auto-generated text font styles. 

The second layer text style is used in the following places in the system: 

• Individuals View, Summary page: on the Children list, children of the currently displayed spouse will 
be shown in the normal font; children of other spouses will be shown in the second layer text style. On 
the Event list, individual events and family events for the currently displayed spouse will be shown in 
the normal font; family events with other spouses will be shown in the second layer text style. 

• Individuals View, Events page: when editing alternate event records, corresponding data values 
stored in the linked event record will be visible, shown in the second layer text style. Values entered in 
the alternate event record will be shown in the normal style. This allows you to see where the 
alternate event record data differs from the linked event record data. You can think of the linked event 
record as "showing through" or "behind" the alternate event record view. 

• Individuals View, Contact page: when editing group contact records, the shared text values will be 
shown in the second layer text style, to remind you that changes made to those fields will affect all 
individuals in the group. Contact records that are not shared (and the Mailing name field for the 
current individual, which is never shared) will be shown in the normal text style. 

• Chart Options View, Content and Styles pages: when viewing content and style settings for Key 
Individuals, Direct Lines, or Individuals in Lists/Queries, the content and style settings for Default will 
"show through" wherever a setting in the current set has not been set. This allows you to see what the 
final result will be for boxes in the current set. Values that have been changed for the current set will 
be shown in the normal font; the default values that "show through" in the other boxes will be shown in 
the second layer text style. 

• Citations View, Assertion Page: when viewing a source citation embedded in a note, all citations 
embedded in the same note are shown in the Cited Sources List; those that cover the same text 
range as the current citation are shown in the normal text style; those that are for a different range of 
text are shown in the second layer text style. 
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Auto-generated Text 

For certain text boxes throughout the system, there are displayed values that have been automatically 
generated by Genbox and do not represent stored data. The auto-generated text style is used to distinguish 
these "display-only" values from stored data values, which are shown in the normal font style.  The default 
auto-generated text style is "green, italic". 

Hint    Choose a style that is different than the marked records and second layer text font styles. 

The auto-generated text font style is used in the following places in the system: 

• Individuals View, Summary page: blank basic events in the Event List that have been added 
according to the "Show blank basic events" preferences option are shown in this style. As soon as 
you enter a date or place for one of these event rows, the font style will change to the normal style, 
indicating this is now an actual event record for the current individual. 

• Individuals View, Summary page, Age column and Events View, Age box: the age at time of 
event computed by Genbox as the difference between the event date and birth date of the individual 
are shown in the auto-generated text style. When an "age at time of event" is entered manually, it will 
be shown in the normal text style and override the auto-generated value. 

Text Expansion Percentage 

The Text Expansion Percentage box lets you specify a percentage increase in the spacing between all 
controls on the View windows. When nonzero, the spacing of labels, edit boxes, and other controls is 
expanded. This option is provided for better display of text for international versions, which often require 
additional space for the translated labels. 

Font Buttons Demonstrate Font 

Click the Font buttons demonstrate font check box if you want the font buttons on all the view windows to 
format the font description information on the face of the buttons in the selected font. If you are using 
extremely small or large font sizes, you may wish to clear this check box. 

Genbox and System Defaults 

There are two buttons for returning the settings on this page to default values:  

• Click the Genbox Defaults button to set the font settings to program defaults. 
• Click the System Defaults button to set the font settings to Windows font defaults. 



       

Preferences View: Windows Page 
Genbox can display each view window in a standard size, a custom size, or maximized to fill the desktop. 
Settings for window sizes and positions are set on the Windows page.  

 

View Windows 

Most view windows have been designed to fit on screens with a minimum resolution of 640 by 480. Some 
view windows are now designed for a minimum resolution of 800 by 600. With an even larger screen 
resolution, such as 1152 by 864, you can easily view multiple windows at once. Views can be resized by 
dragging their borders. This allows you to see more information. The normal behavior is that when the view is 
closed, this new size is forgotten, and the default size will again be used the next time the view is opened. 
With the View Windows group, you can change this default behavior. You can also set the default fixed size 
for windows. Choices are:  

• Default size 
• Fixed size 
• Remember size 
• Remember size and position 

When Default size is chosen, view windows will be displayed in their default minimum sizes. The default size 
for most views is 626 by 363. Some views now have larger default sizes: Individuals, Chart Options, Data 
Setup, Event Types, and Lists.  

When Fixed size is chosen, the values specified for fixed width and fixed height are used as the initial size 
of all of the view windows. These are the values appearing in the two edit boxes to the right of the Fixed 
choice. The default values are 626 (wide) by 363 (high). The sizes are for the interior of the view window; 
space for window borders will be added to the indicated size. 

When Remember size is chosen, each view window will return to its previous size when it is reopened, 
ignoring the Fixed size values. This option allows you to individually size each view window to your 
preference. 

View windows normally cascade when opened, overlapping the previously opened window but with an offset 
to the right and down. When Remember size and position is chosen, each view window will return to the 
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same position and size it last appeared on the screen. This option allows you to automatically lay out view 
windows in a particular arrangement on the screen. 

Data Dialog Windows 

The modal dialog windows that display data are resizable. When the Remember size checkbox is marked, 
their custom sizing will be remembered the next time they are opened. This applies to the pick dialogs, 
template preview dialogs, and magnify dialogs. 

Maximize Windows 

You may prefer to see certain views maximized. A maximized view will fill the screen. The choices for 
maximized views are:  

• Main application 
• Chart View 
• Report View 
• Individuals View 
• All views 

The default is maximized for the main application window, chart views, and report views, and not maximized 
for the other views. 

Grid Lines 

List boxes appear throughout the system: they have labeled columns with multiple rows appearing in a box. 
You may prefer to see grid lines that show the divisions into columns and rows. The grid lines can make 
easier it scan along a row or down a column in a list box. 

There are two kinds of list boxes in Genbox: those that can be used to enter/modify data, and those that are 
for viewing/selection only. Click Data entry lists to enable grid lines on data entry list boxes. Click All lists to 
enable grid lines on all list boxes in the system. 

Auto-close Output Views 

When this option is checked, the "Make Chart" and "Make Report" buttons on the Chart Options View / Report 
Options View will first close a previously made chart/report, if not closed already, before opening a view 
window for the new chart/report. The default is "checked". 

Defaults 

Click the Defaults button to restore all the window sizes and positions to Genbox default values.  



       

Preferences View: Colors Page 
Genbox can display the view windows in different colors. This makes it easier to identify what type of data 
each view is showing, particularly when multiple views are open at once. Settings for window colors are set on 
the Windows page.  

 

Window Backgrounds 

Genbox can display the view windows in different colors. This makes it easier to identify what type of data 
each view is showing, particularly when multiple views are open at once. There are 20 color buttons, each 
for a different view window. Click a color button to open the Select Color Dialog to change the color of the 
corresponding view.  

No Colors Check Box 

If you prefer to see all the view windows in standard gray, click the No colors check box. This setting may be 
helpful when using a limited display device. The color choices will be remembered and restored when the No 
colors check box is later cleared.  

Read-only Lists 

Some list boxes in Genbox are read-only. To make this restriction apparent, the background of the box can be 
shaded. The default color for read-only list boxes is light yellow. 

Read-only Notes 

When a notes box has been toggled to show field values instead of field codes, the box is in read-only mode. 
To make this restriction apparent, the background of the box can be shaded. The default color for read-only 
note boxes is an off-white (ivory). 

Excluded or Hidden Data 
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Some data records in Genbox can be marked "excluded". Also, some individual data items can be marked 
"hidden". To make these settings apparent, the background of the data items can be shaded. Excluded 
records will have the ID box shaded. The default color for excluded or hidden data is a light gray. 

Field Codes 

Field codes that appear in notes, event templates, and source citation formatting can be automatically 
colored to distinguish them from data. The Field codes button is used for this purpose. Genbox field codes 
always appear in [square brackets]. Field code coloring is only used for preview within the program; program 
output (charts and reports) is unaffected. When a note or event template has been toggled to display field 
values, the field values will also be colored. The default color for field codes is blue. 

Unknown Codes 

Unknown field codes that appear in notes, event templates, and source citation formatting can be 
automatically colored in a different color than recognized field codes. This makes it easy to identify when you 
have mistyped a field code.  The Unknown codes color button is used for this purpose. Unknown field code 
coloring is only used for preview within the program; program output (charts and reports) is unaffected. When 
an unknown field code is encountered on a report, it will be output to the report as normal text. This means 
that when you have text in square brackets that is not a field code and is intended to be displayed, such as 
"[sic]" or "[editor]", you don't need to use the backslash escape characters in order to have the brackets 
printed. The bracketed text will be colored in the "unknown code" color within the program, but the coloring will 
not interfere with the output. The default color for unknown field codes is a dark green. 

Defaults 

Click the Defaults button to restore all the window colors to Genbox default values.  



       

Preferences View: Dates Page 
Dates are an important part of genealogy. The Dates page allows you to control how dates are formatted on 
the display and on charts and reports.  

 

Long Dates and Short Dates 

Genbox formats dates using one of two date formats, depending on where the dates appear throughout the 
system:  

• Long dates are used when space is not limited, as on the Events page. 
• Short dates are used when space is limited, as when dates appear as a column on a list view. 

Charts and reports can optionally be set to user either long date or short date formatting. Charts use short 
dates by default, while most reports use long date formatting by default. 

Date Format 

You can set date format independently for long dates and short dates. The long and short sample boxes 
show the results of your date format choices, for a sample long date and short date. 

• Click the Long button to view/select settings for long date format. 
• Click the Short button to view/select settings for short date format. 

Dates have three parts: the day, the month, and the year. Your preference for ordering the parts can be 
selected from the Order box: 

 

The selected ordering will be used when displaying dates on the screen and charts and reports. It will also be 
the assumed order when dates entered into the system are ambiguous. 

The Day box lets you choose whether a leading zero is included for day numbers less than 10. 
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The Separator1 and Separator2 boxes let you choose the separating character, if any, between the first and 
second parts, and between the second and third parts. You can type in your own character, or choose from 
slash, dash, period, or comma. 

The month box lets you choose the format for the month part. The sample month "February" is shown with 
the formatting applied, which in each case is a combination of abbreviation, capitalization, and punctuation: 

 

Default Century 

When dates are entered with two-digit years, the Default century value will be added to produce a 4-year 
date. 

Double Dates 

When Automatic double dates is checked, dates entered with a year between 1583 and the specified Cutoff 
year (default is 1752) that occur between January 1 and March 24 will be changed automatically into double 
date format. See the section Double Date Format for a discussion of double dates. 

Typically, the cutoff year is set to the year that the country of your ancestors switched to the Gregorian 
calendar. If you have double dates from multiple countries, change the cutoff year to be later than the latest 
double date.  

You can also manually enter double dates, for any year after 1582, regardless of the current setting for cutoff 
year. 

Living Individuals 

There is an option on charts and reports to restrict the inclusion of data for Living individuals. For individuals 
that have a date of death entered, or have the Living check box checked, the living status is known. 
Otherwise, the program will make a decision on whether to consider an individual as living based on birth date 
and the age value entered in the Living Age box on this page (default is 100). 

Date Labels 

Date values can be qualified with words like "about", "estimated", "before", and "after". They can be a span, 
such as "from 1861 to 1865". They can be range of possible dates, such as "between 12 April 1745 and 27 
June 1745". There are eight types of qualifications that are understood by the program for purposes of sorting 
dates. The labels used can be selected for each, and two sets of selections can be made: a "Short label" set 
for use with short dates, and a "Long label" set for use with long dates. The Long and Short buttons can be 
pressed to select which set of labels to view/change.  

 

The label choices are: 

Qualifier Type Label Choices 
About about, abt, a, circa, cir, ca, ~ 
Est estimated, est, say 
Cal calculated, calc, cal 
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Before before, bef, < 
After after, aft, > 
Span from .. to .. , frm .. to .. , .. to .. , .. – .. (reports only) 
Range between .. and .. , between .. & .. , bet .. and .. , bet .. & .. , .. – .. 
BC / AD B.C.  A.D., BC  AD, B.C.E.  C.E., BCE  CE 
   

Note When selected, the ".. – .." Span choice will only be used on reports; the ".. to .." choice will be used on 
the screen. Entry of dates in the ".. – .." format will always be interpreted as a Range qualifier. 

Show Christening when Birth Unknown 

Click this check box to allow christening or baptism event dates to be used on charts and reports in place of 
birth event dates when birth event information is missing. 

Show Burial when Death Unknown 

Click this check box to allow burial event dates to be used on charts and reports in place of death event dates 
when death event information is missing. 

Show Since/Until for Incomplete Spans 

When checked, the qualifier "since" will be shown on a date span missing the ending date in place of "from", 
and the qualifier "until" will be shown on a date span missing the starting date in place of "to". This is an output 
formatting option which does not affect how data is stored or entered. Examples: 

    John has resided at 2984 Maplewood Ave, Family Village, Iowa since May, 1964. 
    Carl worked at the brewery until December, 1941. 

This option is checked by default.  

Defaults Button 

The Defaults button will reset the preferences on this page to their default values. 



       

Preferences View: Names Page 
The display and data entry options for individual names and place names are selected on the Names page.  

Note    The display and data entry options available for individual names apply to names viewed and entered 
on the Summary page and in other secondary reference fields in Genbox. Names displayed and modified on 
the Identifiers page will appear exactly as entered. 

 

Display Settings - Individual Names: 
Mark surnames with /Slashes/ 
Show surnames in UPPERCASE 
Show ID numbers after names

Display Settings - Place Names: 
Show commas for missing levels 
Show place levels after names 
 
Data Entry Settings - Individual Names: 
Confirm new individuals 
Convert to initial caps 
Process embedded names

Display Settings - Place Names: 
Confirm new places 
Convert to initial caps

Search - Individual Names: 
Ignore Diacritics

Mark Surnames with /Slashes/ 

When checked, surnames will be shown with a slash character before and after the surname. This can help 
identify the surname portion in names that have nonstandard part order or multi-word surnames. 
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Note    On the Identifiers page, slashes are always shown around surnames, for name types that can have 
surnames. The Name box on the Summary page also shows slashes around surnames regardless of this 
preferences setting. 

Show Surnames in UPPERCASE 

When checked, surnames will be shown capitalized. This can help identify the surname portion in names that 
have nonstandard part order or multi-word surnames. 

Show ID Numbers After Names 

All individual records in the database have a unique numeric ID value. Sometimes it is helpful to see these ID 
values after each name reference, particularly when several people in the database have similar names. 

When checked, you can type a character into the Prefix and Suffix boxes to delimit the ID value. Normally 
parentheses are used, producing name references like "John Smythe (3641)". 

Confirm New Individuals 

When checked, a message box will appear each time an unrecognized individual name is typed into a 
secondary reference box, prompting whether a new individual by that name should be added to the database.  

Individual Names: Convert to Initial Caps 

When checked, each word of newly entered individual names will be formatted with a leading capital letter and 
the rest lowercase. This option helps to correct inconsistency in letter case during entry. It is particularly useful 
in formatting names imported from a GEDCOM file where all or some of the names are in uppercase. 
Because Genbox can selectively show surnames in uppercase, the data itself does not need to be stored that 
way. 

This function can handle a number of exceptional cases, including names like "McDonald".  

Hint    If you find that the function did not capitalize an unusual name correctly, go to the Identifiers page 
where you can type in names exactly as they should appear. 

Process Embedded Names 

When checked, names that are "embedded" within newly entered individual names will be identified and 
removed to separate name records. The removed names will be marked as "preferred", so that the resulting 
composite name will appear virtually the same as the text originally entered. The types of embedded names 
that can be recognized are:  

• Nicknames: names placed within double quotes 
• Suffixes: portions following a comma 
• Other names: names placed within parentheses 
• Aliases: names following the words "alias" and "aka" 

Advantages of removing the embedded names to separate name records include: 

• Each name can be independently documented with source citations, a defining event, and notes. 
• Nicknames that have been identified can be used on narrative reports. 
• Charts and reports can selectively display names of specific types. 
• The composite name can easily be changed by clicking on the "Preferred" checkmarks for each 

name. 

Hint    If you need to store parentheses or double quotes as part of name, go to the Identifiers page, where 
you can type in names exactly as they should appear. 
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Show Commas for Missing Place Levels 

When checked, commas will be inserted into place names for skipped place levels. For example, if a place 
name of "Chicago, Illinois" was typed, it would be displayed as "Chicago,,, Illinois", which indicates that the 
township level and county level names were omitted.  

Show Place Levels After Names 

When checked, the level numbers of the name parts will be shown after each place name in parentheses. 
This can be helpful when working with places, because sometimes the place levels for each part are not 
obvious. For example: 

    Springfield, Sangamon County, Illinois, United States (2-456) 

Each number corresponds to a part name: here, "2" is the level number for "Springfield" (indicating it is at the 
city level); "4" is the level number for "Sangamon County" (indicating it is at the county level). 

When Show Commas for Missing Place Levels is also set, a dash is displayed for an empty level, as shown 
for the "Township" level above. 

Confirm New Places 

When checked, a message box will appear each time an unrecognized place name is typed into a secondary 
reference box, prompting whether a new place by that name should be added to the database.  

Place Names: Convert to Initial Caps 

When checked, each word of newly entered place names will be formatted with a leading capital letter and the 
rest lowercase. This option helps to correct inconsistency in letter case during entry. It is particularly useful in 
formatting names imported from a GEDCOM file where all or some of the place names are in uppercase. 

This function can handle a number of exceptional cases, including names like "McDonald".  

Hint   If you find that the function did not capitalize an unusual place name correctly, go to the Places Names 
page where you can type in names exactly as they should appear. 

Ignore Diacritics 

When checked, the Ignore Diacritics checkbox on the Individuals Pick Dialog will be checked by default. 



       

Preferences View: Operation Page 

The default choices for a number of operational parameters are specified on the Operation page. 

 

System Startup 
Check Restore Open Databases to begin each Genbox session by opening the databases that were open 
the last time Genbox was closed. 

Data Entry 
Data entry can be set to Enabled or View only. 

With the Enabled setting, data can be entered simply by typing the new data in the appropriate edit box. 
Editing is "always active" in the sense that you do not need to first activate a special "edit mode" or separate 
data entry window. Changes are also saved automatically. 

With the View only setting, Genbox will not permit data entry. Attempts to type into data text boxes will have 
no effect. Other types of controls that are also bound to data, such as check boxes and radio buttons, may 
appear to accept input, but changes are not saved to the record when you move to a different record. The 
database file is set to read-only mode. Data imports are also disabled. 

With view only mode, you can continue to view all of the data, produce charts and reports, perform queries, 
and export data. You can explore Genbox, clicking and typing, while feeling secure that you will not 
inadvertently alter any data.  

First Individual 
Check Last viewed to automatically move to the record on the Individuals View that was last viewed when the 
database is first opened. 

Check Home individual to automatically move to the designated home individual when the database is first 
opened. 

Units 
Measurements displayed throughout Genbox can be shown in English or Metric units, depending on this 
selection.  
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Individuals View Summary 
Check Show blank basic events to have the event types marked with the "basic" flag to appear automatically 
in the Events List on the Individuals View Summary Page. This option is convenient when entering data for 
new individuals on the Summary Page, because you do not need to select the event types for the new records 
first. You can begin immediately by typing the dates and places for the basic events into the appropriate 
blanks. When a basic event shown in the list is blank, it will be shown in the auto-generated text font style. 
As soon as data is entered, the event record will be stored to the database and the font style will switch to the 
normal font style. 

Check Sort basic events first to have events that are basic appear first in the Events List on the Individuals 
View Summary Page. This option makes it easy to see this essential information when browsing through 
individual records. Normally, all events are sorted in chronological order. 

Check Hide non-basic attributes to hide attribute events from the list of events on the Individuals View 
Summary Page. Attributes often do not have an associated date or location value, so their appearance on the 
Summary page may not be desirable. When this option is checked, the display includes only the "real" events. 
Other page displays are not affected. 

Check Allow place column overflow to make better use of screen space on the Individuals View Summary 
Page. Whenever there is no value for the "subject" of an event, this option allows long place names to 
"overflow" the place column and also occupy the space in the subject column. This makes them easier to 
read. Note: if grid lines are enabled for data entry lists, this feature is disabled. 

Enable View Previews 
When Enable Video Previews is checked, videos that are linked to data records as the primary media will 
automatically be loaded when the linked data record is shown. The frame selected for the preview position will 
be displayed. If this option is not selected, videos will not be loaded until the Play button is clicked, and the 
media button will appear blank until then. 

A video must be loaded in order to access its preview frame, and loading videos can take several seconds. 
You may wish to clear this checkbox to avoid these delays.  

Report Options File for Preview Dialogs 
On the Individuals View, Events page, the Event Template Preview Dialog and Event Witness Template 
Preview Dialog allow you to preview the formatting of events before you generate a full report. The formatting 
includes any footnotes. The preview text is formatted according to the Report options file for preview 
dialogs. You can type the name of the file, or click the "..." button to select it from the File Open Dialog. 

Preferred Folder for Media Files 
For media files that do not have complete paths, this preferred folder will be checked first. By using relative file 
paths, it is easy to redirect the location where media files are found to another directory. 

If your entered text matches the file prefix of one or more media data records, you will be prompted "Change 
matching media file names to relative paths?". If you choose Okay, the file prefix on the matching media 
records will be replaced with the text "pref". This will be interpreted by the system as the preferred folder 
specified here in preferences.  

Languages 
The languages shown in the program and on output (charts and reports) can be independently selected.   

• Use the Program language selector to select the language for the program.  
• Use the Output language selector to select the language that should be used when generating charts 

and reports. 

Some languages include a flag icon for the nation associated with the language. These flag icons will also be 
shown in the status bar. 

The language choices available on the language selectors can include the full set of languages currently 
installed in the Windows operating system. Or, you can check Choose from installed/in use only, in which 
case only languages for which a Genbox resource file has been installed (or for which data records have been 
defined) will appear on the dropdown language selectors throughout the program. 
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Note: language support for most languages is not complete. Selecting a program or output language tells the 
program the desired language. Text will be in that language when resources are available; otherwise another 
language resource will be substituted.  

Language Support 
Support for multiple languages is being added to Genbox in stages. Currently, the following data items have 
been translated or support multiple languages:  

• Month names, weekday names. This affects the display of dates and the text on Calendar reports. 
• Pronouns, prepositions, conjunctions. These and other "closed class" words are used on charts 

and reports. 
• Event types. The event types have been enabled for multiple languages. Genbox is distributed with a 

varying number of translated event type for some languages. Users can add their own translations as 
needed.  

• Identifier Types, Individual Flags, Place Flags, Media Flags. These records on the Data Setup 
View support multiple languages. 

• Program menus, windows, dialogs, and messages. Genbox is distributed with resource files for 
English (United States), English (United Kingdom), and a number of other languages. More languages 
will be made available in the future. 

• This Help file: currently in English only. 
• User's Manual: (in development) 

Resource files distributed with Genbox may include: 

• GenboxENU.dll English (United States) 
• GenboxENG.dll English (United Kingdom) 
• GenboxAFK.dll Afrikaans 
• GenboxCSY.dll Czech 
• GenboxDAN.dll Danish 
• GenboxNLD.dll Dutch (Netherlands) 
• GenboxNLB.dll Dutch (Belgium) 
• GenboxFIL.dll Filipino 
• GenboxFRA.dll French 
• GenboxDEU.dll German 
• GenboxHUN.dll Hungarian 
• GenboxITA.dll Italian 
• GenboxNOR.dll Norwegian (Bokmal) 
• GenboxNNO.dll Norwegian (Nynorsk) 
• GenboxPLK.dll Polish 
• GenboxPTB.dll Portuguese (Brazil) 
• GenboxPTG.dll Portuguese (Portugal) 
• GenboxRUS.dll Russian 
• GenboxSKY.dll Slovak 
• GenboxSLV.dll Slovenian 
• GenboxVIT.dll Vietnamese 

When a resource file for the selected program language cannot be found, a warning message will be 
presented. Most program text will not be shown translated in this case.  



       

Preferences View: Style Page 
The default choices for a number of report style settings are specified on the Style page.  

 

No Publication Place 
The No publication place dropdown list controls formatting citation text for missing publication place data in a 
source record. Default choices are:  

 
You can also type in your preferred text. 

No Publisher 
The No publisher dropdown list controls formatting citation text for missing publisher data in a source record. 
Default choices are:  

 
You can also type in your preferred text. 

No Publication Date 
The No publication date dropdown list controls formatting citation text for missing publication data in a 
source record. Default choices are:  

 
You can also type in your preferred text. 

Show Program Language Flag, Show Output Language Flag 
The flag icons that appear on the status bar can be removed by clearing these check boxes. 
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Preferences View: Programs Page 
Genbox includes built-in viewers and players for the data types it supports. You can also specify that the 
external, system default viewer or player be used for specific data types. This selection is performed on the 
Programs Page. 

 

Rich Text Reports 
When Internal viewer is selected, generated reports in RTF format will be displayed within Genbox, on the 
Report View. This view allows you to scroll and zoom, and add annotations. When RTF default application is 
selected, generated reports will open directly in your default rich text application, such as Microsoft Word or 
Corel WordPerfect. There, you will have full edit and reformatting capabilities. 

HTML Reports 
When Internal browser is selected, generated web pages will be displayed within Genbox, on the Web Page 
View. This view acts like a normal browser, with some added paging capabilities. When Default browser is 
selected, generated web pages will open directly in your default web browser, such as Internet Explorer or 
Netscape. 

Video Player 
When Internal player is selected, video media files will be played with the player within Genbox. When 
Default player is selected, video files will be played in your default media player, such as Windows Media 
Player or Quicktime. 

Audio Player 
When Internal player is selected, audio media files will be played with the player within Genbox. When 
Default player is selected, audio files will played in your default media player for audio, such as Windows 
Media Player or RealAudio. 

Image Viewer 
When Internal player is selected, image media files will be viewed with the "Show Media Dialog" in Genbox. 
When Default viewer is selected, image files will be viewed in your default media player for images, such as 
Windows Media Player.  

Copyright © 2005  Thoughtful Creations. All rights reserved. 240



       

Preferences View: Web Pages Page 
The default choices for web page creation are specified on the Web Pages page. 

 

Local Folder 

Generated web pages will be stored to the location specified in the Local folder box. The location should be a 
path to a directory on a local drive. When the Prompt check box is checked, you will be prompted each time a 
Web Page report is produced for the output location, with the specified location as the default. 

File Prefix 

Generated pages can all begin with the same filename prefix. A filename prefix helps to organize related files. 
The prefix can be specified in the File prefix box. You can type a literal string, or you can type a template. 
Available template codes for web page prefixes are:  

Template Code Description 
[KEY] The initials of the key individual on the report. 
[TYPE] The type of report being produced. 

The box has a drop-down list with some predefined file prefix templates: 
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Existing Files 

Typically, web page reports will be produced is successive drafts, as more data is entered or various report 
options are tried. Because web pages are stored as files, there is the issue with what to do with the files 
created from previous drafts that have the same filename prefix. The Existing files box provides the following 
choices: 

 

When Overwrite is chosen, it is possible to end up with a combination of new and old draft web pages with 
the same prefix, when there are fewer new pages than old pages. 

You can click the Confirm check box if you want a message box prompting you to confirm the deletions. 

Home Page URL and Text 

Generated web pages can include a link to another web page of your choice. It can be specified in the Home 
page URL box. Type the name for the link in the Text box, such as "Home". 
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Chart Options View 
Genbox can produce charts of your genealogical data. Unlike a report, which is a text document, a chart is a 
graphical representation that is drawn on the screen or printer. Genbox produces five general types of charts:  

• Ancestor 
• Descendant 
• Related 
• Convergent 
• Everyone 

There are many options for each chart type, organized onto eleven pages: 

            Key Page 
            Titles Page 
            Sections Page 
            Layout Page 
            Contents Page 
            Styles Page 
            Detail Page 
            Links Page 
            Format Page 
            Sizes Page 
            Frames Page

There is a row of buttons at the bottom of the view:  

• Click Make Chart when you are ready to produce the chart. 
• Click Save Options to save your settings to a named options file that you can load again later. You 

will be prompted to select a filename. 
• Click Reload to restore the settings to the way they were the last time the options file was saved. 
• Click Defaults to reset all of the settings to Genbox defaults for the current chart type. The defaults 

are the same options as used by the Basic menu choice. 
• Click Close when you are done with the Chart Options View. 

Make Chart Button 

When you choose Make Chart, a progress window will be displayed, then the Chart View will open and 
display the generated chart. The Chart Options View will still be open, but it will be behind the Chart View. 
After you close the Chart View, you will see the Chart Options View again. You can make further changes to 
the options, then choose Make Chart again. You can repeat this cycle until you are satisfied with your chart. 
Then click the Close button to close this view. 

Save Options Button 

There are a lot of chart options that you can set. After you have the options the way you prefer, you can save 
them so that you can quickly produce more charts with the same options later. When you click Save Options, 
the "Save As..." file dialog will appear. The default filename shown on this dialog will be the current filename of 
the options file, if any. If you want to save your changes back in the same file, click OK. Otherwise, enter a 
new name for the options file. 

Reload Button 

Genbox makes it easy for you to experiment with different chart options. When you close the Chart Options 
View, your changes will be remembered throughout the current session. This means you can do other things, 
such as select a different current individual on the Individuals View, then select your same chart options file 
from the menu again, and the changes you made will still be there. This makes it easy to try out your options 
with different individuals as keys. 
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Sometimes you will decide you want to get rid of all the changes you made, and restore the options to the way 
they were when you started. You can do this by clicking the Reload button: the chart options will be reloaded 
from the file, so the settings will be restored to the way they were the last time the options were saved. This 
also happens whenever you exit Genbox and restart the program. 

Defaults Button 

Click the Defaults button to reset all of the settings to Genbox defaults for the current chart type. The defaults 
are the same options as used by the Basic menu choice: it produces a plain-looking chart; no colors, no drop 
shadows, minimal data content. It provides a good starting point when you want to create a new options file 
from "scratch". 

Close Button 

The Close button closes the Chart Options View. If you were using a chart options file selected from the Chart 
Options Menu, only the window is closed; the chart options file will remain open, so that the next time you 
open that menu option, any changes you made during the current session will still be there. 

If you had opened your chart options file with the "Open Options file..." menu choice, both the document and 
window are closed when you click this button. If you have made changes to the chart options file, you will be 
prompted to save your changes first.  



       

Ancestor Charts 
Ancestor charts show the ancestors of the starting individual(s). A typical ancestor chart is shown below: 

 

In this example, Abraham Lincoln is the key individual. Three generations of ancestors were selected on the Sections 
page. The "Direction of Drop" layout setting for this chart was "right", so that each earlier generation is displayed as a 
column of boxes, progressively further to the right. 
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Descendant Charts 
Descendant charts show the descendants of the starting individuals. 

In the example below, the "unboxed" style was used: 

 

For this example, the "Direction of Drop" layout setting was set to "down".  Four generations of descendants are shown, 
with each generation appearing as a row of names progressively lower on the chart. 
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Related Charts 
Related charts show both the ancestors and descendants of the starting individuals. This can produce an 
"hour-glass" chart shape: wide at the top and bottom, with a single individual occupying the middle. 

An example of a related chart appears below: 

 
 

In this example, James 1 Stuart was the key individual. Three ancestor generations and two descendant generations 
are shown. 
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Convergent Charts 
Convergent charts show the lineage paths between two or more starting individuals. Genbox will find all 
possible paths through the data set. 

The example below shows the lineage paths between President George Washington and Robert E. Lee: 
 
 

Copyright © 2005  Thoughtful Creations. All rights reserved. 248



       

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In this example, two lineage paths were found between Washington and Lee. The shortest path is through his paternal 
grandmother Mildred Warner. Washington's great-great grandparents Augustine Warner and Mary Towneley were 
Lee's 4th-great grandparents. This is a direct lineage path. The other convergent path found is through Washington's 
paternal grandfather, back seven more generations to Robert Kytston, then down 16 generations to Lady Diana, who 
married Prince Charles, who is the 9th-great grandson of Washington's great-great-grandfather Augustine Warner. This 
is an indirect path. 
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Everyone Charts 
Everyone charts include every individual in your database. They are good for getting an overview of 
everything you have, which may be one large tree, or a large tree and several disjoint parts. Often you can 
find single boxes or small trees that have gone overlooked. 

An example of an Everyone chart from a small data set appears below:  
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Chart Options View: Key Page 
Charts are based on key individuals. The key individuals determine the starting points for the chart. On a 
Descendants chart, each key individual will be shown, linked to his children, each of them linked to their 
children. Likewise, an Ancestors chart will show the key individual, linked to his parents, each of them linked 
to their parents, and so on. When there are several key individuals, each of them will be treated as the starting 
individual in turn, with the results merged into a single chart.  

 

The key individuals are specified on the Key page. Most often, a single key individual is used. When the 
Chart Options View is first opened, the default key individual will be the current individual on the Individuals 
View.  

Notes  

• The Convergent chart requires a minimum of two key individuals, so that the lineage between them 
can be drawn. 

• The Everyone chart does not require any key individuals. If provided, they will influence the order in 
which the chart is constructed, which allows you to have some control over the resulting structure.  

Key Individuals List 

The Key individuals list displays the names of the key individuals, one on each row.  

• To add a key individual, click where it says "Add key", then type the name of the individual.  

• The Individuals Pick Dialog will open, displaying a list of the matching names, with birth and death 
dates select the intended name from the list. 

Key individuals can also be added by clicking the Select button.  

Besides individual names, lists and queries can also be specified for determination of the key individuals. 
When a row contains the name of a list or query instead of the name of an individual, an icon will precede the 
name, identifying its type: 

        List 
        Query 

A list name is added with the Select List button. All members of the list will be considered key individuals. A 
query name is added with the Select Query button. The resulting list of individuals when the query is run will 
be considered key individuals. 
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Preview Box 
The Preview box displays a chart box for the currently selected key individual. The contents and style of the 
chart box match the settings for default boxes, as specified on the Content and Styles pages. By viewing the 
Preview box, you can get an idea of how the chart boxes will look before the full report is generated. 

By clicking the names of different key individuals, you can view the additional content that will appear for each 
of them on the report, which can be helpful in determining if you selected the key individuals you intended. 

Clear Button 
Click the Clear button to remove all of the names from the list box. 

Load Saved Keys Button 
When the chart options are saved to a chart options file, the current key individuals are saved along with the 
options. When the chart options file is reloaded, the saved key individuals can be reloaded as well by clicking 
the Load Saved Keys button. With this feature, you can save a favorite list of key individuals and select them 
again with just one click. 

Select Button 
Click the Select button to add key individuals using the Individuals Pick Dialog.  

Select List Button 
Besides individual names, lists can also be specified for determination of the key individuals. The List icon 

 identifies rows that contain the name of a list instead of the name of an individual. All members of the list 
will be considered key individuals. 

To add a list name, click the Select List button. The List View will open, allowing you to select a list name. 
Click the name of a saved list of individuals, then click the Select List Name button. Or, click the Select List 
Members button to add the names of the members to the list box instead of the list name. The chart results 
will be the same either way, but each approach has its advantages: 

• Click Select List Name if you plan to save your chart options for future use. Then, the next time the 
chart options are used, the current members of the named list will become key individuals. 

• Click Select List Members if you want to selectively remove some names or reorder the names 
before making the chart. 

Select Query Button 
Besides individual names and lists, queries can also be specified for determination of the key individuals. The 
Query icon  identifies rows that contain the name of a query. The resulting list of individuals when the 
query is run will be considered key individuals. 

To add a query name, click the Select Query button. From the Open File Dialog, select the name of a saved 
query definition. Query definition files have the extension .QRY. 

The query is not run until the Make Chart button is pressed. If you save your chart options for future use, any 
queries will run each time a chart is produced, and the results at that time will be used as the key individuals. 
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Chart Options View: Titles Page 
A chart can have a Main title and a subtitle. It can have legend boxes that define abbreviations and other 
aspects of the chart. It can have generation labels. Book layout charts can also have page headers. These 
options are all set on the Titles page. 

 

Main Title and Subtitle 
The Main Title of the chart will be initialized to a default value, based on the chart type and key individuals. 
The Subtitle will initially be blank. You can set it to any text you wish. 

For easier translation into other languages, you can use a number of variables: 

• [DATATYPE] - data type for current chart: Ancestors, Descendants, Relatives, Convergence, 
Everyone. 

• [CHARTTYPE] - chart name: Ancestor Chart, Descendants Chart, Relatives Chart, Convergence 
Chart, Everyone Chart. 

• [OF] and [FOR] - common prepositions used in titles. 

When a resource file is available for the currently selected output language, these variables will be translated 
automatically. 

You can control the line breaks in the titles by inserting "\n" (backslash followed by the letter n) at the desired 
break points. 

Titles Placement 
The chart titles can be placed in a number of places on the chart. Choices appear on the drop-down list: 
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Above chart will center the title box above the chart, outside of the chart frame. Below chart will center the 
title box below the chart, outside of the chart frame. These placements are independent of the selected drop 
direction and alignment options, and can be used for both normal charts and fan charts. 

Inside top will place the title box inside of the chart frame, at the "top" side of the chart. If the direction of drop 
is down, for example, the "top" would be above the chart. If the direction of drop is to the right, the Inside top 
placement would be the left side. Likewise, the Inside bottom choice will place the title box under the last 
generation, in the direction of drop. For both of these placements, the current alignment option will control the 
centering of the box; if set to "right", for example, the title box will be right aligned, the same as for the chart 
boxes.  Note:  Inside top and Inside bottom placements are not supported for fan charts. 

Chart titles are omitted in the basic chart definition. 

Page Header for Book Layout 

When Book layout is chosen on the Layout page, you can use this box to enter a template for generating the 
page headers. A book layout chart is divided into parts, with one part on each page. Each part is labeled, and 
each link line leading off of a part has a reference label that indicates the part on which it continues. 

The default page header template is: 

    Part # [PAGE] of [PAGECOUNT] 

The variable [PAGE] will be replaced with the part number, and the variable [PAGECOUNT] will be replaced 
with the total number of parts. 

Page Header Placement 

When Book layout is chosen on the Layout page, you can use this box to specify the placement of the page 
headers. Choices from the drop-down list are: 

 

Above means the page header will be placed above the part. Below will place the header at the bottom of the 
page. 

Part Reference Text 

When Book layout is chosen on the Layout page, you can use this box to enter a template for generating the 
part reference labels. A book layout chart is divided into parts, with one part on each page. Each part is 
labeled, and each link line leading off of a part has a reference label that indicates the part on which it 
continues. 

The default part reference template is: 

    see part [PAGE] 

The variable [PAGE] will be replaced with the part number. 

Number Pages Check Box 

Click the Number Pages check box to include page numbers on the chart. The page numbers will appear in 
the lower right corner of each chart page, except on pages where a box obscures that location. Pages will be 
numbered left to right, top to bottom. The font appearing to the right of the Label Generations check box will 
be used. 

Label Generations Check Box 
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When the Label Generations check box is checked, additional chart boxes that display the chart generation 
levels will be included on the chart. 

Tick Marks Color Button 
Use the Tick Marks Color button to select the color for the tick mark lines on a timeline chart. Clicking this 
button will open the Select Color Dialog for selection of the color. 

Note This control is only visible when Generational Alignment is set to timeline. 

Legend Box Title 
The Legend Box Title appears as the title of the legend box, when it is included. 

For easier translation into other languages, you can use the variable [LEGEND] to produce the default title 
"Legend". When a resource file is available for the currently selected output language, this text will be 
translated automatically. 

Legend Placement 
The legend boxes can be placed in a number of places on the chart. Choices appear on the drop-down list: 

 

Above chart will center the legend boxes above the chart, outside of the chart frame. Below chart will center 
the legend boxes below the chart, outside of the chart frame. These placements are independent of the 
selected drop direction and alignment options, and can be used for both normal charts and fan charts. 

Inside top will place the legend boxes inside of the chart frame, at the "top" side of the chart. If the direction of 
drop is down, for example, the "top" would be above the chart. If the direction of drop is to the right, the Inside 
top placement would be the left side. Likewise, the Inside bottom choice will place the legend boxes under 
the last generation, in the direction of drop. For both of these placements, the current alignment option will 
control the centering of the boxes; if set to "right", for example, the legend boxes will be right aligned, the 
same as for the chart boxes. Note:  Inside top and Inside bottom placements are not supported for fan charts. 

Legend boxes are omitted in the basic chart definition. 

Legend Content Check Boxes 
A number of check boxes control the inclusion of content in the Legend Box: 

Field Labels 
When checked, the Field labels will be shown along with their full names, such as: 

    b.    Birth 
    d.    Death 
    m.    Marriage 

Key Individuals 
When checked, the names of the Key individuals will be included in the legend box. 

Section 
When checked, the sections specified on the Section page will be described. Possible descriptions include: 

• Section: All Descendants 
• Section: Descendants to 2 Generations 
• Section: Ancestors to 1750 
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Styles usage 
When checked, the styles specified on the Styles page will be described. 

Icons usage 
When checked, the icons added on the Content page will be shown along with their usage. 

Citations 
When checked, source citations for data included on the chart will be presented. Each citation will be 
numbered in order. "Ibid." will be used when a citation is the same as the previous one listed. 

Brief Citations 
The Brief citations check box is enabled when the Citations check box is checked. It specifies that the 
included citations should be in brief format: lead text, annotations, and excerpt text are omitted. 

Re-use Citation Note Numbers 
The Re-use citation note numbers check box is enabled when the Citations check box is checked. It 
specifies that citations to the same source (and same location within that source) should use the same citation 
note number. This can greatly reduce the use of "Ibid." in the Legend Box. 

Multiple Legend Boxes 
The resulting size of the legend box depends on the content options selected and your data. If Citations is 
checked, and you have a large number of citations for individuals on the chart, the legend box can become 
very tall. You can control the size of the legend box by setting nonzero values for Box Max Height and Box 
Max Width on the Sizes page. When the contents of the legend box exceeds the sizes specified, additional 
legend boxes will automatically be created, so that all of the content can be shown. 

The default placement of multiple legend boxes will be left to right in a centered row for most layout options. 
For a sideways chart layout with legend box placement set to Inside top or Inside bottom, the legend boxes 
will appear top to bottom in a column. 

Font Buttons 
Each of the other elements on this page can have its own font.  

• To set font characteristics for an element, click the Font button next to it. 

The Font buttons are: Main Title font, Subtitle font, Page Header font, Page Reference font, Generations / 
Timeline Label font, Legend Title font, Legend Body font. 

For help on setting the fonts for several elements at once, see the section Select Font for Multiple Group. 

Note   Font buttons for disabled elements will also be disabled. 



       

Chart Options View: Sections Page 
A genealogy database can have tens of thousands of individuals. Often, the individuals you want to show on a 
chart are only a small subset of the database. Some charts can be limited to a small number of individuals 
naturally:  

• A Descendant chart is limited naturally when the key individual is in one of the more recent 
generations. 

• An Ancestor chart is limited naturally when the key individual is in one of the earlier generations. 
• A Convergent chart is limited naturally because the default for that chart is only the path between the 

key individuals. 

But sometimes what you are interested in requires the establishment of "cut-off" points, such as: "Show me 
descendants of the key individual, but for only 3 generations", or, "Show ancestors of my key individual, but 
stop when you get to 1740". Or, "Show me 4 generations of ancestors and 3 generations of descendants, plus 
all of his aunts, uncles, cousins, nieces and nephews." Such limits define a section of the database that is of 
interest. 

The Sections page is used to specify these limits. In addition to number of generations, cutoff dates, and 
collateral relatives, it can also limit the chart by controlling which types of parent-child links to follow, and 
whether spouses and living individuals are included. 

 

Direct Lines 

The Direct lines are the direct ancestors and direct descendants of the key individuals: The grandparents, 
great-grandparents; children, grandchildren, and so on. The Generations to go from Key Individuals 
(Direct Lines) group box is used to specify the limits on direct lines. For Ancestor charts, the Ancestral 
direct lines can be limited. For Descendant charts, the Descendant direct lines can be limited. For other chart 
types, both ancestral and descendant lines can be limited. 

Number of Generations 

The direct lines can be limited to a certain number of generations removed from the key individuals. By 
counting the key individual as generation 0, his parents are generation 1, his grandparents are generation 2, 
and so on. Going the other way, his children are generation 1, and grandchildren are generation 2. So if a 
Descendants chart has "Generations to go from Key Individuals" set to 1, only the key individual and his own 
children will be shown on the chart.  
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1. To limit a direct line to a certain number of generations, click the Number radio button. 
2. Type the number in the box, or use the up/down arrow buttons to set the value. 

Note    Setting the number of generations to zero is the same as clicking the None radio button. Only the key 
individual will be shown. 

To Date 

The direct lines can be limited to a certain date. This date is meant to totally enclose the life spans of the 
individuals to be included on the chart; individuals living even partly outside the range are excluded.  

For Ancestral lines, click the To date radio button and enter the earliest date for birth in the box. 

Ancestors must be born on or after the specified date to be included. When ancestors are born before the 
specified date, they will be omitted. When the birth dates are unknown but another event date places them 
before the specified date, they are also omitted. 

• For Descendant lines, click the To date radio button and enter the latest date for death in the box. 

The descendant must be deceased by the specified date. If the date of death is unknown, and the Living 
attribute flag has not been set, Genbox will determine if the descendant should be considered deceased by 
taking the birth date and adding the default maximum life span value specified on the Preferences View, 
Dates page. 

To Common Ancestor/Descendant 

When producing a Convergent chart, the default limit for an ancestral direct line is To common ancestor, 
and the default limit for a descendant line is To common descendant. This limits the chart to its natural 
section, showing just the generations necessary to display the lineages between the key individuals. 

You may wish to specify a limit on the ancestral or descendant generations. This will restrict the search space 
the program will use in searching for the convergent line between two key individuals. If no convergent line 
can be found while staying within the specified bounds, the chart will not be produced and the message box 
"No convergent paths found" will be displayed. 

Collateral Relatives 

The choice of key individuals determines the direct lines. But there are other relatives--aunts and uncles, 
nieces and nephews, cousins, and their spouses. These relatives are collectively referred to as collateral 
relatives. Collateral relatives are reached by moving along a direct line in one direction to reach a direct 
ancestor or descendant, then, starting from this new individual, moving in the opposite direction along this 
new individual's direct lines. Each relative reached will be a collateral relative of the starting individual.  

Number of Generations--Examples 

For example: suppose we are making an Ancestor chart. We want to show two generations of ancestors: 
parents and grandparents. We set the Ancestral direct lines to two generations. And, we want to see aunts, 
uncles, brothers, sisters, and first cousins. We can do this by setting the Descendant collateral relatives to 
two generations. Genbox will move along the direct lines to ancestors, then, for each direct ancestor, it will 
move to the direct ancestor's direct-line descendants, and include them on the chart as well. 

Another example: suppose we are marking a Descendant chart. We want to show children, their spouses, 
and the parents of the spouses. We would set the descendant direct line generations to 1, and the ancestral 
collateral generations to 1.1 

Max Generations 
Collateral relatives can be limited by the number of generations traversed, the same as for direct line 
generations. But instead of an All radio button, collateral relatives have a Max radio button. This reflects a 
restriction on collateral relatives:  



       

• Collateral relative generations cannot exceed the upper/lower bounds of the direct line generations. 

The effect of this restriction is that collateral relatives merely "fill out" a slice of the genealogy. They don't 
extend it to earlier generations of ancestors or to additional generations of descendants. Click the Max button 
to show the maximum number of generations that are permitted. 

Apply Recursively 
Once the initial set of collateral relatives have been determined by moving from the direct line relatives, it is 
possible to use this new set of collateral relatives and find their collateral relatives, again limited by the 
number of generations specified. This process can be repeated until there are no other relatives. Click the 
Apply recursively check box to select this option. 

Note   This option is available only when nonzero collateral generations have been specified for both 
ancestors and descendants, because it requires movement in two directions ("walking" up and down 
repeatedly) for this feature to have any effect. 

Gender Lines to Follow 
Normally, both male and female lines are followed from the key individuals. If you are interested in only one 
gender, you can restrict your chart to follow just those lines. The choices for this option are: 

 
gender will not be considered. 
all female lines will be excluded. 
all male lines will be excluded. 
all female lines will be terminated after one generation. 
all male lines will be terminated after one generation. 

Parent-child Links 
In addition to the traditional biological relationship between parent and child, Genbox supports the storage of 
other parent-child relationships. The check boxes in the Parent-child links to show group box allow you to 
control which of these parent-child relationships to include on your chart. An excluded relationship type will 
end a lineage line. There can be multiple parent boxes that link to the same child box. 

All: every type of relationship link will be shown. 

Preferred: just the links marked with the Preferred parent family check box on the Parents page will be 
shown. When this choice is the only one selected, the chart will never show more than one parent 
family connected to a child box. 

Biological: links to biological parents are shown. Links marked as "Direct Ancestor" will also be shown. 

Adoptive: links to adoptive parent families are included. 

Foster: links to foster parent families are included. 

Godparent: links to godparents are shown. 

Sealing: links to individuals sealed as parents in an LDS sealing ordinance are shown. 

Relative: links to other individuals known to be relatives are shown. 

Other: links marked as "other" are included. 

Unknown: links marked as "unknown" are included.  

Living Individuals 
By default, living individuals are shown with the normal content (as specified on the Contents page). If you 
plan to distribute a chart outside of your own family, you may wish to restrict the content shown for living 
individuals, to respect their privacy. The Living individuals box presents the following choices on its drop-
down list:  
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When Omit is selected, living individuals and all links to them are treated like they are not even in your 
database. This means lineages will be ended when they reach a living individual. On a Descendants chart, 
for example, if a deceased individual has five children, of which two are still living, the chart will show the 
individual as having only three children. And no further descendants will be shown for the living children, even 
if they are deceased. 

When Identifiers, links is selected, the names and relationships of living individuals are included, but no 
other information. No events, dates, or places. "Names" will include all the identifiers normally selected for 
output. 

When Sex, links is selected, the name will be replaced by "Male" or "Female", so that only the sex and 
relationships of living individuals are shown. This provides a level of privacy higher than Identifiers, links, 
because names are not shown. 

Override Privacy Flags 
When Override privacy flags is checked, parent relationships and spouse relationships that have the Private 
flag checked will be shown with their true relationships on the chart. Normally, private parent relationships are 
shown as "biological" and private spouse relationships are shown as "married" on charts and reports. 

Override Exclude Flags 
When Override exclude flags is checked, parent links, spouse links, and events that have the Exclude flag 
checked will also be included on the chart. Normally, these records are omitted from charts. 

Include Alternate Events 
When Include alternate events is checked, the events that are marked "alternate" will also be charted. 
Normally, alternate events are omitted from charts. 

Converge on Direct Lines Only 
For Convergent charts: when Converge on Direct Lines Only is checked, only direct line (blood) 
relationships will be followed when looking for a convergent ancestor or descendant. When not checked, any 
connecting relationship may be followed. 

Omit Spouses 
When Omit spouses is checked, individuals related to the direct lines only by marriage are not included. This 
means spouses on Descendant charts are omitted from the chart, unless they have an independent direct 
lineage. Ancestor charts are generally unaffected, because both parents are direct line ancestors. 
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Chart Options View: Layout Page 
A genealogy can take on many different shapes. If your research is deep in a few lines, it will be tall and thin. 
If your have tried to include all your recent collateral relatives, it will be short and wide. If you have done some 
deep research in a few lines and concentrated in breadth in other lines, or if you have imported the 
genealogies of other researchers and merged them with your own, your genealogy will have a shape that is 
hard to describe, but certainly interesting. When it comes time to make charts, how should it all be displayed? 
You would like a well-balanced chart. Something that will be attractive in its intended setting. 

The Layout page is used to select from many different organizational possibilities for your chart. Depending 
on the data you are charting, some layouts may look better than others. Experiment until you find something 
that looks good to you. 

 

Direction of Drop 
The Direction of Drop control is a cluster of eight push buttons with arrows pointing in all directions. When a 
button is selected, it will display a pressed appearance. The four rectangular buttons pointing up, down, left, 
and right select rectangular charts. The four buttons in the inner circle select fan charts. 

"Direction of Drop" refers to the direction that a viewer of the chart would need to look to go from one 
generation to the next. 

• For Ancestor charts, the "drop" is from an individual's generation to his parent's generation. 

• For all other chart types, the "drop" is from an individual's generation to his children's generation. 

The default drop direction for Ancestor charts is up: this shows parents above the starting individual. Another 
common drop direction for ancestor charts is right: this shows each generation as a vertical column, with 
earlier generations to the right. 

The default direction for other chart types is down: this shows children below the starting individual. Often, 
this will produce a short, wide chart. This type of chart could extend along a wall or be laid down a long table. 
You may wish to change the drop direction to left or right to produce a tall, narrow chart, which could occupy 
the space from ceiling to floor but be only a few feet wide. 

Fan Charts 
Clicking one or more of the inner circle of buttons will select a fan chart layout. A fan chart begins in the 
center of a circle with the key individual, and each generation becomes a ring (either full or partial) around the 
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center. Fan charts can be an elegant layout for ancestor charts, and a space-saving layout for descendant 
charts. 

There are four fan chart buttons, each selecting a quadrant of the circle.  

• Click a single fan chart button to produce a quarter-circle fan chart. 

• Click two buttons on the same side of the circle to produce a half-circle fan chart. 

• Click all four fan chart buttons to produce a full-circle fan chart. 

To deselect all the fan chart buttons, click on one of the rectangular buttons. 

Drop Alignment 
The Drop Alignment group box allows you to specify how child box groups should be positioned and linked 
beneath their parent boxes. The option buttons available are: 

Box center: child box groups are linked and centered beneath the direct line ancestor. A parent spouse 
box will not affect alignment. 

Link center: same as box center when parents are in same box. When parent spouse boxes are shown, 
child box groups are linked to the center of the family link. Single child boxes are centered beneath 
the link line, and child box groups are centered beneath both parent boxes taken together. 

Left: the left edge of the first child box is aligned with the left edge of the parent. Spouses boxes are 
shown off to the right. 

Right: the right edge of the first child box is aligned with the right edge of the parent Spouse boxes are 
shown off to the left. 

Relaxed: alignment beneath parents is generally ignored. All of the boxes in a generation are centered as 
a whole beneath the parent generation. This produces a nice centering effect when looking at the 
chart as a whole, but it often produces jagged link lines 

Note    The interpretation of "left" and "right" changes with the Direction of Drop. 

Generational Alignment 
A generation is aligned when all of its boxes appear in a row or column (or in a ring for fan charts). Setting 
Generational alignment to Relaxed will permit boxes to be drawn either higher or lower than other boxes of 
the same generational row, or left or right of a generational column. Relaxing the generational alignment 
allows the chart layout to become more compact, as extremely wide charts can be narrowed by stacking some 
boxes from the same generation vertically. It also makes it possible to avoid some crossovers by lowering or 
raising a section of the chart. 

Timeline Charts 
Setting the Generational alignment to Timeline will select a timeline chart layout. This option is only available 
when the Direction of drop is left or right. A timeline chart positions and sizes boxes according to the birth and 
death dates of the individual displayed inside the box. Individuals who had longer life spans will have wider 
boxes. The boxes will be arranged vertically with no overlap in the horizontal direction. A timeline will be 
shown at the top and bottom of the chart, with vertical lines drawn beneath the boxes to make their placement 
easier to read. 

Single Box for Couples 
Families can be drawn in two ways: with information on spouses in separate boxes, and with information on 
spouses in the same box that contains the information on the primary individual. Showing spouse and primary 
information in the same box can save considerable space on a chart. If the ancestors of a spouse are 
included on the chart, then a separate box is required in order to show the ancestor link. 

The Single Box for Couples group box has the following option button choices: 

• When possible: full information for spouses with no ancestors shown on the chart will appear in the 
same box as the primary individual. Full information for spouses that do have ancestors on the chart 
will be shown in a separate box linked to the first. 

• No: spouses are always shown in separate boxes. There is a separate box for each person on the 
chart. 



       

For primary individuals with multiple spouses, more than one spouse may be shown in the same box with the 
primary, provided they have neither ancestors nor children displayed on the chart. In that case, the last 
spouse shown in the box will be the parent of any children shown linked to the box.  

Preview Box 
The Preview box displays a small chart of empty chart boxes, demonstrating the current layout settings. The 
key individual's box is marked with an asterisk. 

Fan Chart Layout 
The Fan Chart Layout group box contains a number of controls for fan charts. These controls are enabled 
only when the Direction of Drop control is set for fan chart layout. 

Rings 
When the Rings check box is checked, the fan chart will be shown with no gaps between generations, and no 
gaps between boxes on a generational level, which gives the chart the appearance of rings. This layout option 
is only available for Ancestor charts. When selected, the Drop Alignment and Generational Alignment 
controls will be disabled. 

Elliptical 
Checking the Elliptical check box will cause the fan chart to assume the same aspect ratio as the page of the 
default printer. If nonrectangular, this will make a round fan chart elliptical in shape. This option can help a 
fan chart fit the paper better. 

Wider Sweep 
The Wider Sweep check box is enabled when doing half-circle charts. It will increase the angular sweep of 
the chart from 180 degrees to about 202 degrees, which helps the chart fill nonrectangular paper. 

Omit Key Individual 
The Direction of Drop for fan charts is always from the center to the edge. The key individual, then, appears in 
the center of the fan. Because all other generations form rings around the center, the size of the key box 
affects the size of the entire chart. If the Omit key individual check box is checked, the overall size of the fan 
chart is often reduced, with just a small hole in the center. The information that would have been displayed for 
the key individual can then be incorporated into the title or the subtitle of the chart. 

Curve Text 
When producing fan charts, there are several ways to draw the text: 

 
• Arc: The text follows an imaginary circle around the center. 

• Radial: The text follows an imaginary line radiating from the center. 

• Chord: The text is drawn on an imaginary straight line whose ends are an equal distance from the 
center. It is like an Arc that isn't curved. 

• Straight: The text completely ignores the curvature of the fan chart; it appears straight and upright, 
regardless of where it is on the fan. To make it stay within the box, each line is staggered. 

Depending on how close a generation is to the center, the number of boxes in the generation, and the amount 
of text in the boxes, some text curvature choices will save more space than others. A fan chart usually will 
have one controlling generation, which is "bigger" than any other. The diameter of that generation is the 
controlling factor for the size of the chart: generations farther out have extra room, and generations farther in 
could have been drawn in tighter circles, but weren't because that would have left a gap. So, the controlling 
generation actually pulls the lower generations up to meet it, creating a center box (or hole) larger than it 
needed to be otherwise.  

• To reduce the chart size, identify the controlling generation and find the text curvature choice that 
will shrink that generation to its minimum diameter.  
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• If another generation is now the controlling generation, see if there is a better choice for its text 
curvature to reduce the chart size further. 

You can independently set your choice for text curvature for the first generation, the second generation, 
and a selectable higher generation. Other generations will have the same text curvature as for the previous 
generation. 

First generation: for full circle Ancestor fan charts, Straight may look the best. For other types of fan 
charts, you might consider Arc or Radial. Chord is usually unattractive in lower generations, because 
the high degree of curvature may send the center of the top text line too close to the top edge of the 
box, or even outside it. 

Second generation, other low generations: usually Arc looks best, unless there are a lot of boxes, in 
which case Radial should be considered. 

Higher generations: for large fan charts, a switch to Radial at some point can reduce the overall size of 
the chart considerably. 

Chord text can also be used as an approximation to Arc text, especially for higher dimensions, where the 
difference becomes insignificant. Drawing Chord text may be noticeably faster than drawing Arc text. 

"Up" Direction 
With generation boxes running in circles, the question of what "up" is becomes a factor. The choices available 
from the drop-down list are: 

 
The Center choice looks good to a viewer standing on any edge: the text closest to the viewer is right-side-up. 
But when viewed as a whole, the text on the far side is up-side-down. The Edge choice would look good to a 
viewer standing at the center. To any other viewer, half the chart would again look upside down. The Top 
choice will cause the text on the bottom half of the chart to be flipped, so that a viewer in front would see all of 
the text right-side-up, or at worse sideways. The Left, Right, and Bottom choices produce a similar flipping of 
text on one side of the chart. 

When a quarter-circle fan or half-circle fan is used, the choice for "up" direction becomes easier to make, as 
several of the choices become equivalent. 

Timeline Chart Layout 
The Timeline Chart Layout group box contains a number of controls for timeline charts. These controls are 
visible only when the Generational Alignment control is set to Timeline. Direction of Drop must be set to 
left or right for a Timeline chart layout. 

Years per Tick 
The Years per tick edit box contains the numeric number of years between each "tick" on the timeline chart. 
Entering a larger value will compress the chart horizontally, while a smaller value will stretch it out. The 
spacing between ticks is not affected. 

Spacing 
The Spacing edit box contains the actual distance (in inches or millimeters) between each tick on the timeline 
chart. A vertical line is drawn on the chart at each tick position. If you would like to see more vertical lines to 
help you read the positioning, enter a smaller value. Entering a smaller value will compress the chart 
horizontally, with the tick lines closer together.  

Style Boxes 
Click the Style boxes checkbox to have Genbox apply a shape to the boxes on the chart according to the 
date qualifiers present in the data. Each end of the box can have a different shape. The end earlier on the 
timeline will display a shape according to the qualifier on the birth date. The other end of the box will display a 
shape according to the qualifier on the death date. The shape corresponding to each date qualifier is given 
below: 
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• unqualified date: straight (rectangular) 
• estimated date: oval 
• "about" date: rounded 
• calculated date: bevel 
• before/after dates: arrow pointing either left or right 
• unknown date: (empty) 

Unboxed 
When Unboxed is checked, the box borders (lines and margin space) are omitted. This typically saves 
considerable space, with perhaps a loss of clarity. Box border styles, colors, and shading are also disabled. 

Strict Key Order 
When producing a chart with multiple key individuals, Genbox will try different left-to-right orderings of the key 
individuals to find the arrangement that minimizes the size of the resulting chart. The order in which the key 
individuals are processed can have a dramatic effect on the resulting arrangement, shape, and size of the 
chart. If you want to control the ordering of the key individuals yourself, click the Strict key order check box. 

Strict Birth Order 
Normally, the children boxes are arranged in left-to-right order beneath the parent boxes. When producing 
certain types of charts, Genbox may alter the ordering if it improves the layout of the chart, either making it 
smaller or avoiding a crossover. Click the Strict birth order check box to disable this feature.  

Stagger Leaves 
When Stagger Leaves selected, runs of child boxes with no descendant boxes will alternate in the level they 
are drawn, which can reduce chart width by 20% to 50% when there are many children shown. This option is 
independent of the "Generational Alignment" setting, so you can have staggered leaves but otherwise have 
"strict" generational alignment. 

Overlap Generations 
When producing a rectangular Ancestor chart with Drop Alignment set to "Link center", this option can be 
selected to reduce the size of the chart. It allows lower generation boxes to tuck partially between higher 
generation boxes, provided there is adequate space. The boxes themselves do not overlap. 

Minimize Straddle 
When a large chart is printed on multiple sheets of paper for later assembly into a wall chart, boxes can be 
split across several pages, "straddling" the page breaks. You may find this unattractive. Clicking the Minimize 
straddle check box will alter the layout of the chart to minimize the straddling. Boxes will be moved left or right 
so that they will be printed completely on one page, or at least on fewer pages than before. The drawback is 
that the drop alignments will be off, and the chart will be larger, as additional white space is often introduced. 

Book Layout 
Charts are produced in wall-chart layout by default. Clicking the Book layout check box will produce a chart 
that is divided cleanly into pages, suitable for inclusion in a book. Each piece is labeled, and joining lines refer 
to the continuing part with a reference label. 

Notes 

• Charts that already fit on one page will be unaffected by clicking Book layout. 

• Book layout is disabled for fan charts. 

Names on Lines 
When Unboxed is checked and the Direction of Drop is not up or down, the Names on lines check box can 
be checked to alter the way links and boxes are drawn, so that the first line of data in the boxes (typically, the 
name of the individual) actually sits on the link line. This can create a visually distinctive look. 

Pedigree Links 
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Family links are the lines drawn between spouses. In Descendant charts where the spouse is shown in a 
separate box, the family link is drawn as two parallel lines between the boxes. For Ancestor charts, family 
links are often drawn a different way: as a single connecting line below the boxes. Click the Pedigree links 
check box if you prefer to show family links this way for ancestors of the key individuals. This option is also 
available for Related charts, which will affect the ancestors portion of the chart. 

Ancestor Blanks 
Genealogies often have some lineages that have been traced to earlier generations than others. When 
producing an Ancestor chart, this may produce an unbalanced appearance in the outer generations, 
particularly on fan charts. Clicking the Ancestor blanks check box will cause extra boxes to be added for the 
unknown ancestors, filling out the chart to the deepest box which has real data. The extra boxes will be blank.  

Ancestor and Descendant Stubs 
A stub is a short link line with an optional arrow and label that indicates that connecting boxes have been left 
out. When the Sections page is used to limit ancestral or descendant lines, you can click on Ancestor stubs 
or Descendant stubs to add stubs to your chart. The label will be something like "(two children)" or "(one 
son)". The format of descendant stubs can be set on the Format page. 

Duplicate Ancestor 
Ancestor charts may lead to the same ancestor by more than one path. When the duplicate ancestor option 
is checked, this second occurrence will be handled by adding a duplicate box, with reference text added to the 
original and duplicate boxes to tie them together. Ancestors of the duplicate ancestor will only be shown on 
the first box. The reference text will contain a unique letter code for each duplicate ancestor, beginning with 
"[A]" for the first pair of duplicate ancestor boxes. The reference text will be drawn in the Link Cross Reference 
Font. 

When this option is not checked, a single box for the ancestor will be drawn with a crosslink to the second 
reference. 

Facing Pages 
When Book layout is clicked, the Facing pages check box becomes available to indicate that book pages 
should be treated in pairs. When checked, the chart will be cleanly divided into parts the size of two side-by-
side pages. Lines will be drawn freely across the two pages, ignoring the page break between them. Part 
references will be to page pairs. 



       

Chart Options View: Contents Page 
After choosing the individuals to show and how the chart should be laid out, the next choice is what to include 
for each individual. The Content page is for this purpose. 

You can set the content for every individual to be the same. You can also vary the content for various groups 
of individuals, or for particular types of events, to emphasize what you consider important. 

The Content page is divided into two parts: 

• The top half of the page is for defining and selecting the match types that you want to assign content 
to. Several buttons are available for predefined match types. You can also select match types from a 
list or query.  

• The bottom half of the page is for setting the content choices for the currently selected match type. 

The match set can be further divided in the bottom half between primary and spouse. 

The Styles Page is the "sister" page to the Content Page. Both pages always maintain the same list of match 
types. Defining a match type on either page will automatically cause it to appear on the other page as well. 
For this reason, you can think of each match type as a "chart/style set" because it is shared by both pages, 
and can be used for both content and style selection. 

 

Match Type List  

The Match Type List displays all the content sets that have been defined. The content choices for the 
selected list will appear on the lower half of the page.  

The order in which the content sets appear is important: the lower in the list, the higher the priority. You can 
drag the rows to reorder them.   

When an individual box is a member of more than one match type, the specified content choices will be 
merged. When there is a conflict for the same element, priority will be given to content groups that appear 
later in the match type list.  
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Default Match Type 

The Default match type is always the first match type in the list. It specifies the content options that will be 
used when no other match type applies to an individual. If also specifies the content to use when a match type 
with a higher priority does not set a value for an option. Most of your content selection will be done when the 
Default match type is selected. 

Male / Female Button  

Click the Male / Female button when you want to vary the content between males and females on the chart. 
When selected, two match types will be added to the list box:  

• Male 
• Female 

Direct Line Button  

Click the Direct Line button when you want to select special content for the boxes of the direct line 
ancestors/descendants of the key individuals on your chart. When selected, two match types will be added to 
the list box: 

• Direct Line Individual 
• Family Link to Direct Line Individual 

The Direct Line Individual content set will be used for the actual direct line individual. If you want to also set 
special content for the spouse/partner of direct line individuals, you can use the Family Link to Direct Line 
Individual content set. This content set will be used for the spouse, regardless of whether the spouse 
appears in the same box as the direct line individual or in a separate box to the side.  

Key Button  

Click the Key button when you want to select special content for the boxes of the key individuals on your 
chart. When selected, two match types will be added to the list box: 

• Key Individual 
• Family Link to Key Individual 

The Key Individual content set will be used for the actual key individual. If you want to also set special 
content for the spouse/partner of key individuals, you can use the Family Link to Key Individual content set. 
This content set will be used for the spouse, regardless of whether the spouse appears in the same box as 
the key individual or in a separate box to the side.  

Individuals in List Button  

Click the Individuals in List button when you want to select special content for the boxes of individuals that 
are members of a list. The List View will open to allow a list or list members to be selected. 

Individuals in Query Button  

Click the Individuals in Query button when you want to select special content for the boxes of individuals that 
are in the result set of a query. 

Event Type Button  
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Click the Event Type button when you want to select special content for events of particular event types. The 
List View will open to allow an event type list to be selected. In addition to selecting event type lists, you can 
also select individual event type members on the List View. 

An event type content set can control the content for the following: 

• Event Parts 
• Event Notes 
• Added Flag 
• Added Icon 
• Event Media 

Text Content for Primary, Spouse, or Either 

Once a match type has been selected, you have a choice as to the content to include when the matching 
individual is the primary individual in the box, or a spouse. 

• Click Primary to view/set content choices for when the matching individual is a primary individual. 
• Click Spouse to view/set content choices for when the matching individual is a spouse. 
• Click Either to view/set content choices for whenever the individual appears.  

When Either is chosen, only the content choices that have been set the same for primary and spouse will be 
shown; the text boxes for other content choices will appear blank. Any changes made when Either is 
selected will change the setting for both primary and spouse. 

Text boxes will be shown in the secondary font style (typically, gray and italic) and the font and color buttons 
will be shown borderless to indicate when no value has been set for the element in the current content set. 
The value that you see in these controls is "showing though" from a lower-priority content set (one higher in 
the list box). Once you make a change to a content control, the text/button will be shown normally, indicating 
that a special content change has been made for the current content set. 

You can remove a content setting by pressing the DEL key when the control has the focus. The control will 
then return to showing the value from a lower-priority content set, in the secondary font style. 



       

Identifiers 

The Identifiers box controls the inclusion of individual names and other identifiers, according to identifier type. 
All non-hidden identifier types appear on the drop-down check list, arranged in a hierarchy. For example: 

 

Multiple items can be checked. 

The default is Preferred.  
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Attributes 

The Attributes box controls the inclusion of text attributes, individual flags, age, and sex. All non-hidden text 
attributes appear on the drop-down check list, arranged in a hierarchy. For example: 

 

Multiple items can be checked. 

The Text group choices refer to the A, B, C, D grouping of event types, as specified on the Event Types 
View, which is where text attributes are defined.  

Note: the text groups A-D define their own set of event types, which add to the other checks indicated on the 
dropdown list. If you include a text group, you may have attributes in the output that you were not expecting. 
An attribute for an event type that is marked (on the Event Types View) as part of a group (A-D) will appear in 
the output whenever the group is checked, even when the separate check for the attribute itself is not 
checked. 

The default setting for Attributes is Omit. 
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Events 

The Events box controls the inclusion of events, according to event type. All non-hidden event types appear 
on the drop-down check list, arranged in a hierarchy. For example: 

 

Multiple items can be checked. 

Choose principal to show all events, except for witnessed events and secondary events. 

The Group choices refer to the A, B, C, D grouping of event types, as specified on the Event Types View. 
Date range will show just the birth and death dates separated by a dash. Year range is similar, except only 
the years of the birth and death dates are shown. 

Note: the text groups A-D define their own set of event types, which add to the other checks indicated on the 
dropdown list. If you include a text group, you may have event types in the output that you were not expecting. 
An event type that is marked (on the Event Types View) as part of a group (A-D) will appear in the output 
whenever the group is checked, even when the separate check for the event type itself is not checked. 

Adding/removing an event type to a group on the Event Types view will affect charts that have a group flag 
selected for content. Using a saved chart options file with a different database will also affect which event 
types are included in each of the group flags. 

Event Parts 

The Event Parts box controls the types of data shown for each event. The following choices appear on the 
drop-down check list for reports: 

 

Multiple items can be checked.  

The default is Date. Choose Label if you are interested only in the types of events stored and not the data 
itself; a label will appear in those boxes where an event record is defined, regardless of the types of data 
available. For the other choices, if no information of the specified type(s) is stored, nothing is shown for the 
event. 
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Notes 

The Notes box controls the inclusion of general and research notes.  

The following choices appear on the drop-down check lists: 

 

Multiple items can be checked. 

The default is Omit. Marked only can be used as a filter of the other note types selected. 

Add Flag 

A text string can be added by typing the text in the Add Flag box. The text will be shown with the "Flags" font 
style, and will be grouped with the other attribute flags, if included. 

Media Content for Primary, Spouse, Family 

Multimedia records that are linked to individuals or families can be shown on the chart. They can appear 
inside and outside the individual boxes, with titles and captions. Separate multimedia choices can be selected 
for when the matching individual is the primary or spouse, or media can be selected for when the matching 
individual is either. For when the individual is the primary, family media can also be selected. In addition to 
multimedia, an icon can also be added. 

• To include multimedia, choose a Picture Placement for Primary, Spouse, or Family. 

Add Icon 

An icon can be added to the chart boxes for individuals in the current group. When you click on the Add Icon 
button, the Icon Pick Dialog will open. You can select any icon in a separate icon file (extension .ico) or in an 
executable file (extension .exe, .dll). Genbox is distributed with a large number of icons useful for genealogical 
charts. They are installed to the subdirectory "icons" beneath the Genbox program directory. 

The selected icon will then show on the button face whenever the individual is the primary, or the spouse, or 
either, depending on the media content setting. If the icon is assigned to just primary or just spouse, the icon 
face will show blank with "both" is selected. 

• To change the icon, click on the button again and make a different selection. 
• To remove the icon, click on the button again, click Cancel on the dialog, and click Yes when 

prompted "Delete link to icon?". 

Picture Placement 

The Picture placement box provides the following choices on its drop-down list: 
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Omit is the default. The next 5 choices produce placements outside of the associated individual box, on the 
indicated side or, in the case of the Nearby choice, whichever side is most convenient. The "Inside" choices 
produce placements inside the associated individual box. The Primary/Spouse/Family choices place the 
media to the left or right of the indicated section within the box. A chart box can have up to three sections: a 
primary individual section, a spouse section, and a family section. The media will be sized to fit next to the 
selected box section, inside the box. 

Video multimedia can be selected for inclusion on charts. The still image will be used when printed. 

Picture Title and Caption 

Pictures appearing outside of the individual boxes may include a title and a caption. The Title box and 
Caption box provide the following placement options on their drop-down lists: 

 

Left bottom will be aligned with the left edge of the picture; Right bottom will be aligned with the right edge 
of the picture. The other placements will be horizontally centered. 

Inside top and Inside bottom will produce placements inside the picture frame, on top of the picture itself. 
With these placements no extra space is required to display picture titles and captions. You may need to 
change the font to white or some other light color in order to make it visible in front of a dark picture.  
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Reset Button 

Click the Reset button to clear all content settings for the current match type (or reset to default values if the 
current match type is Default). 

Reset All Button 

Click the Reset All button to remove all match types (except Default) from the match type list box. 

Note: Match types are shared by the Content and Styles pages. This button will remove all match types from 
the list box on the Styles page as well. 



       

Chart Options View: Styles Page 
After choosing which individuals to show, the layout for the chart, and the content for each individual, the next 
choice is the display style for the data: the fonts, line styles, colors and shading, and box shapes. The Styles 
page is for this purpose. 

You can vary the styles not only for individual display elements, but also for various groups of individuals. 
Special styles are excellent for emphasizing certain individuals, lineages, and selected groups.   

The Styles page is divided into two parts, like the Content page: 

• The top half of the page is for defining and selecting the match types that you want to assign styles to. 
Several buttons are available for predefined match types. You can also select match types from a list 
or query.  

• The bottom half of the page is for setting the style choices for the currently selected match type. 

The match set can be further divided in the bottom half between primary and spouse. 

The Content Page is the "sister" page to the Styles Page. Both pages always maintain the same list of match 
types. Defining a match type on either page will automatically cause it to appear on the other page as well. 
For this reason, you can think of each match type as a "chart/style set" because it is shared by both pages, 
and can be used for both content and style selection. 

 

Match Type List  

The Match Type List displays all the style sets that have been defined. The style choices for the selected 
match type will appear on the lower half of the page.  

The order in which the style sets appear is important: the lower in the list, the higher the priority. You can drag 
the rows to reorder them.   

When an individual box is a member of more than one match type, the specified style choices will be merged. 
When there is a conflict for the same element, priority will be given to style groups that appear later in the 
match type list.  
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Default Match Type 
The Default match type is always the first match type in the list. It specifies the style options that will be used 
when no other match type applies to an individual. If also specifies the styles to use when a match type with a 
higher priority does not set a value for an option.  

Male / Female Button  
Click the Male / Female button when you want to vary the styles between males and females on the chart. 
When selected, two match types will be added to the list box:  

• Male 
• Female 

With these two styles sets, you could, for example, show all males with dark blue text in light blue boxes, and 
all female with dark red text and pink boxes. 

Direct Line Button  
Click the Direct Line button when you want to select special styles for the boxes of the direct line 
ancestors/descendants of the key individuals on your chart. When selected, two match types will be added to 
the list box: 

• Direct Line Individual 
• Family Link to Direct Line Individual 

The Direct Line Individual styles set will be used for the actual direct line individual. If you want to also set 
special styles for the spouse/partner of direct line individuals, you can use the Family Link to Direct Line 
Individual styles set. This styles set will be used for the spouse, regardless of whether the spouse appears in 
the same box as the direct line individual or in a separate box to the side.  

Key Button  
Click the Key button when you want to select special styles for the boxes of the key individuals on your 
chart. When selected, two match types will be added to the list box: 

• Key Individual 
• Family Link to Key Individual 

The Key Individual styles set will be used for the actual key individual. If you want to also set special styles 
for the spouse/partner of key individuals, you can use the Family Link to Key Individual styles set. This 
styles set will be used for the spouse, regardless of whether the spouse appears in the same box as the key 
individual or in a separate box to the side.  

Individuals in List Button  
Click the Individuals in List button when you want to select special styles for the boxes of individuals that are 
members of a list. The List View will open to allow a list or list members to be selected. 

Individuals in Query Button  
Click the Individuals in Query button when you want to select special styles for the boxes of individuals that 
are in the result set of a query. 

Event Type Button  
Click the Event Type button when you want to select special styles for events of particular event types. The 
List View will open to allow an event type list to be selected. In addition to selecting event type lists, you can 
also select individual event type members on the List View. 

An event type styles set can control all styles, except for name font style. 
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Text Fonts for Primary, Spouse, or Either 
Once a match type has been selected, you have a choice as to the styles to display when the matching 
individual is the primary individual in the box, or a spouse.  

• Click Primary to view/set style choices for when the matching individual is a primary individual. 
• Click Spouse to view/set style choices for when the matching individual is a spouse. 
• Click Either to view/set style choices for whenever the individual appears.  

When Either is chosen, only the font style choices that have been set the same for primary and spouse will 
be shown; the font styles for other text field choices will appear blank. Any changes made when Either is 
selected will change the setting for both primary and spouse. 

Font style buttons will be shown borderless to indicate when no value has been set for the font style of the 
corresponding data field in the current style set. The font style value that you see on these buttons is "showing 
though" from a lower-priority style set (one higher in the list box). Once you make a change to a font style, the 
button will be shown normally, indicating that a special font style change has been made for the current style 
set. 

You can remove a style setting by pressing the DEL key when the control has the focus. The control will then 
return to showing the value from a lower-priority style set, in the secondary font style. 

Family Box Styling 
With the exception of the spouse text font styles, all box styles are determined by the primary individual in the 
box. If there are spouses shown in the same box, they will not affect the box styles. 

Text Font Buttons 
There are four font buttons, each for a different subset of the text in the chart boxes: 

• Name 
• Fields 
• Field Labels 
• Flags 

Choosing bold fonts for the Name of the primary and Spouse makes them stand out. The Flags are normally 
shown in a different font style from Fields and Field labels, such as italics. 

You can set the font styles differently for the Primary and Spouse. You could set all spouse fonts to show in 
blue, for example. 



       

Connect Line Styles 
The connecting lines are the lines drawn from child to parent, and from individual to spouse. 

The Style choices available on the drop-down list for connecting lines are: 

 

The Width box is used to set the pixel width of the lines. A value of 0 indicates to draw the lines as narrow as 
possible. 

The Color box can be used to set the color of the connecting lines. 

Box Border Styles 
Box borders can be styled, unless Unboxed is checked on the Layout page. 

The Style choices available on the drop-down list for box borders are: 

 
The Double styles produce a double-line border. 

The Width box is used to set the pixel width of the borders. A value of 0 indicates to draw the box borders as 
narrow as possible. 

The Color box can be used to set the color of the box borders. 

Box Shadow Styles 
Boxes can have simulated shadows, unless Unboxed is checked on the Layout page. 

The Style choices on the drop-down list specify which sides to show the shadow: 

 

The Width box is used to set the pixel width of box shadows. A value greater than 0 is necessary to see the 
shadow. 

The Color box can be used to set the color of the box shadow. The default is black. 

Box Head and Tail Shapes 
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Boxes on rectangular charts don't have to be rectangular! Using a different shape immediately adds interest 
and draws attention. Box shapes can be specified independently for the head and the tail of the box. The 
head is the side of the box that is headed in the drop direction. The tail is the opposite side. 

The choices available on the drop-down lists for head and tail shapes are: 

 

Box Corner Fill 
Box corners can be filled with the Box border color, for added visual effect. Choices on the drop-down list 
are: 

 

External filling means the corner area outside the box shape is filled, up to the enclosing rectangle. This 
choice only has an effect when nonrectangular box shapes are selected. 

Internal filling means the corner area inside the box shape is filled. The effect of this choice varies, 
depending on the box shape selected. 

Box Margins 
The Box head and tail margins control the amount of internal space that is placed between the (rectangular) 
box edges and the text. The default is one-tenth of an inch. Internal box margins are specified on this page 
because they often need to be increased for certain box shape selections, in order to keep the text from 
extending outside the visible box borders. 

• The margins for the box sides will be the larger of the head and tail margin settings. 

Box Shading 
The Box shading button displays the color for the box background on its face. Click the button to choose a 
different color.  

• Keep in mind the font colors when choosing the box shading color. If the fonts are dark, the shading 
color should be a light shade, so that the text will still be readable. 

Reset Button 
Click the Reset button to clear all style settings for the current match type (or reset to default values if the 
current match type is Default). 

Reset All Button 
Click the Reset All button to remove all match types (except Default) from the match type list box. 

Note: Match types are shared by the Content and Styles pages. This button will remove all match types from 
the list box on the Content page as well. 
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Chart Options View: Detail Page 
The Detail page contains content options for specific details of the data. While the Content and Styles pages 
specify options for chart boxes according to groups of individuals, the Detail page options apply to boxes in all 
individual groups, and the chart as a whole. 

 

Place Detail 

Places can appear with all place levels or with only specific place levels. The default operation is to show all 
place levels except for the default nation/area.  

There is a checkbox for each place level, one for place modifiers, and two for special combinations:  

• [6L]    Nation/Area 
• [5L]    State/Province 
• [4L]    County 
• [3L]    Township 
• [2L]    City 
• [1L]    Local site 
• [0L]    Place Modifier 
• [LH]   "Level High" (lowest of {5,6}) 
• [LL]    "Level Low" (lowest of {2,3,4}) 

When a place level is not checked, no place information for that jurisdiction will be shown on the chart.  

Note: The [LH] and [LL] options prevent the use of the other level selectors.  

Place Detail: All Levels 

When this option is checked, all place information will be shown on the chart. 

Place Detail: Low + High 

When this option is checked, only the [LH] and [LL] check boxes will be set. This pair produces a "City, State" 
combination for most place names. It can be selected to save space on the charts. 

Level Low ([LL]) 
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When you select the [LL] ("Level Low") check box, Genbox will select the city name (level 2) when it is 
available, or the township name (level 3) when it is available, or finally the county name (level 4). Only one 
level of information will be shown from the group {2,3,4}. 

Level High ([LH]) 

When you select the [LH] ("Level high") check box, Genbox will select the state name (level 5) when it is 
available, otherwise the nation/area name (level 6). Only one level of information will be shown from the group 
{5,6}. 

Family Box Pairs - Duplicate Spouse Data 

A family box pair is two chart boxes linked with a marriage link. Each box contains the data for a spouse. You 
can optionally include some or all of the data for the other spouse as well, if you think that would make the 
chart more readable. 

Family box pairs can be adjacent to each other. This occurs when the "Single Box for Couples" layout setting 
is set to "No". They can also be widely separated on the chart. This can happen when both spouses have 
ancestor links. 

For both adjacent and non-adjacent family box pairs, the pick list choices are: 

 

Choosing either "Full spouse data" or "Spouse name only" on non-adjacent family boxes can help make a 
chart more readable, because the spouse information is readily available without needing to follow a 
potentially long marriage link line. For adjacent family box pairs, the default is "Omit spouse data". 

Note: Regardless of this setting, the marriage information appears in only one box. It will appear in the box 
that contains the children link, if any. 
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Chart Options View: Links Page 
The Links page contains formatting options for links on the chart. The links are the connecting lines drawn 
between boxes, and their labels. 

 

Partners 

When a family is designated as Partners, special styles can be applied to the link lines from individual to 
spouse, as specified on the drop-down list:  

 

Non-birth Parents 

When the child to parent relationship is something other than biological, special styles can be applied to the 
link lines, as specified on the drop-down list:  
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Descendant Stubs 
Descendant stubs can be included on charts to indicate that there are additional descendant individuals, but 
they have been omitted from the chart. This layout choice is selected on the Layout page. The styles available 
for stubs appear on the drop-down list:  

 

Show Dashed for Surety Levels 
The surety of spouse links and child to parent links can be shown by varying the line style between solid and 
dashed. The choices for which surety levels appear dashed are on the drop-down list:  

 

0 - 1: Undetermined to Marginal 
0 - 2: Undetermined to Probable 
0 - 3: Undetermined to Assemblage 
0 - 4: Undetermined to Convincing 
1 - 2: Marginal to Probable 
1 - 3: Marginal to Assemblage 
1 - 4: Marginal to Convincing 
 

Cross-Links 
A cross-link is a family link drawn between a family box pair that crosses other links. Cross-links appear 
when the chart layout prohibits drawing the link without crossing other links. 

Choices for the display of cross-links are: 

 
The Cross-reference choice produces labels of the form "(A)", "(B)", "(C"), etc. for each cross-link. The labels 
appear on short stubs beneath the boxes being linked. No line is drawn between each pair. This option is 
attractive when the cross-links become a distraction when attempting to read the chart. 

Link Label Font 
Use the Link Label Font button to specify the font for link labels. Typically, a small font size is used (8 points 
or smaller) for link labels. 

Link Cross Reference Font 
Use the Link Cross Reference Font button to specify the font for cross-reference link labels. Specifying a 
color is particularly helpful in spotting these labels when reading a chart. The default color for the cross-
reference link label font is red. This font is also used for the reference text in Duplicate Ancestor boxes. 
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Chart Options View: Format Page 
The Format page contains a variety of formatting options for the chart. While the Content and Styles pages 
specify options for chart boxes according to groups of individuals, the Format page options apply to boxes in 
all groups, and the chart as a whole. 

 

Background Graphic 
A chart can have a background graphic that lies "behind" the boxes. Type the filename of the image file into 

the text box, or click the Open File button  to browse for the file. 

The picture will be sized until its height or width matches that of the chart. The aspect ratio will be maintained 
by default. 

• To make the picture completely fill the chart background, click the Stretch button. 

Tip    If a Chart frame is selected on the Frames page, the picture will assume the shape of the inner chart 
frame. 

Event Templates 
The event labels used for basic events and other events can be independently selected from the following list: 
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Color Boxes by Generation 
Box borders and interiors can be colored according to generation, to highlight the different generations on a 
chart. This feature is particularly useful when the Generational alignment on the Layout Page is set to 
"Relaxed". 

The choices available on the drop-down list are:  

 
There are two rows of six color buttons each, with the top row to specify the box border colors, and the 
bottom row to specify box shading colors. The colors will be used in sequence for each generation, only 
repeating after all six colors have been used.  

• To change the color used for a generation, click its color button to open the Select Color Dialog. 
• You can click the Default button to set all the color buttons to the default values. 

Note   If used, this control will override the box color choices on the Styles page. 

Pictures: Connecting Line 
On the Content page, multimedia can be selected for placement outside of the associated individual box, 
either above, below, left, or right. If you would like a connecting line to be drawn from the picture to the 
associated box, click the Connecting line check box. 

Pictures: Body 
When printing drafts of a chart, you may wish to omit the body of pictures, to save on ink and decrease 
printing time. Or, you may intend to tape the actual photographs to the printed chart, so you don't need a 
printed image. The Body box allows you to select these features. The choices on the drop-down list are: 

 
For omit, no media appears on chart, and no space is reserved. Choose show for normal operation. The Info 
choice will print the image filename and other related information inside a simple frame, instead of the picture. 
The frame choice will print only a simple frame. 

Box Format: Text Alignment 
The Text alignment box provides choices for text horizontal alignment inside the individual boxes: 

 
Left is the default. 

Box Format: Spouse Label 
When family boxes are used, the name of the spouse appears in the same box as the primary individual. 
Normally, there is no label before the name of the spouse. The Spouse label box provides choices for a label: 

 
You can also type in your own text for the label. 
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Box Format: Dim Text for Surety Levels 
The surety level on data inside an individual box can be indicated by showing the text in gray. The Dim text 
for surety levels box provides a choice of the following surety level combinations to show with dimmed text: 

 

0 - 1: Undetermined to Marginal 
0 - 2: Undetermined to Probable 
0 - 3: Undetermined to Assemblage 
0 - 4: Undetermined to Convincing 
1 - 2: Marginal to Probable 
1 - 3: Marginal to Assemblage 
1 - 4: Marginal to Convincing 

Box Format: Check Boxes 
A number of check boxes are provided for various format options for text inside individual boxes. 

Format notes as plain text 
Click this check box to show the notes text without any special formatting (bold, italics, underline). 

Show generation level numbers 
Click this check box to include the generation number in the box. 

Hide label-only content 
Click this check box to suppress lines for events that have no data content to display, other than the event 
type label. For example: suppose the event parts selected for output on a chart are "Label, Date". That means 
the chart should display the event type label and the event date for each event. Only event dates are shown; 
event places should be omitted from the chart. Now suppose there is an event record for an individual's "birth" 
that includes the place of birth, but the birth date has been left blank. Since chart options is restricting event 
parts to "Label, Date", then for this event, only the event label ("b.") will be output. 
 
This empty line is often undesirable. To get rid of these label-only lines, click Hide label-only content.  

Label missing basic events 
Click this check box when all boxes should include a line for birth, death, and marriage, even if no data 
records for these events are stored. This option is useful when you want to leave space for others to write this 
information on the chart.  

Name IDs 
Click this check box to include the name IDs for all individuals. 

Short dates 
Click this check box to show dates in the short date format. 

Short names 
Click this check box to show individual names in the short name format. This format abbreviates middle 
names. 

Short places 
Click this check box to show places in the short place format. This format uses identified short names for 
each place level. 
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Chart Options View: Sizes Page 
Genealogy charts can be huge. Without careful selection of content, layout, and sizing, the resulting size of 
the chart may be impractical. You may be able to view it fine on the screen, but printing it out, assembling it, 
and finding a place to display it can be another matter. The Sizes page is an important tool for controlling the 
overall size of the chart. You will find that changing settings on this page can affect the size of your chart 
dramatically. Not only the size, but the aspect ratio can be altered. If your chart is too short and wide, you can 
make it taller and narrower.  

 

Chart Margins 

The top, bottom, left, and right Chart margins control the white space around the outside edge of the chart. 

Page Margins 

The top, bottom, left, and right Page margins control the white space around the outside edge of each 
printed page. The page margins do not show when viewing the chart onscreen. However, the divisions that 
will be used for pages do show as an overlay of dashed lines. As you increase the page margins, you will see 
that the page divisions become closer together, because less will fit on each page. 

Max Pages Wide 

Use the Max pages wide setting to force the chart to a certain size. The entire chart will be scaled down in 
order to make it fit the specified number of pages wide. 

You may wish to limit the size of a chart when printing draft charts, and then return to normal size when 
making your final copy. This can save on paper and printing time, and produce a chart that's easier to handle 
while you are checking its contents. 

A value of 0 (the default) will disable this option. 

Chart Max Width/Height Ratio 

Use the Max width/height ratio to control the aspect ratio of the chart as a whole. A value of "3", for example, 
means that the chart can be no wider than three times its height. When used, the boxes with be narrowed, or 
more boxes will be arranged vertically, until the specified ratio is achieved. 
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A value of 0 (the default) will disable this option. 

Horizontal and Vertical Overlap 
When printing charts on multiple pages for later assembly, sometimes it is helpful to have a small amount of 
the chart shown on the edge of one page to be repeated on the next page. This area of overlap can make it 
easier to trim and tape the pages together, because the trimming doesn't need to be as accurate. The 
Horizontal overlap and Vertical overlap boxes are for entry of the overlap amounts. 

Alignment 
The Alignment box allows you to control how the chart is positioned on its group of pages. You may find that 
the last row or column of pages contain only a small portion of the chart, making it appear off-center. The 
choices available for alignment are: 

 

Box Width and Height 
Genbox sizes chart boxes according to their contents: boxes with more content are larger than boxes will less 
content. The Box width and Box height boxes for maximum and minimum sizes allow you to limit this 
automating sizing. Entering a minimum value will force small boxes to be larger. Entering a maximum value 
for either height or width will force large boxes to grow in the other dimension. Entering a maximum value for 
both height and width may cause data in some boxes to be omitted. You can produce a chart with boxes of a 
fixed width or height by setting Max and Min to the same value. 

A value of 0 indicates the size is unlimited. 

Box Width/Height Ratio 
You can control the sizing of chart boxes in a relative way with the Box width/height ratio box. For example, 
a value of "3" (the default) will limit the width of chart boxes to be no more than three times their height. When 
boxes start to become too wide, the text will be wrapped, making the box taller. 

Enter a value of 0 to allow unlimited box aspect ratios.  

Box Separation 
Box separation refers to the distance between boxes on the chart that are in each generational row (or 
column). Decreasing the box separation will bring all of the boxes closer together. 

Drop Distance 
Drop distance refers to the distance between generations. This is the spacing between parent boxes and 
children boxes. Decreasing this value will bring generations closer together. 

Uniform Generations 
When Uniform Generations is checked, all boxes on each generational level will be sized to the largest box 
on that level. The uniform sizing is in the direction of drop only. This can create a neat appearance for some 
types of charts. Setting this option does not increase the overall size of the chart. 

Line Spacing 
The text lines in a chart box have a default vertical spacing, determined by the font. You can override the 
normal setting and have lines drawn closer together, making the boxes smaller in the vertical direction. 
Depending on the font choices, clarity may become a problem. The Line spacing choices available are: 
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Font Scaling 
Changing this value will affect all fonts on the chart. Enter any percentage value, or choose from the drop-
down list: 

 

You can also reduce the size of a chart with the Max Pages Wide setting. The difference is that Font scaling 
affects only fonts, while the Max Pages Wide setting affects all elements. 

You may wish to drastically reduce the font scaling when printing draft charts, and only returning to normal 
size when making your final copy. This can save on paper and printing time, and produce a chart that's easier 
to handle while you are checking its contents. 

Pictures - Sizing 
Pictures can appear in two types of places on a chart: inside of the individual boxes next to the text, and 
outside of the individual boxes. The Inside box - Max size box is used to specify the size of pictures when 
they appear inside individual boxes. The value entered will be used for both the maximum height and 
maximum width. The Outside box - Max size box is used to specify the size of pictures when they appear 
outside individual boxes. Pictures outside can be shown larger. 

The Inside margin value is used to specify the white space separating the box text from the picture when a 
picture appears inside an individual box. 

The Outside margin value controls the white space separating the title and caption text from the picture 
edges. 

Pictures - Fonts 
The Title font and Caption font buttons allow you to specify the fonts for title and caption text for pictures on 
the chart. 
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Chart Options View: Frames Page 
As the finishing touch, frames can be added to the chart, picture boxes, title box, and legend. Frames are 
excellent for setting off an item from its surroundings, adding color and drawing attention. Frame choices 
include corner shape, corner fill, sides to include, pixel width, color, corner size, margin size, matte, shading, 
and shadow. The chart frame can also be a double frame, with independent settings for each. These options 
are set on the Frames page. 

 

Chart Frame 
Check the Include check box to produce either a single or double Chart frame. The chart frame runs around 
the outside edge of the chart, with all boxes appearing inside the frame. A double chart frame will be drawn 
with independent option settings for the outer and inner frame. Depending on the Corner shape and Corner 
margin size, the frames may overlap, producing a complex design. 

Picture Box Frames 
Pictures positioned outside of individual boxes have a thin line rectangular frame by default. You can use the 
options here to create more elaborate frames. 

Title Box Frame 
When chart titles have been selected for output, you can click the Include frame check box to include a frame 
around the titles. 

Legend Box Frame 
When a chart legend has been selected for output, you can click the Include frame check box to include a 
frame around the legend box. 
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Corner Shape 
The choices available on the drop-down lists for corner shapes are: 

 

Corner Fills 
Frame corners can be filled with the Frame color, for added visual effect. Click the Corner fill check box to 
select. 

Sides to Include 
Individual sides of the frame can be selected from inclusion. Choices from the drop-down list are:  

 

Frame Width 
The Frame width boxes allow entry of the pixel width for the frame. A value of 0 means use the narrowest 
line possible. 

Shadows 
Picture boxes, the title box, and the legend box can have a simulated shadow. The Shadow placement 
boxes provide the following placement choices:  

 

Colors for Frame, Matte, Shadow, Shading 
There is a Color button to select the color for each frame and shadow. Pictures have an additional Matte 
color button. The matte is the open area between the frame and the picture. The title and legend boxes also 
have a Shading color button. The shading color will fill the box behind the text. Clicking any of these color 
buttons will open the Select Color Dialog for selection of the color.  
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Sizes for Corners, Margins and Matte 
The Corner size specifies the size of the corner area of the frame. The corners can have special shapes. A 
larger corner size value will produce larger shapes.   

The Margin size is the amount of white space between the (rectangular) frame and its contents. This value 
may need to be increased when the frame is not rectangular, as some choices for corner shape can result in a 
visible frame that extends into the text inside the frame.  

The Matte size specifies the size of the matte used with picture frames. The matte is the open area between 
the frame and the picture. A value larger than zero is necessary in order to see the matte color. 



       

Chart View 
The Chart View appears when a chart is generated by clicking the Make Chart button on the Chart Options 
View. The generated chart will be shown in the view, centered on the box of the key individual. When the 
chart is larger than the visible area, you can use the scroll bars at the right and bottom edges to scroll. 

Using the Chart/Report Toolbar 
When the Chart View opens, the Chart/Report Toolbar will appear next to the main toolbar. There are five 
tool buttons and a drop-down list box. The current tool will have a pressed appearance. Click on a tool button 
to select a tool: 

 Select Tool 

 Magnify Tool 

 Zoom Size Tool 

 Text Tool 

 Picture Tool 

 Line Tool 

Zooming 
When you want to see more of your chart at once, you need to zoom out. If you are interested in seeing more 

detail in a small area, you need to zoom in. To zoom, use the Magnify Tool  or the Zoom Size Tool  

.  

Finding Data 
When a large chart is produced, it can be a challenge to maneuver to the location of interest using just the 
zoom tools and scrollbars. Another way is available. When you right-click on the chart, a popup-menu will 
appear, which includes the following items: 

• Find ... 
• Find Again 
• Find Reverse 

When you select Find, the Chart Find Data Dialog appears. You can enter a name, ID, or any text that you 
want to search for, for a specified chart box type or any box type. 

Selecting Chart Boxes 
• To select chart boxes, first click on the Select tool .  
• Click on the box you want to select. A selected box will be shown with handles at the corners and 

sides. 
• You can also drag a selection rectangle around a group of boxes that you want to select. 

Viewing Chart Properties 

• To view the properties for a chart, right-click the mouse on an open area of the chart 
• From the pop-menu, select Chart Properties. 

The Chart Properties Dialog will open, showing information about the current chart. 

Viewing Box Properties 
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• To view the properties for a chart box, first select it. 
• Right-click the mouse to bring up the popup menu. 
• Select Box Properties from the menu. 

The Chart Box Properties Dialog will open, showing the box type, primary individual's name, ID, and date 
range. If there is a spouse in the box, the name, ID, and date range of the spouse will also be shown. The 
page number on which the box sits is also shown. 

Adding Annotations 
Annotations are short lengths of text that can be typed on top of the chart. They can be used to draw attention 

to certain data items, or provide explanatory text. They are added with the Text Tool . 

Adding Lines 
Freehand lines can be added to a chart after it has been generated. You can draw arrows, circle boxes, and 

draw connecting lines between annotations and boxes. Lines are added with the Line Tool  . 

Adding Pictures 
Additional pictures can be added to a chart after it has been generated. They are added with the Picture Tool  

. 
• To add a picture to a chart, click the Picture Tool. 
• On the chart, click where a corner of the picture should start, and drag the pointer to the diagonally 

opposite corner to define the desired rectangle. 
• If a database is open, the Media Pick Dialog will open and you will be prompted to select a picture 

from the Media Library for that database. You can also click the Add File to Library... button on the 
dialog if you want to use a different picture from the file system. 

• If a database is not open, you will be prompted to select a media file from the file system. 
• If you click Cancel, a frame will be added without a picture. This can be a useful background for an 

annotation, "callout box", or other purpose. 

When a picture is inserted into the chart, the rectangle selected by dragging the pointer will be used to size 
and place the picture. Because the aspect ratio is always maintained on inserted pictures, the actual size may 
be narrower or shorter than the selected rectangle. If a position on the chart is clicked with the Picture Tool 
but no rectangle is drawn by dragging the pointer, a default rectangle will be used instead. 

You can click and drag your picture selection rectangle on top of an existing box. This results in a picture 
placement that appears to be "inside" the box. 

Adding Linked Objects 
In addition to lines, text, and pictures, virtually any document on your computer can be inserted as a link on a 
chart. For example: you may have a Microsoft Word document that provides some interesting background 
details on the people or locations that are named on your chart. You could include this document into an open 
area on your chart. You can move it and size it just like any other object on the chart. 

• To insert a link to an object on your chart, choose Insert New Object from the Edit Menu. 
• When the dialog appears, click Create from file. 
• Enter the path to the file, or click the Browse... button and select the file. 
• Click the Link check box. 
• Click OK. 

The original application will generate an image of the document, then the image will appear at the top left 
corner of the chart in its original size. You can drag the object from any point on its interior to the desired 
location. You can also drag any of its corners or edges to size the object. 

Sizing Boxes 
• To size a chart box, first select it. 
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• Drag one of the side or corner handles to the desired new size. 

Dragging a side handle will preserve the size of the opposite dimension. Dragging a corner will preserve the 
location of the diagonally opposite corner. The link lines will be resized to match.  

Moving Boxes 
• To move a chart box, first select it. 
• Click on the center of the box and drag it to the desired location. 

The link links will follow the moved boxes. 

Deleting Boxes 
• To delete a box or group of boxes, first select them. 
• Select Cut from the Edit menu, or press the Delete key. 

When boxes are deleted, any link lines connected to them are also deleted.  

Hiding Leaves 
Sometimes it is helpful in understanding the link structure of a complex chart to be able to "strip away" the 
"leaf" boxes. A leaf box is a box with no descendants, no marriage links, and no attached boxes (attached 
boxes include media boxes, annotations or lines).  

• To hide all the leaf boxes on the chart, choose "Hide Leaves" from the right-click popup menu. 

This operation can be performed repeatedly, each time removing the boxes that became leaves after the 
previous set of removals. 

Making the Frame Snug 
Fan Charts 
A fan chart is initially drawn with space for the full portion of a circle selected-- either 90, 180, or 360 degrees. 
Depending on the actual data selected for output, there may be portions of this reserved area that are blank. 
A more appealing chart can be produced by "closing up" this unused space between the actual chart and the 
frame. To do this, right-click on the fan chart and choose the option Make Frame Snug. 

Rectangular Charts 
For rectangular charts, the chart frame will resize automatically in most cases, whenever an edge box is 
resized, moved, or deleted. You can choose Make Frame Snug from the right-click menu in case the 
automatic resizing did not occur. 

Undoing the Last Operation 
To undo the last chart edit operation (which could be moving a box or group of boxes, deleting a box or group 
of boxes, sizing a box, adding a picture box or annotation, hiding leaves, etc.), press CTRL+Z. You can also 
select "Undo" from the Edit Menu. Selecting "Undo" a second time will restore the last edit operation. 
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Report Options View 
Genbox can produce reports of your genealogical data. Reports are rich text documents that can be viewed 
and edited in a word processor, or web pages that can be viewed in a browser and uploaded to the web. 
Reports can be narrative text, fill-in-the-blank forms, indented lists, tables, envelopes, or labels. They 
sometimes include graphical lines, and can include images. 

Genbox produces several types of reports: 

• Ancestor Narrative 
• Pedigree 
• Descendant Narrative 
• Outline Descendant 
• Family Group 
• Individual Narrative 
• Calendar 
• Custom 

There are many options for each report type, organized onto pages. Some pages are only available for certain 
report types. Most pages are similar for each report type: 

            Key Page 
            Front Page 
            Sections Page 
            Back Page 
            Headings Page 
            Content Page 
            Content Page (Custom Reports) 
            Content Page (Calendar Reports) 
            Sort Page (Custom Reports) 
            Media Page 
            Media Page (Calendar Reports) 
            Style Page 
            Detail Page 
            Format Page 
            Frames Page

There is a row of buttons at the bottom of the view:  

• Click Make Report when you are ready to produce the report. 
• Click Save Options to save your settings to a named options file that you can load again later. You 

will be prompted to select a filename. 
• Click Reload to restore the settings to the way they were the last time the options file was saved. 
• Click Defaults to reset all of the settings to Genbox defaults for the current report type. The defaults 

are the same options as used by the Basic menu choice. 
• Click Close when you are done with the Report Options View. 

Make Report Button 

When you choose Make Report, a progress window will be displayed, then the Report View will open and 
display the generated report. The Report Options View will still be open, but it will be behind the Report 
View. After you close the Report View, you will see the Repot Options View again. You can make further 
changes to the options, then choose Make Report again. You can repeat this cycle until you are satisfied with 
your report. Then click the Close button to close this view. 

Save Options Button 

There are a lot of report options that you can set. After you have the options the way you prefer, you can save 
them so that you can quickly produce more reports with the same options later. When you click Save 
Options, the "Save As..." file dialog will appear. The default filename shown on this dialog will be the current 
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filename of the options file, if any. If you want to save your changes back in the same file, click OK. Otherwise, 
enter a new name for the options file. 

Reload Button 

Genbox makes it easy for you to experiment with different report options. When you close the Report Options 
View, your changes will be remembered throughout the current session. This means you can do other things, 
such as select a different current individual on the Individuals View, then select your same report options file 
from the menu again, and the changes you made will still be there. This makes it easy to try out your options 
with different individuals as keys. 

Sometimes you will decide you want to get rid of all the changes you made, and restore the options to the way 
they were when you started. You can do this by clicking the Reload button: the report options will be reloaded 
from the file, so the settings will be restored to the way they were the last time the options were saved. This 
also happens whenever you exit Genbox and restart the program. 

Defaults Button 

Click the Defaults button to reset all of the settings to Genbox defaults for the current report type. The 
defaults are the same options as used by the Basic menu choice: it produces a plain-looking report. It 
provides a good starting point when you want to create a new options file from "scratch". 

Close Button 

The Close button closes the Report Options View. If you were using a report options file selected from the 
Report Options Menu, only the window is closed; the report options file will remain open, so that the next time 
you open that menu option, any changes you made during the current session will still be there. 

If you had opened your report options file with the "Open Options file..." menu choice, both the document and 
window are closed when you click this button. If you have made changes to the report options file, you will be 
prompted to save your changes first.  

 If the media file is not found in the specified location, no other locations will be searched. 

Ancestor Narrative Reports 

Ancestor Narrative reports show the ancestors of the starting individual(s). 

Pedigree Reports 

Pedigree reports show the ancestors of the starting individuals. 

Descendant Narrative Reports 

Descendant Narrative reports show the descendants of the starting individuals. 

Outline Descendant Reports 

Outline Descendant reports show the descendants of the starting individuals. 

Family Group Reports 

Family Group reports present the data on individuals, their spouses, and children in a family format. 

Individual Narrative Reports 

Individual Narrative reports present the data of a single individual. 
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Calendar Reports 

Calendar reports present data about individuals organized into a calendar format. 

Custom Reports 

Custom reports are customized reports that can contain lists of nearly any type of data from the database: 

• Individuals 
• Places 
• Events 
• Citations 
• Sources 
• Multimedia 
• Researchers 
• Correspondence Log 
• Research Targets 
• Projects 
• Lists 

Information can be presented in various formats: 

• Form: the data is shown in individually labelled fields, several fields per row. 
• Single Column: the data is shown in individually labelled fields, one field per row. 
• Table: labels are shown in a header across the top, with data in columns below. 
• Envelope: the unlabeled data for each key appears on a page, positioned as for an address on an 

envelope. 
• Labels: the unlabeled data is grouped by key into a specified number of labels across and down the 

page. 
• Outline: Custom reports for projects can be shown in an indented hierarchy. The size of the indent 

can be selected on the Format page. 
• Narrative: Custom reports for projects can also be shown in narrative format, with numbered 

paragraphs. 

You can save custom reports in Text format. Data in columns will be tab-delimited. You can then import this 
text file into spreadsheet programs, such as Microsoft Excel. 



       

Report Options View: Key Page 
Most reports are based on key individuals. The key individuals determine the starting points for the report. 
When there are several key individuals, each of them will be treated as the starting individual in turn, with the 
results merged into a single report.  

Custom reports are based on keys that are either individuals, places, sources, multimedia, researchers, 
correspondence, research targets, projects, or lists. Calendar reports do not require any keys. 

The keys are specified on the Key page. For most reports, a single key individual is used. When the Repot 
Options View is first opened, the default key individual will be the current individual on the Individuals View.  

The Key page also includes a number of layout controls. The controls available will vary slightly depending 
on the report type selected. 

 

Key List 
Select Button 
Select List Button 
Select Query Button 
Clear Keys Button 
Default Key Button 
Default List Button 
Use Saved Keys

Report Layout 
Make Web Pages 
Generations to Show 
Show Children 
Remove Duplicates

Ancestor Narrative Report: 
    Ancestors to Include

Pedigree Report: 
    Starting Chart Number and Label 
    Generations Per Page 
    Overlap Generations
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Descendant Narrative Report: 
    Descendants to Follow 
    Show Main Entries

Family Group Report: 
    Single Family / Cascade 
    Spouses 
    Number of Children

Individual Narrative Report: 
    Single Individual / Cascade

Custom Reports: 
    No Row Wrap 
    Hide Empty Columns, Rows, or Cells 
    Flatten Rows 
    Maximum Rows 
    Label Width and Height 
    Labels Across and Down 
    Return Address  

Key List 

The Key list displays the names of the keys, one on each row.  

• To add a key name, click where it says "Add key", then type the name of the key. 
• A pick dialog will open, displaying a list of the matching names. Select the intended name from the 

list. 

Keys can also be added by clicking the Select button.  

Besides key names, lists and queries can also be specified for determination of the keys for the report. When 
a row contains the name of a list or query, an icon will precede the name, identifying its type: 

        List 
        Query 

A list name is added with the Select List button. All members of the list will be considered keys. Only lists with 
the same data type as the report can be selected. 

When the current report is for individuals, the name of a saved query can also be specified. The query name 
is added with the Select Query button. The resulting list of individuals when the query is run will be 
considered key individuals. 

Select Button 

Click the Select button to add keys using one of the pick dialogs. If the current report is for individuals, the 
Individuals Pick Dialog will open. Other pick dialogs will open when doing a custom report for places, sources, 
multimedia, research, projects, or lists.  

Select List Button 

Besides entering the names of keys, lists can also be specified for determination of the keys for a report. The 
List icon  identifies rows that contain the name of a list. All members of the list will be considered keys for 
the report. 

To add a list name, click the Select List button. The List View will open, allowing you to select a list name. 
Click the name of a saved list, then click the Select List Name button. Or, click the Select List Members 
button to add the names of the members to the list box instead of the list name. The report will be the same 
either way, but each approach has its advantages: 
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• Click Select List Name if you plan to save your report options for future use. Then, the next time the 
report options are used, the current members of the named list will become keys. 

• Click Select List Members if you want to selectively remove some names or reorder the names 
before making the report. 

Select Query Button 

Besides entering names and lists, queries can also be specified when the current report is for individuals. The 
Query icon  identifies rows that contain the name of a query. The resulting list of individuals when the 
query is run will be considered key individuals. 

To add a query name, click the Select Query button. From the Open File Dialog, select the name of a saved 
query definition. Query definition files have the extension .QRY. 

• The query is not run until the Make Report button is pressed. If you save your report options for future 
use, any queries will run each time a report is produced, and the results at that time will be used as 
the key individuals. 

Clear Keys Button 

Click the Clear Keys button to remove all of the names from the list box.  

Default Key Check Box 

When this check box is checked, the Report Options View will automatically load the "default key". The default 
key will be the current individual in the Individuals View, or the current place in the Places View, current 
source in Sources View, etc. If a view of the required type is not open, the default key will be blank. 

When editing a report options file, clicking and unclicking this option will load and unload the default key. 

Default List Check Box 

When this check box is checked, the Report Options View will automatically load the "default list". The default 
list will be the Individuals List, Places List, Sources List, etc., depending on the type of the current report 
options file. 

When editing a report options file, clicking and unclicking this option will load and unload the default list. 

Use Saved Keys Check Box 

When the report options are saved to a report options file, the current keys are saved along with the options. 
When the report options file is reloaded, the saved keys can be reloaded as well by clicking the Load Saved 
Keys button. With this feature, you can save a favorite list of keys, including lists and queries, and select them 
again with just one click. 

When editing a report options file, clicking and unclicking this option will load and unload the saved keys. 

Report Layout 

The choices on the drop-down list for Report layout vary with report type. 

For Ancestor Narrative, Descendant Narrative, and Individual Narrative reports:  

• Narrative: the data is composed into sentences and paragraphs. 

For Pedigree reports: 

• Pedigree: a standard ancestor pedigree layout is produced, using parent-child lines. 
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• Fill-in Pedigree: like the Pedigree layout, with the addition of blanks for missing data. 
• Condensed Pedigree: similar to the Pedigree layout, but without lines or extra spacing. 

For Outline Descendant reports: 

• Outline: an indented outline is produced, using parent-child lines. 

For Family Group reports: 

• Form: the data is presented in a fixed arrangement. 
• Fill-in Form: like Form, with the addition of blanks for missing data. 
• Condensed Form:  

For Calendar reports: 

• Wall Calendar: a calendar is produced with a fixed size for each month. 
• Compressed calendar: a calendar is produced with space varying according to content. 

For Custom reports: 

• Form: the data is shown in individually labelled fields, several fields per row. 
• Single Column: the data is shown in individually labelled fields, one field per row. 
• Table: labels are shown in a header across the top, with data in columns below. 
• Envelope: the unlabeled data for each key appears on a page, positioned as for an address on an 

envelope. 
• Labels: the unlabeled data is grouped by key into a specified number of labels across and down the 

page. 
• Outline: Custom reports for projects can be shown in an indented hierarchy. 
• Narrative: Custom reports for projects can also be shown in narrative format, with numbered 

paragraphs. 

Make Web Pages 

Click the Make web pages check box if you want to produce the report in HTML format. When the Make 
Report button is clicked, multiple web pages will be produced. You can specify the defaults for web page 
output on the Preferences View, Operation page. 

Generations to Show 

Most reports allow you specify the Generations to show, with an All choice and a Range choice. For the 
range, you can specify a starting generation number and an ending generation number. 

This option is useful in limiting the report to just the portion that you are interested in. 

Show Children 

Click the Show children check box when you want to include children on the report. 

Remove Duplicates 

When determining the ancestors or descendants of a key individual, there may be more than one path that 
leads to the same individual. Click the Remove duplicates check box if you do not want to see the data 
repeated for such "doubly-related" individuals. 

Ancestors to Include 

On Ancestor Narrative reports, the Ancestors to Include box has the following choices on the drop-down 
list:  



       

• All 
• Male only 
• Female only 
• Direct lineage 

This option allows you to control the types of ancestral lineage that will be followed. 

Starting Chart Number and Label 

On Pedigree reports, each chart page is numbered. The Starting chart number defaults to 1, but you can 
change it to any number you wish. This is useful when the pedigree charts being produced are the 
continuation of charts made previously. The Label box can be used to enter a text label that will print next to 
the chart number on the first chart page produced. This can explain the continuation, such as "(continued from 
chart 8)". 

Generations Per Page 

On Pedigree reports, either 4, 5, or 6 generations can be shown on each chart page. If you have a lot of data 
to show for each individual, you may wish to choose 4 generations per page. If you have a lot of generations, 
you may wish to choose 6 generations per page. 

Overlap Generations 

On Pedigree reports, click Overlap generations to produce a slightly different chart layout, making better use 
of available space. The first generations will be "sunk" into the higher generations, allowing more horizontal 
space for text on all generations. 

Descendants to Follow 

On Descendant Narrative reports, the Descendants to Follow box has the following choices on the drop-
down list:  

 

This option allows you to control the types of descendant lineage that will be followed. 

Show Main Entries 

On Descendant Narrative reports, a main entry is normally not shown for an individual, unless they have 
children of their own. The show main entries box has the following choices on its drop-down list:  

 

Single Family / Cascade 

Family Group reports are normally produced for just the key individuals. You can also automatically produce 
Family Group reports for all of each key individual's ancestors or descendants. This process of moving to an 
individual's parents, and then to their parents, is called cascading. Click Cascade to ancestors or Cascade 
to descendants to select this option. 

Spouses 

On Family Group reports, the spouses setting can be set to one of the following:  
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• Omit - no spouses will be shown on the report. 
• Preferred - the spouse marked preferred (or the first spouse if no preferred spouse) will be shown in 

full on the report, with other spouses of the primary and preferred spouse shown on "Other Spouse" 
lines. 

• Current -  the spouse currently showing in the Individuals View will be shown in full on the report, with 
other spouses of the primary and current spouse shown on "Other Spouse" lines. 

• All  - a separate Family Group report will be generated for each spouse of the key individual showing 
the spouse data in full, with other spouses of the primary and preferred spouse shown on "Other 
Spouse" lines. 

Number of Children 

On Family Group reports with the Report layout set to Fill-in Form, the Number of children box specifies 
the minimum number of children blocks that will be included. This can be used to produce blank children 
blocks, ready for people to write in the additional information. 

Single Individual / Cascade 

Individual Narrative reports are normally produced for just the key individuals. You can also automatically 
produce Individual Narrative reports for all of each key individual's ancestors or descendants. This process 
of moving to an individual's parents, and then to their parents, is called cascading. Click Cascade to 
ancestors or Cascade to descendants to select this option. 

No Row Wrap 

On custom reports with the Report layout set to Table, a header section appears across the top of each 
page containing data labels, with the data appearing in columns underneath. If there are more data items 
selected for output than can fit across the page, both the header and the data rows beneath will normally be 
wrapped, which means they occupy more than one row. 

This presentation can be difficult to read, particularly when wrapping continues onto three or more lines. Click 
the No row wrap check box to force the report rows to fit within the maximum page width. This will cause 
some text cells to increase the line wrap within their own column, and may cause some data values to be 
truncated.  

Hide Empty Columns, Rows, or Cells 

On custom reports with the Report layout set to Table, a header section appears across the top of each 
page containing data labels, with the data appearing in columns underneath. Click the Hide empty columns 
check box to cause columns that are blank for all keys to be omitted from the report. 

On custom reports with the Report Layout set to Single Column, Labels, or Envelopes, click Hide empty 
rows to cause completely empty rows to be omitted from the report. 

On custom reports with the Report Layout set to Form, click Hide empty cells to cause empty form boxes 
to be omitted.  

Flatten Rows 

On custom reports with the Report layout set to Table, data fields with multiple values will normally occupy a 
single cell in the table, with each value starting a new line. When the number of values is large, this decision 
can create a very tall row, affecting how many rows can be shown on a page. Often, large areas of white 
space will be left in an effort to keep the row together on a page. 

The solution is to flatten the row by breaking up the fields with multiple values; only one value is shown in a 
row, and additional rows are created for the remaining values. To choose this layout, click the Flatten rows 
check box.  

Maximum Rows 
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When Maximum rows is set to a value greater than zero on a custom report, this limits the number of table 
rows that will be shown on the report. This feature is useful when you are interested in seeing only the first 
few pages of the report.  

Label Width and Height 

On custom reports, the Label width and Label height boxes appear when the Report layout is set to 
Labels. Enter the physical dimensions of the labels. 

Labels Across and Down 

On custom reports, the Labels across and Labels down boxes appear when the Report layout is set to 
Labels. Enter the arrangement of labels on the label sheet. 

The combination of page size, page margins, Label width, Label height, Labels across, and Labels down 
completely determine the layout for labels. The labels will be spaced evenly within the page margins. 

Return Address 

On custom reports, the Return address box appears when the Report layout is set to Envelopes. Type the 
return address that you want to show on the envelopes into the box. 



       

Report Options View: Front Page 
Reports and books can have title pages. When they are lengthy, they often have a table of contents, and 
possibly a list of illustrations. These options can be specified on the Front page. 

 

Include Check Boxes 

There is an Include check box inside each of the three group boxes: Titles, Table of Contents, and List of 
Illustrations. The check box must be checked to include the corresponding element on the report. 

Titles: No Page Break 

To save space, the titles can be printed as the first half of the first page, rather than on a separate page. Click 
the No page break check box to enable this feature. 

Title and Subtitle 

The contents of the Title box are automatically generated from a template. You can edit the template or enter 
your own title information. The Subtitle box can be used for any text you want to include on the title page. 

For easier translation into other languages, you can use a number of variables in titles and headings: 

• [DATATYPE] - data type for current report: Ancestors, Descendants, Family, Calendar, Places, etc. 
• [REPTYPE] - report name: Ancestors Report, Family Group Report, Places Report, etc. 
• [OF] and [FOR] - common prepositions used in titles and headings. 

A common title/heading template is [DATATYPE] [OF] [KEY]. This could be "Ancestors of John Doe" when 
filled. 

Another common title/heading template is [REPFTYPE] [FOR] [KEY]. This could be "Ancestors Report for 
John Doe". 

When a resource file is available for the currently selected output language, these variables will be translated 
automatically. 

Author 
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The Author box is initialized to the name of the current researcher. You can change this to the name of a 
different researcher. 

Title Page Fonts 

There are three font buttons, one each for the Title, subtitle, and author. 

Table of Contents: Show Leaders 

A leader is the line of dots that appears between the name of an entry and the page number. Click the Show 
leaders check box to include leaders in the table of contents. 

Table of Contents Fonts 

There are two font buttons for text in the table of contents: the Level 1 font will be used for main entries, and 
the Level 2 font will be used for subentries under the main entries. 

List of Illustrations: Show Captions 

Click the Show captions check box to include the captions of the pictures in the list of illustrations. 



       

Report Options View: Sections Page 
A report is divided into sections. Each section has a heading and contents. You can add, rename, and 
remove sections. Most report sections are named and generated automatically. You can include the contents 
of file as a section on the report. You can even include another Genbox report as a section. 

The Sections page is used to view and specify the sections on the report. It contains a list box, which 
displays one row for each section in the report. When you look at the Sections page, it will show one row for 
every section that will be shown on the report with the current options. Before making the report, you can get 
an idea of how long it will be and what it will look like. 

The sections will appear on the report in the order they appear in the list box. You can drag a row up or down 
to change its printing order. The list box has four columns. There are also two check boxes for controlling 
section page breaks: 

 

Section Number Column 

Each section can have a section number. The section numbers can be used in page number formatting. 
Sections specified on the Front page and Back page (such as Table of Contents and End Notes) are usually 
not numbered. 

Page Break Column 

The Page break column contains a check box. When checked, the corresponding section will begin on a new 
page. If not checked, the section will begin on the same page as the end of the previous section. 

Heading Column 

Each section can have a name. Section names are printed at the start of each section, unless the names are 
surrounded with brackets. All section names will appear in the Table of Contents. Section names can be 
printed at the top of each page, if specified on the Headings page. 

You can change the names of sections on this page. You may wish to do this if the automatically generated 
name for a section isn't exactly what you want. 
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Note    If the Individual Headings template on the Headings page is changed, all headings for individual 
sections will be updated to match the new template, wiping out any editing changes made to individual section 
headings on this page. 

Contents Column 

The Contents column identifies what will be shown in the corresponding section. The contents of most 
sections of the report will be automatically generated. 

To include the contents of a file as a report section, click in the Contents column and type the name of a file. 
The Open File Dialog will open to help you browse for the file. 

Exclude Section Column 

The exclude checkbox can be checked if the corresponding section should be omitted from the report. This is 
a quick way to limit output of a large report to just the sections you are interested in viewing/printing. 

Start Section on Odd Pages 

When this is checked, each section of the report will start on an odd page. Blank pages will be inserted when 
necessary. Normally, sections would start on the next page, regardless of whether it was even or odd.  

New Page for Each Generation 

When this is checked, each generation will begin on a new page. This option is particularly useful when 
generating web pages.  



       

Report Options View: Back Page 
Reports can have the source citation notes collected into a single section at the back, titled End Notes. They 
can have a Bibliography which lists all of the sources cited. And they can have an Index which helps readers 
find information in the report by keyword. These sections can be specified on the Back page. 

 

Include Check Boxes 

There is an Include check box inside each of the three group boxes: Endnotes, Bibliography and Index. 
The check box must be checked to include the corresponding section on the report. When checked, a row will 
be added to the Sections page to represent the section. By default, these sections will be placed after other 
sections, so that they appear last. 

Note   If Endnotes is not checked, footnotes will be produced for citations, and for general notes or research 
notes when the In text check box is not checked. 

Index Main Headings 

An index is the door to your report. When you publish your genealogical work, readers will often turn first to 
the index to see if it contains the names or places that interest them. You can choose the types of information 
that will be included in the index. The choices for the Main headings are: 

• Surnames 
• States/Countries  (place names, levels 5 and 6) 
• Cities/Counties    (place names, levels 2, 3, 4) 
• Local Places        (place names, level 1) 

The subheadings beneath Surnames will be all the individuals with that surname. Beneath the 
State/Countries and Cities/Counties main headings will be the places at lower levels. Beneath the Local 
Places main heading will be the higher place levels of the local site. 

Bold Main Headings 

Bolding some of the headings in an index can make it easier to find certain categories of entries. Choices from 
the drop-down list are: 
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Index Columns 

Indexes can be produced with one, two or three columns. A two-column layout usually looks best. 

Include Letter Headings 

Click the Include letter headings check box to show large letters of the alphabet before each group of entries 
in the index. 

Show Birth-Death Years 

Click the Show birth-death years check box to include the birth and death years of individuals in the index. 
This can help distinguish between people who have the same names. 

Index Font 

The Index Font button is used to set the font for the index text. The font size for indexes is typically smaller 
than for the main body of the report. 
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Report Options View: Headings Page 
The headings on a report identify the current section or generation. They can also identify the report or 
author. Headings are like road signs that tell the reader where he is and what he is reading. They can appear 
at the top or bottom of each page, and before the beginning of each section. Headings are specified on the 
Headings page. 

 

Report Title/Heading Template Variables 
All of the headings except for Generation headings and Day Name Headings are specified by using a 
template. You can define the templates yourself. Each heading box also has a number of predefined 
templates available on the drop-down list. The template variables are all uppercase and surrounded by 
brackets. The following template variables may be specified: 

ADDRESS Address of current researcher, formatted as one line 
AUTHORTITLE Report Author title, as specified on the Front page. 
KEY Current key individual. 
KEYNUM Number of current key individual. 
MONTH Name of current month on report (Calendar reports). 
RESEARCHER Name of current researcher. 
SECTION Section title. 
SUBTITLE Report Subtitle, as specified on the Front page. 
TITLE Report Main title, as specified on the Front page. 
TYPE Report type. 
YEAR Current year on report (Calendar reports). 
DATATYPE Data type for current report: Ancestors, Descendants, Family, Calendar, Places, etc. 
REPTYPE Report name: Ancestors Report, Family Group Report, Places Report, etc. 

OF A common preposition. Will be translated to the output language when a matching 
resource file is available. 

FOR A common preposition. Will be translated to the output language when a matching 
resource file is available. 

Odd and Even Page Headers 
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Page headings for odd-numbered pages and even-numbered pages can be set independently. The headings 
are each set with a template. You can define the templates yourself. A number of predefined templates are 
available on the drop-down list: 

 

Individual Headings 

Individual headings appear as the section name for each individual section on the report. The heading is set 
with a template. You can define the template yourself. A number of predefined templates are available on the 
drop-down list, which vary according to the general report type: 

• (omit) 
• [KEY] 
• PART [KEYNUM]: [KEY] 
• Ancestors of [KEY] 
• Descendants of [KEY] 
• Pedigree of [KEY] 
• Family of [KEY] 
• [KEY] Family 

Changes made to the Individual headings template will immediately update the section headings for 
individual sections, which you can see on the Sections page. This is done immediately so that you can see 
what the names for all the sections will look like before the report is printed. All variables will be filled with their 
current values. If you make changes to any variables used in the Individual headings template, you will need 
to reselect or edit the template again to update the headings on the Sections page.  

Generation Headings 

Generation headings appear before each generation. Choices on the drop-down list are: 

 

Month Name Headings (Calendar Report) 

For Calendar reports, the format for the Month name that appears at the top of each page is set with a 
template. The predefined templates available on the drop-down list are: 

 

Day Name Headings (Calendar Report) 

The format for the Day names can be selected from the drop-down list: 
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Page Footers 

Page footers can appear at the bottom of each page. The footer is set with a template. You can define the 
template yourself. The predefined templates available on the drop-down list are the same as for the page 
headers. 

Alignment 

There are five Alignment boxes. Each heading can have its own horizontal alignment setting. Choices from 
the drop-down lists include: 

 

The Inside alignment will align the heading to the side of the page closest to the binding: the left side for odd-
numbered pages, and the right side for even-numbered pages. The Outside alignment will align the heading 
to the side of the page closest to the open edge: the right side for odd-numbered pages, and the left side for 
even-numbered pages. 

For Day Name Headings on Calendar reports, Inside will print the day names inside the top of the first week 
of day boxes, while Outside will print the day names just above the first week of day boxes. 

Font Buttons 

There are five Font buttons. Each heading can have its own font. Clicking on a Font button will open the 
Select Font Dialog. 
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Report Options View: Content Page 
After choosing the key individuals you want to include on your report, you need to decide what content you 
want to show for each individual. The Content page is for this purpose. This section describes the Content 
page for most reports. For Calendar reports, see Content Page (Calendar Reports). For custom reports, see 
Content Page (Custom Reports).  

On genealogy reports, the content for individuals usually varies, according to the type of individual and where 
the individual appears on the report. A given individual may also appear multiple times on the same report, 
with varying content according to placement. You can vary the content on individual reports for several groups 
of individuals. 

 

The Content page is divided into three parts: 

• The top part of the page is for selecting a group of individuals: ALL, Primary, Preferred Spouse, Other 
Spouses, Child (has main entry), Child (no main entry); on Pedigree reports, the group choices are for 
each generation 

• The middle part of the page is for setting the content choices for that group. 
• The bottom part of the page is for content choices that affect the whole report. 

ALL Content 

The ALL choice allows you to affect all groups at once, which can save you time. When ALL is chosen, only 
the content choices that all individual groups have in common will be shown; other content choices will blank. 
Any changes made when All is selected will change the settings for all groups. 

Primary Content 

The Primary group is generally the key individuals and their direct lines. Most information on reports is for 
individuals in the Primary group. 
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Preferred Spouse Content 

The Preferred spouse is the spouse of a primary individual with the Preferred check box checked for the 
family, which can be viewed on the Individuals View, Family page. The preferred spouse is usually the spouse 
that had the children in the line of interest. 

Other Spouses Content 

Other spouses are spouses of primary individuals that are not marked as Preferred. Usually, the content for 
Other spouses is less than for the Preferred spouse, and sometimes all information is omitted. 

Child (has main entry) Content 

On genealogy reports, a child introduced in the parent's main entry may appear elsewhere in the report in its 
own main entry. For descendant reports, a child that also has its own main entry would be called a child 
carried forward. For ancestor reports, the main entry for the child actually appears earlier in the report. 

To avoid unnecessary duplication, the content for a Child (has main entry) paragraph is usually reduced, 
and the full content is shown when the individual appears in its main entry. 

Child (no main entry) Content 

On genealogy reports, a child that does not have a main entry of its own and is mentioned only in a child 
paragraph of the parent's main entry is called a child not carried forward. Typically, a child that did not 
marry and/or had no children is not given a main entry of its own. Also, a report that is limited in the number of 
generations will show terminal children in the final generation. Compared to Child (has main entry) Content, 
the content for Child (no main entry) Content is usually increased, since this is the only time the child will be 
mentioned in the report. 

Pedigree Generation Content 

On Pedigree reports, individuals are grouped by generation. Content for each generation (1-4, 1-5, or 1-6, 
depending on Generations per Page setting on the Key Page) can be set. 

Often, you will want to reduce content for the higher generations, where space is more limited. 



       

Identifiers 

The Identifiers box controls the inclusion of individual names and other identifiers, according to identifier type. 
All non-hidden identifier types appear on the drop-down check list, arranged in a hierarchy. For example: 

 

Multiple items can be checked. 

The default is Preferred. Selected names and identifiers not shown as part of the initial name will be included 
later in the body of the report. 
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Attributes 

The Attributes box controls the inclusion of text attributes, individual flags, age, and sex. All non-hidden text 
attributes appear on the drop-down check list, arranged in a hierarchy. For example: 

 

Multiple items can be checked. 

The Text group choices refer to the A, B, C, D grouping of event types, as specified on the Event Types 
View, which is where text attributes are defined. 

Note: the text groups A-D define their own set of event types, which add to the other checks indicated on the 
dropdown list. If you include a text group, you may have attributes in the output that you were not expecting. 
An attribute for an event type that is marked (on the Event Types View) as part of a group (A-D) will appear in 
the output whenever the group is checked, even when the separate check for the attribute itself is not 
checked. 

The default Attribute content setting is Omit. 
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Events 

The Events box controls the inclusion of events, according to event type. All non-hidden event types appear 
on the drop-down check list, arranged in a hierarchy. For example: 

 

Multiple items can be checked. 

Choose principal to show all events, except for witnessed events and secondary events. Secondary events 
are the reverse directional events, such as childbirth (reverse of birth), and child adopted (reverse of 
adoption). 

The Group choices refer to the A, B, C, D grouping of event types, as specified on the Event Types View. 
Date range will show just the birth and death dates separated by a dash. Year range is similar, except only 
the years of the birth and death dates are shown. 

Note: the text groups A-D define their own set of event types, which add to the other checks indicated on the 
dropdown list. If you include a text group, you may have event types in the output that you were not expecting. 
An event type that is marked (on the Event Types View) as part of a group (A-D) will appear in the output 
whenever the group is checked, even when the separate check for the event type itself is not checked. 

Adding/removing an event type to a group on the Event Types view will affect charts that have a group flag 
selected for content. Using a saved chart options file with a different database will also affect which event 
types are included in each of the group flags. 

Contacts 
The Contacts box controls inclusion of individual contact information. Choices appear on the drop-down 
check list: 

 

Multiple items can be checked. 

The actual contents for each contact record are specified with the Contact Detail box. 

Parents 
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The Parents box controls inclusion of parent information, on reports where a reference can be made to 
parents of an individual. The choices available are: 

 

General Notes and Research Notes 
The General notes and Research notes boxes controls the inclusion of general and research notes. The 
following choices appear on the drop-down check lists: 

 

Multiple items can be checked. 

The default is Omit. Marked only can be used as a filter of the other note types selected. 

Next to each of these drop-down check list boxes is a check box named In text. When checked, the 
corresponding note types will be shown in the body of the report. If not checked, the corresponding note types 
will appear in the footnotes or endnotes. The default is to show notes in the body of the report. 

Event Parts 
The Event Parts box controls the types of data shown for each event. The following choices appear on the 
drop-down check list for reports: 

 
Multiple items can be checked.  

Note: Local Site and Place are filtered by selections on the Report Options Detail page. 
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Contact Detail 
The Contact Detail box controls the types of data shown for each contact record. The following choices 
appear on the drop-down check list: 

 
Multiple items can be checked.  

This box is disabled when the Contacts box is set to Omit. 

Disproved Relations Check Box 
Parents records on the Individuals View, Parents page have a check box named Disproved. This identifies 
individuals that are known NOT be parents of the current individual. The Disproved relations check box can 
be checked to include these relationships on the report. Normally, disproved relationships are omitted. 

Alternate Events Check Box 
Check the Alternate events check box to include alternate events on the report. The default is omit alternate 
events. 

All, None, and Reset Buttons 
Click the All button to "turn everything on" for the current individual group. Click the None button to "turn 
everything off" for the current individual group. These settings are useful as a preliminary shortcut when the 
desired content is close to one of these extremes. Click the Reset button to reset settings for all individual 
groups to their default values. 

Living Individuals 
By default, living individuals are shown with the normal content (as specified on the Contents page). If you 
plan to distribute a report outside of your own family, you may wish to restrict the content shown for living 
individuals, to respect their privacy. The Living individuals box presents the following choices on its drop-
down list:  

 
When Omit is selected, living individuals and all links to them are treated like they are not even in your 
database. This means lineages will be ended when they reach a living individual. On a Descendants report, 
for example, if a deceased individual has five children, of which two are still living, the report will show the 
individual as having only three children. And no further descendants will be shown for the living children, even 
if they are deceased. 

When Identifiers, links is selected, the names and relationships of living individuals are included, but no 
other information. No events, dates, or places. "Names" will include all the identifiers normally selected for 
output. 

When Sex, links is selected, the name will be replaced by "Male" or "Female", so that only the sex and 
relationships of living individuals are shown. This provides a level of privacy higher than Identifiers, links, 
because names are not shown. 

The Sex only choice will show only "Male" or "Female", with no information on further descendants. 
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Override Privacy Flags/Marks Check Box 
When Override privacy flags/marks is checked, parent relationships and spouse relationships that have the 
Private flag checked will be shown with their true relationships on the chart. Normally, private parent 
relationships are shown as "biological" and private spouse relationships are shown as "married" on charts and 
reports. 

Override Exclude Flags Check Box 
When Override exclude flags is checked, parent links, spouse links, and events that have the Exclude flag 
checked will also be included on the report. 

Author Note 
The note text in the record for the current researcher can be included on the report. The Author note box 
offers the following choices for placement: 

 

Copyright © 2005  Thoughtful Creations. All rights reserved. 323



       

Report Options View: Content Page (Calendar Reports) 
Calendar reports produce calendars that can include birthdays and anniversaries for selected individuals. The 
report can include all months or a single month for a specified year. The content for the report is specified on 
the Content page. 

 

Year 
Enter the year for the calendar in the Year box. 

Month 
Select either All or a specific month for the calendar from the Month box: 

 

Weeks Per Month 
The Weeks per month box offers the following choices: 

 

In Five week format, day boxes at the end of months with six weeks will be shared. In Five, wrap to top 
format, months with six weeks will have the extra one or two days appearing in blank spaces of the first week. 
This allows a full box to show their content. 

Starting Day of Week 
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The Starting day of week box allows you to specify which day of the week will be shown first. The default is 
Sunday: 

 

Birthdays 
When Birthdays is checked, the names of the key individuals will appear in the day boxes that correspond to 
the anniversary of their birth date. There are three format choices for the data: 

• Show name only 
• Show year of birth 
• Show age if under: (value) 

Anniversaries 
When Anniversaries is checked, the names of the key individuals will appear in the day boxes that 
correspond to the anniversary of their marriage date. There are two format choices for the data: 

• Show name only 
• Show year of anniversary 

Override Privacy Flags/Marks 
Normally, families that are marked as partners but have the privacy flag set will be treated as spouses, and 
their anniversary date will be shown on the chart. When Override privacy flags/marks is checked, the 
privacy flag will be ignored, and any families marked as partners will have their anniversary date omitted from 
the report. 

Override Exclude Flags 
Normally, events that have the Exclude flag checked will not be used to show birth dates or anniversary 
dates. When Override exclude flags is checked, these data records will be used. 

Include Alternate Events 
Normally, events that have the Alternate flag checked will not be used to show birth dates or anniversary 
dates. When Include alternate events is checked, these data records will be used. This can result in a birth 
date or anniversary date for an individual being shown on multiple dates. 

Reset Button 
Click the Reset button to set all content settings back to their default values. 
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Report Options View: Content Page (Custom Reports) 
Custom reports can show a wide variety of data for each of the different key types. The data choices are 
organized into categories. On the Content page for custom reports, there are two list boxes: the box on the 
left shows available fields, while the box on the right shows selected fields.  

1. To select data for output, first choose a category from the Category box. The available data fields in 
that category will appear in the Available fields list box. 

2. Select fields you want to include on the report. You can double-click on them, or single-click and then 
press the > button. 

 

Category Box 

The categories available in the Category box vary, depending on the choice of custom report type: 

Custom Report Type Categories 

Individuals All, General, Identifiers, Attributes, Flags, Parent Family, Families, Events, 
Contacts, Individual Media, Family Media, Event Media, Special 

Places All, Places, Place Names, Media, Links 
Events All, Events, Witnesses, Media 
Citations All, Citations, Sources, Events 
Sources All, Sources, Content, Media, Links 
Media All, Media, Flags 
Researchers All, Researchers, Media, Contact 
Correspondence Log All, Correspondence, Contact 
Research Targets All, Research Targets, Searches 
Projects All, Projects, Correspondence, Research Targets, Searches 
Lists All, Lists, Members 
   

Next to the Category box are Left and Right Arrow buttons. You can use these buttons to step through the 
categories. 
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Available Fields List 
The Available Fields list will display the names of the data items in the selected category. The All category 
will show all of the data fields available.   

Selected Fields List 
The Selected Fields list shows the names of the currently selected data fields (the destination list). 

Arrow Movement Buttons 
There are four Arrow Movement buttons. They can be used to move data field names into and out of the 
Selected fields list. 

> Add the selected names on the Available fields list to the Selected fields list. Shortcut: RIGHT 
ARROW. 

< Remove the selected names from the Selected fields list. Shortcut: LEFT ARROW. 

Note    Even though it is helpful to think of the data fields "moving" from the list on the left to the list on the 
right, field names are not actually removed from the Selected fields list.  

Line Break Button 
• To add a line break to the report after a particular column, click the Line Break button. It will be 

represented on the Selected Fields list as a dashed line. 

Using this feature, you can further tailor the appearance of a custom report. 

Multiple Subrecords Controls 
When the current category is for a data type that can contain multiple subrecords for each main record, there 
are additional choices for what to include on the report. The Multiples controls will be enabled to allow you to 
choose whether all of the subrecords should be shown or just one, and whether only subrecords of a 
particular type should be included. 

• Click the One radio button if you wish to include only one value on the report. When selected, the text 
"(1)" will appear after the label name in the Selected Fields list box to indicate this. 

• Some subrecords provide a pick list of types. The dropdown pick list supports multiple checked items, 
so you can choose just the types that you want for the report. Or, click the top entry for "All types". 

For example, on an Individuals Report, you could choose to include just Birth and Death event information, 
rather than information for all event types.  

Using the Filter Box 
Normally, custom reports will contain output for every key selected on the Key Page, and for every subrecord 
of each main record. Sometimes, you will only be interested in outputting some of the subrecords, or in 
outputting a subset of the main records. To limit the output of a custom report, you can filter according to 
values in data fields.  

• To use the filter box, enter the match pattern into the filter box before moving the data field to the 
selected list. Only records that have a value that matches the match pattern will appear in the output. 
The filter text will be shown after the field name on the destination side, surrounded in either square 
brackets (when filtering the main record) or curly braces (when filtering subrecords only). 

• The asterisk wildcard (*) can be used to mean "match any number of characters in this position". 
• The question mark wildcard (?) can be used to match a single character at that position. 
• If your filter text is for only a portion of the data value, use the asterisk wildcard (*) before and 

after your text. 
• To limit the report only to data records that are non-blank in a particular field, enter just an asterisk 

(*). 
• To limit the report only to data records that are blank in a particular field, enter "!*" 

Hint: make your filter field one of the first fields in the output list for faster report generation. 



       

Filtering the Main Record 
You can filter according to data values in the main record or in the subrecords. When filtering according to 
data values in the main record (the first category), the filter must match in order for the main record to be part 
of the report. 

When filtering data values in subrecords, you have a choice as to how to perform the filter: 

• To filter just the subrecords, clear the Filter main record check box. All main records will be included, 
regardless of whether there is a subrecord that matches the filter. Only the subrecords that match the 
filter will be included. 

• To filter the main record, check Filter main record. When there is no subrecord that matches the 
filter, output for the entire main record will be omitted. When there is a matching subrecord, the main 
record along with the matching subrecords will be included in the output. 

When Filter main record is checked, the filter text will be required to match at least one subrecord in order 
for the main record to be output. 

When a filter fails on a subrecord, any additional data fields selected for output from the same subrecord will 
be omitted, but data fields from that subrecord that appear before the filtering field will still be output. For this 
reason, it is a good practice to put the fields that have filter values first in the output field order. 

Filtering for Missing Subrecords 
Sometimes it is desirable to know which main records have no subrecords of a particular type. For example, 
you might want to produce a report of individuals that have no death event subrecords. Normally, a filter will 
fail when the filter text cannot be matched: this means missing subrecords will cause the match to fail. 

As a special convention, the filter "!*", which can be read "not something", can be used on the ID fields of 
subrecords to indicate that only main records that are missing subrecords of that type should be returned. 
Because every valid subrecord will have a non-zero ID field value, only main records missing all subrecords of 
the specified type will pass the filter. 

Setting Report Field Properties 
The labels and case for each field selected for output can be specified.  

1. To set properties for a field, first click it to make it the current selection. 
2. Right-click to bring up the popup menu, and then click Field Properties. Or, click the Field 

Properties  button.  The Report Field Properties Dialog will open. 

Ordering Selected Fields 
• To order the selected fields, drag them to the desired position in the list. 

Clear Button 
This button removes all of the names, in all categories, from the Selected fields list.  

Default Button 
This button restores the selected fields to their default values.  
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Report Options View: Sort Page (Custom Reports) 
For your custom report, after you have selected the data fields for output on the Content Page, you can 
specify the sort order for the data on the Sort page. 

 

Available Fields 
The Available fields list displays the names of the data fields selected for output on the Content Page. You 
can sort on one or more of the fields selected for output. Fields that have been marked "Exclude" are still 
available for sort purposes.  

Selected Fields 
The Selected fields list displays the data fields that will control the sorting on the report. The first data field 
listed will be the primary sort field. The second data field listed will be the secondary sort field. When two 
output records have the same value in the primary sort field, the records will be sorted according to the values 
in the secondary sort field. There can be more than two sort data fields as well. 

• A down arrow appearing before the data field name indicates descending order.  
• An up arrow appearing before the data field name indicates ascending order. 
• Clicking a sort field name will reverse the direction of the arrow. 

Arrow Movement Buttons 

There are three arrow buttons that can be used to move data fields between the left and right list boxes. 

• Click the > arrow button to move the selected field on the Available fields list to the Selected fields 
list. 

• Click the < arrow button to move the selected field on the Selected fields list to the Available fields 
list. 

• Click the << arrow button to move all the fields on the Selected fields list back to the Available 
fields list. 

Ascending or Descending 
The Ascending and Descending radio buttons select the default sort direction for data fields being moved to 
the Selected fields list. 
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Report Options View: Media Page 
Adding pictures to a report can make it much more interesting. Being able to see images of your ancestors 
next to their discussions makes the story come to life. You can select the multimedia content you want to 
appear on your report with the Media page. For calendar reports, see Media Page (Calendar Reports). 

Multimedia can be linked to Individuals, Families, Events, Places, Sources. On genealogy reports, Individuals 
can be further divided into Primary, Preferred Spouse, Other Spouses, Child Carried Forward, and Child Not 
Carried Forward. On the Media page, you can specify the multimedia you want to include for each of these 
groups. 

 

The Media page is divided into three parts: 

• The top part of the page is for selecting a group for multimedia choices: ALL, Primary, Preferred 
Spouse, Other Spouses, Child (carried forward), Child (not carried forward), Family, Event, Place. For 
custom reports: choices are ALL, Key, and Media Field. 

• The middle part of the page is for setting the multimedia content choices for that group. 
• The bottom part of the page is for multimedia choices that affect the whole report. 

ALL Content 

The ALL choice allows you to affect all groups at once, which can save you time. When ALL is chosen, only 
the multimedia choices that all groups have in common will be shown; other choices will be shown blank. Any 
changes made when All is selected will change the settings for all groups. 

Primary Content 

The Primary group is generally the key individuals and their direct lines. Often, multimedia on reports is 
selected for individuals in the Primary group. 

Preferred Spouse Content 

The Preferred spouse is the spouse of a primary individual with the Preferred check box checked for the 
family, which can be viewed on the Individuals View, Family page. The preferred spouse is usually the spouse 
that had the children in the line of interest. 

Other Spouses Content 
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Other spouses are spouses of primary individuals that are not marked as Preferred. Usually, the content for 
Other spouses is less than for the Preferred spouse, and sometimes all information is omitted. 

Child Carried Forward Content 
On genealogy reports, a Child carried forward is a child that appears later on the report as a primary 
individual. To avoid unnecessary duplication, the content for a Child carried forward is usually reduced, and 
the full content is shown when the individual appears as the primary. For multimedia, that means pictures are 
usually omitted from this group. 

Child Not Carried Forward Content 
On genealogy reports, a Child not carried forward is a child that does not appear later on the report as a 
primary individual. This is usually because the child did not marry, or had no children. Compared to Child 
carried forward, the content is usually increased for Child not carried forward.  

Family Content 
Families appearing on a report can have associated media included. 

Event Content 
Events appearing on a report can have associated media included. 

Place Content 
Places appearing on a report can have associated media included. 

Key Content 
For custom reports, media selected for keys will appear above or below the tabular data. This means that it 
won't be placed in a column by itself; rather, it will appear between the data rows. This is a content selection 
independent of content selected on the Content page. 

Media Field Content 
For custom reports, this group will control settings for the "Media" field, if one has already been selected on 
the Content Page. You can specify whether multiple pictures should appear, and how large. These media 
items will appear only in the columns where they have been selected. If multiple pictures are allowed, they will 
be shown in additional rows on the report. 

Number 
The Number box allows you to limit the number of multimedia objects to show for data items in the current 
group: 

 

When Omit is selected, all other multimedia controls for the current group will be disabled. 
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Type 
The Type box allows you to control the type of media objects that will be included. Usually, only images are 
included. Choices are: 

 

Flag 
The Flag box allows you to limit the multimedia that will be included to only those media records that have a 
specified flag checked.  The drop-down list displays the names of all defined media flags. With this feature, 
you could define a flag just for reporting purposes and check it for the specific media records you want to use 
on your report. For example: 

 

When the Flag box is empty, multimedia is not limited to a particular flag. 

Principal Only 
When checked, multimedia will be limited to the principal multimedia record attached to each data item.  

Placement 
The Placement box allows you to specify where the multimedia will appear on the report, relative to the linked 
data item. Choices are: 

 

For the four "margin" placements, the report text will wrap around the left or right side of the multimedia. For 
the other placements, the report text will not wrap on either side. 

When several multimedia objects have the same placement, they will appear in rows and/or columns. 

Show Frame 
When Show frame is clicked, multimedia in the current group will be shown with a picture frame, as specified 
on the Frames page. 
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Width and Height 
The Width and Height boxes allow you to control the size of the pictures. Choices are: 

 

Each media record can have a Preferred size, which is used when the Media default choice is selected. For 
Maximum of:, the text box to the right will be enabled and you can enter a value. For Fit to text, the size of 
the picture will be limited by the adjacent text paragraph describing the linked data object. 

Title and Caption Placement 
The Title and Caption Placement boxes allow you to control the placement of the title and caption text for 
pictures in the current group. Choices are: 

 

Inside top and Inside bottom will produce placements inside the picture frame, on top of the picture itself. 
With these placements no extra space is required to display picture titles and captions. You may need to 
change the font to white or some other light color in order to make it visible in front of  a dark picture. 

Master 
When printing drafts of a report, you may wish to omit the body of pictures, to save on ink and decrease 
printing time. Or, you may intend to have your report published, and the publisher will be adding the pictures 
to the pages, so you don't need a printed image. The Master box controls this feature. When the body of a 
picture is omitted, space for the picture will still be reserved, and the picture frame will still be printed. The 
choices on the drop-down list are: 

 

The Information in frames choice will print the image filename and other related information about the 
picture, instead of the image. 

Omit Duplicates 
When multimedia is linked to several data items, or when data items appear in multiple places in the report, 
you may see the same picture shown more than once in the report. To avoid this, click the Omit duplicates 
check box. Only the first occurrence of a picture will be included. 

Title Page Picture 
A report can have a picture on the title page. Type the filename into the Title page picture box, or click the 

Open File  button to browse for the file. 

Title and Caption Font Buttons 
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The Title and Caption font buttons are used to display and select the fonts used in the report for multimedia 
titles and captions. 

Reset Button 
 Click the Reset button to set all multimedia choices back to their default choices. 



       

Report Options View: Media Page (Calendar Reports) 
Calendar reports can include pictures. You can make wall calendars that display one of your favorite 
genealogy photos for each month. The pictures will be shown on separate pages, before the associated 
month.  

 

Picture List 

The Picture list box displays one row for each month selected for output, and additional row at the top for an 
optional picture on the title page. Each row has two columns: the Month name, and the Picture Filename.  

• To specify a picture for a month, click on the Picture Filename column and type the name of the 
image file. 

• The Open File Dialog will open and allow you to browse for the file. 

Master 

When printing drafts of a report, you may wish to omit the body of pictures, to save on ink and decrease 
printing time. Or, you may intend to have your report published, and the publisher will be adding the pictures 
to the pages, so you don't need a printed image. The Master box controls this feature. When the body of a 
picture is omitted, space for the picture will still be reserved, and the picture frame will still be printed. The 
choices on the drop-down list are: 

 

The Information in frames choice will print the image filename and other related information about the 
picture, inside of the frame. 

Show Frame 

When Show frame is clicked, the pictures will be shown with a picture frame, as specified on the Frames 
page. 

Title and Caption Placement 
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The Title and Caption Placement boxes allow you to control the placement of the title and caption text 
Choices are: 

 

Inside top and Inside bottom will produce placements inside the picture frame, on top of the picture itself. 
With these placements no extra space is required to display picture titles and captions. You may need to 
change the font to white or some other light color in order to make it visible in front of  a dark picture. The 
Next page options will place the text at the top of the following page (the page displaying the associated 
month). You can place the text centered, left or right. The Next page options are useful when you want to 
show the pictures filling the page. 

Title and Caption Font Buttons 

The Title and Caption font buttons are used to display and select the fonts used in the report for multimedia 
titles and captions. 

Reset Button 

 Click the Reset button to set all multimedia choices back to their default choices.  
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Report Options View: Style Page 
Reports that consistently follow style guidelines will be easier to understand and navigate. All primary 
individuals should be presented in a uniform way. Text styles, such as bolding, capitalization, and italics, 
should aid the reader in identifying and interpreting the data. The Style page is used to apply styles to the 
report. 

 

Individual Numbering System 

A number of systems for individual numbering have been developed in the genealogical community. Choices 
are: 

 

Generation Number Superscripts 

Generation number superscripts are placed before the surnames of individual names to indicate their 
relative generation. They can be relative to the key individual or to an ancestor: 

 

Generations before immigration are given uppercase letters instead of numbers. 

Italic Generation Number Superscripts 

When Italic generation superscripts is checked, the generation number superscripts will appear with the 
italics style. This is an NGSQ default. 
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Brackets on Notes to Distinguish 

Check the Brackets on notes to distinguish check box when Italic generation superscripts is not checked 
in order to distinguish the source citation note numbers from the generation superscript numbers. This is a 
Register default. 

Back References 

Back references on genealogical reports are the sequence of ancestral names in the direct line or the line of 
interest. The back reference is placed in parentheses after the initial appearance of the primary individual's 
name. The styles available for back references are: 

 

The italic check box can also be checked, which will add italics style to back references. This is a Register 
default. 

Paragraph Spacing 

The Space before box specifies the vertical spacing between paragraphs. The Indent box specifies the 
indentation on the first line of paragraphs. 

Bolding and Caps 

Individual names can have added styling: Bolding and Capitalization. The styling can be applied to different 
categories of individual names: 

 

Uppercase on Surnames Only 

When Uppercase on surnames only is checked, the individuals selected for Caps will be shown with the 
capitalization on their surnames only. 

ID Numbers 

If ID numbers is checked, Individual ID numbers will be shown after every name on the report. 

Use Nicknames 

If Use nicknames is checked, nicknames defined for individuals will be used after their initial reference. 

Children Names 
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For children names in child sections, either Given names or Full names may be selected. 

Event Sequence 

Events on the report can be presented chronologically or with vital events first. Choices from the drop-down 
list show the orders that are supported: 

 

Event Detail Order 

For each event, either the date or the place information can be presented first. For family events, the 
placement of the spouse information can also be specified. Choices from the drop-down list for Event detail 
order are: 

 

Child List Event Templates 

The event templates used in child paragraphs can be selected from the following choices, for both basic 
events and other events: 

 

Basic events are often abbreviated, and other events are often shown in either brief or full format. 

Register Defaults Button  

Click the Register Defaults button to set style choices on this page according to the recommended style 
guidelines of the New England Historical Genealogical Society (NEHGS). 

NGSQ Defaults Button  

Click the NGSQ Defaults button to set style choices on this page according to the recommended style 
guidelines of the National Genealogical Society Quarterly (NGS). 
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Report Options View: Detail Page 
The Detail page contains content options for specific details of the data. While the Content and Media pages 
specify options according to types of individuals, the Detail page options apply to data for all individuals, and 
the report as a whole. 

 

Place Detail 
Places can appear with all place levels or with only specific place levels. The default operation is to show all 
place levels except for the default nation/area.  

There is a checkbox for each place level, one for place modifiers, and three for special combinations:  

• [6L]    Nation/Area 
• [5L]    State/Province 
• [4L]    County/Parish 
• [3L]    Township 
• [2L]    City/Town 
• [1L]    Local site 
• [0L]    Place modifier 
• [L~]    Lowest non-blank 
• [LL]    "Level Low" (lowest of {2,3,4}) 
• [LH]   "Level High" (lowest of {5,6}) 

When a place level is not checked, no place information for that jurisdiction will be shown on the report.  

Note: The [LH] and [LL] options prevent the use of the other level selectors.  

Place Detail: All Levels 
When this option is checked, All place information will be shown on the report. 

Place Detail: Low + High 
When this option is checked, only the [LH] and [LL] check boxes will be set. This pair produces a "City, State" 
combination for most place names. It can be selected to save space on the reports. 

Level Low ([LL]) 
When you select the [LL] ("Level Low") check box, Genbox will select the city name (level 2) when it is 
available, or the township name (level 3) when it is available, or finally the county name (level 4). Only one 
level of information will be shown from the group {2,3,4}. 

Level High ([LH]) 
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When you select the [LH] ("Level high") check box, Genbox will select the state name (level 5) when it is 
available, otherwise the nation/area name (level 6). Only one level of information will be shown from the group 
{5,6}. 

Source Citations 
Source citations can be included on reports, in either full or brief format. The Citations box offers the following 
choices: 

 
The Brief format will omit annotations. 

If the In text check box is checked, the source citations will appear in the text body, immediately after the data 
they are linked to. Otherwise, source citations will appear in footnotes, or in endnotes if Include endnotes is 
checked on the Back page. 

Merge Event Citations into Single Footnote 
Each fact stored in Genbox can have one or more source citations. Events can have source citations on the 
date, place, age at time of the event, on the entire event, on the notes, etc. When narrative reports are 
produced, these source citations can be grouped into footnotes according to various schemes. Some people 
prefer to have a single footnote number at the end of each sentence, with all source citations in one group, 
although this may obscure which source documents which fact. Other people like to see a separate footnote 
for each fact, although this means there may be a distracting number of footnote numbers in the body of the 
text. The Merge event citations into single footnote selection controls when multiple citations are merged 
into grouped footnotes. It provides the following choices: 

• Always merge 
• Merge when event-level citation or all facts are documented 
• Merge only when event-level citation 
• Separate footnotes for each fact 
• Separate footnotes for every citation (never merge) 

Ambiguous Fact References 
When source citations for several facts have been merged into a single footnote, it may be unclear which 
source citation documents which fact. The Ambiguous fact references box allows you to add a label before 
each grouping of source citations, where the label refers to the type of fact being documented. You can type 
your own text or choose from the drop-down list: 

 

The special keywords [LABEL], [CR], and [TAB] are recognized for this field. If this box is left blank, no label 
will be used (the default). 
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Citation Separator 
When multiple citations appear in a footnote, they are normally separated with a semicolon (;). If there are 
many citations, or they are lengthy with their own internal semicolons, this separator may be hard to find, 
making the footnote difficult to read and understand. The Citation separator box allows you to enter your 
own separator text to appear between citations in a merged footnote. You can type your own text or choose 
from the drop-down list: 

 

The special keywords [CR] (carriage return) and [TAB] are recognized for this field. 

Note: if the special keyword [NOSEP] appears in the annotation text of a source citation, no separator will 
follow that source citation when followed by another source citation in a merged footnote. This allows you to 
override the default citation separator specified here, making it possible to string two source citations together 
into the same thought. For example, you could end the first citation's annotation text with something like "..., 
but see also [NOSEP]". 
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Report Options View: Format Page 
The Format page is used to specify the margins, indents, spacing, main fonts, pagination, and page 
numbering for the report.  

 

Page Top/Bottom Margins 

Use the Page top/bottom boxes to set the margins for the top and bottom of each page.  

Left/Right Margins 

Reports have two sets of left/right margins:  

• Use the Text left/right boxes to set margins for the text. 
• Use the Media left/right boxes to set margins for pictures. 

Separate margins for multimedia allow pictures to extend into the space that serves as a margin around the 
text. This allows pictures to be larger and leaves more room for text within the text margins. Small pictures can 
fit completely into the media margins, allowing the text to fill the page to the text margins. 

Gutter Margin 

The Gutter margin reserves extra space on the "binding" side of each page (left side for odd-numbered 
pages, and right side for even-numbered pages). A gutter margin is useful when the report is intended to be 
bound with a binding that will obscure part of the page.  

Flip Odd/Even 

Clicking Flip odd/even will cause the settings for left and right margins to reverse for even-numbered pages.  

Outline Indent 

For Outline Descendant reports, the Outline indent box can be used to specify the indent for children lines 
beneath their parents. The default is .25 inches. You may wish to decrease this value when there are many 
generations, and you want the report to fit within one page width.  
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Media Min Separation 

The Media min separation box is used to specify the minimum spacing between pictures on the report.  

Report Lines 

For Custom and Family Group reports, you can include lines on the reports to indicate divisions. Choices 
are:  

 

The Key row choice is useful when the table columns wrap onto multiple rows. 

For Pedigree and Outline Descendant reports, you can include lines connecting the individuals. Choices 
are: 

 

Short Names 

Click Short Names to format individual names in the "short" format. This format abbreviates middle names.  

Short Dates 

Click Short Dates to use short date formatting for dates on the report. 

Short Places 

Click Short Places to use the "Short name" identifier for places where a short name has been identified.  

Place Context 

When Genbox produces a report, place names can be remembered when they are added to a paragraph. 
Subsequent references to that place within the same context will use a shortened form of the place name, 
usually just the first level. This removes a lot of redundancy and makes the generated paragraph sound more 
natural. Unlike the "Short Places" option, place context does not need short names defined in order to work.  

• Click Place Context to remember place names in each context and use the shortened form of the 
names.  

• Clear this option to always see all place levels on place names within the report. 

Note: setting and clearing this option also selects similar processing for date context.  

Data and Label Font Buttons 

There are four font buttons for selecting the fonts used in the body of the report: 

• Data Font 
• Label Font 
• General Notes Font 
• Research Notes Font 
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Normally, general notes and research notes will use the same font as other data appearing on the report. You 
can change their font styles if you wish to make them more visible. Sometimes it is helpful to be able to tell 
which text is being generated by the event templates, and which text is coming directly from the general notes 
or research notes. You may wish to show the general notes in blue, and the research notes in red, bold, and 
italic, for example. 

Line Spacing 

The Line spacing on a report can be varied, which will permit more or less information to fit on each page. 
Choices are:  

 

Page Number Position 

The Page number position box is used to select the placement of the page number. Choices are:  

 

Page Number At Section Start 

The Page number at section start box is used to control the placement of the page number at the start of 
sections, which often is different than on normal pages. The placement choices are the same as for normal 
pages.  

Starting Page Number 

The Starting Page Number box is used to specify the starting page number for the report, and also the 
formatting of the page number.  For formatting, you can include any prefix or suffix.   

You can use the special keyword [PAGE] to insert the word "Page" in the correct output language.  

The default is "[PAGE] 1".  

Page Number Font 

The Page Number Font button can be used to select the font for page numbering.  

Renumber Each Section as Page 1 

When checked, the page number for each section on the report will be reset to 1.  

Date Position 

Use the Date position box to specify where the report generation date should print on the report:  
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Report Options View: Frames Page 

As the finishing touch, frames can be added to the title page, pictures, and headings. Frames are excellent 
for setting off an item from its surroundings, adding color and drawing attention. Frame choices include corner 
shape, corner fill, sides to include, pixel width, color, corner size, margin size, matte, shading, and shadow. 
These options are set on the Frames page. 

 

Title Page Frame 
Check the Include check box to produce either a single or double Title page frame.  A double frame will be 
drawn with independent option settings for the outer and inner frame. Depending on the Corner shape and 
Corner margin size, the frames may overlap, producing a complex design. 

Picture Frames 
Pictures on the report have a thin line rectangular frame by default. You can use the options here to create 
more elaborate frames.  

Heading Frames 
The sides, width, and color can be specified for Page header frames, Section header frames, Generation 
header frames, and Page footer frames. The default for sides is Omit. 

Corner Shape 
The choices available on the drop-down lists for corner shapes are: 
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Corner Fills 
Frame corners can be filled with the Frame color, for added visual effect. Click the Corner fill check box to 
select. 

Sides to Include 
Individual sides of the frame can be selected from inclusion. Choices from the drop-down list are:  

 

Frame Width 
The Frame width boxes allow entry of the pixel width for the frame. A value of 0 means use the narrowest 
line possible. 

Shadows 
Picture boxes can have a simulated shadow. The Shadow placement boxes provide the following placement 
choices:  

 

Colors for Frame, Matte, Shadow 
There is a Color button to select the color for each frame. Pictures have an additional Matte color button and 
a Shadow color button. The matte is the open area between the frame and the picture. Clicking any of these 
color buttons will open the Select Color Dialog for selection of the color.  

Sizes for Corners, Margins and Matte 
The Corner size specifies the size of the corner area of the frame. The corners can have special shapes. A 
larger corner size value will produce larger shapes.   

The Margin size is the amount of white space between the (rectangular) frame and its contents. This value 
may need to be increased when the frame is not rectangular, as some choices for corner shape can result in a 
visible frame that extends into the text inside the frame.  

The Matte size specifies the size of the matte used with picture frames. The matte is the open area between 
the frame and the picture. A value larger than zero is necessary in order to see the matte color.  
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Report View 
The Report View appears when a report is generated by clicking the Make Report button on the Report 
Options View. The first page of the generated report will be shown in the view. You can use the scroll bars at 
the right and bottom edges to scroll. 

Using the Chart/Report Toolbar 

When the Report View opens, the Chart/Report Toolbar will appear next to the main toolbar. There are five 
tool buttons and a drop-down list box. The current tool will have a pressed appearance. Click on a tool button 
to select a tool: 

 Select Tool 

 Magnify Tool 

 Zoom Size Tool 

 Text Tool 

 Picture Tool 

 Line Tool 

Zooming 

When you want to see more of your Report at once, you need to zoom out. If you are interested in seeing 

more detail in a small area, you need to zoom in. To zoom, click the Magnify tool .  

• When the Magnify tool is selected, click the left mouse button anywhere on the Report to zoom in. 
• Click the right mouse button to zoom out. 

The zoom size will increase or decrease by about 20% for each click. The location clicked will be positioned 
as close as possible to the center of the view. 

You can also use the Zoom size tool  to quickly set the zoom size at preset sizes: 

• Full size 
• Full page 
• Full doc 
• 2400%, 1200%, 800%, 400%, 200%, 160%, 110%, 100%, 90%, 75%, 50%, 25%, 12%, 8%, or 4% 

Full size is the same as 100%. Full page will pick a zoom size just large enough to show a complete page. 
Full doc will pick a zoom size that will allow the entire report to fit on the screen. 

When the zoom size of pages is smaller than the view window, the pages will be tiled in rows across the view. 

Adding Annotations 

Annotations are short lengths of text that can be typed on top of the report. They can be used to draw 
attention to certain data items, or provide explanatory text. 

• To add an annotation, click the Text Tool . 
• Click the location on the report where you want the annotation to start. 
• Type the text. 
• To end the annotation, click elsewhere to start a new annotation, or click a different tool button. 
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Once on a report, an annotation can be selected, sized, and moved. You can also change its font properties: 

1. To change the font properties of an annotation, first select it. 

2. Double-click the Text Tool . 
3. The Select Font Dialog will appear, allowing you to select font properties for the annotation and for 

new annotations. 

The default font styles for annotations are bold, italic, and red. 

Adding Pictures 

Additional pictures can be added to a report after it has been generated. 

1. To add a picture, click the Picture Tool . 
2. Drag a selection rectangle to specify the size and location for the picture. 
3. The Media Pick Dialog will open. Select the picture you want to include on the report. 

If no picture is selected from the Media Pick Dialog, only a frame will be added to the report. Frame properties 
for empty frames and pictures on the report can be changed: 

• To change the frame properties of a picture, first select it. 

• Double-click the Picture Tool . 
• The Picture Tool Options Dialog will appear. Select the frame properties for the picture and for new 

pictures. 

Adding Lines 

Freehand lines can be added to a report after it has been generated. You can draw arrows, circles, and 
connecting lines between annotations and text. 

1. To add lines, click the Line Tool . 
2. Click the locations where you want the end points of the line segments to be. 
3. To draw curves, hold the mouse button down while moving. 
4. Click the same location twice to end the line figure. 

The endpoints of each line segment in the figure will be shown with handles. You can reposition individual 
endpoints by dragging on the handles. 

The thickness and color of a freehand line can be changed: 

• To change the properties of a freehand line, first select it. 

• Double-click on the Line Tool . 
• The Line Tool Options Dialog will open. Select the new values for line width and color. 
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Web Page View 
The Web Page View appears when the Make Report button is clicked on the Report Options View, and the 
Make web pages check box is checked. 

The Web Page View functions as a standard web browser. An address bar appears that displays the URL of 
the current page.  

 

A Favorites menu is added to the main menu bar.  

The first page of the generated web pages will be shown in the view.  

 

• Use the record movement buttons on the main toolbar as page movement buttons to move to the 
first, previous, next, and last generated page. 

• Use the back and forward buttons as the normal web browser back and forward commands. 
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Export Options View 
When you want to share your data with others, choose Export Data from the Files menu, then either 
GEDCOM file or Genbox Database. The Export Options View with then appear, allowing you to choose 
options for the export. Options are arranged onto three pages:  

            Key Page 
            Header Page  
            Data Content Page 
            Other Content Page 
            Options Page  

Buttons 

There is a row of buttons at the bottom of the view:  

• Click the Make Export File button when you are ready to produce the export file. The Save File 
Dialog will appear. Enter the name for the file, then click Save. 

• Click the Save button if you want to save your export options settings for use later. On the Save File 
Dialog, enter a name for the options file, then click Save. 

• Click Reload and choose the file from the Open File Dialog when you want to reload a saved export 
options file. 

• Click Defaults to reset all export options to Genbox defaults. 



       

Export Options View: Key Page 
Like Genbox reports, an export file is based on key individuals. The key individuals determine the starting 
points for the export. When there are several key individuals, each of them will be treated as the starting 
individual in turn, with the results merged into a single export file.  

The keys are specified on the Key page. When the Export Options View is first opened, the default will be the 
list of all individuals in the database.  

 

Key List 

The Key list displays the names of the keys, one on each row.  

• To add a key name, click where it says "Add key", then type the name of the key. 
• A pick dialog will open, displaying a list of the matching names. Select the intended name from the 

list. 

Keys can also be added by clicking the Select button.  

Besides key names, lists and queries can also be specified for determination of the keys for the export. 
When a row contains the name of a list or query, an icon will precede the name, identifying its type: 

        List 
        Query 

A list name is added with the Select List button. All members of the list will be considered keys. Only 
individual lists can be selected. 

The name of a saved query can also be specified. The query name is added with the Select Query button. 
The resulting list of individuals when the query is run will be considered key individuals. 

Select Button 

Click the Select button to add keys using the Individuals Pick Dialog. 
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Select List Button 

Besides entering the names of keys, lists can also be specified for determination of the keys for an export. 
The List icon  identifies rows that contain the name of a list. All members of the list will be considered keys 
for the export. 

To add a list name, click the Select List button. The List View will open, allowing you to select a list name. 
Click the name of a saved list, then click the Select List Name button. Or, click the Select List Members 
button to add the names of the members to the list box instead of the list name. The export will be the same 
either way, but each approach has its advantages: 

• Click Select List Name if you plan to save your export options for future use. Then, the next time the 
export options are used, the current members of the named list will become keys. 

• Click Select List Members if you want to selectively remove some names or reorder the names 
before making the export. 

Select Query Button 

Besides entering names and lists, queries can also be specified. The Query icon  identifies rows that 
contain the name of a query. The resulting list of individuals when the query is run will be considered key 
individuals. 

To add a query name, click the Select Query button. From the Open File Dialog, select the name of a saved 
query definition. Query definition files have the extension .QRY. 

• The query is not run until the Make Export File button is pressed. If you save your export options for 
future use, any queries will run each time an export is produced, and the results at that time will be 
used as the key individuals. 

Clear Keys Button 

Click the Clear Keys button to remove all of the names from the list box.  

Use Saved Keys 

When the export options are saved to an export options file, the current keys are saved along with the options. 
When the export options file is reloaded, the saved keys can be reloaded as well by clicking the Load Saved 
Keys button. With this feature, you can save a favorite list of keys, including lists and queries, and select them 
again with just one click. 

Export Format 

The Export format box allows you to choose the format for the export file. For GEDCOM files, currently the 
only choice is GEDCOM 5.5. Future versions of Genbox may support later versions, as they are finalized. For 
Genbox files, currently the only choice is GENBOX 3.0. 

Generations to Go from Key Individuals 

The export options file can include the direct ancestors or direct descendants of the key individuals.  

All 

When All is selected, all direct descendants (or ancestors) will be selected for inclusion in the export, as well 
as their spouses.  

None 
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When None is selected, only the key individuals will be exported. Spouses will not be exported, unless they 
are also a key individual.  

Number of Generations 

The direct lines can be limited to a certain number of generations removed from the key individuals. By 
counting the key individual as generation 0, his parents are generation 1, his grandparents are generation 2, 
and so on. Going the other way, his children are generation 1, and grandchildren are generation 2. So if the 
descendant "Generations to go from Key Individuals" is set to 1, only the key individuals, their spouses, their 
children, and their children's spouses will be included on the export.  

1. To limit a direct line to a certain number of generations, click the Number radio button. 
2. Type the number in the box, or use the up/down arrow buttons to set the value. 

If you want to export just the key individuals and their spouses, but no children, set the number of 
descendant generations to zero instead of "None". 

To Date 

The direct lines can be limited to a certain date. This date is meant to totally enclose the life spans of the 
individuals to be exported; individuals living even partly beyond the range are excluded.  

• For Ancestral lines, click the To date radio button and enter the earliest date for birth in the box. 

Ancestors must be born on or after the specified date to be included. When ancestors are born before the 
specified date, they will be omitted. When the birth dates are unknown but another event date places them 
before the specified date, they are also omitted. 

• For Descendant lines, click the To date radio button and enter the latest date for death in the box. 

The descendant must be deceased by the specified date. If the date of death is unknown, and the Living 
attribute flag has not been set, Genbox will determine if the descendant should be considered deceased by 
taking the birth date and adding the default maximum life span value specified on the Preferences View, 
Dates page. 



       

Export Options View: Header Page 
The Header page is available when exporting to a GEDCOM file. It provides places to enter header 
information about the file.  

 

Submitter 

The Submitter field stores a link into the Researchers Table. Enter the name of the researcher that should be 
shown as the originator of the export file. 

Copyright 

Enter your copyright information for the export file. 

Content Description 

Enter a description of the contents of the database in the Content box. 
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Export Options View: Data Content Page 
The content for each individual, and for other data types, can be specified on the Data Content page. 

 

Individual Content 

The birth name and links to the preferred parents are included automatically. Other subrecords for individuals 
can be independently selected. 

Subrecords 

Subrecords can be included by checking the check boxes:  

• Name variations 
• Other identifiers 
• Attributes 
• Flags 
• Alternate parents 
• Alternate events 
• General notes 
• Research notes 
• Source citations 
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Event Types 

The event data included in the export file can be limited by event type. Choices are: 

 

Contact Record Types 

The contact records included in the export file can be limited by type. Choices are: 

 

All Button and None Button 

• Click the All button to select all individual content options. 
• Click the None button to clear all individual content options. 

Other Records 

In addition to individual records, other types of records can be independently selected for inclusion in the 
export file. 

Record Types 

Other record types can be selected by clicking the check boxes: 

• Sources 
• Media 
• Researchers 
• Correspondence Log 
• Research Targets 
• Projects / Objectives 
• Places 
• Lists 

Linked Only 

When Linked only is checked for Sources, Media, or Researchers, only the records that are linked to 
individual records which have been selected for export will be included. 

All Button and None Button 

• Click the All button to select all of the other record types. 
• Click the None button to clear all the other record types. 
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Living Individuals 

By default, living individuals are exported with the normal content. If you plan to distribute your data outside of 
your own family, you may wish to restrict the content included for living individuals, to respect their privacy. 
The Living individuals box presents the following choices on its drop-down list:  

 

When Omit is selected, living individuals and all links to them are treated like they are not even in your 
database. This means lineages will be ended when they reach a living individual. 

When Identifiers, links is selected, all the names and identifiers normally selected for output and 
relationships of living individuals are included, but no other information. No events, dates, or places.  

When Sex, links is selected, the name will be replaced by "Male" or "Female", so that only the sex and 
relationships of living individuals are shown. This provides a level of privacy higher than Identifiers, links, 
because names are not shown. 

Sex only is like Sex, links, only the information on children is omitted, even if the children are deceased. 

Defaults Button 

Click the Defaults button to reset all content options to Genbox defaults for the selected output file type. 
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Export Options View: Other Content Page 
The Other Content Page contains options for exporting record types that are not related to particular 
individuals or research.  

 

Other Records 

Other record types can be selected by clicking the check boxes: 

• Event Types 
• Source Types 
• Identifier Types 
• Individual Flag Definitions 
• Place Flag Definitions 
• Media Flag Definitions 
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Language Selector 

The Language Selector allows you to restrict the export of records to only those for a particular language. 
The default is all languages: 

 

All Button and None Button 

• Click the All button to select all of the other record types. 
• Click the None button to clear all the other record types. 

Defaults Button 
Click the Defaults button to reset all content options to Genbox defaults for the selected output file type. 
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Export Options View: Options Page 
The Options page contains additional options, most of which are enabled only when exporting to a GEDCOM 
file.  

 

The options that are available when exporting to either a Genbox database or a GEDCOM file are:  

Override Privacy Flags/Marks 
Override Exclude Flags 
Include Change Dates  

The option available only when exporting to a Genbox database is: 

Initialize Database 
 
The options available only when exporting to a GEDCOM file are: 

Intended Receiving System 
Maximum Line Length 
Character Set 
Include Embedded Citations 
Field Codes Format 
Continued Lines Format

Override Privacy Flags/Marks 

When Override privacy flags/marks is checked, parent relationships and spouse relationships that have the 
Private flag checked will be exported with their true relationships. Normally, private parent relationships are 
treated as "biological" and private spouse relationships are treated as "married" when exporting data. 

Override Exclude Flags 

When Override exclude flags is checked, parent links, spouse links, events, and other data items that have 
the Exclude flag checked will also be included in the export. 
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Include Change Dates 

All records in the database have change dates. If you want to include this information in your export file, click 
Include change dates. This information can significantly increase the size of a GEDCOM file, and most 
receiving systems do not import it. 

Initialize Database 

When checked, the exported Genbox database will first be initialized with data in the GBXDBINI.GDZ 
initialization database. This includes the default set of place names, event types, source types, flags, and 
other records normally used to initialize a new Genbox database. This data will appear in the exported 
Genbox database in addition to the data in the current database this is selected for export. 

When not checked, only the data that is selected for export will be written to the new Genbox database. 

This option is checked by default. 

Intended Receiving System 

Choose the Intended receiving system from the drop-down list, or type in your own: 

 

The choice of intended receiving system affects the defaults for other GEDCOM options on this page, based 
on known compatibility/incompatibility. The default is "(unspecified)". 

Maximum Line Length 

The Maximum line length value determines the maximum length for note lines in the GEDCOM file. It can be 
a value from 50 to 255 characters. The default value is 70 characters.  

Character Set 

The Character set box determines the character set that will be used in the export file. Choose a character 
set that can be read by the intended receiving system. Choices are: 

 

Include Embedded Citations 

When Include Embedded Citations is checked, source citations embedded in notes will be included in the 
GEDCOM file. Excluding embedded notes is useful when exporting to systems that the presence of this data 
would interfere with the import of the note text itself (such as for Personal Ancestral File). For most systems, 
embedded source citations are simply skipped, as unrecognized lower-level data. 

Field Codes Format 
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Field codes in notes can be exported in one of three ways: 

• Value and code 
• Value only 
• Code only 

The default is Value and code; the codes are placed in a lower level beneath the corresponding value text, 
which allows receiving systems that don't understand the codes to simply store the value portion. This results 
in exactly the same text as shown in the note preview mode. For systems where the codes in a lower level 
would interfere with the import of the note text itself, the "value only" option can be selected. 

Continued Lines Format 

Notes that extend longer than one line can be broken in one of two ways: 

• Break before space 
• Break mid-word 

Some systems, such as Personal Ancestral File, require Break mid-word, because spaces at the beginning 
and ending of lines are stripped on import. Other programs, such as Family Tree Maker, incorrectly assume a 
space between every continued line, so they have better results when Break before space is selected. The 
default is Break before space. 
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Import File View 
When Import Data from GEDCOM File or Import Data from Genbox Database is selected from the File menu, 
and a GEDCOM file (*.GED) or Genbox Database (*.GDB) is selected from the Open File Dialog, the Import 
File View appears. It has three pages. The Header page displays information about the file. The Content 
page allows you to select which types of data will be imported.  The Options page contains options you can 
set to control the import. 

            Header Page 
            Content Page 
            Options Page

Buttons 

Imported data can be handled in two ways:  

• Click the Append to Current Database button to add the imported data to the currently open 
database. 

• Click the Import to New Database button if you want to place the data in a new database. 

Import to a New Database is recommended when you are unfamiliar with the data. That allows you to view it, 
produce some charts, and make a determination as to whether the data or a portion of the data would be 
helpful in your main database. Then you can do another import and choose the Append to Current 
Database button. While appending data, no attempt to reconcile duplicate individual records is made. This 
can be done later with the Match Finder Tool. 

You may wish to view the GEDCOM file directly before processing it. If so, click the View File button. 

Troubleshooting Character Set Problems 

After you import a GEDCOM file, you may notice certain characters in your data that did not appear to import 
correctly. These include accented characters and other special characters that are not part of the standard 
ANSI character set. In some cases, this problem is the result of the source program writing the data using the 
wrong codepage. For example, the source program may have written the GEDCOM using the Cyrillic 
codepage but the GEDCOM file states that the character set is ANSI. As a special conversion capability, 
Genbox can correct this type of error on input, provided you know the correct codepage value and the 
GEDCOM file is edited to indicate this value: 

• Open the GEDCOM file in a text editor. 
• Find the line near the top that begins with the tag "CHAR". Typically, it will indicate the ANSI character 

set, as in "CHAR ANSI". 
• Change the value for the tag to the numeric codepage value. For example, the line should read 

"CHAR 1251" for Cyrillic. 
• Save the GEDCOM file. 
• Import normally. 

Genbox will use the codepage value to convert all data on input. If the character problems appear worse 
rather than better, then either the codepage value specified was incorrect or the problem is unrelated to the 
codepage that was used by the source program. 



       

Import File View: Header Page 
The Header page displays information about the import file. All of the controls on this page are read-only. 

 

Source Program 
The Source program box displays information about the genealogy program that exported the file. It includes 
the program name and version, company, and address. 

Submitter 
The Submitter box displays information about the researcher who created the GEDCOM file. It includes the 
researcher's name and address. 

Intended Destination 
The Intended destination box displays the type of receiving system that the GEDCOM file was made for, if 
any. 

Date 
The Date box displays the date stored inside the file. 

File Information 
The File information box shows the full path name to the file, the internal name of the file, the character set 
used to encode the information, the GEDCOM file version, and the language of the data. It also shows any 
comments stored for the file. 

Analysis  
The Analysis box displays the number of the elements for each of the following:  

• Lines 
• Individuals 
• Families 
• Sources 
• Submitters 
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Import File View: Content Page 
The Content page allows you to select which types of data will be imported. Normally, you would import all 
data types. Sometimes, however, you may find it useful to be able to import just certain data types. You may 
wish to import just the source types and event types from another database, for example. 

 

The data sets are organized into two groups: independent data sets, and dependent data sets. The 
independent data sets can always be selected for importing, regardless of other content selections. The 
dependent data sets can only be imported when the other data sets that they depend on are being imported. 
Genbox will automatically disable and enable the dependent data set choices as appropriate.  

The independent data sets are: 

• Individuals, Families, and Links 
• Places 
• Event types 
• Source types 
• Flag definitions 
• Media 
• Projects / Objectives 

The dependent data sets are: 

• Events 
• Sources 
• Source citations 
• Correspondence log 
• Research targets 
• Flags 
• Lists 

There are two buttons: 

• Click All to select all check boxes. 
• Click None to clear all check boxes. 

Copyright © 2005  Thoughtful Creations. All rights reserved. 367



       

Import File View: Options Page 
The Options page provides a number of settings to control the import.  

 

Duplicates Processing 

Event Templates and Source Templates 

The Event Templates table and the Source Templates table do not hold genealogical information; they are 
supporting tables that often have the same records across databases. When importing a file into an existing 
database, you have some options for handling the likely duplication of records (records that have the same 
key field values): 

• Keep old 
• Replace old 
• Merge 

If you don't want any of your existing records to be changed, choose Keep old. If instead you are interested to 
see if the incoming file has any custom modifications to the templates, choose Replace old. As a third choice, 
you can choose Merge, in which case the data from both records will be combined; any blank data values in 
the existing record will be filled with new values. Non-blank values in the existing record will be retained. This 
means if you have any customized templates, the "Merge" option is still safe to use. 

For all choices, imported template records which have new key field values will always be added to the tables. 

Media Records 

When imported media records have the same filename and reference name as an existing media record, 
Keep old processing will apply: the imported record will be skipped. 

Project Objectives 

When imported project objectives records have the same name and parent objective as an existing project 
objective, Keep old processing will also apply: the imported record will be skipped. 

Places 
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Imported places that match existing place names will automatically be merged. 

Other Record Types 

Imported records of other types (individuals, families, events, sources, etc.) will not be checked for duplicates. 
After importing, you should carefully review the data to determine if any imported individuals are a good match 
with other individual records. Then, you can choose Merge for the Data menu to merge them together. The 
Match Finder tool can also be used to find individual merge candidates. 

Retain Original ID Numbers 

By default, individuals are assigned new ID numbers when they are imported. Click the Retain original ID 
numbers check box if you want to keep the old ID values. The system will then use the original IDs, except 
when there is an existing Individual record with the same ID; in that case, a new ID value will be assigned. 

Replace Underlines with Spaces 

GEDCOM files originating from older systems may have used underlines instead of spaces in name 
identifiers. Click the Replace Underlines with Spaces check box to have these automatically converted to 
space characters. 

Retain Hard Line Breaks in Note Text 

Some GEDCOM files incorrectly specify hard line breaks between every line in note text. Genbox takes out 
hard line breaks by default, so that the note text can be formatted to the correct width on reports. If you want 
to see the notes with the line breaks indicated, click the Retain hard line breaks in note text check box. 

Log File Warnings  

When an import is performed, a log file is created that keeps a record of cautions and warnings for specific 
imported data items. For a large GEDCOM file, a large number of warnings can be generated. In particular, 
the Unknown tag and Unsupported tag in context warnings can be numerous, which would make it harder 
to find other warnings within the log file. You have a choice for handling these types of warnings:  

• Warn once 
• Warn on all 

When Warn once is chosen, the warning message will only appear for the first data item with the problem. 
Subsequent warnings for the same situation will be omitted. 



       

Magnify Notes View 
The Magnify Notes View, also known as the Notes View, presents the contents of the notes fields on the 
current view page in a larger window. You can size this window to be as large as you like. A separate page is 
shown for each note type. A number of function buttons appear along the right side. 

• To open a Magnify Notes View for the current notes field, press F5 or choose "Magnify Notes" 
from either the right-click context menu or the Select Menu. 

The Magnify Notes View is modeless. This means you can freely move between the Notes View and other 
views, entering and modifying text. Your changes will be saved automatically.  

You can click Close to close the Magnify Notes View when you are done with the current notes, or you can 
leave the view open where it will be reused when F5 is pressed in another notes box. If you want instead to 
have multiple Notes Views open at the same time, press SHIFT+F5 to open the second Notes View. That 
allows you to compare text and easily cut and paste between them. 

 

A number of function buttons are available on the Magnify Notes View: 

Spell Check 
Click the Spell Check button to open the Spell Checker Tool which will check the spelling of words in the note 
text. 

Wordwrap 
Click the Wordwrap button to remove the "hard" carriage return/line feed characters in the current selection or 
the entire note.  

Clear 
Click the Clear button to delete all of the text in the note. 

Insert File... 
When the Insert File... button is clicked, the File Open Dialog will appear. Select the name of a file that 
contains plain text you would like to insert at the current text position. 

Write File... 
When the Write File... button is clicked, the File Open Dialog will appear. Enter the name of a file that will be 
written the current selection or the entire contents of the notes box. You can output the text either in plain 
ASCII format or as rich text (RTF). 
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Pick Dialogs 

Backup Select Files Dialog 
The Backup Select Files Dialog is selected from the File menu by clicking Backup. It is used to select files 
for backup. It is based on the Open File Dialog. You may wish to change some of the backup options before 
performing the operation.  

 

• To back up files, type the file path or browse to the location of the file. 
• Click Add. 
• The Save File Dialog will appear. Specify a filename and path for the backup file. 
• Click Save. 

Subfolders 
If you have organized your data files into subdirectories, you can easily back up all your files. The Subfolders 
option has the following choices: 

• Ignore 
• Add all files 
• Search for files 

When Ignore is chosen, only the files matching the file path entered are included in the backup. 

When Add all files is chosen, all files in all subdirectories of the specified path are automatically included. For 
example, if you type in "c:\Mydata\mymain.GDB", and there is a subdirectory called "OldData" with a file 
named "Robin.GDB" and another subdirectory called "Chart Options" with a file named "Robchart.GCO", both 
of these files (and all the rest of the content in the subdirectories) would be backed up as well as 
mymain.GDB in the top-level directory. 

When Search for files is chosen, only those files matching the specified name are included. For example, if 
you type "c:\mydata\Rob*" using the asterisk wildcard, a file named "Robin.GDB" in the "OldData" 
subdirectory and another one named "Robchart.GCO" in the "Chart Options" subdirectory would be included, 
but a file named "Pennychart.GCO" in the "Chart Options" subdirectory and the file "Mymain.GDB" would not 
be included. 

File Paths 
Click Save full path info if you want the full directory path to be stored with each file. If selected, the Restore 
operation will be able to restore files directly to the subdirectories where they were. Otherwise, the Restore 
operation will restore all the files to the current directory. 
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Chart Properties Dialog 
The Chart Properties Dialog appears when Chart Properties is selected from the Chart Popup Menu.  

 

This menu option is available when you right-click anywhere in the open area on the chart. The dialog 
displays properties about the current chart: 

• Number of boxes 
• Number of individuals 
• Number of families 
• Number of starting individuals (keys) 
• Number of generations 
• Number of levels (if "strict generational alignment" is selected and "stagger leaves" is not selected, 

the number of levels will be the same as the number of generations) 
• Number of cross-links 
• Width of chart, in inches or millimeters 
• Height of chart, in inches or millimeters 
• Number of pages, in the horizontal and vertical directions. 
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Chart Box Properties Dialog 
The Chart Box Properties Dialog appears when Box Properties is selected from the Chart Popup Menu. 
This menu option is available when you right-click on a box on the chart.  

 

The dialog displays properties about the current chart object: 

• Box type (Family box, Individual box, Picture box, Title box, Legend box, Draw Object, Annotation) 
• Primary individual name, ID, and date range (not all boxes have a primary individual) 
• Spouse name, ID, and date range of spouse in box, if any 
• Page(s) that the box appears on 
• Checkbox: "Include in Chart Frame Sizing" 

To more easily see box properties for several boxes, click the image of a push pin to "pin" the dialog to the 
window. Then click on each box you want to see properties for. The dialog will be updated automatically. 

Include in Chart Frame Sizing Checkbox 

Boxes and objects on a chart can be either inside or outside the optional chart frame. Often, the Title Box will 
be above the chart frame, and the Legend Box will be below, with the Individual and Family boxes inside the 
frame. The default setting for added pictures, freehand lines, and annotations is outside the chart frame. 

You can view and change the default setting for a chart object with the Include in Chart Frame Sizing 
checkbox. When checked, the position and size of the chart object will be considered by the program when 
sizing and positioning the chart frame. When the chart object is moved or resized, the chart frame will 
automatically be adjusted so that the frame continues to surround the object. The chart margin setting will also 
be respected, keeping the chart frame at the specified distance from its contents. Boxes marked "outside" the 
chart frame will be completely ignored when drawing the frame; this means the frame might be overlapped. 
This effect might be desired, as when a freehand arrow is drawn from outside the frame, across the frame and 
pointing at a box inside. Other times, you may need to manually drag the overlapping "outside" boxes to get 
them out of the way of a newly resized chart frame. 

To change the setting for a chart object, check or clear the checkbox, then click the "OK" button or the "Apply" 
button. The "OK" button will also close the dialog window, unless the push pin has been pinned. 
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Citations Pick Dialog 
The Citations Pick Dialog is used to select citation records.  

 

ID 

If you know the ID of the citation, type it into the ID box. The citation record with that ID will be shown 
automatically. 

Name 

Type the name of the citation in the Name box. You can type a full citation name or just the first part. All 
citation names that begin with the portion you typed will be displayed automatically. 

List Box 

The list box has two columns: Citation ID and Name. Double-click on a row to select that citation. 

Filter List 

The citation displayed in the list box can be filtered according to a number of data values: 

• Surety level 
• Citation data type 
• Individual  
• Source 
• Number of sources 

After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 
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The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 

Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 

When the Citations Pick dialog is used to filter citation on the Citations View, click the Set Filter button to turn 
filtering on with the current filter conditions and close the dialog. The citation records shown on the Citations 
View and reachable with the record movement buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 

When filtering of the Citations View has been turned on, click the Clear Filter button to turn off filtering and 
close the dialog. The full set of citation records will be shown on the Citations View and will be reachable with 
the record movement buttons. 



       

Correspondence Pick Dialog 
The Correspondence Pick Dialog is used to select correspondence log records.  

 

ID 

If you know the ID of the correspondence, type it into the ID box. The correspondence log record with that 
correspondence log ID will be shown automatically. 

Name 

Type the name of the correspondence log record in the Name box. You can type a full name or just the first 
part.  All correspondence log records with names that begin with the portion you typed will be displayed 
automatically. 

List Box 

The list box has six columns: Correspondence Log ID, Type, Direction, Correspondent, Date, and Subject. 
Double-click on a row to select that correspondence log. 

To sort on a column, click its header. A second click on the same column header will show the reverse sort. A 
triangle will indicate the current sort column and direction of sort; the triangle will point in the direction of 
increasing values. 

Filter List 

The correspondence records displayed in the list box can be filtered according to a number of data values: 

• Type 
• Date 
• Subject 
• Direction 
• Correspondent 

After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 
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The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 

Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 

When the Correspondence Pick dialog is used to filter correspondence log on the Correspondence View, click 
the Set Filter button to turn filtering on with the current filter conditions and close the dialog. The 
correspondence log records shown on the Correspondence View and reachable with the record movement 
buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 

When filtering of the Correspondence View has been turned on, click the Clear Filter button to turn off 
filtering and close the dialog. The full set of correspondence log records will be shown on the Correspondence 
View and will be reachable with the record movement buttons. 



       

Database Pick Dialog 
The Database Pick Dialog presents choices for selecting a Genbox database:  

 

• Create a new, blank database 
• Create a new database by importing a GEDCOM file 
• Open an existing Genbox database by selecting it from the displayed list of recently opened 

databases 
• Browse for a database by choosing the "More files..." option. 

This dialog will appear when Genbox is first run, and when preferences have been set not to open the last 
opened database on startup. 
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Event Template Preview Dialog 

The Event Template Preview Dialog is opened by clicking the Magnify button  next to the Template box 
on the Individuals View: Events page, or by pressing F5 or selecting "Magnify Event Sentence" from the right-
click context menu or the Select Menu. You can use it to enter, modify, and test your event template and see 
how your event data will look formatted on a report, complete with footnotes. You can also modify and add to 
the default event subtype templates stored in the Event Types record for the current event type. 

The preview text is formatted according to the Report Options File for Preview Dialogs, defined on the 
Operation Page of Preferences. This also controls the footnotes. You can create a report that suits your 
"preview" needs, then save the options file and use that file in your preferences setting. 

The templates and formatted result are both shown for the currently selected output language. 

 

Event Subtype Selector 

The Event Subtype Selector provides a choice between the defined subtypes for the current event type. 
Each subtype has a predefined template, which will appear in the Template Box when selected. 

The full set of subtypes defined for the current event tag are included on the drop-down list. Subtypes that do 
not have templates defined in the current output language family will appear on the drop-down list in the 
"secondary data" font style. 

Template Box 

The Template box displays the template. Changes that you make to the template will be immediately 
reflected in the Preview box. 
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Preview Box 

The Preview box shows you how the event data will look formatted on reports, according to the template in 
the Template box. The Preview box is read-only. 

Reset to Default Button 

Click Reset to Default to restore the template to the default for the current event subtype. 

Make This Default for Subtype Button 

Click Make This Default for Subtype to make the template the new default for the current event subtype. 
This button provides an easy way to update the default templates for event types without opening the Event 
Types View. 

Make This New Subtype Button 

A new subtype choice for the current event type can be created as follows:  

• Enter the desired name for the new subtype into the Event Subtype Selector box. 
• Modify the template as appropriate. 
• Click the Make This New Subtype button. 

This button provides an easy way to add more subtype templates for the current event type without needing to 
open the Event Types View. 



       

Event Witness Template Preview Dialog 
The Event Witness Template Preview Dialog is opened by clicking in the "T" column of the Witness list for 
a witness on the Individuals View: Events page. You can use it to test and update the event witness template 
for the selected witness and see how your event witness data will look formatted on a report. You can also 
modify or add to the roles defined for an event type without needing to open the Event Types View. 

The preview text is formatted according to the Report Options File for Preview Dialogs, defined on the 
Operation Page of Preferences. This also controls the footnotes. You can create a report that suits your 
"preview" needs, then save the options file and use that file in your preferences setting.  

The role names, templates, and formatted result are all shown for the currently selected output language. 

 

Witness 

The Witness box displays the name and ID of the selected witness. This box is read-only. 

Role Selector Box 

The Role Selector box displays the roles defined for the current event type. You can choose one of the 
predefined roles for the current event type from the drop-down list. 

The full set of roles defined for the current event tag are included on the drop-down list. Roles that do not 
have templates defined in the current output language family will appear on the drop-down list in the 
"secondary data" font style.  

Role Text Box 

The Role Text box displays the role name currently selected or entered for the witness. You can type in your 
own custom role name here. 
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Template Box 

The Template box displays the witness template. Changes that you make to the template will be immediately 
reflected in the Preview box. 

Preview Box 

The Preview box shows you how the event witness data will look formatted on reports, according to the 
template in the Template box. The Preview box is read-only.  

Reset Button 

Click Reset to restore the witness template for the current witness to the default template for the current event 
type and role.  

Make This Default for Role Button 

Click Make This Default for Role to make the template the new default for the current role. This button 
provides an easy way to update the default templates for roles without needing to open the Event Types View.  

Make New Role Template Button 

A new role template for the current event type can be created as follows:  

• Enter the desired name for the new role into the Role Selector box. 
• Modify the template as appropriate. 
• Click the Make New Role Template button. 

This button provides an easy way to add more role templates for the current event type without needing to 
open the Event Types View.  



       

Find Dialog 
The Find Dialog appears when Find is selected from the Chart Popup Menu. This dialog allows you to find 
data on the chart. 

 

Text Box 

Enter the text you want to search for in the Text box. 

Name/ID Box 

Enter the Individual name or ID that you want to search for in the Name/ID box. 

Object Type 

Select the type of chart objects you want to search: 

 

For many of these types, you don't need to specify any text for the search--the object type is enough. For 
Parent, select the child box before opening the Find dialog, and leave the other match fields blank. 

Match Case 
Click the Match case check box if you want to require that the upper and lower case letters you typed match 
exactly. 

Find Button 
Click the Find button to begin the search. The first matching chart object will be selected, or the message 
"Match Not Found" will appear. To find the next matching chart object, you can press CTRL+G. 

Clear Button 
Click the Clear button to reset all match conditions to blank. 
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Icon Pick Dialog 
The Icon Pick Dialog is used to select icons for the Chart Options View: Contents page. This dialog is like the 
Open File Dialog, with the addition of a display of the icons. Choose a file that contains icons, pick an icon 
from the file, then click Open.  

 

File Types 

Besides separate files, icons can also be found in programs and libraries. The Files of type box presents the 
following choices: 

 

Icon List Box 

More than one icon can be found in some files. An image of each of the icons found in the currently selected 
file will appear in the Icon List box. The currently selected icon will have a box around it. To select a different 
icon, click it. 

Icon Selection Box  

The Icon Selection box displays the currently selected icon. This image is read-only. To select a different 
icon in the current file, click its image in the Icon List box.  
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Individuals Pick Dialog 
The Individuals Pick Dialog is used to select individuals.  

 

Individual ID 
If you know the ID of the individual you are searching for, enter it in the Individual ID box. 

Search Box 
To search by name, type the name of the individual in the Search box. You can type a full name or just the 
first part of the given name or surname or both. All individual names that begin with the portion you typed will 
be displayed automatically. 

Ignore Diacritics 
When Ignore diacritics is checked, characters with accents, such as é and â, will be treated the same as the 
corresponding characters without the accents.  

Phonetic Match 
When Phonetic match is checked, the phonetic equivalent of the typed name will be used in the search. 
Type the name normally. A phonetic search generally produces more matches than an exact spelling match. 

List Box 
The list box has four columns: Individual ID, Name, Birth Date, and Death Date. Double-click on a row to 
select that record. 

The Name column displays the matching individual names. If the match was to an identifier or name variant 
that is not part of the preferred name, the matching name will be shown first, followed by a dash, then the 
preferred name. If the identifier type is of class prefix, suffix, or identifier, or if the identifier type has the "label" 
flag set, the identifier type will also be shown in parentheses. Nicknames will be shown in double quotes, and 
User ID values in brackets: 
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Rachel Moore  -  Rachel Woods 
[M6543] - Margaret Lynn 
Jr. (suffix title) - Frederick Smith 
"Tom" - Thomas Smith 

List Box Sorting 
You can sort the names in the list box by clicking on the column headers: Individual ID, Name, Birth Date, or 
Death Date. A second click on the same column will reverse the sort. An arrow next to the column label will 
point in the direction of increasing values. 

For the "Name" column, you can sort on either surname-first order or given-name-first order. The default sort 
order is by surname; clicking on the column header will cycle through surname ascending, surname 
descending, given name ascending, given name descending. The column header indicates the sort direction 
and sort type. 

Filter List 
The individuals displayed in the list box can be filtered according to a number of data values: 

• Birth and Death dates 
• Number of spouses 
• Number of parent families 
• Number of children 
• Sex: male, female, and/or unknown 
• Individual flags 

After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 
The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 
Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 
When the Individuals Pick dialog is used to filter individuals on the Individuals View, click the Set Filter button 
to turn filtering on with the current filter conditions and close the dialog. The individual records shown on the 
Individuals View and reachable with the record movement buttons will be restricted to those matching the filter 
conditions. 

Clear Filter Button 
When filtering of the Individuals View has been turned on, click the Clear Filter button to turn off filtering and 
close the dialog. The full set of individual records will be shown on the Individuals View and will be reachable 
with the record movement buttons. 



       

Insert Field Code Dialog 

The Insert Field Code Dialog is opened by clicking the Insert Field Code toolbar button  or by pressing 
CTRL+D. You can use it to insert new field codes or edit existing field codes in your event templates and note 
text. 

 

Category Selector 

The Category Selector provides a choice between the defined categories of field codes. When a category is 
selected, the base codes defined for that category will appear in the Base Code List Box. The top of the pick 
list has the choice "(all categories)". 

The categories that you can select from are: 

 

When the dialog opens to add a new field code, the initial category displayed will be the one most recently 
used. 

Base Code List Box 

The Base Code List Box lists the base codes in the currently selected category. Click a base code to select 
it. Your selection will appear in the Field Code box. 
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Options 

Most base codes support a number of options. The options supported will vary according to the currently 
selected base code. 

Once Only 

When Once only is checked, the field code will return a blank value if the data value it references has already 
appeared at least once in the current template. 

Suppress 

When Suppress is checked, the data value that would have been returned by the field code is treated as if it 
were blank. This affects following field codes that reference the same data value. A field code with the 
Suppress option should not be placed in a conditional group, because that condition would always fail. 

Suppress After 

When Suppress after is checked, the data value is treated as if it were blank, but only after showing the 
value. This option can be used to ensure the data value only appears once in the output. 

Hide Value 

When Hide value is checked, the field code is processed normally, except that the data value returned (if any) 
is not shown in the output. This option allows you to tailor your conditional template parts based on whether a 
data value is non-blank without needing to output the data value itself. While both Hide value and Suppress 
prevent the data value from being shown, a Hide value field code will still look at the data to see if it is non-
blank, while a Suppress field code will behave as if it were blank. 

Sentence Case 

The Sentence Case pick list provides the following choices: 

 

The choice of Sentence case influences which pronoun is used. 

Name Shortened Forms  

For individual names, you have a choice of the following formats: 

• Initial full name 
• Always full name 
• Force pronoun 
• Never pronoun 

The default is Initial full name, which will show the full name on first reference to the individual, then use just 
the given name or a pronoun if this is a subsequent reference. 

Filter 

The filter options will cause the field code to return a blank value if the filter conditions are not met. 

Sex 
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The Sex pick list provides the following choices for filtering on sex: 

 

The sex filter options allow you to tailor templates according to the sex of the individual. This allows proper 
forms of surrounding words to be used. 

When Focus Individual 

For the [P1], [P2], [P3] base codes, check the When focus individual checkbox to cause the field code to 
show a value only when the selected principal is the focus individual. When used in a conditional group for an 
event general note, this option allows you to tailor the general text to be different for each principal in the 
event. 

Parameters 

Some of the base codes can use a record ID value to specify the specific data record to use. The type of ID 
varies according to base code: it can be the ID for an Individual, Individual Identifier, Place, Place Name, 
Event, or Source. 

The type of ID expected is shown by the label in the Parameters section. The ID box allows you to type the 
ID number in directly, if known. Or, you can type the name of the data record in the Name box. Or, you can 

click on the Filter button  to open the pick dialog for the current data type. 

When a data record has been selected, the ID box and Name box will display your selection. 

For the Individual Name Variant Reference base code [N], the Name Variant ID box and Name Variant Pick 
List will be activated once an individual has been selected. 

Field Code 

The Field code box displays the complete field code, with all the currently selected options, filters, and 
parameters. You can edit this text directly if you wish. 

Insert Button 

When The Insert button is pressed, the field code will be inserted into the note or template at the current text 
cursor position, and the dialog will close. 

Cancel Button 

When the Cancel button is pressed, the dialog will close without inserting a field code. 
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Insert Source Field Code Dialog 

The Insert Source Field Code Dialog is opened by clicking the Insert Field Code toolbar button  or by 
pressing CTRL+D. You can use it to insert new field codes or edit existing field codes in your source 
templates. Before opening the dialog, position the text cursor at the position in your source template where 
you would like to add the new field code. 

 

Category Selector 

The Category Selector provides a choice between the defined categories of field codes. When a category is 
selected, the base codes defined for that category will appear in the Base Code List Box. The top of the pick 
list has the choice "(all categories)". 

The categories that you can select from are: 

 

When the dialog opens to add a new field code, the initial category displayed will be the one most recently 
used. 

Base Code List Box 

The Base Code List Box lists the base codes in the currently selected category. Click a base code to select 
it. Your selection will appear in the Field Code box. 

Options 

Most base codes support a number of options. The options supported will vary according to the currently 
selected base code. 
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Once Only 

When Once only is checked, the field code will return a blank value if the data value it references has already 
appeared at least once in the current template. 

Suppress 

When Suppress is checked, the data value that would have been returned by the field code is treated as if it 
were blank. This affects following field codes that reference the same data value. A field code with the 
Suppress option should not be placed in a conditional group, because that condition would always fail. 

Suppress After 

When Suppress after is checked, the data value is treated as if it were blank, but only after showing the 
value. This option can be used to ensure the data value only appears once in the output. 

Hide Value 

When Hide value is checked, the field code is processed normally, except that the data value returned (if any) 
is not shown in the output. This option allows you to tailor your conditional template parts based on whether a 
data value is non-blank without needing to output the data value itself. While both Hide value and Suppress 
prevent the data value from being shown, a Hide value field code will still look at the data to see if it is non-
blank, while a Suppress field code will behave as if it were blank. 

Field Code 

The Field code box displays the complete field code, with all the currently selected options. You can edit this 
text directly if you wish. 

Insert Button 

When The Insert button is pressed, the field code will be inserted into the source template at the current text 
cursor position, and the dialog will close. 

Cancel Button 

When the Cancel button is pressed, the dialog will close without inserting a field code. 



       

Line Tool Options Dialog 

The Line Tool Options Dialog appears when the Line Tool  is double-clicked while viewing a chart or 
report. You can use it to change the properties of a selected line, and set options for new lines. 

 

Thickness 

Enter the thickness, in number of pixels. 

Line Style 

Select the Line style, from the drop-down list: 

 

Note   When Thickness is greater than 1, Line style must be Solid. 

Color 

Click on the Color button to open the Select Color Dialog. Choose the new color from the dialog. 
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List Properties Dialog 
The List Properties Dialog appears when Properties is selected from the popup menu for a list name on the 
List View. It is used to display and enter properties of lists.  

 

ID 

Each saved list has an ID, which is displayed in this box. This box is read-only. 

Name 

This box displays the name of the list. To rename the list, type the new name. 

Change Date 

This box displays the date the list was last modified. It is read-only. 

Description 

Type your description of the list into the Description box. 
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Magnify Place Dialog 
The Magnify Place dialog displays the place name for the current field, with names at each place level in a 
separate field. You can use the up/down arrow buttons to easily move place name parts either up or down the 
place level hierarchy. Names in a "new" position are shown in the "marked text" font. A place name that is 
already in the database is shown in the normal text font.  

• To open the Magnify Place Dialog, first click in the Place field that contains the data of interest, then 
press F5 or select "Magnify Place" from the right-click context menu or the Select Menu. The Magnify 
Place Dialog will also be opened automatically when the preferences option "Confirm New Places" is 
checked and a new place name is entered. 

 

In this example, "Grace Chapel" is shown highlighted, which indicates this is a new place name. The City of 
Springfield, and all higher levels shown, are displayed in the normal font, indicating these place names are 
already stored in the database. 

Moving Name Parts Up or Down 
Genbox will attempt to place new names into the correct levels. When this default assignment is incorrect, you 
can easily move a name part up or down by clicking on the arrows to the left of the field. There are no "push 
restrictions" in this dialog; if a place name is pushed to a box already containing a name, the old name will be 
pushed out and into the next text box. 

There are three boxes that can accumulate name parts pushed into them: Leading modifier, Local Site, and 
Nation/Area. Each name in a multiple-name level will be separated by a comma. 

Using the Street Address Box 
In Genbox, the "street address" for a local site is considered a name variant of that local site. If the local site 
name is left blank, the street address becomes the primary name. Values entered into the street address box 
on this dialog will be marked "postal".  

The indented set of up/down buttons allows you to handle movement to/from the street address box 
separately. When name parts are "pushed" from local site or city, they normally skip over the street address 
box. If you want to move a name into the street address box, use one of the indented arrow buttons. 

Entering a Leading Modifier 
The Leading Modifier box can be used to enter a leading modifier for the place. If left blank, the leading 
modifier is determined by the event type and place level, and is usually "at" or "in". The leading modifier text 
should all be lowercase. Commas can be included. 

Note the leading modifier text is stored in the event record, not in the Places database with the place name.  
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Media Pick Dialog 
The Media Pick Dialog is used to select media records.  

 

ID 

If you know the ID of the media, type it into the ID box. The media record with that media ID will be shown 
automatically. 

Search By 

You can search for media by values in the following data fields: 

 

The fourth column in the list box will change to reflect your selection. 

Text Box 

Depending on your choice for Search by, type the reference name, file name, title, caption, or description into 
the text box. You can type a full value or just the first part.  All media records with values that begin with the 
portion you typed will be displayed automatically. 

List Box 

The list box has four columns: Media ID, Type, Last Modified, and a fourth column that is dependent on your 
choices for Search by. Double-click on a row to select that media. 

To sort on a column, click its header. A second click on the same column header will show the reverse sort. A 
triangle will indicate the current sort column and direction of sort; the triangle will point in the direction of 
increasing values. 
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Filter List 

The media displayed in the list box can be filtered according to a number of data values: 

Filter by Media Type 

Choices are: 

 

Filter by Media Subject 

Choices are the same as on the media subject pick list on the Media Content Page: 

 

Filter by Media Setting 

Choices are the same as on the media settings pick list on the Media Content Page: 

 

Filter by Number of Links 

Enter the number of links required for a match. You can use comparative operators, such as "> 2". 

Filter by File Not Found 

When File not found is checked, the media list is filtered to those records where the file name contains an 
invalid path.  

Filter by Linked Data Type 

Choices for linked data type are: 
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If no data record ID is entered, then media will be restricted to any links of the specified data type. 

For "Individual", links to summary, family, or event media for individuals will be included. 

Filter by Linked Data Record ID 
First choose the data type, then enter the ID or type the name of a data record that the media must be linked 
to. With this filter option, you can restrict the media list to just the media linked to a particular individual, for 
example. 

The "Individual Families" data type will restrict the list to family media linked to the entered individual ID. 

The "Individual Events" data type will restrict the list to event media linked to the entered individual ID. 

The "Family" data type requires a Family ID to be entered. 

The "Event" data type requires an Event ID to be entered. 

Filter By Media Flags 
Click any of the media flags to include them in the filter conditions. 

Update Filter Button 
After changing values in the filter group, click the Update button to update the list box. 

Reset Filter Button 
Click the Reset button to clear all filter conditions. 

Select Button 
The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 
Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 
When the Media Pick dialog is used to filter media on the Media View, click the Set Filter button to turn 
filtering on with the current filter conditions and close the dialog. The media records shown on the Media View 
and reachable with the record movement buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 
When filtering of the Media View has been turned on, click the Clear Filter button to turn off filtering and close 
the dialog. The full set of media records will be shown on the Media View and will be reachable with the 
record movement buttons. 

Add File to Library Button 
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If the media file you want to select does not have a record in the Media Table, click the Add file to library 
button. The Open File Dialog will appear. Select the file you want to add to the library and click Open. A new 
record in the Media Table will be created, and a new row will appear in the list box on the Media Pick Dialog. 

Preview Check Box 
Click the Preview check box to enable viewing of the media. The pictures will appear in the blank area above 
the check box.  



       

Media Preview Dialog 
The Media Preview Dialog appears when the Play button  next to a Media control displaying a picture is 
clicked, or when the Media control has the focus and F5 is pressed or "Magnify Media" is selected from the 
right-click context menu or the Select Menu. It shows the media in a larger window. 

 

View Number 
The Media Preview Dialog can display multiple pictures at once. Choices for viewing number are:  

• One 
• Six 
• Twelve 
• All 

Media Control Buttons 
There are four media control buttons beneath the image area: Play, Previous, Next, and New.  

• The Play button will display a desert landscape  when the current media is a picture. Click this 
button to toggle the picture between maximum fit size and actual image size. Note: if the actual image 
size is as large or larger than the Media Preview window, no change will be observed. 

• The Play button will have an ear on its face  when an audio sound is the current media. Click this 
button to hear the sound.  

• The Play button will look like a film strip  when a video is the current media. Click this button to start 
the movie. A second click will stop the movie.  

• The Play button will not appear If there is no current media. 
• Use the Previous button and the Next button to step through all of the pictures linked to the data 

record. If both buttons are grayed, that means there are no other pictures. If a button is bold, that 
means there are more pictures to view in that direction. Clicking a grayed button will cycle to the 
picture at the other end of the sequence. 

• Click the New Media Link button  to add a new media link to the current data record. The Media 
Pick Dialog will appear and allow you to choose the media you wish to link. 
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Message Dialog 
The Message Dialog appears when an error or warning condition occurs. It also appears when a question 
needs to be answered before an operation can proceed. 

 

This is an example dialog displayed after exporting a database to GEDCOM file. 
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Open File Dialog 
The Open File Dialog will appear when a filename is needed for an operation.  

 

1. Type the filename into the File name box, or click its name in the list box. 
2. Click Open. The dialog will close. 

You can filter the view of files with the Files of type box. The choices of file types and the default type will 
vary, depending on the command selected that caused the dialog to appear. 
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Paste List Dialog 
The Paste List Dialog appears when you paste a list you copied on the List View. It allows you to enter a 
name for your new list. 

 

If you are pasting your list to a selected destination, you will be presented with the following options for 
merging your list with the destination list: 

• Paste as new list 
• Merge with existing List  (OR) 
• Select common with existing list  (AND) 
• Select unique with existing list  (XOR) 
• Subtract from existing list  (NOT) 

Lists in Genbox contain unique members. When you paste to a list, only the members that are not already on 
the list will be added. That is why there is no "Add" option for combining two lists. 

The merge option will result in a list that contains all members from both lists. Members that were already on 
both lists will only be represented once in the resulting list. 

The common option will result in a list that contains only members that were on both lists before the operation 
began. Members that were only on one of the two lists will be dropped. 

The unique option will result in a list that contains only members that appeared on exactly one of the two lists. 
Members that appeared on both lists will be dropped. 

The subtract option will result in a list that contains the original destination members that did not also appear 
on the merged list. 

By using these merge options to combine lists, you have powerful capabilities for manipulating your lists in 
Genbox. 
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Picture Tool Options Dialog 

The Picture Tool Options Dialog appears when the Picture Tool  is double-clicked while viewing a chart 
or report. You can use it to change the frame, title, and caption options of a selected picture, and set default 
options for new pictures. 

 

Corner Shape 

The choices available on the drop-down lists for corner shapes are: 

 

Corner Fills 

Frame corners can be filled with the Frame color, for added visual effect. Click the Corner fill check box to 
select. 
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Sides to Include 

Individual sides of the frame can be selected from inclusion. Choices from the drop-down list are:  

 

Line Width 

The Line width boxes allow entry of the pixel width for the frame. A value of 0 means use the narrowest line 
possible. 

Shadows 

Picture boxes can have a simulated shadow. The Shadow placement boxes provide the following placement 
choices:  

 

Colors for Frame, Shadow, and Matte 

There is a Color button to select the color for the frame, shadow, and matte. Clicking any of these color 
buttons will open the Select Color Dialog for selection of the color.  

Sizes for Corners, Shadow, and Matte 

The Corner size specifies the size of the corner area of the frame. The corners can have special shapes. A 
larger corner size value will produce larger shapes.  

The Shadow size specifies the width of the drop shadow. 

The Matte size specifies the size of the matte used with picture frames. The matte is the open area between 
the frame and the picture. A value larger than zero is necessary in order to see the matte color. 

Remove Frame Button 

Click this button to completely remove the picture frame. 
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Picture Title and Caption 

Pictures may include a title and a caption. The Picture title box and Picture caption box provide the 
following placement options on their drop-down lists: 

 

Left bottom will be aligned with the left edge of the picture; Right bottom will be aligned with the right edge 
of the picture. The other placements will be horizontally centered. 

Inside top and Inside bottom will produce placements inside the picture frame, on top of the picture itself. 
With these placements no extra space is required to display picture titles and captions. You may need to 
change the font to white or some other light color in order to make it visible in front of a dark picture. 

Picture Font Buttons 

Fonts for picture titles and captions can be set independently with the two font buttons. Clicking a font button 
opens the Select Font Dialog. 

Text Margins 

The Text Margins value controls the space separating the title and caption text from the picture edges. 

Defaults Button 

Click the Defaults button to set options to the defaults for pictures, as set on the Frames Page.  

Selected Button 

Click the Selected button to load options from the currently selected picture. 
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Places Pick Dialog 
The Places Pick Dialog is used to select place records.  

 

ID 

If you know the ID of the place, type it into the ID box. All names associated with that place ID will be shown 
automatically. 

Name 

Type the name of the place in the Name box. You can type a full place name or just the first part. All place 
names that begin with the portion you typed will be displayed automatically. 

Higher Place 

If you want to see a list of all places within a certain place, type the name of the higher place in the Higher 
place box. If you type "Ohio", for example, the names of all local sites, cities, and counties of Ohio that are 
stored in the Places Table will be displayed. This makes it easy to define a filter for a geographic area. 

Search By 

The names displayed in the list box can be one of the following choices: 

 

The All names choice will display all matching names for a place, which means it is possible for several rows 
in the list box to refer to the same place. If you want to avoid this possibility, choose Standard names, which 
will show and match against the standard name only. The Variant names choice will show all the place 
names except the standard names. 

List Box 
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The list box has two columns: Place ID and Name. Double-click on a row to select that place. 

Filter List 

The places displayed in the list box can be filtered according to a number of data values: 

• Place level 
• Local site type 
• Number of links to data 
• Number of links from lower places 
• Number of names 
• Date last changed 
• Place flags 

After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 

The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 

Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 

When the Places Pick dialog is used to filter places on the Places View, click the Set Filter button to turn 
filtering on with the current filter conditions and close the dialog. The place records shown on the Places View 
and reachable with the record movement buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 

When filtering of the Places View has been turned on, click the Clear Filter button to turn off filtering and 
close the dialog. The full set of place records will be shown on the Places View and will be reachable with the 
record movement buttons. 

Preview Check Box 

Click the Preview check box to enable viewing of the preferred media for the selected place, if any. The 
pictures will appear in the blank area above the check box. 



       

Projects Pick Dialog 
The Projects Pick Dialog is used to select project/objective records.  

 

ID 

If you know the ID of the project/objective, type it into the ID box. The record with that ID will be shown 
automatically. 

Name 

Type the name of the project/objective in the Name box. You can type a full name or just the first part. All 
project/objective names that begin with the portion you typed will be displayed automatically. 

Higher Level/Project 

If you want to see a list of all objectives beneath a certain objective or project, type the name of the higher 
objective or project in the Higher level/project box. This makes it easy to filter on a particular section of the 
hierarchy. 

List Box 

The list box has four columns: Project/Objective ID, Status, Name, and Level. Double-click on a row to select 
that record. 

Filter List 

The projects/objectives displayed in the list box can be filtered according to a number of data values: 

• Level 
• Status 
• Date Scheduled 
• Date last changed 
• Number of Research Target links 
• Number of sub-objectives 
• Priority 
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After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 

The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 

Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 

When the Projects Pick dialog is used to filter records on the Projects View, click the Set Filter button to turn 
filtering on with the current filter conditions and close the dialog. The records shown on the Projects View and 
reachable with the record movement buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 

When filtering of the Projects View has been turned on, click the Clear Filter button to turn off filtering and 
close the dialog. The full set of records will be shown on the Projects View and will be reachable with the 
record movement buttons. 



       

Record Properties Dialog 
The Record Properties Dialog appears when Record Properties is selected from the Text Box Popup 
Menu, or from the Edit Menu.  

 

It displays properties of the current data record:  

• Record ID 
• Date last modified 
• Researcher who last modified the record 
• Current data table name and number of records 
• Current database name 

To see record properties for multiple records, click the image of a push pin to "pin" the dialog to the window. 
Then as you move to different data records, the dialog will be updated automatically. 
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Repair/Compact Dialog 
The Repair/Compact Dialog can be used to repair or compact a Genbox database file.  

 

1. On the File menu, click Repair/Compact. The Open File Dialog will appear. The default filename will 
be the current Genbox database. 

2. Browse to the desired Genbox database file (extension .GDB) 
3. Click the filename in the list box or type in the file name. 
4. Click Open. The Repair/Compact Dialog will appear. 
5. Click Check Structure to check the data structure for errors. If no problems are detected, the 

message "Data Structure Verified" will appear. 
6. If errors are detected with Check Structure, a message box will open summarizing the structural 

problems found, and you will be prompted "Please Confirm: Correct these Problems?". Click OK to 
repair the database. The message box "Data Structure Corrected" will appear, with a summary of the 
corrections. 

7. Click Compact to compact the selected database. Compacting makes the file smaller by taking out 
deleted records. 

You can repair/compact another database file by click the Open File button  and browsing for the 
filename, or by typing the desired filename in the Genbox Database box.  
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Report Field Properties Dialog 
The properties of fields selected for a custom report can be specified with the Report Field Properties 
Dialog. When viewing the Content Page of the Report Options View (for custom reports), click on the selected 
field you want to set properties for. Right-click to bring up the popup menu, then click Field Properties. Or, 

click the Field Properties  button. The Report Fields Properties Dialog will open. 

 

Category 

The Category box displays the name of the category of the report field. This box is read-only. 

Field Name 

The Field Name box displays the name of the report field. This box is read-only. 

As Selected 

The As Selected box displays the default label of the report field as it would appear on the report. The default 
label is the same as the Field Name, unless a Multiple Subrecord filter has been selected, in which case the 
label is modified to include the name of the selected filter. 

Label 

The Label box displays the actual label of the report field as it will appear on the report. The label is initially 
the same as the "As Selected" text. In this box, you can type any text that you want for the label. 

Uppercase 

Click the Uppercase check box if you want the data to appear in uppercase. When a field is marked for 
uppercase, the label of the field in the Selected Fields list box will be shown in uppercase to indicate this. 

Note: this does not indicate that the label itself will be in uppercase. If you want an uppercase label name, you 
can type the label name that way in the Label box. 
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Exclude 

Click the Exclude check box if you do not want the data field to appear on the report. You may wish to mark a 
field "Exclude" for temporary test purposes. Or, you may be using the field for filtering or sorting and do not 
wish to see the field on the output. 

Blank 

Click the Blank check box if you want the contents of the field to be used for spacing on the report, but don't 
want any text output. This makes it easier to indent or align columns after an inserted line break. It can also be 
used to add space on a report for data entry blanks or any other spacing purposes. 

Show All, Show One 

For fields that can have multiple values, click the Show One radio button if you wish to include only one value 
on the report. When selected the text "(1)" will appear after the label name in the Selected Fields list box to 
indicate this. 

The default for fields with multiple values is Show All. 

Note: if a field type is also selected, this setting is reinterpreted to mean all values of the selected field type. 

Type 

When checked, the Field Type drop-down list can be used to select the field type. The field types vary with 
each field. 

Filter Box 

The Filter Box can be used to edit the filter match pattern for the report field, if any. 

Push Pin 

To view and set the properties for multiple report fields, click the image of a push pin to "pin" the dialog to the 
window. Then click on each field you want to see properties for. The dialog will be updated automatically. 



       

Research Targets Pick Dialog 
The Research Targets Pick Dialog is used to select Research Target records.  

 

ID 

If you know the ID of the Research Target, type it into the ID box. The Research Target record with that 
Research Target ID will be shown automatically. 

Name 

Type the name of the Research Target into the Name box. You can type a full name or just the first part.  All 
Research Target records with names that begin with the portion you typed will be displayed automatically. 

List Box 

The list box has two columns: Research Target ID and Name. Double-click on a row to select that Research 
Target. 

To sort on a column, click its header. A second click on the same column header will show the reverse sort. A 
triangle will indicate the current sort column and direction of sort; the triangle will point in the direction of 
increasing values. 

Filter List 

The Research Targets displayed in the list box can be filtered according to a number of data values: 

• Main item type 
• Main item ID 
• Sub-item type 
• Sub-item ID 
• Date last changed 
• Number of searches 
• Number of links 

After changing values in the filter group, click the Update button to update the list box. 
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Click the Reset button to clear all filter conditions. 

Select Button 

The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 

Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 

When the Research Targets Pick dialog is used to filter Research Targets on the Research Targets View, 
click the Set Filter button to turn filtering on with the current filter conditions and close the dialog. The 
Research Target records shown on the Research Targets View and reachable with the record movement 
buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 

When filtering of the Research Targets View has been turned on, click the Clear Filter button to turn off 
filtering and close the dialog. The full set of Research Target records will be shown on the Research Targets 
View and will be reachable with the record movement buttons. 



       

Researchers Pick Dialog 
The Researchers Pick Dialog is used to select researcher records.  

 

ID 
If you know the ID of the researcher, type it into the ID box. The researcher record with that researcher ID will 
be shown automatically. 

Name 
Depending on your choice for Search by, type the researcher name, title, author, publisher/subject, or place 
into the text box. You can type a full value or just the first part.  All researcher records with values that begin 
with the portion you typed will be displayed automatically. 

List Box 
The list box has two columns: Researcher ID and Name. Double-click on a row to select that researcher. 

To sort on a column, click its header. A second click on the same column header will show the reverse sort. A 
triangle will indicate the current sort column and direction of sort; the triangle will point in the direction of 
increasing values. 

Select Button 
The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 
Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 
When the Researchers Pick dialog is used to filter researchers on the Researchers View, click the Set Filter 
button to turn filtering on with the current filter conditions and close the dialog. The researcher records shown 
on the Researchers View and reachable with the record movement buttons will be restricted to those 
matching the filter conditions. 

Clear Filter Button 
When filtering of the Researchers View has been turned on, click the Clear Filter button to turn off filtering 
and close the dialog. The full set of researcher records will be shown on the Researchers View and will be 
reachable with the record movement buttons. 

Preview Check Box 
Click the Preview check box to enable viewing of the preferred media for the selected researcher, if any. The 
pictures will appear in the blank area above the check box. 
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Restore from ZIP File Dialog 
The Restore from ZIP File Dialog is used to select a folder for files restored from a backup file (or any ZIP 
file).  

• To open the dialog, begin by clicking Restore on the File menu. The Open File Dialog will appear. 
• Select the backup file, then click Open. The Restore from ZIP File Dialog will appear. 

 

Restore Filename Box 

Type the desired folder in the Restore to box. You can also click on a folder in the list box. 

Files of Type Box 

This dialog normally displays only folders in the list box. Files are not shown. You can use the Files of type 
box to change this behavior. Choices are: 

 

You might want to change it to "Genbox databases" or "All files" if you are concerned that your selected 
destination folder may already contain files that would conflict with the files being restored. 

Overwrite Existing Files 

Normally, when a file being restored has the same name as an existing file in the destination folder, a 
message box will appear, asking if you want to replace the existing file, giving file sizes and last modified 
dates for comparison. You choices on this message box are: 

• Yes 
• Yes to All 
• No 
• No to All 
• Cancel 
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You will get this message box for each file conflict, unless you choose "Yes to All" or "No to All". 

If you want to avoid getting the message box and don't mind if files are overwritten, click the Overwrite 
existing files check box before performing the restore operation. 

Skip Older Files 

Click Skip older files if you don't want to overwrite any files that are newer than files of the same name being 
restored from the backup. When the backup file has an earlier date than the file of the same name in the 
destination folder, it will be skipped. 

Use Folder Names 

A backup file can be saved for full path names. If you want to use the path names stored in the backup file, 
click Use folder names. Otherwise, all files will be restored to the specified destination folder. 

Restore Button 

When you have the restore options set properly, click the Restore button to perform the operation. The 
"Restore Operation Completed" message box will appear when the operation is finished. 



       

Save File Dialog 
The Save File Dialog will appear when a filename is needed for output. Its controls are the same as the Open 
File Dialog. 
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Select Color Dialog 
The Select Color Dialog appears when a Color button is clicked. It allows you to select a color for the 
associated element.  

 

Predefined Colors 

A number of predefined colors appear on the left side. Click a hexagon-shaped region to select its color. A 
white border will appear around the selected color.  

Hue, Saturation, and Luminance 

In the hue, saturation, and luminance color model, hue is the color tint, saturation can be thought of as the 
shade or "amount" of color, and luminance is the brightness.  Each has a range of 0 to 255.  

A hue of 0 is red, 42 is yellow, 85 is green, 170 is blue, 212 is purple. 255 is back to red again.   

At the maximum saturation of 255, colors are the most vivid. As saturation approaches 0, the color appears 
more and more washed out. At 0, the color is a shade of gray.  

Luminance varies from 0 to 255. Colors appear with medium brightness at 128. As luminance moves toward 
255, the color moves to white. As luminance moves toward 0, the color moves to black.  

You can directly set the values for hue, saturation, and luminance by typing values into the corresponding text 
boxes, or using the up-down buttons.  

Red, Green, and Blue 

In the red, green, blue color model, the three primary components are set independently. Each has a range 
of 0 to 255. The values can be thought of as the "amount" of color being added. Colors are notated in (red, 
green, blue) order. Maximum red would be (255 0 0). Green is (0 255 0). Black is (0 0 0) and White is (255 
255 255). 

You can directly set the values for red, green, and blue by typing values into the corresponding text boxes, or 
using the up-down buttons.  

Hue-Saturation Square 
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The Hue-Saturation square displays a range of continuous colors. The horizontal dimension is hue, ranging 
from 0 at the left edge to 255 at the right edge. The vertical dimension is saturation, ranging from 255 at the 
top edge to 0 at the bottom edge. The luminance is constant across the square, and is controlled by the 
setting of the Luminance Selector. 

You can pick a color from the square by clicking at the desired color spot.  

Luminance Selector 

The Luminance Selector appears to the right of the Hue-Saturation square. It displays a range of 
luminance, from 255 at the top to 0 at the bottom. A "thumb" marks the current selection.  

To change the luminance, drag the thumb up or down. When you stop dragging, the Hue-Saturation square 
will be redrawn with the new luminance value. A value in the middle will produce the most vivid colors.  

New and Current Colors 

The New color box displays the newly selected color. The Current color box displays the color that is 
currently set for the associated element, which is the default for the New color when the dialog is first opened. 
By comparing the two colors side by side, you can determine how the new color compares to the old. 

If your display is in 256-color mode, the New color box will divided into two halves: the selected color will be 
shown on the right half, and it may be dithered between two or more colors in order to best represent the 
selected color. The left half of the New color box will display the nearest solid color from the 256 colors 
available. Dithered colors appear to have a grain or texture to their appearance.  

• To use the displayed dithered color, simply click OK to close the dialog. 
• To use the displayed solid color, click on the left half of the New color box. The solid color will replace 

the dithered color. 
• To reset the New color to be the same as the Current color, click the Current color box. 



       

Select Font Dialog 
The Select Font Dialog allows you to set font characteristics for a specific element. 

 

Case 
When enabled, you can control the case of the text shown in the font. Choices are:  

• Normal case 
• All uppercase 
• All lowercase 
• Surname uppercase 

Select Font for Multiple Group 
When there are several font buttons on a view window page, it is possible to set font characters for several of 
them at one time.  

1. To set font characteristics for several fonts at once, press and hold the SHIFT key. 
2. Click each font button you want to affect. A selection rectangle will appear on the button face. 
3. Release the SHIFT key, then click any of the selected buttons to open the Font Dialog. 
4. Changes you make will affect all font buttons in your selected group. 

Setting font characteristics for a font group differs from a single font in some respects: 

• The dialog will initially show a value for only the font characteristics all of the fonts have in common. 
Otherwise, the value for a font characteristic will be blank. 

• Blank settings that are not given a value will have no effect when the dialog is closed. 

This makes it possible to change only the Font family for a group of fonts, without affecting the font sizes and 
styles, which can all be different. Or, the font sizes for all fonts on a page can be set to the same value, 
without affecting the font families and styles. 
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Shared Contact Pick Dialog 
The Shared Contact Pick Dialog is used to pick shared contact records. 

 

ID 
If you know the ID of the Contact record, type it into the ID box. The record with that Contact ID will be shown 
automatically. 

Search By 
You can search by Shared name or Address. 

Text Box 
Depending on your choice for Search by, type the shared name or address into the text box. You can type a 
full value or just the first part.  All records with values that begin with the portion you typed will be displayed 
automatically. 

List Box 
The list box has three columns: Contact ID, Shared Name, and Address. Double-click on a row to select that 
contact. 

Filter List 
The contact records displayed in the list box can be filtered according to a number of data values: 

• Place of address 
• Number of links to data 

After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 
The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 
Click Select all when you want to select all of the names shown in the list. 
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Sources Pick Dialog 
The Sources Pick Dialog is used to select source records.  

 

ID 

If you know the ID of the source, type it into the ID box. The source record with that source ID will be shown 
automatically. 

Search By 

You can search for sources by values in the following data fields: 

 

The third column in the list box will change to reflect your selection. 

Text Box 

Depending on your choice for Search by, type the source name, title, author, publisher/subject, or place into 
the text box. You can type a full value or just the first part.  All source records with values that begin with the 
portion you typed will be displayed automatically. 

List Box 

The list box has three columns: Source ID, Type, and a third column that is dependent on your choices for 
Search by. Double-click on a row to select that source. 
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To sort on a column, click its header. A second click on the same column header will show the reverse sort. A 
triangle will indicate the current sort column and direction of sort; the triangle will point in the direction of 
increasing values. 

Filter List 

The sources displayed in the list box can be filtered according to a number of data values: 

• Source level 
• Source type 
• Repository 
• Publication date 
• Number of links 
• Date last changed 
• Recent flag 

After changing values in the filter group, click the Update button to update the list box. 

Click the Reset button to clear all filter conditions. 

Select Button 

The Select button is enabled when one of the names in the list is highlighted. Click this button to select the 
highlighted record and close the dialog. 

Select All Button 

Click Select all when you want to select all of the names shown in the list. 

Set Filter Button 

When the Sources Pick dialog is used to filter sources on the Sources View, click the Set Filter button to turn 
filtering on with the current filter conditions and close the dialog. The source records shown on the Sources 
View and reachable with the record movement buttons will be restricted to those matching the filter conditions. 

Clear Filter Button 

When filtering of the Sources View has been turned on, click the Clear Filter button to turn off filtering and 
close the dialog. The full set of source records will be shown on the Sources View and will be reachable with 
the record movement buttons. 

Preview Check Box 

Click the Preview check box to enable viewing of the preferred media for the selected source, if any. The 
pictures will appear in the blank area above the check box. 



       

Main Menu Bar 
The Main menu bar extends across the top of the Genbox main window.  

 

When a database is open, the menus available are named File, Edit, Data, Select, View, Charts, Reports, 
Tools, Window, Help. If a Web Page report is being viewed, an additional menu named Favorites will be 
available. When no database is open, the menus available are limited to File, Edit, View, Tools, Window, and 
Help.  

            File Menu 
            Edit Menu 
            Data Menu 
            Select Menu
            View Menu 
            Charts Menu 
            Reports Menu 
            Tools Menu 
            Window Menu 
            Help Menu 
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File Menu 
The File menu provides access to file management and printing functions.  

 

New Database    

On the File menu, click New Database to create a new Genbox database. The Open File Dialog will appear 
and prompt you to supply a name for the database. The default extension is .GDB. The Individuals View will 
then be opened with a blank record, ready for data entry. 

New Genbox databases are initialized with basic data in the following tables:  

• Event Types 
• Source Types 
• Identifier Types 
• Individual, Place, and Media Flag Names 
• Places 

If you have an existing database that you have customized the event types, source types, identifier types, or 
flag names and you want to carry these changes into your new database, you should do a GEDCOM export of 
the desired data types from your existing database, then a GEDCOM import into the new database. See the 
chapter Sharing Your Data for information on exporting and importing. 

As an alternative, you can base your new database on a file copy of your existing database. Using Windows 
Explorer, make a copy of your existing database and give it a new name. Open this new database, then 
delete the data you do not want.  

Open...    
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Click this menu option or toolbar button to open a Genbox database, a saved Chart or Report file, or other file 
type. More than one database can be open at one time. When selected, the Open File Dialog will appear. 

Close Database 
This menu option will close the current database, closing all open views for that database as well. Open 
databases will also be closed when the File: Exit menu option is selected to exit the program. 

Save    

Click this menu option or toolbar button to save changes to the current document. 

File Menu: Save As 
Click this menu option to save the current document to a different filename. 

File Menu: Print...    

Click this menu option or toolbar button to open the Print Dialog Window, which allows you to select options 
for printing the current chart or report. 

File Menu: Print Preview 
Click this menu option to open the Print Preview Dialog. 

Print Setup 
Click this menu option to open the Print Setup Dialog. 

Import Data from GEDCOM File 
On the File menu, point to Import Data and then click from GEDCOM File to import data from a GEDCOM 
file.   

The Open File Dialog will appear. Select the GEDCOM file you want to import data from, then click OK. The 
Import File View will appear, allowing you to view information about the file and set import options.  

Import Data from Genbox Database 
On the File menu, point to Import Data and then click from Genbox File to import data from a Genbox 
database. 

The Open File Dialog will appear. Select the Genbox database you want to import data from, then click OK. 
The Import File View will appear, allowing you to view information about the file and set import options.  

Export Data to GEDCOM File 
On the File menu, point to Export Data and then click to GEDCOM File to save a copy of a portion of the 
data from the current Genbox database to a file in GEDCOM format. The Export Options View will open, 
where you can set options for export and then click Make Export File to complete the operation. 

Export Data to Genbox Database 
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On the File menu, point to Export Data and then click to Genbox Database to save a copy of a portion of the 
data from the current Genbox database to a new Genbox database file. The Export Options View will open, 
where you can set options for export and then click Make Export File to complete the operation. 

Backup 
1. To make a backup file, on the File menu, click Backup. The Backup Select Files Dialog will appear.  
2. Select the files you want to back up, then click Add. The Save File Dialog will appear.  
3. Enter a name for your backup file, then click Save. 

File Menu: Restore 
To restore files from a backup file made previously with Backup: 

1. On the File menu, click Restore. The Open File Dialog will appear.  
2. Select the backup file you want to restore, then click Open. The Restore from ZIP File Dialog will 

appear. 
3. Enter the desired destination folder to restore the files to, and other options. 
4. Click Restore. 

The default extension for backup files is .ZIP. 

File Menu: Repair/Compact 
On the File menu, click Repair/Compact to repair or compact a Genbox database. The Repair/Compact 
Dialog will open. The default filename will be the current Genbox database. Click Check Structure to see if 
the database needs repairing. Click Compact to compact the database. 

File Menu: Check Links 
Genbox databases are relational. A relational database contains multiple tables of data records. Data records 
can link to records in the same table or other tables. If Genbox is not exited by clicking Exit on the File menu, 
the data may become corrupted. If you suspect that the links between data records may need repair, click 
Check Links on the File menu.  

A progress dialog will appear, showing the progress of the operation. All links will be checked. If there are any 
problems encountered, you will be prompted whether the problems should be corrected. You will be able to 
review a log file before answering the question that details all the problems that have been detected. Click 
Yes to have all the problems corrected.  

Note: This operation also checks for missing or invalid field code links, including embedded source citation 
references. If you have a database that was created prior to version 3.5, Check Links should be performed to 
initialize this field code tracking feature. 

Refresh Data 
After changes have been made to a Genbox database by external programs, or when the program was 
abnormally terminated, you may need to click Refresh Data on the File menu. This operation will look through 
the tables for internal consistency and make corrections where needed.  

This operation will also update internal event date estimates, which are used to sort individual events that 
are missing a date or do not have a recognizable date. This ensures that events are displayed in the expected 
order in chart boxes and on reports. 
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Recent Files 
The Recent Files submenu maintains a list of the 10 most recent (non-database) files accessed in Genbox. 
These files are number 1 through 10. You can open one of these files by clicking its name. 

Recent Databases 
The Recent Databases submenu maintains a list of the 10 most recent database files accessed in Genbox. 
These files are number 1 through 10. You can open one of these databases by clicking its name. 

Exit 
On the File menu, click Exit to exit Genbox. Always exit the program this way to ensure the current database 
is closed properly. 



       

Edit Menu 
The Edit menu provides editing functions for the current text box.  

 

Undo  

Click Undo to undo the most recent editing change to the current text box. 

Cut    

Click this menu option or toolbar button to remove the current selection and place it on the clipboard. 

Copy    

Click this menu option or toolbar button to copy the current selection and place it on the clipboard. 

Paste    

Click this menu option or toolbar button to paste the contents of the clipboard to the current location of the text 
cursor. 

Delete   

Click this menu option to delete the current selection. 
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Select All 
For text boxes, click this menu option to select all of the text in the box. For charts, click this menu option to 
select all of the chart boxes. For lists, click this menu option to select all list members. 

Find 
Click the Find toolbar button or menu option to open the Find Dialog, where you can specify match conditions 
to find objects on the chart or report. You can also press CTRL+F for this option. 

Find Again 
Click Find Again to repeat the previous Find Dialog operation. You can also press F3 for this option. 

Jump to [Data Type]   

For data items, click this menu option to jump to the main data record for the data reference displayed.  

For charts, click this menu option to jump to the record on the Individuals View for the individual displayed in 
the selected chart box. The chart will remain open as the Individuals View is brought in front. 

Go To… 
For reports, click this menu option to go to a specified page of the report. A dialog will appear for entry of the 
page number. You can also press CTRL+G for this option.  

Rename 
For the List View, click this menu option to rename the current list. 

Properties 
For a text box, click this menu option to view properties associated with the current data record. When 
selected, the Record Properties Dialog Box will appear. 

For a selected list name on the List View, click this menu option to view properties for the selected list. The 
List Properties Dialog will appear. 

Insert New Object 
This menu option is part of the OLE (Object Linking and Embedding) system. You can use it to embed or link 
to an external document when editing a Genbox chart. This makes the external document part of the chart.  
Then when the object is selected on the chart, you can choose "Activate Object" from the menu to "Open" or 
"Run" the embedded/linked object. Once it has been added to the chart, you can move and size it like any 
other chart box. 
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For example, you could link or embed an important source document from Microsoft Word, so that people 
viewing your chart could also read the source document that the chart information is based upon. Or maybe 
you have related information stored in an Excel spread sheet that you would like the viewer to see. Or 
perhaps you have designed an elaborate title, legend box, fancy box frame, or in-depth sidebar in another text 
processing or graphic program. You can link it into your chart using this menu command. 

Links 
This menu option is part of the OLE (Object Linking and Embedding) system. When selected, a dialog will 
open that displays a list of the linked objects in the active chart, if any. You can use this dialog to update, 
open, change, or remove linked objects in your chart. 
 

 
 

Activate Object 
This menu option is for use by the OLE (Object Linking and Embedding) system. When there is an OLE object 
selected on a Genbox chart, use this option to "Open" or "Run" the embedded/linked object. 



       

Data Menu 

The Data Menu provides access to a number of data record manipulation operations.  

 

Restore 
Click this option to restore changes to the current data record. 

Add Lower Record 
Click this menu option to add a subrecord to the current main record. 

Delete Subrecord 
Click this menu option to delete the current subrecord. 

Make Copy of Record 
Click this menu option to make another record in the current table that is a duplicate of the current record. 
Often it is easier to add new records by starting with a copy of an existing record and making changes, rather 
than by clicking New and starting with a blank record. 

New Record    
Click this menu option or toolbar button to cause the current View Window to create a new main record in the 
corresponding data table. The new record will become the current record. In most views, the new record will 
be blank and the ID box in the header will show as "New".  

The icon on this toolbar button or menu option will change, indicating the type of data record that will be 
created:  

 

The image will contain a yellow "star" at the top left, indicating that a new record of the current type will be 
created with this function. 

Merge Records 
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Click this menu option to merge records. The menu option will change, depending on the current view or 
page.  

• To merge records, first position the view on the record you want to keep (the "target" record). 
• Choose Merge Records from the Data Menu. 
• You will be prompted to select another record. This is the record you want to merge (the "source" 

record) 
• You will be asked to confirm the merge. Click "Yes" to perform the operation. 

The following record types can be merged: 

• Event Templates: Event Types View 
• Individuals: Individuals View 
• Events: Individuals View, Events Page 
• Places: Places View 
• Researchers: Researchers View 
• Sources: Sources View 

When a record is merged into another record, all non-blank values in the target record are usually retained. 
Any links to the source record are transferred to the target record. The source record is then deleted. 

Extract Marked Subrecords 
When you decide that subrecords attributed to one individual actually are a different person, you need to 
move them. After you have marked the subrecords you want to move, click Extract Marked Subrecords on 
the Data menu. A message box will prompt for confirmation, then the selected subrecords will be transferred 
to a new individual. 

Delete Record    
Click this menu option or toolbar button to cause the current View Window to delete the current main record in 
the corresponding data table. You will be prompted to confirm the operation before the deletion takes place.  

The icon on this toolbar button or menu option will change, indicating the type of data record that will be 
deleted: 

 

In all cases, the image will contain a red "X" at the lower right.  

List View Deletions 

If the current view is the List View, with a list in the Tree pane highlighted, clicking this button will cause that 
list to be deleted. 

If the current view is the List View, with one or more records in the List pane highlighted, clicking this button 
will delete the selected records only. 

Delete Selected Records   
When a list name or one or more list records have been selected on the List View, this menu option can be 
used to delete all of selected data records.  

If one of the "Records" lists is selected, such as the Individuals List, the menu item will display as:  

    Delete ALL Individual Records  

If one of the saved individual lists is selected, or if one or more records on the right side of the Lists View is 
selected, the menu item will display as:  
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    Delete Selected Individual Records  

WARNING! This operation permanently removes data from your database. When selected, a confirmation 
window will appear. If confirmed, the referenced data records will be permanently removed.  

Restore Excluded Links    
On the Individuals View, there is a check box on the Parents and Family pages labeled "Exclude link from 
reports". When checked, these records will be skipped when producing charts and reports. This feature allows 
you to selectively include certain relationships when producing output. You may wish to mark several links as 
"Exclude" in order to tailor the output of a chart you are making, for example. Later, you will likely want to clear 
these check boxes so that relationships will again be included.  

Click the Restore Excluded Links menu option to clear all of the "Exclude" check boxes for parent and family 
links, restoring all links. 

Change Preferred Identifiers    
The P column on the Individuals View: Identifiers Page contains check marks next to those identifiers that are 
preferred. Genbox builds a composite name for an individual based on the names that are marked. This 
composite name, or preferred name, is used when a reference is made to an individual from elsewhere in the 
program. 

If you want to clear or mark the preferred checkbox for all identifiers of a particular type, such as "User ID", 
select Change Preferred Identifiers from the Data menu. The Change Preferred Identifiers dialog will 
appear. Select the identifier type you want to change, then click either the Mark All or Clear All button. 

Identify Default Researcher    
When data is entered into a database before a current researcher is identified, it will be assigned as entered 
by "default researcher". After you have created a researcher record for yourself on the Researchers View, 
you can use the Identify Default Researcher menu option to identify the correct researcher for the data 
entered previously. Before selecting this option, open the Researchers View and position the view on the 
correct record. 

Update Empty Language Fields    
A database created prior to version 3.1.4 will not have any values set in the event template records for 
language. You can update each record one at a time to enter the correct language, or you can update all of 
the event template records that have a blank language value at once. To do this update procedure: 

• First, verify that that the current program language (set in Preferences on the Operation page) is the 
desired language. 

• Open the Event Types View. 
• Choose Update Empty Language Fields from the Data menu. When asked to confirm, choose OK. 

This operation should be performed once for existing Genbox databases. 



       

Select Menu 
The Select Menu contains operations to move to particular data records or to mark the current selection. 
Unlike the Data Menu, these operations do not alter the data. 

 

Home Individual    

Click this menu option or toolbar button to move to the designated home individual for the current database. 
The Individuals View will open if not already open.  

If the Individuals View is already displaying the home individual, click this menu option or toolbar button to 
open the Individuals Pick Dialog, where a new home individual can be selected.  

The default home individual is the first individual in the database. 

The shortcut combination CTRL+ALT+HOME can be used to select this option. 

Set Home Individual  
Click this menu option to open the Individuals Pick Dialog, where a new home individual can be designated.  

The default home individual is the first individual in the database. 

First Record    

Click this menu option or toolbar button to cause the current View Window to display the first record in the 
corresponding data table. 

For the Web Page View, click this menu option or toolbar button to view the first generated page. 
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Previous Record    

Click this menu option or toolbar button to cause the current View Window to display the previous record in 
the corresponding data table.  

For the Web Page View, click this menu option or toolbar button to view the previous generated page. 

Next Record    

Click this menu option or toolbar button to cause the current View Window to display the next record in the 
corresponding data table.  

For the Web Page View, click this menu option or toolbar button to view the next generated page. 

Last Record    

Click this menu option or toolbar button to cause the current View Window to display the last record in the 
corresponding data table.  

For the Web Page View, click this menu option or toolbar button to view the last generated page. 

Select Records    

Click this menu option or toolbar button to open the Select Records Dialog for the current view. 

Jump to Data Record   

Click this menu option to jump to the main data record for the current data item. 

Jump to Citations  

Click this menu option to jump to the source citation record for the current data item. 

Jump Back    
Click this menu option or toolbar button to cause the previously displayed view to become the current view 
again. By using the Back and Forward buttons, you can revisit all the records and tables that you have viewed 
in the current session. 

Jump Forward    

After revisiting a previously displayed view by using the Back button, you can select this toolbar button (or 
menu option) to return to the view that used to be the current view. By using the Back and Forward buttons, 
you can revisit all the records and tables that you have viewed in the current session. 

Magnify    

A number of data field types support a Magnify View or Dialog, which shows the current data item in a larger 
window with additional functions. This larger window can be opened by pressing F5 or clicking the Magnify 
menu option. 

The data types that can be magnified are: 
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Notes boxes: Magnify Notes View

Places: Magnify Place Dialog

Event templates: Event Template Preview Dialog

Witness templates: Event Witness Template Preview Dialog

Media: Media Preview Dialog 

Lock Source 
Click this menu option to lock the current source record to the Individuals View. The view will be restricted to 
data linked to the current source, and new data entered will automatically be linked to the current source. 

Mark/Unmark Record 
Click this menu option to mark the current record. Click again to unmark the record. 

Mark Subrecords 
Click this menu option to mark all subrecords of the current main record. 

Unmark Subrecords 
Click this menu option to unmark all subrecords of the current main record. 

Clear All Record Marks 
Click this menu option to clear all record marks in the current table. 

Reset All Marks 
Click this menu option to clear all record marks in all tables. 



       

View Menu 
The View menu is used to control display of the toolbars, main data views, research views, data 
customization views, and preferences. Multiple views can be open at once. Typically, the main toolbar and the 
Individuals View are always open, and the other views are added to the display when needed. 

Views can be closed by clicking on the "x" close box in the top right corner, or by choosing the Close Current 
Window button from the toolbar. 

Note: if all views are closed, the database will also be closed. 

Clicking on one of these menu options will open the indicated view, or simply bring the view to the front if 
already open but partially or fully obscured by other windows. 

Tip: Sometimes it is useful to have two or more views of the same type open at once, as when two different 
records are to be compared side-by-side for a possible merger. To open another view of the same type as the 
current view, click Window:Open Another View. 

 

Toolbar 
Clicking this menu option will toggle the display of the main toolbar. A check appears next to the menu item 
when the toolbar is currently displayed. 

Status Bar 
Clicking this menu option will toggle the display of the status toolbar. A check appears next to the menu item 
when the status toolbar is currently displayed. 

All Other View Menu Options 
Clicking any other menu option displays the View window applicable. See the Table of Contents on where to 
find information on the related View window.  
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Charts Menu 
The Charts menu is used to select the options for chart production. Genbox has default options for each chart 
type. You can define your own options files and add them as submenu options on this menu. See the section 
Charts and Reports Submenus.  

 

Ancestor 
Click this menu option to choose an Ancestor Chart options file from the submenu. The Chart Options View 
will open. You can view and change the options settings. When you are ready, click the Make Chart button to 
produce the chart.  

Descendant 
Click this menu option to choose a Descendant Chart options file from the submenu. The Chart Options View 
will open. You can view and change the options settings. When you are ready, click the Make Chart button to 
produce the chart. 

Related 
Click this menu option to choose a Related Chart options file from the submenu. The Chart Options View will 
open. You can view and change the options settings. When you are ready, click the Make Chart button to 
produce the chart. 

Convergent 
Click this menu option to choose a Convergent Chart options file from the submenu. The Chart Options View 
will open. You can view and change the options settings. When you are ready, click the Make Chart button to 
produce the chart. 

Everyone 
Click this menu option to choose an Everyone Chart options file from the submenu. The Chart Options View 
will open. You can view and change the options settings. When you are ready, click the Make Chart button to 
produce the chart. 

Open File 
Click this menu option to choose a chart options file with the Open File Dialog. Chart options files have the 
extension .GCO. Select a chart options file and click Open. The Chart Options View will appear. You can view 
and change the options settings. When you are ready, click the Make Chart button to produce the chart. 
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Reports Menu 
The Reports menu is used to select the options for report production. Genbox has default options for each 
report type. You can define your own options files and add them as submenu options on this menu. See the 
section Charts and Reports Submenus. 

 

Ancestor Narrative 
Click this menu option to choose an Ancestor Narrative Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Pedigree 
Click this menu option to choose a Pedigree Report options file from the submenu. The Report Options View 
will open. You can view and change the options settings. When you are ready, click the Make Report button 
to produce the report. 

Descendant Narrative 
Click this menu option to choose a Descendant Narrative Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 
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Outline Descendant 
Click this menu option to choose an Outline Descendant Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Family Group 
Click this menu option to choose a Family Group Report options file from the submenu. The Report Options 
View will open. You can view and change the options settings. When you are ready, click the Make Report 
button to produce the report. 

Individual Narrative 
Click this menu option to choose an Individual Narrative Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Calendar 
Click this menu option to choose a Calendar Report options file from the submenu. The Report Options View 
will open. You can view and change the options settings. When you are ready, click the Make Report button 
to produce the report. 

Individuals 
Click this menu option to choose an Individuals Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Places 
Click this menu option to choose a Places Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Events 
Click this menu option to choose an Events Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Citations 
Click this menu option to choose a Citations Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Sources 
Click this menu option to choose a Sources Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Media 
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Click this menu option to choose a Media Custom Report options file from the submenu. The Report Options 
View will open. You can view and change the options settings. When you are ready, click the Make Report 
button to produce the report. 

Researchers 
Click this menu option to choose a Researchers Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Correspondence Log 
Click this menu option to choose a Correspondence Log Custom Report options file from the submenu. The 
Report Options View will open. You can view and change the options settings. When you are ready, click the 
Make Report button to produce the report. 

Research Targets 
Click this menu option to choose a Research Targets Custom Report options file from the submenu. The 
Report Options View will open. You can view and change the options settings. When you are ready, click the 
Make Report button to produce the report. 

Projects 
Click this menu option to choose a Projects Custom Report options file from the submenu. The Report 
Options View will open. You can view and change the options settings. When you are ready, click the Make 
Report button to produce the report. 

Lists 
Click this menu option to choose a Lists Custom Report options file from the submenu. The Report Options 
View will open. You can view and change the options settings. When you are ready, click the Make Report 
button to produce the report. 

Open File 
Click this menu option to choose a report options file with the Open File Dialog. Report options files have the 
extension .GRO. Select a report options file and click Open. The Report Options View will appear. You can 
view and change the options settings. When you are ready, click the Make Report button to produce the 
report. 



       

Tools Menu 
The Tools Menu provides access to a number of useful utilities. 
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Spell Checker 
The Spell Checker Tool can be used to check and correct the spelling of the words in any notes box. Words 
are checked against a main dictionary and a user dictionary. A number of options allow you to control the 
operation of the tool. 

 

The Spell Checker Tool can be activated from a Notes box by pressing F7 or by selecting "Spell Checker" 
from the Tools Menu. It is also available as a function button on the Magnify Notes View. 

General Options 
Main Dictionary 
User Dictionary 
Common Misspellings

When opened, the spell checker tool will stop on the first misspelled word. The sentence in which the word 
appears will appear in the top box. The misspelled word will be shown in red and bolded. Suggested correct 
spellings appear in the bottom box. The first suggestion will be highlighted by default. 

Before the tool will continue to the next misspelled word, one of the following options must be selected.  

Ignore 

Click Ignore to skip the current word, leaving it unchanged.  

Ignore All 

Click Ignore All to skip the current word and all future occurrences of this same word, during the current 
spelling session. 

Add 

Click Add to insert the current word into the User Dictionary. Words in the User Dictionary are considered 
correct, so future occurrences of the same word will not be flagged as an error for the current spelling session 
and future spelling sessions. 

Change 

Click Change to replace the current word with the selected Suggestion. If the word you want to change to is in 
the suggestion list but is not currently selected, click on it first so that it is highlighted. 
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Change All 

Click Change All when you want to perform Change on the current word and all future occurrences of the 
word during the current spelling session. 

Cancel 

Click Cancel when you want to close the Spell Checker tool before making any spelling corrections. After 
corrections have been made, the label on this button will change to Close. Closing the spell checker tool will 
preserve the changes that have already been made. 

Note The "Change All" function makes changes in sequence with normal processing. This means that if the 
window is closed before the entire text has been searched for misspelled words, not all occurrences of a 
"Change All" word may have been changed.  

Editing the Text Directly 

Instead of choosing one of the automatic options, you can click in the displayed text and correct the 
misspelled text manually. When finished, press the TAB key to continue the search for the next misspelled 
word. 

Spell Checker General Options 
 

 
Ignore capitalized words 

When checked, all words beginning with a capital letter will be skipped. 

Ignore words in UPPERCASE 

When checked, all words appearing entirely in uppercase will be skipped. 

Ignore words with numbers 
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When checked, all words containing the digits 0-9 will be skipped. 

Ignore Internet and file paths 

When checked, words containing one or more of "/ \ : @" (slashes, backslashes, colons, or ampersands) will 
be skipped. 

Ignore place names 

When checked, capitalized words that are place names in the current database will be skipped. 

Ignore individual names 

When checked, capitalized words that are individual names in the current database will be skipped. 

Language 

Use this selector to choose the language of the dictionary files: 

 

Your installation may have additional languages available. 

Main dictionary, User dictionary, Common misspellings file 

Enter the paths to the main dictionary file, user dictionary file, and common misspellings file in these boxes. 
Click on the "..." button for the File Open Dialog. The default path for all is the same directory in which Genbox 
was installed. The default extension is "gdt" for Genbox dictionary files, and "gcm" for Genbox common 
misspellings files.  

Default file names are: 

 English (US) English (UK) 
Main dictionary file: MainENU.gdt MainENG.gdt 
User dictionary file: UserENU.gdt UserENG.gdt 
Common misspellings file: CommonENU.gcm CommonENG.gcm 

A user dictionary is optional. If a file with the entered name does not exist, a new user dictionary file will be 
created. 

The main dictionary can be viewed on the Main Dictionary page. The user dictionary can be viewed on the 
User Dictionary page.  The common misspellings file can be viewed on the Common Misspellings page. 
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Spell Checker Main Dictionary 
 

 
The Main Dictionary page lists words contained in the main dictionary file.  

Add Word List 

Words can be added to the main dictionary by clicking Add Word List and entering the name of a text file that 
contains a list of the new words. The file should have just one word per line. When the file contains 
abbreviations, such as "Mr.", be sure that they are each followed by an ending period. This informs the system 
that the word is actually an abbreviation, allowing it to mark abbreviations missing the ending period as a 
spelling error. 

Words can also be added to the main dictionary by transfer from the user dictionary, by using the Merge with 
Main Dictionary button on the User Dictionary page. 

Subtract Word List 

Words can be removed from the main dictionary by clicking Subtract Word List and entering the name of a 
text file that contains a list of the words to be removed. The file should have just one word per line. 

Deleting Single Words 

• To delete a single word from the main dictionary, click on the line containing the word, then press 
DEL. 

Delete All 

To delete all words in the main dictionary, click Delete All. You may wish to do this prior to adding a new word 
list. 

Export to File 
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The current list of words in the main dictionary can be saved to a text file by clicking Export to File and 
entering the name of the file. 

Spell Checker User Dictionary 
 

 
The User Dictionary page lists words contained in the user dictionary file. Words are automatically added to 
the user dictionary when the "Add" button is used while spell-checking. 

Add Word List 

Words can be added to the user dictionary by clicking Add Word List and entering the name of a text file that 
contains a list of the new words. The file should have just one word per line. When the file contains 
abbreviations, such as "Mr.", be sure that they are each followed by an ending period. This informs the system 
that the word is actually an abbreviation, allowing it to mark abbreviations missing the ending period as a 
spelling error. 

Subtract Word List 

Words can be removed from the user dictionary by clicking Subtract Word List and entering the name of a 
text file that contains a list of the words to be removed. The file should have just one word per line. 

Deleting Single Words 

• To delete a single word from the user dictionary, click on the line containing the word, then press 
DEL. 

Delete All 

To delete all words in the user dictionary, click Delete All. You may wish to do this prior to adding a new word 
list. 

Export to File 
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The current list of words in the user dictionary can be saved to a text file by clicking Export to File and 
entering the name of the file. 

Merge With Main Dictionary 

Click this button to transfer the entire contents of the User Dictionary to the Main Dictionary. The User 
Dictionary will then be emptied. 

Spell Checker Common Misspellings 
Use this page to enter common misspellings and their corrections. This helps the spell checker make better 
suggestions; words found on this list will have their corrections shown higher in the list of suggestions. 

 

Adding a Common Misspelling Entry 
• To add an entry, type the incorrect spelling and correct spelling in the boxes at the top of the page. 

Editing a Common Misspelling Entry 
• To edit an entry, first click on the line containing the entry, then edit the incorrect spelling and correct 

spelling in the boxes at the top of the page. 

Removing a Common Misspelling Entry 
• To remove an entry, click on the line containing the entry, then press DEL. 
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Character Map 
Click this menu option to open the system Character Map Tool. With this tool, you can easily select 
characters that are not available from the keyboard and insert them at the current text position. 
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Date Converter 
The Date Converter Tool is selected from the Tools menu. This tool converts dates between five calendar 
systems: Gregorian, Julian, Hebrew, Islamic, and Republican. Genbox uses the modern Gregorian calendar 
for its date storage. If you have a source document that uses dates in one of the other calendars, you can use 
this tool to find the equivalent date in the Gregorian calendar. Genbox will also automatically convert Hebrew 
and Republican calendar dates entered into an event date box when they can be identified by the month 
name. 

 

• To use the Date Converter Tool, enter the date that you want to convert into the appropriate 
calendar system boxes. 

• The corresponding dates in the other calendar systems will be shown automatically once the year is 
entered. 

• Negative year values indicate BC dates. 
• The up-down spinners can be used to increment or decrement the corresponding numeric value. 

Converting Julian (Old Style) Dates 
The Julian dates shown are for the proleptic Julian calendar, using the modern system for year numbering 
and using January 1 as the first day of the year. If your source document is marked with a double date as in 
"11 Feb 1731/32", this indicates the recorder was using March 25 as the first day of the year, and you will 
need to add "1" to the resulting Gregorian year value shown: 

• To convert a Julian (Old Style) date to Gregorian, enter the day, month, and year into the Julian 
date text boxes. 

• The equivalent Gregorian date will automatically be computed and displayed. 
• If the Julian date contains a double year value separated by a slash, enter the first year value only, 

then add one to the resulting Gregorian year shown. 

For the Julian double date "11 Feb 1731/32", you would enter "11", "Feb", and "1731" into the Julian text 
boxes. The resulting Gregorian date shown will be "22 Feb 1731", but you need to add one to the year, so the 
final result is "22 Feb 1732". The reason you need to add one is because the date falls before March 25 in a 
country/region that was using March 25 as the first day of the year, so the equivalent year on the Gregorian 
will actually be one more than the value shown. For Julian dates on or after March 25, you do not need to add 
one to the resulting Gregorian year. Some countries started using January 1 as the first day of the year long 
before they switched to the Gregorian calendar; in those countries, the Julian conversion to Gregorian is 
correct as it is generated, for all months of the year. For more information on Julian dates, see the section on 
Calendar Systems. 

Note You may ask, why is it important to enter the first year of a double date, and add one to the resulting 
Gregorian year, rather than just entering the second year of a double date? While this method will nearly 
always work, it will fail on Julian leap days, because they are based on the first year in the pair. Otherwise, 
this shortcut can be used.  
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Date Calculator 
The Date Calculator Tool is selected from the Tools menu. This tool is used to calculate the difference 
between two dates, or to calculate the date that is a certain interval after or before a given date.  

 

1. To calculate the difference between two dates, enter the earlier date in the First date field. 
2. Enter the later date in the Second date field. 
3. Click the Calculate button. The difference in years, months, and days will be shown. 

1. To add an interval to a date, enter the starting date in the First date field. 
2. Enter the years, months, and/or days to add. The resulting date will immediately be shown in the 

Second date field. 

Other useful notes about the Date Calculator: 

• Negative interval values can be entered by using the "down" spinner button on each interval control. 
• You can specify the interval as just a number of days; adding "1000 days" to a date will work. 
• The tool remembers which two of the three entry sections (First date, interval controls, Second date) 

you most recently changed; the calculation will always be for the remaining section. 
• All dates will be for the Proleptic Gregorian calendar. 
• You can type "today" for a date field to load it with the current date. 
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Relationship Calculator 
The Relationship Calculator Tool is selected from the Tools Menu. It is used to calculate the relationships, if 
any, between two individuals. Each relationship is listed on a new line in the Relationships list box.  

 

The Linkage box displays a lengthier description of the currently selected relationship. It includes the 
common ancestors of the two individuals.  

To calculate the relationships between two individuals:  

• Enter the names of the two individuals into the First person and Second person boxes. 
• The relationship will be shown automatically. 

Blood Relationships Only 
Normally, Genbox calculates both blood relationships and marital relationships. Click the Blood relationships 
only check box if you don't want the calculation to consider marriage links. 

Swap Names 
Clicking the Swap Names button will reverse the First person and Second person names, allowing you to 
see the relationship from the context of the second individual. 

Lock Person 
The Relationship Calculator can be left open while other views are used. When the current focus changes on 
the Individuals View or on a Chart View, the new focus individual will automatically be entered as the 
"unlocked" individual on the Relationship Calculator, and the relationships will be calculated automatically. 
This feature allows you to move through the database or the boxes on a chart, and see how other individuals 
are related to your locked individual. 

You can control whether the relationships are shown from the viewpoint of your locked individual or from the 
viewpoint of the other individual. Suppose you want to see how everyone in the database is related to "Mary 
Jones". If you enter Mary Jones as the First person, and set Lock person to 1, then you will see results like 
"Mary Jones is the daughter of X", "Mary Jones is the aunt of Y", "Mary Jones is the mother of Z". If instead 
you enter Mary Jones as the Second person, and set Lock person to 2, then you will see results like "X is 
the mother of Mary Jones", "Y is the niece of Mary Jones", "Z is the child of Mary Jones". 
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Soundex Calculator 
The Soundex Calculator Tool is selected from the Tools Menu. It allows you to compute the phonetic 
spellings of an entered name.  

 

• To use the Soundex Calculator Tool, enter the name you want to process into the text box. 
• The Soundex code and the Genbox phonetic code will be shown automatically. 

The Soundex code is used in some document indexing systems. Knowing the Soundex code for a surname 
may be helpful in locating documents. 

The Genbox phonetic code is used internally to enhance name searching capabilities. It provides a better 
phonetic equivalency than the Soundex code for most names. You may wish to use this coding with your own 
document filing system. 
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Problems Spotter 
The Problems Spotter Tool is selected from the Tools Menu. It helps you locate possible irregularities in your 
data, which you may wish to investigate and correct. The results of this tool are saved to a list which you can 
view on the List View. 

 

Improbable Event Sequence 

When Improbable event sequence is checked, individual that have living events after death or events before 
birth will be marked. 

Marriage When Younger Than [13] 

Individuals who have a marriage event when their age was younger than the specified value will be marked. 

Childbirth When Younger Than [13] or Older Than [50] 

Individuals who gave birth to a child when their age was younger or older than the specified values will be 
marked. 

Death After Age [100] or Burial [30] Days or More After Death 

Individuals who have a death event at an age greater than the specified value, or a burial event that is more 
than the specified number of dates after a death event, will be marked. 

More than [10] Children 

Individuals who are linked to more than the specified number of children will be marked. 

More than [5] Marriages 

Individuals who have more than the indicated number of marriages will be marked. 

Generate List Button 

When the Generate list button is clicked, the database will be processed, looking for data that could be a 
problem, according to the entered values. When a potential problem is found, it will be added to the Potential 
Problems list. Once processing is complete, the List View will be opened to display the results. Each entry on 
the List View will be shown on two rows:  
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• The first row will give the ID and name of the individual record with the problem. 
• The second row will describe the nature of the problem. 

Dividing lines will be shown between problem entries. 

Clear Button 

Click the Clear button to set all the parameter values to blank. Controls with a blank value will not be 
processed. 

Defaults Button 

Click the Defaults button to restore all the parameter values to their default values.  

Skip Problems Check Flag 

When the individual flag named "Skip Problems Check" (tag XPRB) has been marked for an individual, the 
Problems Spotter will not check the individual for problems. This flag can be set for individuals who were 
previously identified as having a problem but you have confirmed there is none.  



       

Match Finder 
The Match Finder Tool is selected from the Tools menu. It is used to find pairs (or larger groups) of individual 
records that potentially represent the same person. The results will be saved to the Possible Duplicates list. 
You can then compare the individual records in each group on this list, and make your own determination as 
to which are the same individual, and then merge their records together. 

 

A number of match criteria may be specified to control the operation of the tool. 

Key Individual or All 

To find potential matches to a single individual, click the Key individual radio button and enter the name in 
the box. To find matches to all individuals in the database, click All. 

Surnames and Given Names 

Match conditions for Surnames and Given names can be set independently. Choices are: 

 

For Same first letters, enter the number of matching initial letters required in the adjacent box. 

Birth Dates and Death Dates 

Match conditions for Birth dates and Death dates can be set independently. Choices are: 

 

For the Within years and Within days choices, enter the required number in the adjacent box. 

Parents 

Choices for matching Parents are: 
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Children 

Choices for matching Children are: 

 

Birth Places and Burial Places 

Match conditions for Birth places and Burial places can be set independently. Choices are: 

 

Disqualify Pairs 

Certain close relationships or data mismatches can be set to exclude possible matches: 

• Parent and child 
• Siblings 
• Male and female 

Treat a Blank Value as a Matching Value 

When checked, missing data will be considered a good match to anything. Otherwise, missing data will cause 
the exclusion of potential matches. 

Match When Ancestral File Numbers Match 

When checked, a matching Ancestral File Number (AFN) will automatically generate a candidate pair, 
disregarding other match criteria. 

Match When User ID Numbers Match 

When checked, individual records with matching User ID values will be considered a match, disregarding 
other match criteria. 

Generate List Button 

When the Generate list button is clicked, the database will be processed, looking for individual match 
candidates, according to the entered values. When a potential match is found, it will be added to the Possible 
Duplicates list. Once processing is complete, the List View will be opened to display the results. Each entry 
on the List View will be shown on two or more multiple rows:  

• The first row will give the ID and name of the first individual. 
• The second row will the ID and name of the second individual. 
• There can be more than two individuals in a group that match; if so, there will be additional lines for 

matching individuals. 

Dividing lines will be shown between match candidate groups. 
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Clear Fields Button 

Click the Clear Fields button to set all the parameter values to blank. Controls with a blank value will not be 
processed. 

Defaults Button 

Click the Defaults button to restore all the parameter values to their default values. 
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Search View 
You can find individual records with a number of methods: you can type in the ID or name into the key fields 
on the header section of the Individuals View; you can use the record movement buttons on the toolbar; you 
can use the Individuals Pick Dialog. For a more sophisticated method, you can use the Search View. The 
Search View provides several pages of options for search criteria:  

            Identifiers Page 
            Attributes Page 
            Events Page 
            Contact Page 
            Media Page 
            Notes Page 
            Match Page 
            Properties Page  

Selecting Match Individuals 

The first six pages allow you to set match criteria for each of four match individuals. Each page has a 
section at the top containing four buttons.   

• To Select a match individual, click the corresponding button (1-4). The options displayed at the bottom 
are those for the currently selected match individual. 

Buttons 

There is a row of buttons at the bottom of the view.  

• Click Search when you are ready to perform the query. The results will be saved to the Query 
Results list, which is visible on the List View. The List View will be opened automatically to display the 
results. 

• Click Save to save the query definition to a file. You can later reload this file to re-run the query. 
• Click Reload to set all options back to what they were when the view first opened. 
• Click Clear All to set all query conditions to blank. 



       

Search View: Identifiers Page 
The Identifiers page presents match criteria for identifiers. 

 

Identifier Boxes 

There are two Identifier boxes provided. You can use these to enter one or two names or numeric 
identifiers. If match conditions for two identifiers are entered, a successful match must satisfy both 
conditions.  

You can enter a partial given name, surname, or full name; wildcards will be added automatically. A search on 
"Pete", for example, would match "Pete Smith", "Peter David Jones", and "Samuel Michael Peterson". A 
search on "P J" would match "Peter David Jones" and "Pamela Eugene Johnson".  

You can use a forward slash character ("/") to mark the start of the surname portion of your match string. If no 
slash character is used to mark the surname portion, the match string is compared to both the full name and 
the given name of each record in the database. For the full name comparison, the last word of the match 
string will be considered the surname.  

If you want to search on surnames beginning with "John" but don't want any matches to the given name 
"John", precede the portion that must match a surname with a slash character: "/John".  

If you are searching on a given name, such as "John", but don't want to see any surname matches, such as 
"Johnson", Put a slash after your match pattern: "John /".  

A wildcard is added after each "word" in the match string automatically. When you enter "M C Smith", Genbox 
adds wildcards so that it looks like "M* C* Smith*". If you want to search on exactly what you enter without the 
default wildcards, enclose your search string in double quotes: "M C /Smith/". This would match only "M C 
Smith", it won't return "Michael Craig Smith" or "Mary Christine Smithers".   

Note: surnames are stored delimited with forward slash characters; when searching on exact names, you will 
need to include them in your search string.  

Identifier Type Selectors 
There are two Identifier Type Selectors, one for each Identifier box. For example: 
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Normally, you would leave the type selectors on their default value of Any. If a specific type is selected, the 
identifiers will be considered a match only when the type matches as well. 

Father, Mother, Spouse, and Child Match Individuals 
Queries can specify conditions for up to four match individuals. The Father, Mother, Spouse, and Child 
boxes each allow you to define a link to another match individual (1-4). 

For example: Suppose you are looking for (1) someone named "Robert" who had (2) a father also named 
"Robert" and (3) a mother named "Susan", and (4) was married to someone named "Hannah". You would set 
criteria for four match individuals, each specifying a given name match. Then, for match individual 1, you 
would set the Father box to Individual 2, the Mother box to Individual 3, and the Spouse box to Individual 4. 
(You wouldn't set these boxes for other match individuals). 

Totals 
The Total Number boxes for Father, Mother, Spouse, Child, and Names allow you to specify how many 
links of the indicated type the match individual has. 

Individual ID 
The Individual ID box can be used to search for a particular individual ID. This criteria is generally most 
useful with comparison operators. For example, enter "> 500" to return all individuals with ID numbers greater 
than 500. 

Any Text 
You can search for text in any individual text field by typing it into the Any text box. 

Clear Button 
Click the Clear button to set all match criteria on this page to blank. 
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Search View: Attributes Page 
The Attributes page presents match criteria for individual attributes.  

 

Attribute Type 
Select the Attribute type from the drop-down list. Choices will be taken from the defined attributes in the 
database. For example: 

 

Attribute Value 
Type the Attribute value into this box. You can type just the first part of it.  

Sex 
Choices for sex: 

 

Years Since Birth 
Years since birth is the number of years since the earliest birth date stored for an individual.  

Total Flags 
Enter the Total number of flags in this box.  

Flags 
You can select individual flags as match criteria by clicking on their check boxes. 
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Search View: Events Page 
The Events page presents match criteria for events. Birth and event dates, total events, and detailed 
information about one event can be specified.  

 

Birth Date and Death Date 
Enter the Birth date and/or Death date in these boxes. You can specify a full date, a single year, a range of 
years, or a range of dates. If only a year is entered, all dates occurring during the indicated year will be 
considered matches. If only a month and year are entered, all days of that month will be considered matches.  

Total Principal Events 
Enter the total number of event records where the individual was a principal (primary, spouse, other/child) 
required for a match.  

Total Witnessed Events 
Enter the total number of witnessed event records required for a match. For example, enter "> 0" to find all 
individuals that are listed as witnesses.  

Event Type 
The remaining fields on the page all work together to define a single event record. The Event type is the type 
for this event record.  

Principal 
The Principal Selector has the following choices:  

 

When any is selected (the default), any principal linked to the event will be considered for a match. This 
means if the event is a "Birth" event, the match could return up to the three people: the child, father, and 
mother. If you want the match to return just the child, set the Principal Selector to "Other/child". 

"Parent" means "Primary or Spouse".  
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Date 

Enter a date for the event. You can specify a full date, a single year, a range of years, or a range of dates.   

Age 

Enter an age for the primary individual at the time of the event.  

Place 

Enter a place for the event.  

Text 

Enter the extra text for the event.  

Secondary Link 

You can specify that another match individual should also be linked to this event record. There are two 
selectors that work together for this feature. The first selector provides these choices: 

  

The second selector provides a choice of match individual (1-4): 

 

Total Witnesses 

Enter the total number of witnesses for the event. For example, enter "> 0" to find all individuals that were 
principals in events that had witnesses. 
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Search View: Contact Page 
The Contact page presents match criteria for contact information. The fields are the same as those on the 
Individuals View: Contact page.  

 

 

Copyright © 2005  Thoughtful Creations. All rights reserved. 468



       

Search View: Media Page 
The Media page presents match criteria for linked multimedia.  

 

Media for Data Type 

You can limit the media matching to media linked to a particular type of data. Choices are:  

 

Total Media Links 

Enter the total number of media links required.  

Reference Name 

Enter the Reference name for the media.  

Filename 

Enter the Filename for the media.  

Media Type 

Select the Media type required: 

 

Format 

Enter the Media format required.  
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Modified 

Enter a date specification for the last modified date.  

Quality 

Select a quality value (Poor, Fair, Good, Excellent): 
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Search View: Notes Page 
The Notes page presents match criteria for general and research notes, and source citations.  

 

Note for Data Type 

You can limit the note matching to notes for a particular data type. Choices are:  

 

Note Type 

The Note type choices are:  

 

Total Notes 

Enter the total number of notes of all types.  

Note Text 

Enter a portion of the text. Wildcards will be added automatically both before and after the portion entered.  

Total Citations 

Enter the total number of source citation links.  
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Source 

Enter the name of the source. This is an auto-completion field; if no source is found matching what you type, 
the field will be set to blank when you move out.  

Where In Source 

Enter a portion of text that should appear in the "Where in Source" field.  

Lead Text 

Enter a portion of text that should appear in the Lead Text.  

Annotation 

Enter a portion of the text that should appear in the Annotation.  

Rationale 

Enter a portion of the text that should appear in the Rationale.  



       

Search View: Match Page 
The Match page controls how the criteria for the four match individuals are combined and used.  

 

Match Conditions 

For Individual 1 through Individual 4, you can set the Match conditions. Choices are:  

 

Setting a match individual to Disable is any easy way to limit the query for test purposes. With some of the 
match individuals disabled, you can run the query and check the results against the criteria for the remaining 
match individuals. 

Relationship List Box 

The Identifiers Page allowed you to specify certain relationships between match individuals, such as Father 
and Spouse. With the Relationship list box, you can specify more complex relationships. The list box has 
four columns: Individual, Verb, Relationship, Individual / List. 

Individual Column 

Specify the first individual in the match relationship in the Individual column.  Choices are Individual 1 - 4. 

Verb Column 

The Verb choices are "Is" and "Is NOT". You can use the "Is NOT" setting to specify when two individuals 
should NOT have a certain relationship. 

 

Relationship Column 

The Relationship column specifies the required relationship between the two match individuals. Choices are: 
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Individual/List Column 

Specify the second individual in the match relationship in the Individual/List column. Choices are: 

 

When the Relationship column specifies "In List", the Individual/List column will display the names of saved 
lists to choose from. You can even select "Query Results" as the list, which makes it possible to base the 
results of a new query on the results of the previous query. 

Returning Results 

While there are four match individuals, the Results can only come from one set of matching individuals. The 
default is Individual 1. Click one of the other radio buttons to change where the output is coming from. This 
option is useful when you are testing a complex query and want to see which individuals are matching in a 
different set. 

Defaults Button  

Click the Defaults button to reset all fields on this page to their default values.  
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Search View: Properties Page 
The Properties page provides data fields to store descriptive information about the query, which is useful for 
queries that will be saved and reloaded later.  

 

Query Name 
Type a name for the query.  

Descriptive Title 
Type a descriptive title for the query.  

Change Date 
The Change date box displays the date and time the query was last modified. This box is read-only.  

Notes Box 
Enter your notes about the query in the Notes box. Queries can be complex and it is often not obvious what 
the intent of the query is. If you take the time to describe why you created the query, what it does, and where 
and when it is used, you will be thankful later.  

View SQL Button 
The options entered on the pages of this view are converted into an SQL statement that is used to perform the 
query. Click the View SQL button to see the SQL command that will be performed when the Search button is 
clicked. If you have some knowledge of SQL, you can often scrutinize the SQL statement to determine why 
something is not working as you thought it would. 

This view is read-only. 
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Open Query Definition 
Click this menu option to open a saved query definition file. The Open File Dialog will open. Saved query 
definitions have a file extension of .GQY. Select a query definition file and click Open. The Search View will 
appear. You can view and change the options settings. When you are ready, click the Search button to 
perform the search. 
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Window Menu 
The Window menu contains options for manipulating the windows in Genbox.  

 

New Window   

Click this menu option to open another window of the same type as the current window. 

Close Window    

Click this menu option or toolbar button to close the current View Window. The next view window in the 
"stacking order" will become active. Selecting this option again will close that window as well. Repeated 
clicking on this option will close all view windows. 

Close All 
Click this menu option to close all open windows and databases. 

Cascade 
Click this menu option to arrange the open windows in a cascade. Each window will overlap the previous one, 
offset slightly to the right and down. 

Tile Horizontally 
Click this menu option to arrange the open windows horizontally. No windows will overlap. 

Tile Vertically 
Click this menu option to arrange the open windows vertically. No windows will overlap. 
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Arrange Icons 
Click this option to arrange the icons of the closed windows on the Genbox work area. 

Save Layout 
When this option is selected, you will be prompted if you want to save the current configuration of windows as 
the standard layout. Genbox uses this saved layout of active views when it opens a database. The default 
layout shows the Individuals View. 

To use this feature, first open the views that you prefer to see each time you open a database. Size and 
position them on the screen as you like. Finally, choose this menu option. 

To restore the default window layout, close all view windows (except the Database View), then choose this 
menu option. 

Next Window   

Click this menu option to move to the next open window. 

Previous Window   

Click this menu option to move to the previous open window. 

Capture Window 
Click this menu option to capture an image of the active view window. The File Open Dialog will appear. You 
can save it in BMP, JPEG, or PNG format. A copy is also placed on the clipboard, where it is available for 
other applications to paste. You can use this function to provide a reference picture when submitting a 
problem report, feature suggestion, or question to customer support. 

Note  You can also use the keyboard shortcut CTRL+F6. 

Reset Partitions 
Click this menu option to reset the splitter bars and list box column widths on the active window pane to their 
default positions. 
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Help Menu 

 
Contents 
Click this menu option to open the Genbox Help Window. The Contents pane will be shown, where you can 
select a help topic. Complete help is available on Genbox. 

 

Reference 
Click this menu option to open the Genbox Help Window, with the Reference section displayed. 

Keyboard Shortcuts 
Click this menu option to open the Genbox Help Window, with the Keyboard Shortcuts section displayed. 

Index 
Click this menu option to open the Genbox Help Window. The Index pane will be shown, where you can type 
in a keyword. 

Genbox Home Page 
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Click this menu option to go online to the home page for Genbox Family History, http://www.genbox.com. A 
connection to the internet must be established first. 

Check for Updates 
Click this menu option to see if a newer version of Genbox Family History is available for download. First, the 
installed version number is displayed. Then, a link is provided to the Genbox download page, 
http://www.genbox.com/download.htm, where you can compare the current version number to see if a newer 
version is available. 

 

If a newer version is available, you can download the new version and follow its installation instructions to 
update your copy of Genbox. 

Note: A connection to the internet must be established before visiting the download page. 

Tip of the Day 
Click this menu option to open the Tip of the Day Dialog. 

 

The Tip of the Day Dialog is part of the Genbox Help System. Helpful tips for using Genbox are presented, 
one at a time. Click the Next Tip button to see another tip. Click the OK button to close the window. 

If you want to see a tip each time Genbox is started, click the Show tips on startup check box. 

Database Information 
Click this menu option to open the Database Information Dialog. It displays status information about the 
current database or another database. 
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The Database Information Dialog presents status information on the current database or another database. 
When first opened, information on the current database is presented:  

• Full path name 
• Total size of the database, in megabytes (Mb) 
• Date and time of last modification (system date format) 
• Number of records in each table 

You can view status information on another database by clicking the Open File button  and selecting it 
from the Open File Dialog. 

System Information 
Click this menu option to open the System Information Dialog. 

 

The System Information Dialog displays detailed information about your computer system, including:  

• Hardware resources (conflicts/sharing, DMA, forced hardware, I/O, IRQs, memory) 
• Components (multimedia, display, ports, storage, printing, problem devices, etc.) 
• Software environment (drivers, OLE registration, software updates) 

The dialog can be selected from the Help Menu, System Info option. It can also be selected by clicking the 
System Info button on the About Genbox Dialog below. 
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About Genbox Family History 
Click this menu option to open the About Genbox Dialog.  

 

The About Genbox dialog displays the program version number, release date, licensed user name, 
registration number, and a number of buttons. 

Click the System Info button to open the System Information Dialog. This is the same as clicking the Help 
Menu: System Information menu option. 

Click the Copyright button to review copyright information and acknowledgements. 

Click the License button to review the Genbox software license.  

How to Register 
Click this menu option to open the How to Register Genbox dialog window. It explains the registration 
process and provides a link to the Genbox registration page. 

Enter Registration Information 
Click this menu option to open the Enter Registration Information dialog window. After you register Genbox, 
enter your registration information here to enable all features of the program. 
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Chart Popup Menu 
The Chart Popup Menu appears when you right-click on a chart displayed on the Chart View.  

 

Hide Leaves 
Sometimes it is helpful in understanding the link structure of a complex chart to be able to "strip away" the 
"leaf" boxes. A leaf box is a box with no descendants, no marriage links, and no attached boxes (attached 
boxes include media boxes, annotations or lines).  

• To hide all the leaf boxes on the chart, choose "Hide Leaves" from the right-click popup menu. 

This operation can be performed repeatedly, each time removing the boxes that became leaves after the 
previous set of removals. 

Hide Side Spouses 
A "Side Spouse" box contains the name of a spouse (husband or wife) of the primary individual, which is in a 
separate box. The spouse box appears to the left or ride side of the primary box, and is linked with a marriage 
connector. Side spouse boxes are common when the Layout option "Single Box for Couples" is set to "No". 

• To hide all the (open) side spouse boxes on the chart, choose "Hide Side Spouses" from the right-
click popup menu.  

When the "Hide Side Spouses" option is selected, spouse boxes with no ancestors/children are removed from 
chart. By repeatedly using this option and the "Hide Leaves" option, it is possible to whittle a chart down to just 
the family link connections. This may help you determine the underlying structure of the chart. 
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Make Frame Snug 
Fan Charts 
A fan chart is initially drawn with space for the full portion of a circle selected-- either 90, 180, or 360 degrees. 
Depending on the actual data selected for output, there may be portions of this reserved area that are blank. 
A more appealing chart can be produced by "closing up" this unused space between the actual chart and the 
frame. To do this, right-click on the fan chart and choose the option Make Frame Snug. 

Rectangular Charts 
For rectangular charts, the chart frame will resize automatically in most cases, whenever an edge box is 
resized, moved, or deleted. You can choose Make Frame Snug from the right-click menu in case the 
automatic resizing does not occur. 

Reorganize Chart 
After a chart has been edited and a number of boxes have been deleted, there will be gaps, or "holes", 
between the remaining boxes. This space can be closed up by reorganizing the chart with just the remaining 
boxes. This operation is not performed automatically after a box deletion, because you may want to preserve 
your custom positioning on other parts of the chart that you have already edited. 

• To reorganize all the boxes on the chart, choose "Reorganize Chart" from the right-click popup 
menu.  

Note: any custom box positioning will be lost by this operation. 

Find Reverse 
Clicking Find Reverse is like clicking Find Again to repeat the previous Find Dialog operation, except the 
direction of the search is reversed. You can use Find Again to move forward 3 times, and then use Find 
Reverse 3 times to return to your starting position. You can also press CTRL+R for this option. 



       

Data List Popup Menu 
The Data List Popup Menu appears when you right-click on a list item on the List View.  

 

Remove Duplicates 
Click this menu option to remove duplicate list members from the current list. 
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Data Tree Popup Menu 
The Data Tree Popup Menu appears when you right-click on a tree item on the List View.  

 

Create New List 
Click this menu option to create a new list. The new list will initially be named "NewList", unless that name is 
already used, in which case the new list will be named "NewList1". It will appear in the Saved Lists section of 
the hierarchy. It will initially have no members. 
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Text Box Popup Menu 
The Text Box Popup Menu appears when you right-click on a text box. Many of these menu options are also 
available on the Edit Menu or the Select Menu.  

 

Mark/Unmark [Data Type] 
Click this menu option to mark or unmark the current data item. Marked items can appear with special font 
styles, such as a different color, bolding, and italics. When clicked, the mark status will be reversed: the data 
will be marked if it was unmarked, otherwise the marking will be cleared. 
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Main Toolbar 

 

The main toolbar is displayed just below the menu bar. It provides easy access to common application 
operations. Many of these functions can also be selected from the menus. 

Rich Text: Bold    

Click this toolbar button to set bold style for the selected text or for newly typed text in a notes box that you 
wish to emphasize. If the selected text is already bold, pressing this toolbar button will remove the style 
instead. The button face will have a pressed appearance when bold style is active, normal when bold style is 
off, and grayed when the selected text is only partly bolded. Bold style can also be toggled on/off with the 
keyboard shortcut CTRL+B. 

This toolbar button can also be used to add or remove the special [BOLD] and [BOLD0] template codes from 
the selected text when editing a source template on the Sources View Formatting Page or Citations View 
Formatting Page.  

Rich Text: Italic    

Click this toolbar button to set italic style for the selected text or for newly typed text in a notes box. If the 
selected text is already in italics, pressing this toolbar button will remove the style instead. The button will 
have a pressed appearance when italic style is active, normal when italic style is off, and grayed when the 
selected text is only partly in italics. Italic style can also be toggled on/off with the keyboard shortcut CTRL+I. 

This toolbar button can also be used to add or remove the special [ITAL] and [ITAL0] template codes from the 
selected text when editing a source template on the Sources View Formatting Page or Citations View 
Formatting Page.  

Rich Text: Underline    

Click this toolbar button to set underline style for the selected text or for newly typed text in a notes box that 
you wish to underline. If the selected text is already underlined, pressing this toolbar button will remove the 
style instead. The button face will have a pressed appearance when underline style is active, normal when 
underline style is off, and grayed when the selected text is only partly underlined. Underline style can also be 
toggled on/off with the keyboard shortcut CTRL+U. 

This toolbar button can also be used to add or remove the special [UNDL] and [UNDL0] template codes from 
the selected text when editing a source template on the Sources View Formatting Page or Citations View 
Formatting Page.  

Rich Text: Toggle Codes    

Click this toolbar button or press the F2 function key to toggle between display of field codes and field values. 
The button face will have a pressed appearance when field values are being shown, and a normal 
appearance when field codes are being shown. 

When displaying field values, the note text will be read-only. 

Rich Text: Insert Field Code    

Click this toolbar button or press the keyboard shortcut CTRL+D to open a dialog where a new field code can 
be inserted. 
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If you are editing a source template, source, or citation record, the Insert Source Field Code Dialog will 
open. 

If you are editing a note in another table, the Insert Field Code Dialog will open. 

If your text cursor is positioned inside an existing field code with the dialog is opened, it will become the 
default value, and any changes will replace the existing field code when the dialog closes. This allows you to 
edit existing field codes. 

The information provided by the dialog also provides a way to remind yourself of what a particular field code 
does. 

Rich Text: Source    

Click this toolbar button whenever you are editing data and you want to add a source citation. This toolbar 
button can be used both for text fields and for notes. When adding source citations to notes, first position the 
text cursor at the text location where the footnote reference should appear, either by clicking with the mouse 
or moving with the arrow keys.  

If there are existing source citations for the current text item, they will be displayed.  

You can also press the F4 key to add source citations. 
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Status Toolbar 

 

The status toolbar appears at the bottom of the Genbox main window.  It contains seven panes of current 
status information about the program.  

The Message pane displays the current status of the program as a text string, shown here as "Ready". 
Helpful information on toolbar buttons and menu options will also be displayed here when they are selected. 

The Current Researcher pane displays the name of the current researcher, if any. Here it is shown as "John 
Smith". You can jump to the record for the current researcher on the Researchers View by clicking on this 
pane. 

The Program Language pane displays a flag icon and language code for the language currently selected for 
the program. Here it is shown as "ENU" for English (United States). Click on this pane to open a menu where 
you can select from all the languages currently installed for the program. 

The Output Language pane displays a flag icon and language code for the language currently selected for 
use on charts and reports. Here it is shown as "DEU" for German (Germany). Click on this pane to open a 
menu where you can select from all the languages that currently have event types defined. 

Status of the Caps Lock (CAP), Num Lock (NUM), and Scroll Lock (SCRL) keys appear on the final three 
panes.  
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Chart/Report Toolbar 

 

The Chart/Report Toolbar appears when a chart or report is the current view.  

 Select Tool 

 Magnify Tool 

 Zoom Size Tool 

 Text Tool 

 Picture Tool 

 Line Tool 

The chart toolbar works independently with each open chart/report window. This means that you can open 
several views of the same chart, and each can have its own zoom size setting. You might want to keep a 
small full-chart "overview" window open, for example, while you do your main editing in a larger, actual-size 
window. (A second view of the current document is opened by clicking "New Window" on the Windows menu.) 

Select Tool    

• To select chart boxes, first click on the Select tool .  
• Click on the box you want to select. A selected box will be shown with handles at the corners and 

sides. 
• You can also drag a selection rectangle around a group of boxes that you want to select. 

Magnify Tool    
When you want to see more of your chart at once, you need to zoom out. If you are interested in seeing more 

detail in a small area, you need to zoom in. To zoom, click the Magnify tool .  

• When the Magnify tool is selected, click the left mouse button anywhere on the chart to zoom in. 
• Click the right mouse button to zoom out. 

The zoom size will increase or decrease by about 20% for each click. The location clicked will be positioned 
as close as possible to the center of the view. 

Zoom Size Tool    

You can use the Zoom size tool  to quickly set the zoom size at preset sizes: 

• Full size 
• Full page 
• Full doc 
• 2400%, 1200%, 800%, 400%, 200%, 160%, 110%, 100%, 90%, 75%, 50%, 25%, 12%, 8%, or 4% 

Full size is the same as 100%. Full page will pick a zoom size just large enough to show a complete page. 
Full doc will pick a zoom size that will allow the entire chart to fit on the screen. 

Text Tool    
Annotations are short lengths of text that can be typed on top of the chart or report. They can be used to draw 
attention to certain data items, or provide explanatory text. 
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• To add an annotation, click the Text Tool . 
• Click the location on the chart or report where you want the annotation to start. 
• Type the text. 
• To end the annotation, click elsewhere to start a new annotation, or click a different tool button. 

Once on a chart or report, an annotation can be selected, sized, and moved. You can also change its font 
properties: 

1. To change the font properties of an annotation, first select it. 

2. Double-click the Text Tool . 
3. The Select Font Dialog will appear, allowing you to select font properties for the annotation and for 

new annotations. 

The default font styles for annotations are bold, italic, and red. 

Picture Tool    
Additional pictures can be added to a chart or report after it has been generated. 

1. To add a picture, click the Picture Tool . 
2. Drag a selection rectangle to specify the size and location for the picture. 
3. The Media Pick Dialog will open. Select the picture you want to include on the chart or report. 

If no picture is selected from the Media Pick Dialog, only a frame will be added to the chart or report. Frame 
properties for empty frames and pictures can be changed: 

• To change the frame properties of a picture, first select it. 

• Double-click the Picture Tool . 
• The Picture Tool Options Dialog will appear. Select the frame properties for the picture and for new 

pictures. 

Line Tool    
Freehand lines can be added to a chart or report after it has been generated. You can draw arrows, circle 
boxes, and draw connecting lines between annotations and boxes. 

1. To add lines, click the Line Tool . 
2. Click the locations where you want the end points of the line segments to be. 
3. To draw curves, hold the mouse button down while moving. 
4. Click the same location twice to end the line figure. 

The endpoints of each line segment in the figure will be shown with handles. You can reposition individual 
endpoints by dragging on the handles. 

The thickness and color of a freehand line can be changed: 

• To change the properties of a freehand line, first select it. 

• Double-click on the Line Tool . 
• The Line Tool Options Dialog will open. Select the new values for line width and color. 
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Data Structure 
Genbox is built on a relational data model, using the Microsoft JET database engine. Text data is stored in 
UNICODE format. 

Key fields 

In most data tables, the record structure begins with a numeric key field named "ID". These ID fields allow 
records in different tables to link to each other. In the Families table, for example, the first field is named "ID" 
and is the numeric identifier for the family represented by the current record. Among the other fields, there is 
one name "Father" and one named "Mother", which are used to link to two different records in the Individuals 
table. This linking is accomplished simply by storing a copy of the ID that identifies those records in the 
Individuals table. These two fields are also known as foreign keys, because they refer to key fields in an 
external table. 

Linked Tables 

There are more than 40 different tables in a Genbox database. Each table stores a different type of data, with 
its own record structure. For each individual, there is one main data record in the Individuals table. The ID 
value in the Individuals record serves to identify that particular individual throughout the system. Most data for 
an individual is stored in other tables. Birth, marriage, death, and other events are stored in the Events table; 
birth names, married names, nicknames, aliases, and numeric identifiers such as SSN and AFN numbers are 
stored in the Individual Names table; links to parents are stored in the Child to Family Links table; spouse 
links are stored in the Spouse to Family Links table and so on. Each type of data is stored in a separate 
table to make it possible to have "one-to-many" links: for any particular individual, there can be many linked 
records in the Events table. If event data had instead been stored in the main Individual record, then the 
number of events would have been restricted to the number of fields defined in the record structure. 

Events Table 

The Events table has perhaps the most complicated structure in the system. Unlike Individual Names records, 
Event records are not "owned" by a single individual. Each Event record can have up to three individuals 
directly associated with it, named PRIMARY, SPOUSE, and OTHER. Any number of additional individuals can 
be associated as witnesses. Some event types use only PRIMARY, such as "Died" and "Buried". The 
marriage-related events use PRIMARY and SPOUSE. Events relating two individuals who are not considered 
a family use PRIMARY and OTHER. The birth event uses PRIMARY and SPOUSE for the parents, and 
OTHER refers to the child. 

Events data for an individual appears on the "Events" tab. But because event records can be shared by up to 
three individuals, an Events record entered for one individual may automatically appear as a record on the 
Events tab of up to two other individuals. For example: suppose a marriage event for Reginald Smythe is 
entered, with a date of 15 July 1803 at Burnt Pelham, Hertfordshire, England, and the spouse is entered as 
Elizabeth Conyer. Later, when you are looking at the data for Elizabeth Conyer, you will see that she has a 
marriage event record, with the same date and place, showing a spouse by the name of Reginald Smythe. 
This is another view of the same event record, except that the viewpoint has changed. Elizabeth is now 
considered PRIMARY, and Reginald is the SPOUSE.  
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Data Tables 
TABLE NAME CONTENTS 
Child to Family Links Links from individuals to parent families 
Citations Citation data 

Contact Links Links from data of various types to contacts. The "Ref Type" field identifies 
reference type: I = Individual, P = place, etc. 

Contacts Address, phone, and other contact information 

Correspondence 
Correspondence data. The "Correspondent Type" field identifies the type of 
correspondent with one of the constants DI_RESEARCHER, DI_IND, 
DI_PLACE. 

Event Roles 

Defined roles for events, available for use with witnesses.  "Role" contains the 
role name. "Sequence" is the Display sequence in the witness list. "Template" 
is the default witnessed template. "Unique" is Yes/No: Is this role unique in the 
event. 

Event Tags 

Main event type data. The "Tag" field contains the GEDCOM tag. The 
"Secondary" field indicates the secondary type: 1 = Parents; 2 = Spouse; 3 = 
Other Individual; 4= Name Variation; 5 = Identifier; 6 = Attribute; 7 = Text Item. 
"SecType" is the type of Identifier or Attribute. "Flags" contains Unique, Group 
A, Group B. 

Event Templates Supplementary event type data. 
Events Individual events 
Excerpts Begin and end markers for citation excerpts from source evidence text 
Families Family data 
Flag Names Names of individual flags 

Genbox 

Special table for holding identification information. "Creation Date": Date this 
database was created. "Researcher ID": The current Researcher ID. "Source 
Version": Source system ID and version that created this file. "Source Name": 
Name of source program. "Source Corp": Company and address of source 
program. "Data Version": Version of this data structure. "Copyright": Copyright 
statement for content. "Description": Description of content. 

Individual Flags Links from individuals to individual flags 
Individual Names Individual names 
Individuals Main table of individual data 
List Links members of lists 
Lists Defined lists 
Media Flag Names Names of media flags 
Media Flags Links from media to media flags 
Multimedia media 
Multimedia Link links from media to other data types 
Notes Notes. "Note Type": G = General; R = Research 
Place Flag Names Names of place flags 
Place Flags Links from places to place flags 

Place Names 

Names of places. "Level": 1: Country; 2: State/Province; 3: County/Parish; 4: 
Township; 5: City/Town; 6: Local Site. "Parent ID": Link to parent part name ID. 
"Sequence": First is standard. "Full ID": If this name is an abbreviation, this 
points to the equivalent full name; otherwise, it points to the short name. 

Places 

Main table of places data. "ADM": 4-Letter Administration code, levels 1 and 2. 
"Flags": Bit 1 = historical. "Latitude": Formatted as: DD MM SS C (degrees, 
minutes, seconds, N/S). Stored as + for N, - for S. "Longitude": Formatted as: 
DDD MM SS C (degrees, minutes, seconds, E/W). Stored as + for E, - for W. 

PlacesQuery Special table used by query subsystem 
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Project Objectives Projects, objectives, and tasks 
Project to Research Links Links from projects/objectives to research targets 
Research Research targets 
Researchers Researchers 
Searches Searches defined for research targets 
Source Contents Information on contents of a source 
Source Templates Source type data 

Sources 
Main table on source data. "Agency": Responsible Agency. "Sort Date": 
Publication date for source; creation date for document. "Locater": Location 
with source or repository; call number. 

Spouse to Family Links Links from individuals to families 
Value Special table used by query subsystem 
Witnesses Witnesses of events 
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File List 
SYSTEM FOLDER: File Version Size (KB) File Date Description 

asycfilt.dll 2.40.4275.1 145 KB Feb 11, 2000 Microsoft OLE 2.40 for 
Windows NT/95 

atl.dll (Win 95/98/Me) 3.0.8449.0 73 KB Feb 11, 2000 ATL Module for Windows 
(ANSI) 

atl.dll (Win
2000/NT/XP) 

 3.0.8449.0 58 KB Feb 11, 2000 ATL Module for Windows 
NT (Unicode) 

comcat.dll 4.71.1460.1 22 KB Feb 11, 2000 Component Category 
Manager Library 

mfc42.dll 6.0.8665.0 973 KB Feb 11, 2000 MFC DLL Shared Library 
mfc42u.dll 6.0.8665.0 973 KB Feb 11, 2000 MFC DLL Shared Library 

msvcirt.dll 6.0.8168.0 77 KB June 16, 1998 Microsoft C++ Runtime 
Library 

msvcp60.dll 6.0.8972.0 393 KB Aug 29, 2000 Microsoft C++ Runtime 
Library 

msvcrt.dll 6.0.8797.0 273 KB March 7, 2000 Microsoft C Runtime Library

oleaut32.dll 2.40.4275.1 585 KB Feb 11, 2000 Microsoft OLE 2.40 for 
Windows NT/95 

olepro32.dll 5.0.4275.1 161 KB Feb 11, 2000 Microsoft OLE 

stdole2.tlb 2.40.4275.1 18 KB Feb 11, 2000 Microsoft OLE 2.40 for 
Windows NT/95 

shfolder.dll 6.0.2600.0 22 KB Aug 18, 2001 Shell Folder Service 

msjtes40.dll 4.0.2521.8 233 KB March 5, 1999 Microsoft Jet Expression 
Service 

vbajet32.dll 6.0.1.8268 31 KB Jan 21, 1999 
Visual Basic for 
Applications Development 
Environment 

expsrv.dll 6.0.0.8268 371 KB Jan 21, 1999 
Visual Basic for 
Applications Runtime - 
Express 

mswstr10.dll 4.0.2521.8 601 KB March 5, 1999 Microsoft Jet Sort Library 
msjet40.dll 4.0.2521.8 1,465 KB March 6, 1999 Microsoft Jet Engine Library

msjint40.dll 4.0.2521.8 149 KB March 5, 1999 Microsoft Jet International 
Components 

msjter40.dll 4.0.2521.8 53 KB March 5, 1999 Microsoft Jet Errors 
DAO FOLDER:     

dao360.dll 3.60.3714.5 545 KB Jan 28, 2000 Microsoft DAO 3.6 Object 
Library 
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File Types 
Genbox makes use of a number of different file types, each identified by their three-letter file extension.  

Common Misspellings Type (.GCM) 
The Spell Checker Tool makes use of a Common Misspellings File. This plain text file has two entries per 
line: the misspelling followed by the correct spelling. 

Chart Type (.GCT) 
On the Chart View, a Genbox chart can be saved as a Chart File. A saved chart file can be opened in 
Genbox, where you can view, edit, and print it. 

A Genbox chart file is saved in a proprietary format. It begins with the ASCII string "GBOXGCHT". The next 
four characters identify the major and minor version of the chart format. 

Chart Options File Type (.GCO) 
On the Chart Options View, the options used to generate a Genbox chart can be saved to a Chart Options 
File. A saved chart options file can be opened in Genbox, where you can view the options, change them, and 
then generate a chart. 

The chart options file is saved in a proprietary format. It begins with the ASCII string "GBOXCOPT". The next 
four characters identify the major and minor version of the chart options format. 

Export Options File Type (.GXO) 
On the Export Options View, the options selected to export data can be saved to an Export Options File. A 
saved export options file can be opened in Genbox, where you can view the options, possibly change them, 
and then export data. 

The export options file is saved in a proprietary format. It begins with the ASCII string "GBOXXOPT". The next 
four characters identify the major and minor version of the export options format.  

GEDCOM File Type (.GED) 
GEDCOM is a standard genealogy file format designed for the transfer of data between genealogy programs. 
Genbox can import data from GEDCOM files and export data into a GEDCOM file. 

GEDCOM was designed to handle basic genealogy data types. The standard defines how extensions can be 
added for novel data types. Genbox uses these extensions to export its novel data types. All data stored in a 
Genbox database can be exported to a GEDCOM file, and imported by Genbox. You can assume that other 
genealogy programs probably won't support importing of the data in a GEDCOM file specific to Genbox. The 
import of basic genealogy data by other genealogy programs should work, with the extra data ignored. 

Genbox Database Type (.GDB) 
A Genbox database is stored in a Genbox Database File (.GDB). This is the same as the Microsoft database 
format (.MDB). It can be opened as a database in Microsoft Access 2000.  

Note: modifying a Genbox database file outside of the program could corrupt the database, leading to a 
partial or full loss of data. 
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Compressed Genbox Database File (.GDZ) 
When New Database is selected from the File menu, Genbox initializes the new database by copying the 
data stored in the special file GBXDBINI.GDZ. This file contains a standard Genbox database, compressed in 
standard ZIP format.  The initialization database typically includes data on higher-level places, source types, 
event types, and flag definitions. 

If this file is not found in the same directory as GENBOX.EXE, new databases will be created without any 
initial data. You can initialize a blank database by importing data from one of your other databases. 

Creating your Own Initialization Database 

You can create your own GBXDBINI.GDZ file for initialization of new databases:  

1. If you want to start from scratch, rename or delete the current GBXDBINI.GDZ file first. 
2. On the File menu, select New Database. Choose a name for your initialization database. 
3. Import or enter the data you want to include in the initialization of new databases.  
4. Close the database. 
5. Using PkZIP or WinZIP, compress your initialization database. Name the compressed file 

GBXDBINI.GDZ. 
6. Move the file to the same directory as GENBOX.EXE. 

Note: Be careful not to import data on individuals and other data types that should not be part of a new 
database. 

Saved Query File Type (.GQY) 
On the Query View, a defined Genbox query can be saved for later use as a Saved Query File. 

A Genbox query file is saved in a proprietary format. It begins with the ASCII string "GBOXQDEF". The next 
four characters identify the major and minor version of the query format. 

Report Options File Type (.GRO) 
On the Report Options View, the options used to generate a Genbox report can be saved to a Report 
Options File. A saved report options file can be opened in Genbox, where you can view the options, change 
them, and then generate a report. 

The report options file is saved in a proprietary format. It begins with the ASCII string "GBOXROPT". The next 
four characters identify the major and minor version of the report options format.  

Report Options File Type (.GRO) 
On the Report Options View, the options used to generate a Genbox report can be saved to a Report 
Options File. A saved report options file can be opened in Genbox, where you can view the options, change 
them, and then generate a report. 

The report options file is saved in a proprietary format. It begins with the ASCII string "GBOXROPT". The next 
four characters identify the major and minor version of the report options format.  

Rich Text File Format (.RTF) 
On the Report View, a Genbox report can be saved in Rich Text Format. A report saved in rich text format 
can be opened in Genbox, where you can view, edit, and print it. You can also open a rich text format file in 
Microsoft Word, Corel WordPerfect, and other word processors. 

Rich text format is a standard document format. Rich text documents can include fonts and layout 
specifications. 
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ZIP File Format (.ZIP) 
When you create backup files with the Backup option on the File Menu, the files are saved in ZIP File Format 
(.ZIP). 

ZIP is a standard file format for compressed files. 

Dynamic Link Libraries (.DLL) 
Genbox makes use of dynamic link libraries, which have the extension .DLL. These are essential program 
components. The file GENBOXENU.DLL, for example, contains the English version of all system resources. 
The files GBXINIT.DLL and GBXINIT4.DLL are used for system startup initialization. Other DLL files provide 
language translations for other languages. 
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Folders 

Default Folders 

Genbox tracks the names of system folders (also called directories) that are selected in the course of 
completing various operations, so that they can become the default folder for similar operations in the future. 

Genbox Main Folder 

The folder on your system that contains GENBOX.EXE is the Genbox Main Folder.  The content of this folder 
includes: 

    Genbox.exe  The main program. 
    GenboxENU.dll Resource file for English (United States) language. Resource files for other languages 

may also appear, such as GenboxENG.dll for English (United Kingdom) and 
GenboxDEU.dll for German (Germany). In general: when a file name ends in three 
capitalized letters from the set of language codes, it indicates the file is specific to that 
language. The spelling files, for example, also follow this naming convention. 

    GBXDBINI.GDZ Compressed Genbox initialization database. 
    Genbox.chm Online help file. 
    commonENU.gcm Commonly misspelled words, for English (United States). 
    mainENU.gdt Main spelling dictionary for English (United States). 
    userENU.gdt User-defined spelling dictionary for English (United States). This file is optional. 
    pad_file.xml File version information. (optional) 

Subfolders Used by Genbox 

There are three subfolders beneath the Genbox Main Folder that are used by the menu system. These folders 
are named: 

• Chart Options Menu 
• Report Options Menu 
• Sample 

The "Chart Options Menu" subfolder contains the Genbox chart options files (extension .GCO) that will appear 
as the choices on the submenus of the Chart Options Menu. The name of each chart options file determines 
both where it will appear on the submenus and what the text of the menu option will be. 

The "Report Options Menu" subfolder contains the Genbox report options files (extension .GRO) that will 
appear as the choices on the submenus of the Report Options Menu. 

See the section Charts and Reports Submenus for more information. 

The “Sample” subdirectory contains the sample.ged GEDCOM file, which is used to initialize the sample.gdb 
sample database that is also stored in this folder. Any pictures used by the sample database are also stored 
there. 
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Keyboard Shortcuts 
A number of menu commands can also be activated using the keyboard. The special key sequences are 
given in the table below. 
ALT+DOWN ARROW Select: Select Records... 
ALT+END Select: Last Record 
ALT+ENTER Edit: Properties 
ALT+HOME Select: First Record 
ALT+LEFT ARROW Select: Jump Back 
ALT+PAGE DOWN Select: Next Record 
ALT+PAGE UP Select: Previous Record 
ALT+RIGHT ARROW Select: Jump Forward 
ALT+UP ARROW Tools: Search... 
CONTEXT MENU KEY (on some keyboards) Accesses right-click context menu. 
CTRL+ESC Edit: Restore 
CTRL+F6 Capture Window 
CTRL+PAGE DOWN Next Tab 
CTRL+PAGE UP Previous Tab 
CTRL+A Edit: Select All 
CTRL+B Rich Text: Bold 
CTRL+C Edit: Copy 
CTRL+D Insert Field Code 
CTRL+F Find 
CTRL+G Go To 
CTRL+I Rich Text: Italic 
CTRL+L Add Subrecord 
CTRL+M Mark Record 
CTRL+N New Main Record 
CTRL+O File: Open 
CTRL+P File: Print 
CTRL+R Edit: Rename 
CTRL+S File: Save 
CTRL+U Rich Text: Underline 
CTRL+V Edit: Paste 
CTRL+W Close Window 
CTRL+X Edit: Cut 
CTRL+Z Edit: Undo 
ESC Edit: Cancel 
F1 Context-Sensitive Help 
F2 Toggle Codes 
F3 Find Next 
SHIFT+F3 Find Previous 
F4 Jump to Citation 
F5 Magnify 
F7 Spell Checker 
F8 Next Window 
SHIFT+F8 Previous Window 
A key sequence like "CTRL+B" is entered by pressing and holding the CONTROL key, then pressing the "B" 
key. 



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 502

Language Codes 
Following is a list of the language codes used by Genbox.  

AFK Afrikaans 
SQI Albanian 
AR Arabic 
ARA Arabic (Saudi Arabia) 
ARB Arabic (Lebanon) 
ARI Arabic (Iraq) 
ARE Arabic (Egypt) 
ARG Arabic (Algeria) 
ARJ Arabic (Jordan) 
ARK Arabic (U.A.E.) 
ARL Arabic (Libya) 
ARM Arabic (Monaco) 
ARO Arabic (Oman) 
ARQ Arabic (Qatar) 
ARS Arabic (Syria) 
ART Arabic (Tunisia) 
ARU Arabic (Bahrain) 
ARY Arabic (Yemen) 
HYE Armenian 
AZE Azeri 
EUQ Basque 
BEL Belarusian 
BGR Bulgarian 
CAT Catalan 
CHS Chinese (PRC) 
CHT Chinese (Taiwan) 
ZHH Chinese (Hong Kong) 
ZHI Chinese (Singapore) 
ZHM Chinese (Macau SAR) 
CSY Czech 
DAN Danish 
NL Dutch 
NLB Dutch (Belgium) 
NLD Dutch (Netherlands) 
EN English 
ENA English (Australia) 
ENB English (Belize) 
ENC English (Canada) 
ENG English (United Kingdom) 
ENI English (Ireland) 
ENJ English (Jamaica) 
ENP English (Philippines) 
ENS English (South Africa) 
ENT English (Trinidad) 
ENU English (United States) 
ENW English (Zimbabwe) 
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ENZ English (New Zealand) 
ETI Estonian 
FOS Faeroese 
FAR Farsi 
FIL Filipino 
FIN Finnish 
FR French 
FRA French (France) 
FRB French (Belgium) 
FRC French (Canada) 
FRL French (Luxembourg) 
FRM French (Monaco) 
FRS French (Switzerland) 
GLC Galician 
KAT Georgian  
DE German 
DEA German (Austria) 
DEU German (Germany) 
ELL Greek 
GUJ Gujarati 
HEB Hebrew 
HIN Hindi 
HUN Hungarian 
ISL Icelandic 
IND Indonesian 
IT Italian 
ITA Italian (Italy) 
ITS Italian (Switzerland) 
JPN Japanese 
KAN Kannada 
KKZ Kazakh 
KNK Konkani 
KOR Korean 
KYR Kyrgyz 
LVI Latvian 
LTH Lithuanian 
MKI FYRO Macedonian 
MS Malay 
MSB Malay (Brunei Darussalam) 
MSL Malay (Malaysia) 
MAR Marathi 
MON Mongolian 
NO Norwegian 
NOR Norwegian (Bokmal) 
NON Norwegian (Nynorsk) 
PLK Polish 
PT Portuguese 
PTB Portuguese (Brazil) 
PTG Portuguese (Portugal) 
PAN Punjabi 
ROM Romanian 



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 504

RUS Russian 
SAN Sanskrit 
SRB Serbian (Cyrillic) 
SRL Serbian (Latin) 
SLV Slovenian 
ES Spanish 
ESA Spanish (Panama) 
ESB Spanish (Bolivia) 
ESC Spanish (Costa Rica) 
ESD Spanish (Dom. Rep.) 
ESE Spanish (El Salvador) 
ESF Spanish (Ecuador) 
ESG Spanish (Guatamala) 
ESH Spanish (Honduras) 
ESI Spanish (Nicaragua) 
ESL Spanish (Chile) 
ESM Spanish (Mexico) 
ESN Spanish (Spain, intl. sort) 
ESO Spanish (Colombia) 
ESP Spanish (Spain, trad. sort) 
ESR Spanish (Peru) 
ESS Spanish (Argentina) 
ESU Spanish (Puerto Rico) 
ESV Spanish (Venezuela) 
ESY Spanish (Uruguay) 
ESZ Spanish (Paraguay) 
SWK Swahili 
SV Swedish 
SVE Swedish (Sweden) 
SVF Swedish (Finland) 
SYR Syriac 
TAM Tamil 
TTT Tatar 
TEL Telugu 
THA Thai 
TRK Turkish 
UKR Ukrainian 
URD Urdu 
UZB Uzbek 
VIT Vietnamese 
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Sentence Template Code Reference 
Following is the list of sentence template field codes recognized by Genbox. These codes can be used in 
event templates and also in general and research notes. To use a code, enclose it in square brackets, such 
as "[L1234]". For a discussion of how to construct templates, see the section Sentence Templates. 

Base Codes Modifiers  

BOLD  Turn bold style on. (Instead of a code, you can also highlight the text to be 
bolded and press the "B" toolbar button.) 

BOLD 0 Turn bold style off. 

UNDL  Turn underline style on. (Instead of a code, you can also highlight the text to 
be underlined and press the "U" toolbar button.) 

UNDL 0 Turn underline style off. 

ITAL  Turn italic style on. (Instead of a code, you can also highlight the text to be 
italicized and press the "I" toolbar button.) 

ITAL 0 Turn italic style off. 

P  
Primary individual name. Full name shown on first reference; given name (or 
nickname) on second reference; pronoun (he/she) if last referenced individual 
was the same and sex is known. 

S  
Spouse individual name. Full name shown on first reference; given name (or 
nickname) on second reference; pronoun (he/she) if last referenced individual 
was the same and sex is known. 

S (with ID) 
Embedded Source citation. The ID value is the source citation ID. To add/edit 
source citations, press the F4 key. Source citations are handled separately 
from other field codes. 

O  
Other individual name. Full name shown on first reference; given name (or 
nickname) on second reference; pronoun (he/she) if last referenced individual 
was the same and sex is known. 

P 1, 2, 3 

Principal 1, 2, or 3 individual name. These are same three individuals that are 
referenced by [P], [S], and [O], but these references are context-independent. 
That means the names that fill the [P1], [P2], [P3] codes will not change 
depending on the current focus individual, which is not always the case for 
the context-dependent [P], [S], and [O] codes. 

W  

Witness name. Full name shown on first reference; given name (or nickname) 
on second reference or pronoun (he/she) if last referenced individual was the 
same and sex is known. [W1] returns name of first listed witness; [W2] returns 
names of second listed witness. Witnesses can also be referenced by role 
name: [W: groomsman] returns name of first witness with the role 
"groomsman". An ending wildcard can be used with the role name, so for 
example "[WW:god*]" would return a list of witnesses with roles of "godfather" 
or "godmother". The [W] code without a numeric parameter or role name 
parameter references the most recently referred witness. 

WW  
The list of all witness names that have not been mentioned already, in a 
comma separated list, with "and" before the last name. A role name filter can 
also be appended following a colon, as in [WW:bridesmaid]. 

WWR  
A list of all witness names that have not been mentioned already, along with 
roles, if any. A role name filter can also be appended following a colon, as in 
[WWR:god*]. 

WW, WWR ' When the single-quote qualifier is appended, as in [WW'] or [WWR'], this 
returns the "list" of witnesses only when there is exactly one witness left. 

WW, WWR " 

When the double-quote qualifier is appended, as in [WW"] or [WWR"], this 
returns the "list" of witness names only when there are two or more witness 
names left. By using the single and double quote modifiers, sentence 
templates that use singular or plural verbs can be constructed. 

I (with ID) Individual name of any individual in the database: ID value must follow the 
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base code, as in [I234] for the name of individual ID 234. Full name (preferred 
or primary, depending on report options) shown on first reference; given 
name (or nickname) on second reference; pronoun (he/she) if last referenced 
individual was the same and sex is known. 

N  When not followed by a number: Secondary value of individual name variation 
or identifier. 

N (with ID) 

Specific individual name/identifier of any individual in the database: Identifier 
ID value must follow the base code, as in [N3824] for individual identifier ID 
3824. The name appears as stored in the identifier record. With this code, you 
can control which name variation appears in the output. 

P, S, O, W, I, 
WW, WWR + Like base code, but forced to show full name always. 

P,S, O, W, I, 
WW, WWR ~ Like base code, but forced to show given name/nickname always. 

P, S, O, W, I - Like base code, but pronoun is never used. 

P, S, O, W, I = Like base code, but pronoun is always used. Note: care must be taken that 
the context will always make the reference clear. 

P, S, O, W, I, 
WW, WWR m, f, u, o 

These modifiers apply a filter according to sex: male (m), female (f), unknown 
gender (u), or other gender (o). If the individual indicated by the base does 
not match the sex modifier, then an empty value is returned. This allows 
templates to be tailored to the sex of the individual. 

P, S, O, W, I P 

Possessive case for primary, spouse, other, and witness individuals (his or 
her, depending on sex data value). If the individual has not been mentioned 
yet in the current context, the given name will be made possessive, producing 
a construction such as "John's". 

P, S, O, W, I N 
Nominative case for primary, spouse, other, and witness individuals. These 
will be filled with "he" or "she" when a pronoun is to be used. Nominative case 
is the default when no case qualifier is given. 

P, S, O, W, I D Direct object for primary, spouse, other, and witness individuals. These will be 
filled with "him" or "her" when a pronoun is to be used. 

P, S, O, W, I I Indirect object for primary, spouse, other, and witness individuals. These will 
be filled with "him" or "her" when a pronoun is to be used. 

P, S, O, W, I X Reflexive case for primary, spouse, other, and witness individuals. These will 
be filled with "himself" or "herself" when a pronoun is to be used. 

A P, S, O, W, I, 
1, 2, 3 

Age of individual at time of event, in years, for primary, spouse, other, 
witness, individual, principal 1, principal 2, or principal 3. An Individual ID is 
required with the base code "I". 

WR  
Witness role. [WR1] returns role of first witness, [WR2] returns role of second 
witness. [WR] without a numeric parameter returns role of most recently 
shown witness. 

C  Secondary value of contact address. 

D  Date (space, qualifier, day+month+year, parenthetical part). Default qualifier 
will be "on" if day value or "in" if month or year only. 

0D  Date qualifier only. Default qualifier will be "on" if day value or "in" if month or 
year only. 

1D  Date without the qualifier. 
DY  Date year. 
DM  Date month name. 
DD  Date day of month. 

D+L  
Date and Location. Either date or location may appear first. The actual 
ordering of the data and place information for a particular event will be based 
on report option settings, surety levels, and data modifiers.  

L  
Standard place name (location) for the event. Includes leading space and 
place modifier value. Full place levels are shown on first reference; first level 
(or enough levels to distinguish place in context) is shown on second 
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reference; "there" is used if last referenced place was the same. The default 
place modifier is normally  "at" if a local site or "in" otherwise. 

L (with ID) 

Standard place name for any place in the database. Place ID is required. Full 
place levels are shown on first reference; first level (or enough levels to 
distinguish place in context) is shown on second reference; "there" is used if 
last referenced place was the same. 

L + Like [L] but forced to show full place levels always. 

L - Like [L] but "there" is never used; if the place is the same as the previous one 
mentioned, the lowest place level will be shown instead. 

L ~ Like [L] but only the lowest non-blank place level is used. 

0L, 1L, 2L, 3L, 
4L, 5L, 6L  

A part number preceding the "L" base code indicates that only a particular 
place level (0-6) should be returned. 0L = place modifier; 1L = local site; 2L = 
city/town; 3L = township; 4L = county/parish; 5L = state/province; 6L = 
nation/area. For example: if the place stored was "north of Miami, Florida", 
and the template was "[P] lived [0L] the fine city of [2L] in the sunny state of 
[5L]", the result would be "He lived north of the fine city of Miami in the sunny 
state of Florida". References to empty place levels will be blank. No leading 
place modifiers are used with place level names. 

1L, 2L, 3L, 4L, 
5L + Show full place levels starting with the indicated level. No leading place 

modifier. 
1L, 2L, 3L, 4L, 
5L - Show contextual place name starting with the indicated level. No leading 

place modifier; "there" is never used. 
1L, 2L, 3L, 4L, 
5L ~ Show lowest non-blank place level on or after the indicated starting level. 

LN (with ID) 

place name variation for any place in the database. Place Name ID is 
required. Full place levels are shown on first reference; first level (or enough 
levels to distinguish place in context) is shown on second reference; "there" is 
used if last referenced place was the same. This code allows you to control
which place name variation is used. 

T  Secondary value of attribute or text. 

G  

Event general note. When the [G] code is used to explicitly include general 
notes in the sentence, then the note text will be considered an integral part of 
the sentence, overriding note content options. Sentence terminating 
punctuation will appear at the end of the template, along with any sentence-
level citation references; thus, the text of the note will assume the same 
sentence-level citations as the rest of the sentence.  

When no [G] code is specified in an event template, then report content 
options will control whether general notes appear after the event sentence. In 
this case, the general note is considered to start a separate sentence from 
the event template; the event template will receive sentence terminating 
punctuation and any source citation references will immediately follow, then 
the general note will appear. 

G P, S, O, W, I, 
N, L, LN, E 

General note for Primary, Spouse or Source, Other, Witness, Individual, 
Individual Name, Place, Place Name, or Event. If "GS" is followed with a 
number, this is a Source ID general note reference; otherwise it is the event 
Spouse/Secondary reference. I, N, L, LN, and E require an ID value when 
referring to data items outside the current event record. For example: "[P] 
changed his name to [N]. [GN]" would include the general notes from the 
linked name record. 

R  

Event research note. When the [R] code is used to explicitly include research 
notes in the sentence, then the note text will be considered an integral part of 
the sentence, overriding note content options. Sentence terminating 
punctuation will appear at the end of the template, along with any sentence-
level citation references; thus, the text of the note will assume the same 
sentence-level citations as the rest of the sentence.  

When no [R] code is specified in an event template, then report content 
options will control whether research notes appear after the event sentence 
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(or optionally in a footnote reference). In this case, the research note is 
considered to start a separate sentence from the event template; the event 
template will receive sentence terminating punctuation and any source 
citation references will immediately follow, then the research note will appear. 

R P, S, O, W, I, 
N, L, LN, E 

Research note for Primary, Spouse or Source, Other, Witness, Individual, 
Individual Name, Place, Place Name, or Event. If "RS" is followed with a 
number, this is a Source ID research note reference; otherwise it is the event 
Spouse/Secondary reference. I, N, L, LN, and E require an ID value. 

P1, P2, P3 % 

"When focus individual" modifier. When the percent sign (%) is added to the 
principal codes P1, P2, and P3, a value will be produced only when the 
selected principal is the current focus individual. With this feature, you can 
construct conditional groups in the general notes that will be based on which 
principal in the event is the current focus individual. This means different 
event notes can be stored for the father, mother, and child of an event. 

PID  Individual ID of primary individual. 
SID  Individual ID of spouse. 
CR  Start a new line (carriage return). 
TAB  Insert a tab character. 
E  Event name. Includes leading indefinite article ("a" or "an" in English). 
0E  Event name article only ("a" or "an"). 
1E  Event name without the article. 
ET  Event type. Includes leading indefinite article ("a" or "an" in English). 
0ET  Event type article only ("a" or "an"). 
1ET  Event type without the article. 

CHILD  
Relation of other to primary: son, daughter, or child. For example: "[P] had a 
[CHILD] [D+L]" would read "Reginald had a son ..." if the sex of the OTHER 
individual is a male. If the sex is unknown, "child" will be used. 

* 
COMMENT  

When appearing in a group, as in "< this is the comment text [COMMENT]>, 
the text in the group will be treated as informational, and will not appear in the 
output. You can also use this keyword to "comment out" portions of a 
template you wish to temporarily disable, as in "<[*] <. Witnesses: [WWR]>>". 

...  

(Global template only) This keyword represents the results of the local event 
template. It allows the global template to position elements both before and 
after the local template's results. Note: if missing from the global template, all 
local event templates will effectively be disabled. 
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Source Template Code Reference 
Following is a list of the source template codes recognized by Genbox. Each of these template codes must be 
entered with square brackets, as in [BOLD], in order to be recognized. They can be entered in upper or lower 
case. For a discussion of source templates, see the section Source Templates. 

BOLD Turn bold style on. 
BOLD0 Turn bold style off. 
UNDL Turn underline style on. 
UNDL0 Turn underline style off. 
ITAL Turn italic style on. 
ITAL0 Turn italic style off. 
NEWL New line. 
CD Citation detail from the citation record. 
EXCERPT Citation excerpt text. 
DOC ID Source ID of the lower source record. This can be used for diagnostic purposes. 
DOC TITLE Full Title of the lower source. 

DOC SHORT 
TITLE 

Short Title of the lower source. If used in the secondary citation and the Short Title field is 
empty, a short title will be auto-generated from the full title. If used in the primary citation 
and the Short Title is the same as the full title, the [DOC SHORT TITLE] value will be set to 
blank; this makes it possible to construct a template clause of "<hereinafter called [DOC 
SHORT TITLE]>" that will only appear when the short title is different from the full title. 

DOC PLACE Full place information of the lower source record. 

DOC PLACE INV 
Full place information of the lower source, inverted so that the country place level is shown 
first, followed by state, county, city, and local site. Parts are separated by periods. This 
code is useful in bibliographies, where entries are sorted by location. 

DOC COUNTRY Country place level of lower source record. 
DOC STATE State place level of lower source record. 
DOC COUNTY County place level of lower source record. 
DOC CITY City place level of lower source record. 
DOC LOCAL 
SITE Local site place level of lower source record. 

DOC AUTHOR Author of lower source record. 
DOC AUTHOR 
TYPE 

Author type of lower source record. If the type is "Author" or "Agency", the type will be 
omitted. 

DOC SUBJECT Subject field of the lower source record. 
DOC DATE Date value of the lower source record. 

DOC ORIGINAL 
DATE 

Second date field of the lower source record. This is used for the earliest date of a 
document. For example, the date a will was signed could be stored in this field, and the 
date the will was probated would go in the normal date field. If only one date value is 
available, it should go in the [DOC DATE] field. 

DOC LOCATER Locater field of the lower source record. 
DOC QUALIFIER Qualifier field of the lower source record. 
DOC NOTES General notes of the lower source record. 
DOC TEXT Evidence text of the lower source record. 
RATIONALE Citation rationale text. 
SOURCE ID Source ID of the higher source. This can be used for diagnostic purposes. 
SOURCE TITLE Title of the higher source record. 

SOURCE 
SHORT TITLE 

Short Title of the higher source. If used in the secondary citation and the Short Title field is 
empty, a short title will be auto-generated from the full title. If used in the primary citation 
and the Short Title is the same as the full title, the [SOURCE SHORT TITLE] value will be 
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set to blank; this makes it possible to construct a template clause of "<hereinafter called 
[SOURCE SHORT TITLE]>" that will only appear when the short title is different from the 
full title. 

SOURCE 
AUTHOR Author of the higher source record. 

SOURCE 
AUTHOR TYPE 

Author type of the higher source record. If the type is "Author" or "Agency", the type will be 
omitted. 

SOURCE 
LOCATER Locater field of the higher source record. 

SOURCE 
QUALIFIER Qualifier field of the higher source record. 

SOURCE 
NOTES General notes of the higher source record. 

SOURCE TEXT Evidence text of the higher source record. 
PUBLISHER Name of publisher of the higher source record. 
PUB DATE Date field of the higher source record. 

PUB ORIGINAL 
DATE 

Second date field of the higher source record. This is useful for storing the original 
publication date of books that have been reprinted, with the more recent date in the normal 
date field. 

PUB PLACE Full place information of the higher source record. 

PUB PLACE INV 
Full publisher place information of the higher source, inverted so that the country place 
level is shown first, followed by state, county, city, and local site. Parts are separated by 
periods. This code is useful in biographies, where entries are sorted by location. 

REPOSITORY Full repository name. 
REPOSITORY 
PLACE Full place information for the repository. 

REPOSITORY 
PLACE INV 

Full publisher place information of the repository, inverted so that the country place level is 
shown first, followed by state, county, city, and local site. Parts are separated by periods. 
This code is useful in biographies, where entries are sorted by location. 

REPOSITORY 
ADDRESS Repository contact address information formatted as one line. 

REPOSITORY 
URL URL of the repository. 

REPOSITORY 
EMAIL Email address of the repository. 

REPOSITORY 
COUNTRY Country place level of the repository. 

REPOSITORY 
STATE State place level of the repository. 

REPOSITORY 
COUNTY County place level of the repository. 

REPOSITORY 
CITY City place level of the repository. 

REPOSITORY 
LOCAL SITE Local site level of the repository. 

REPOSITORY 
NOTES General notes of the repository. 

ANNOTATION Annotation text from the citation record. 
LEAD TEXT Lead text from the citation record. 

NOSEP 

(for use in Annotation text only) When the annotation text ends with the special keyword 
[NOSEP], the default "Citation Separator" text (usually a semicolon) is not added when 
followed by another source in the footnote. This allows two source citations to be formatted 
together and read as one sentence. 

CR Start a new line (carriage return). 
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TAB Insert a tab character. 

TEMPLATE Name of the current source template, shortened by truncating at the first occurrence of a 
comma, semicolon, colon, double quote, opening parenthesis, bracket, or brace. 

* or COMMENT 

When appearing in a group, as in "< this is the comment text [COMMENT]>, the text in the 
group will be treated as informational, and will not appear in the output. You can also use 
this keyword to "comment out" portions of a template you wish to temporarily disable, as in 
"<[*] <[ANNOTATION]>>". 

... 

(Global template only) This keyword represents the results of the local source template. It 
allows the global template to position elements both before and after the local template's 
results. Note: if missing from the global template, all local source templates will effectively 
be disabled. 

[ or ] 

Insert a left or right square bracket. Normally, square brackets indicate the start of a 
template code; to cause a square bracket to appear in the output, it must be entered as a 
template code itself (surrounded by its own set of square brackets). For example: "[[]the 
date is unreadable[]]" would appear in the output as "[the date is unreadable]". 

< or > 
Insert a left or right angle bracket. Normally, angle brackets are used for grouping. To 
cause an angle bracket to appear in the output, it must be entered as a template code, as 
in "[<] this is not a group [>]", which would appear as "<this is not a group>". 

| Insert a vertical bar. Normally, the vertical bar is used to separate alternatives in a group. 
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Glossary 
Ahnentafel 
An individual numbering system for ancestors where the father's number is twice the child's number, and the 
mother's number is twice the child's number plus 1. 

AIFF 
Audio Interchange File Format: an audio file format. 

alert 
A warning or notice of an error in the form of a message that pops up on the screen. 

ASCII 
American Standard Code for Information Interchange: a text file format. ASCII does not support formatted 
text. 

AU 
Audio Data File: an audio file format. 

auto-completion 
A data entry feature that will display the characters that complete a partially-entered name. The program 
guesses at what you are typing and provides the remainder. If the guess is correct, press ENTER or TAB or 
the right arrow to accept it; otherwise simply ignore the added portion and continue typing the correct text. 

AVI 
Audio/Video Interleaved File: a video file format. 

bibliography 
On a report, an alphabetical list of sources that have been referenced in the citations. 

BMDB 
Birth, Marriage, Death, Burial. These four events are commonly selected on charts and reports. 

BMP 
Windows Bitmap: an image file format. 

case sensitive 
Distinguishes between upper and lower case characters. If, for example, a search is case sensitive, then a 
search on "Apple" would not match "APPLE" or "apple". If a search was case insensitive, it would have found 
these matches. 

character field  
A table data field that can include any characters, such as letters, numbers and punctuation. 

chart 
A document generated by the program that is primarily graphical in nature and can be edited in a graphics 
program. 

check box 
A hollow square that represents the status of an option that can be selected or deselected by clicking; when 
selected, an "X" or a check mark appears in the box. 
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citation 
The documentation accompanying a piece of information that states the source of the information. The citation 
can be used to evaluate the validity of the information and also to relocate the source. 

click 
A mouse operation accomplished by first positioning the pointer on the item of interest, then quickly pressing 
and releasing the left mouse button, without moving the mouse. 

clipboard 
An internal temporary storage location used to hold text being transferred between data entry boxes or 
programs. Text is placed on the clipboard with the Cut or Copy menu operations and retrieved with the Paste 
menu operation. 

collateral relative 
A relative who is not a direct ancestor or dependant. 

compact 
For a database, to permanently remove the records that have been marked for deletion. Compacting a 
database will cause the wasted space to be removed, making the file take up less space on the storage 
medium. 

computed field 
A value that is the result of an expression or calculation which is based on other fields in the database. 
Computed fields are not stored in the database. The value shown cannot be edited directly.  

context 
On a report, the individuals, dates, places, and events that have been mentioned in the current unit of 
discourse (sentence or paragraph). By keeping track of the context, the program can use shortened forms 
(short names, pronouns, and conjunctions) to remove redundancy and produce a more natural text flow. 

cursor 
In a text box, the blinking vertical bar used to indicate the current insertion point or selection position. 

data table  
Information stored on the computer and organized into records so that it can be readily manipulated and 
sorted. 

data type 
An identifier for the type of data that can be stored in a field, such as character, numeric, date, pick field, or 
check box. 

default 
The setting used when no selection has been made by the user. 

default_button 
The push button with a bold border in dialogs. It can be selected simply by pressing the Enter key. 

dialog 
A window that appears on the screen when more information is needed in order to complete the command 
requested. 

direct ancestor 
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A parent, grandparent, great-grandparent, etc. in the direct-line ancestry of the starting individual. 

disable 
To make an item unavailable for use. Disabled items are shown "dimmed" and cannot be chosen. 

double-click 
A mouse operation accomplished by first positioning the pointer on the item of interest, then clicking the left 
mouse button twice in rapid succession without moving the mouse. 

drag 
A mouse operation accomplished by first positioning the pointer at the desired location, then pressing and 
holding down the left mouse button while moving the mouse at the same time. The drag operation is complete 
when the button is released. 

EMF 
Enhanced Metafile: an image file format. 

ESC key 
A keyboard key that generates the escape character. The Escape key is labeled "Esc" on the keyboard and 
usually appears in the top left corner. 

event-driven 
A state in which the sequence of actions is determined by the user. When a program is event-driven, the 
computer responds to you instead of making you respond to it. 

export 
To convert data to a special format and write it to an external file that can later be imported into another 
program. 

expression 
A number, variable, word or group of words that can be evaluated using operators and functions to form a 
new value. 

family 
In Genbox, a family is defined as two parents (one possibly unknown) and their joint offspring, if any. Each 
pairing of an individual and spouse constitutes a different family. 

fan chart 
A genealogy chart arranged in arcs similar in appearance to a paper fan. 

field 
In a database table, a particular data element in a record. A data record is made up of several fields, and a 
database table is made up of a number of records. 

On a window, Text boxes that accept input are also sometimes called fields. 

flag 
A data element or program option that can accept a yes/no or on/off setting. 

GCO 
Genbox Chart Options Format: a custom file format for the storage of Genbox chart options. 

GCT 
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Genbox Chart Format: a custom file format for the storage of Genbox charts. 

GDB 
Genbox Database Format: same as MDB, but renamed to help identify the file as a Genbox database. 

GEDCOM 
Genealogical Data Communication: a file format for the exchange of computerized genealogical data. It was 
developed by the Family History Department of the Church of Jesus Christ of Latter-day Saints. 

Genbox 
Pronounced "GEN-box": the name given to the program, reflecting its roots as a genealogical box chart 
generation utility. 

GQY 
Genbox Query Definition Format: a custom file format for the storage of Genbox query definitions. 

GRO 
Genbox Report Options Format: a custom file format for the storage of Genbox report options. 

GRT 
Genbox Report Format: a custom file format for the storage of Genbox reports. 

hierarchy 
An organization of elements into groups and subgroups, where each element is subordinate to the one above 
it. In Genbox, places are organized into a 6-level hierarchy. Project objectives are also organized into a 
hierarchy. 

highlight 
Text displayed in a special style to distinguish it from surrounding text. 

HTML 
Hypertext Markup Language: the file format used for documents published on the world-wide web. 

import 
To load and convert data from a file written in a supported format and either append it to the current database 
or store it to a new database. 

index 
An ordering of records within a table, based on key fields. 

individual 
A data record representing a specific person. Each person stored in a database will have their own individual 
record. When there is doubt whether two source records refer to the same person, separate individual records 
can be created for each. When the match is confirmed, the individual records can be merged. 

insert mode 
The default text-editing mode in which any character you type is inserted at the cursor position and the text to 
the right of the cursor is shifted to the right. Compare with replace mode. 

join condition 
A state that specifies a relationship between two open tables, usually based on a field common to both tables. 
Related tables can have several join conditions. 



       

Copyright © 2005  Thoughtful Creations. All rights reserved. 516

JPG 
Joint Photographic Experts Group: an image file format. 

key 
On a chart or report, the name of an individual or other data item that the chart or report should be based on. 
Multiple keys can be entered. If a list is selected, each member of the list becomes a key. If a query is 
selected, each matching record of the query becomes a key. 

key field 
A field in a record that is used, possibly along with other fields, to uniquely identify a record. 

list box 
A window control that contains multiple lines of text, each line containing data from a different data table 
record. Column headings appear across the top. 

menu bar 
A horizontal strip that appears at the top of the screen and contains menu pads. 

menu options 
Commands, found on menus, that perform specific actions. When you choose a menu option, you are telling 
the program what action to take. 

menu pads 
The menu names found on the menu bar. 

menu name 
A word, phrase or icon on the menu bar that designates one menu. Selecting the menu pad highlights the 
name and causes the menu options to appear. 

menu system 
The combination of the menu bar, menu pads, menus and menu options. 

MIDI 
Musical Instrument Digital Interface: an audio file format. 

minimize 
For a window, the act of causing the window to become an icon that includes the title of the window. 

modal 
Describes the state of a window or dialog when it does not allow another window or dialog to be brought in 
front of it until that window or dialog is deactivated. 

MP3 
MPEG Audio Layer 3: an audio file format. 

MPGA 
MPEG Audio Layer 3: an audio file format. 

MOV 
QuickTime Movie File: a video file format. 
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MPG 
MPEG (Moving Picture Experts Group): a video file format. 

narrative 
A report format where the data is composed into sentences and paragraphs, much like a story. 

NEHGS 
New England Historical and Genealogical Society. 

NGS 
National Genealogical Society. 

numeric field 
A data table field that can store numbers. A decimal point and a leading plus or minus sign can also be stored 
in the field. 

online help 
A guide to the system, accessible while using the program, that provides complete information to all of the 
system functions. 

page down region 
The region on the scroll bar between the down arrow and the thumb. Clicking in this area causes a window to 
scroll forwards through a full page of text at a time. 

page up region 
The region on the scroll bar between the up arrow and the thumb. Clicking in this area causes a window to 
scroll backwards through a full page of text at a time. 

paste 
To place the contents of the clipboard at the insertion point. 

PCX 
PC Paintbrush File: an image file format. 

PDF 
Portable Document Format: a read-only file format for formatted text and graphics, designed for maximum 
portability. A number of third-party companies provide specially-designed printer drivers that, instead of 
printing a document, produce a file in PDF format. With one of these products installed, you can produce 
Genbox charts and reports in PDF format. 

pedigree 
A standard direct ancestor report format where the parents of each individual are shown to the right, with the 
father above the mother. 

PICT 
Macintosh PICT File: an image file format. 

PNG 
Portable Network Graphics: an image file format. 

pointer 
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A small arrow on the screen that follows the movement of the mouse and is used to indicate where your next 
action will take place. 

principal 
For events, one of up to three individuals having primary importance in the event. For a birth event, the 
principals are the father, mother, and child. For a marriage event, the principals are the husband and wife. For 
a death event, the single principal is the individual that died. 

push buttons 
A usually rectangular window control displaying text or an icon with an associated action. The action 
associated with a push button occurs immediately when you click the push button. 

QT 
QuickTime Movie File: a video file format. 

query 
For a database, an operation that searches for records according to a specified criteria. In Genbox, a query 
can be performed to search for individual records. The results of the query are returned in the form of a list. 

radio buttons 
A set of hollow circles followed by text or pictures used to select one option from a group of options. Radio 
buttons are grouped so that only one can be chosen at a time, like the buttons on a car radio. Click a radio 
button to select it. When a radio button is selected, it appears filled in and any previously chosen radio button 
becomes deselected. 

record 
A unit of storage in a data table. Each table can contain a large number of records. Each record is comprised 
of fields. 

related table 
A table with records that store a copy of the key fields of records in another table.  

relational expression 
An expression that describes a link between two tables based on a common field or set of fields. 

report 
A document generated by the program that is primarily textual in nature and can be edited in a word 
processing program. 

repository 
A place where a source can be found. It could be a library, archive, private home, etc. 

RQBE 
Relational Query By Example: an interface design of specifying query conditions by simply filling in blanks to 
show what matching records should look like. 

RTF 
Rich Text Format: a file format for text documents that includes special codes for font characteristics, text 
styles, pictures, headings, etc. RTF is supported by most word processors and provides a way to exchange 
formatted text documents between them. 

scroll 
To move through the contents of a window or control or so that a different part becomes visible. 

scroll bar 
A vertical or horizontal bar along the edge of a window or control used to view the contents that extends 
beyond the visible area. 
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select  
To designate where the next action will take place. To select using a mouse, you click on or drag across 
information. You can also select menu items by typing a letter or number at the prompt, by using a 
combination key press, or by using arrow keys. 

selection  
The information or items that will be affected by the next command. A selection usually appears highlighted. 

Soundex 
A system of codifying words according to their sound, rather than their spelling. 

spouse 
The husband or wife of the current individual. 

SQL 
Structured Query Language: an industry standard for querying relational databases for information. In 
Genbox, the Query tool generates the SQL statement automatically. The generated SQL statement can be 
viewed on the Properties Page. 

tabbed dialog window 
A window containing multiple pages of information, where the names of the pages are displayed in a row of 
boxes called "tabs". Clicking a tab brings its page to the front of the other pages. 

SND 
Audio Data File: an audio file format. 

string  
An item of information consisting of a sequence of text characters. 

tag 
For an event, the usually 4-character label that identifies the event type. For a birth event, the tag is "BIRT". 
For a marriage event, the tag is "MARR". Event tags are part of the GEDCOM standard. 

TGA 
Targa Image File: an image file format. 

template 
A sentence containing codes that will be filled in with data when the report is produced. The template allows 
you to specify how the data should be organized and formatted. Genbox supports templates for events and for 
source citations. It also supports simple templates for chart and report headings, and for default source 
names. 

thumb  
A gray box in the scroll bar that indicates the relative position in the content. If you want to move through the 
content rapidly you can drag the thumb up and down. 

TIFF 
Tagged Image File Format: an image file format. 

TXT 
Text Format: a text file format. 

title bar  
A horizontal band across the top of a window that displays the window's title. 

WAV 
Wave File Format: an audio file format. 

wildcard  
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A character that may be used to represent a sequence of characters when searching for text. Genbox 
supports two wildcards: the asterisk "*" to represent zero or more unknown characters and the question mark 
"?" to represent a single unknown character. 

window  
An independent, boxed area on the screen that displays information. A window can be opened and closed, 
moved around on the desktop, and changed in size. Windows commonly overlap other windows. 

witness 
An individual who was associated with an event but was not one of the principals involved. 

WMF 
Windows Metafile: an image file format. 

word wrap  
The automatic continuation of text from the end of one line to the beginning of the next, so that you don't have 
to press the Enter key at the end of each line as you type. Entire words are usually wrapped. 

WMV 
Windows Media File: a video file format. 

WVX 
Windows Media File: a video file format. 

zoom 
The process of enlarging the current view or window. 
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